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Introduction

Welcome to SigmaPlot® 5.0 This chapter introduces you to some of the basics of 
SigmaPlot, including:

➤ An overview of SigmaPlot features (see below)

➤ Using SigmaPlot in Windows (see page 5)

➤ Using the toolbars (see page 6)

➤ Examples of SigmaPlot graphs (see page 9)

➤ Setting basic program options (see page 17)

➤ Getting help on using SigmaPlot (see page 19)

SigmaPlot 5.0 is a state-of-the-art technical graphing program designed for Windows 
95. It is both Windows 95 certified, and compatible with Office 95 and Office 97. 
SigmaPlot 5.0 is specifically designed to aid in documenting and publishing research, 
specializing in the graphical presentation of results. 

Creating and editing graphs is easy. Simply click a Graph toolbar button, pick your 
data with the Graph Wizard, and you have your graph. You can also use templates to 
apply favorite graphs again and again. 

SigmaPlot also includes a powerful nonlinear curve fitter, a huge scientific data 
worksheet that accommodates large data sets, summary statistics, a mathematical 
transform language and much more.

OLE2 technology is fully supported. You can annotate graphs with the MS Word 
Equation Editor, edit your graphs directly inside Word or PowerPoint, or plot your 
data with an Excel spreadsheet right inside SigmaPlot. 

You can add more numeric power with SigmaStat, a complete basic statistical 
program. SigmaStat contains a set of easily applied statistical tests that can be 
integrated directly in SigmaPlot. The Visual Display Graph Library add-on, designed 
by Edward Tufte, author of The Visual Display of Quantitative Information , can be 
used to create complex graphs using pre-defined templates. 

1
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2 New Features in SigmaPlot Version 5.0

New Features in SigmaPlot Version 5.0 0

SigmaPlot 5.0 provides many new state-of-the-art graphing features, including:

➤ Automation: Automate repetitive and complex tasks with macros that execute a 
series of steps.

➤ New Data Worksheet:  Work with data sets that have more than one billion data 
points. You can format text, cell, column, row and grid lines. Drag and drop 
columns, move items around more easily, and change grid colors.

➤ Rulers and Snap-to Grids: Lay out graphs more easily with graph page rulers and 
adjustable snap-to grids.

➤ Improved Notebook: Batch print selected items and in-place text edit.

Graph Types and
Styles

SigmaPlot�s selectable Graph Type determines the structure of your graph. SigmaPlot 
provides many different types of two- and three-dimensional Cartesian (XY and 
XYZ) graphs, as well as pie charts and polar plots. 

Graph Style determines how data is plotted on a graph. Available styles depend on the 
Graph Type you have selected; the Graph Wizard lists available graph styles once you 
have selected a graph type. 

Templates SigmaPlot includes a template notebook containing several page layouts you can use 
to apply specific attributes to new or to previously saved pages and graphs. 

You can use a graph that you create as a template for other graphs by copying it into 
a different section of the notebook. You can store your templates in a SigmaPlot 
Notebook Template file (.JNT). You may want to create your own template 
notebook.

Graph Defaults Graph attributes, such as size and position, font, and settings for symbols, lines, and 
bars can be preset using default settings.

Axis Scales SigmaPlot lets you create multiple axes for 2D graphs. Each plot can have separate X 
and Y axes. Axis ranges can be automatically calculated by SigmaPlot, or you can 
specify them manually. 

Tick Marks  Use both major and minor axis tick marks and grid lines. Tick intervals, 
length, direction, thickness, and color are all adjustable; grid line types are also 
adjustable. Tick labels can be numeric, time series, or customized, using labels in a 
worksheet column.

Axis Breaks  You can specify an axis break with a different post-break tick interval. 

Automatic Legends You can turn on or off automatically generated legends, or ungroup a legend into 
individually customized text labels.
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3D Mesh
Interpolation

Generate mesh data points for a 3D mesh plot from XYZ triplet data using inverse 
distance interpolation. 3D mesh points can be calculated using different distance 
weighting values.

SigmaPlot Worksheet SigmaPlot is now column and row oriented. The SigmaPlot Worksheet lets you enter 
data as X, Y, and other variable data. The worksheet is over 32,000,000 rows by 
32,000 columns in size.

Column widths are adjustable by changing the number of digits displayed, or the 
column size. Each cell can display up to fifteen figures of significance, but can 
calculate up to 21 significant numbers. Worksheet cells can contain data, labels, date/
time values, or special sequences of symbols, line and fill patterns, colors, and error 
bar direction codes. You can apply these customized sequences to a graph and copy 
and use the same sequences over and over again.

 Microsoft Excel If Excel for Office 95 or Office 97 is installed on your system, you can create and 
open Excel workbooks from within SigmaPlot, and graph and run transforms and 
statistics using Excel worksheets just as you would SigmaPlot worksheets. Almost all 
Excel functionality is available from within SigmaPlot.

Statistics Descriptive statistics are available for all your worksheet columns. The Statistics 
Worksheet lists basic statistics for all worksheet columns.

You can also display linear regression lines with confidence and prediction intervals, 
chart error bars for graphs of column means, and run paired and unpaired t-tests 
between worksheet columns. The Histogram feature can be used to compute and 
plot distributions for datasets up to 64,000 points in size.

Regression Wizard The Regression Wizard guides you through each step in running a curve fit, plotting 
the results, and generating a report. 

For more information on the Regression Wizard, see the Programming Guide . 

Data Transform
Functions

SigmaPlot comes with a comprehensive mathematical transform language. This can 
be used to modify and compute data in a very complex manner. Transforms are 
described in the Programming Guide . 

Drawing Features Drawing tools are provided for multi-line text labels, lines, rectangles, ellipses, and 
arrows. Change the font, size, and style of any text, and change the color, line type, 
thickness, and fill pattern of graphs and drawn objects.

Graphs and axes can be sized and scaled using the drawing tools, or moved and sized 
precisely using formatting commands.

Reports The SigmaPlot Report Editor helps you keep descriptions of SigmaPlot notebooks 
and graphs. It features a complete text editor, OLE2 (Object Linking and 
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Embedding, version 2), insertion and editing, and automatic report generation for 
regression results.

OLE2 You can paste and drag and drop between SigmaPlot and other Windows 
applications (such as word processors, drawing programs, or desktop publishers) 
using OLE2 (Object Linking and Embedding, version 2). 

Pasting or dragging and dropping between SigmaPlot and other applications lets you 
edit a SigmaPlot graph that has been pasted into another OLE2 application, and 
display and print text and art embedded into SigmaPlot pages and reports.

Installing SigmaPlot 0

SigmaPlot is installed on your computer from diskettes or CD. The dialog boxes that 
guide you through the installation process are simple and self-explanatory. 

Σ In order to accomplish your installation, you will need to have your product 
registration number available. 

To install SigmaPlot from diskette,  insert diskette 1 into the appropriate floppy drive, 
and run Setup from your floppy drive.

To install SigmaPlot from CD,  the installation program automatically starts up when 
the CD is placed in the CD-ROM drive under Windows 95. 

System
Requirements

SigmaPlot 5.0 can run under the following systems:

➤ Windows 95 

➤ Windows NT version 4.0

Excel Workbooks:  In order to use Excel workbooks in SigmaPlot, you must have 
either Excel for Office 95 or Office 97 installed on your local drive or network. To 
take full advantage of Excel�s functionality within SigmaPlot, use Excel for Office 97.

Hardware:  Your computer should be at least a 486, with at least 32 megabytes of 
RAM.

Serial Numbers Your serial number is your identification number with SPSS Inc. You will need this 
serial number when you call for information regarding support, payment, or an 
upgraded system. Before using the system, please copy this number to the 
registration card.

Registration Card Don�t put it off: fill out and send us your registration card. Until we receive your 
registration card, you have an unregistered system. Registering your system entitles 
you to:
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➤ Technical support services

➤ New product announcements and upgrade announcements

Using SigmaPlot in Windows 0

SigmaPlot runs under the Windows operating system, using the standard Windows 
95 interface. For information on how Windows works, please refer to your Windows 
95 documentation. A brief explanation of standard Windows 95 terminology as it 
applies to SigmaPlot is provided here.

Figure 1�1
The SigmaPlot Application

Window as it Appears in
Windows 95

Figure 1�1
The SigmaPlot Application

Window as it appears in
Windows 95

SigmaPlot Notebook 
File Name

Menu Worksheet 
Window

Drawing, Properties, 
and Arranging Toolbars

Menu Bar

Standard Toolbar

2D and 3D 
Graph Toolbars

SigmaPlot 
Notebook Window

Graph Page 
Window

Column Statistics 
Window

Status Bar
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Using Toolbars 0

You can set SigmaPlot to display a selection of toolbars at the top, or along the sides 
of the SigmaPlot window. The toolbars contain buttons for the most commonly used 
commands. 

Zoom

Figure 1�2
The Standard Toolbar

New 
Notebook

Save New 
Worksheet

Help PasteCut View 
Page

Graph 
Properties

New 
Graph 
Page

Undo

Redo
 Excel 

WorksheetCopy Custom Zoom Open Print
View 
Data

View 
Statistics

Graph 
Wizard

Figure 1�3
The 2D Graph Toolbar

Scatter Plot Line/Scatter 
Plot

Pie ChartHorizontal 
Bar Chart

Box PlotLine Plot Polar Plot
Vertical 

Bar Chart

Ternary 
Plot

Figure 1�4
The 3D Graph Toolbar

Contour Plot Trajectory Plot 3D Bar Chart

3D Scatter 
Plot

 Mesh 
Plot
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The Report Editor toolbar and ruler are described in �Using the Report Editor 
Ruler� on page 315.

Viewing and
Hiding Toolbars

Choose Toolbars from the View menu to open the Toolbars dialog box. Select or 
clear a toolbar by clicking the option.

The Large Buttons check box increases the size of Standard, Drawing, Properties, and 
Arranging toolbar buttons. The Color Buttons check box displays color toolbar 
buttons on your screen, rather than monochrome. The Show Tool Tips check box 
hides the toolbar help tags that appear as you drag the mouse over the toolbar. 

Figure 1�5
From left to right:

the Drawing Toolbar,
Properties Toolbar, and

Arranging Toolbar

Select Object

Draw Arrow

Draw Ellipse

Draw Line

Draw Box

Text

Line Properties

Symbol

Fill Properties

Bar Width

Axis Scale

BringTo
Front

Group

Send To
Back

Ungroup

Align

Figure 1�6
The Toolbars Dialog Box
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Positioning
Toolbars

A toolbar can be moved from its default position to anywhere in the screen, and its 
positions can be changed from horizontal to vertical.

To move a toolbar, click anywhere in the toolbar that is not a button, and drag it to 
the desired place. The toolbar appears as a floating palette when it is not attached to 
the SigmaPlot window. You can also join two floating Toolbars together by dragging 
a toolbar by the palette border (not the title bar) onto another toolbar.

To reattach the toolbar, either double-click the titlebar, or drag it by the palette 
border onto any edge of the SigmaPlot window until it docks, then release the mouse 
button. To change between horizontal and vertical positions, drag the toolbar to the 
edge of the window and release the mouse button after the toolbar flips to the new 
position. 

Figure 1�7
Toolbars are docked by

dragging a toolbar by its
edge onto any SigmaPlot

window border
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Anatomy of SigmaPlot Graphs 0

This section introduces terminology used in describing SigmaPlot graphs.

Basic Terminology:
Graphs, Plots,

and Axes

A SigmaPlot graph consists of one or more  plots of data, and one or more sets of axes. 
A graph uses a specific coordinate system (e.g., 2D Cartesian, 3D Cartesian, pie, or 
polar) and has a specific size and location on a page.

Plots are graphical representations of your worksheet data. You can change the way 
your graph is plotted, even after the graph has been created. For example, you can 
view your data as a vertical bar chart, then as a horizontal bar chart. You can also 
show more than one plot on most graphs.

Axes are the scales that determine position of the graph�s data points, usually with 
Cartesian coordinates. The X, Y, and for 3D graphs, Z coordinates, are indicated on 
each axis by tick marks. An axis can use a linear numeric scale, nonlinear scales such 
as log, natural log, and probability, or a date/time scale. 2D graphs can have multiple 
sets of X and Y axes. The axes� tick marks and tick labels, can be numeric, time series, 
or customized with worksheet column labels.

2D Cartesian Graph
Examples

2D Cartesian graphs  are the most commonly used scientific graphs. SigmaPlot 
provides an extensive range of 2D graph features, including:

➤ Scatter plots, line plots, dot plots, grouped bar charts, error bars, linear 
regressions with confidence and prediction intervals, an equation library for 
nonlinear regressions, reference lines with labels, box plots, ternary plots, bubble 
plots.

➤ Contour plots.

➤ X and Y axes, log axis scales, major and minor tick marks, tick labels from a 
worksheet column, axis titles, axis breaks, grid lines and backplanes.

➤ Multi-line text labels and automatic legends.

The following figures exemplify some SigmaPlot 2D Graphs with the terminology 
defined in this section.
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Population Growth with and without Inhibitor

Time (hours)

0 2 4 6 8 10 12

P
op

ul
at

io
n 

(c
ol

on
ie

s)

0

1

2

3

4

5

6

K1

K2

Without Inhibitor

With Inhibitor

Y axis with a linear 
axis scale

Left Y axis title

Left Y axis with 
major tick marks

Numeric major 
tick labels

Top X axis with tick 
marks turned off

Reference line for 
the plot used to 
indicate carrying 
capacity K

Spline line plot of data 
generated with the 
nonlinear curve fitter

Bottom X axis title

Right Y axis with 
tick marks turned 
off

Scatter plot of 
column averaged 
data points, with Y 
error bars 
computed from the 
standard deviations 

X axis with a 
linear axis scale

Graph Title

Automatically         
generated legend

1 months 3 months 5 months 7 months 9 months 11 months

N
um

be
r 

of
 In

di
vi

du
al

s

0

40

80

120

160

200

240

400

800

1200

with competition

monospecies

Y axis break at 
75% along the 
axis length

Bar fill colors use a 
pattern from a 
worksheet column

Error bars using 
worksheet column data

Post break tick interval 
set to a new value

Legend symbols 
and text labels

Grouped bar chart
with specified bar 
and group widths

Image art cut from a paint program and pasted 
onto the page using the Windows Clipboard

X axis tick labels using 
text from a worksheet 
column



Introduction

Anatomy of SigmaPlot Graphs 11

1996

January  April  July  October  January  

C
ou

nt
s 

pe
r 

A
re

a

100

101

102

103

Counts
1st Order Regression
95% Confidence Interval
95% Prediction Interval

Common log scale
Y axis with major

and minor tick
marks

Base and
exponent log

axis tick labels

Scatter plot of
color gradient
filled symbols
using  a point

plot style

Linear regression 
with 99% 
confidence and 
prediction intervals

True Date and Time 
axis scale, 
displaying months 
and weeks

Diet

SP1 DL5 HX12 IND7

Li
fe

sp
an

 (
w

ee
ks

)

0

5

10

15

20

25

30

Box Widths = Final Population

Colored graph
backplane with Y axis

grid lines

Tick mark direction 
pointing out

X axis tick labels using a 
category axis scale.

5th and 95th 
percentiles displayed 
as symbols

Tukey box plot 
with mean 
value lines

Variable box widths can
be used to express

another variable
dimension



Introduction

12 Anatomy of SigmaPlot Graphs

Pie Chart Example Pie charts are useful for displaying a quick comparison of ratios in a data set. The 
example figure displays: 

➤ Slice fills 

➤ Text labels

➤ Exploded slices 

Archean Eon

Proterozoic Eon

Paleozoic Era

Mesozoic Era

Cenozoic Era
Man

Hadean Eon

Pie slice fills are 
incremented colors.

Text labels

Exploded slices
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Polar Plot Example Polar plots are useful for displaying data which is modular in nature. The example 
figure displays:

➤ Angular axis size and location

➤ Major grid lines for the angular axis

➤ Radial axes range angle and length
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Contour Plot Example Use 2D Contour Plots to graph three dimensional data in two dimensions. The 
following example includes:

➤ Major and minor contour lines 

➤ Contour labels     
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3D Cartesian Graph
Examples

3D Cartesian Graphs  are scatter, trajectory, mesh plots, and bar charts. SigmaPlot 
provides an extensive range of 3D graph features, including: 

➤ Bar charts, scatter plots, mesh plots, frame lines

➤ Incrementing fill color, transparent mesh, drop lines

➤ X, Y, and Z axis titles, rotated axis labels, grid lines, backplanes

The following figures contain examples of these plots, as well as some additional 3D 
features. 
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Scatter plot with 
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Setting Program Options 0

Use SigmaPlot�s program options to control application settings, as well as how 
worksheets and new pages and graphs will appear. To view the Options dialog box, 
choose Options from the Tools menu.

Worksheet Options Worksheet options include settings for numbers, statistics, date and time, worksheet 
display, default column width, number of decimal places, and use of engineering 
notation. Using this panel is described in �Worksheet Basics� on page 55.

Page Options Page options control graph page properties. Working with graph pages is explained in 
�Graph Page Basics� on page 93.

System Options The system panel of the Options dialog box controls application settings. 

Novice Prompting  Novice prompts are warning, information, and confirmation 
messages that may display before certain operations occur. When novice prompting 
is disabled, some of these messages no longer appear. To disable novice prompting, 
clear the check box.

Automatic Legends  SigmaPlot creates a legend each time a graph is created, based 
upon the specifications of the graph. When this check box is selected, the legend 
appears by default.

If this check box is not selected, legends are not automatically displayed, but can be 
displayed by selecting Show Legend in the Title and Legend panel of the Graph 

Figure 1�8
The Options Dialog Box
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Properties dialog box. To learn more about automatic legends, see �Graph Page 
Basics� on page 93.

3D Dialog boxes  Use this option to alter the appearance of the SigmaPlot dialogs. 
3D dialog boxes have a gray background and a �chiseled� appearance. If you clear this 
option, dialogs will replace the shades of gray with a black and white 2D appearance.

Backup Files  Check this option to automatically create a backup file when saving 
any notebook. You can also select the extension SigmaPlot assigns to these files by 
selecting the With Extension edit box and typing three letters. These files appear in 
the directory where your original data files are stored, and can also be accessed from 
SigmaPlot by choosing Option from the File menu.

New Notebooks Use Excel Workbooks   Check this option to open an Excel 
workbook each time you create a new notebook. See �Notebook Basics� on page 39.

Fast Page Open  Improves saving and opening times for graph pages by not saving 
the attributes for hidden objects.

Retain Notebook Settings  This option retains the windows and items open when 
the notebook was saved last, and reopens them the next time the notebook is open. 
When unchecked, time is saved when opening a notebook that had many open 
items.

Template File   Type the path and file name of the template file for SigmaPlot to use 
when creating new graph pages. Available templates are displayed in the Templates 
dialog box. For more information on applying and using templates, �Graph Page 
Basics� on page 93.

Author  Select and type your name, or any other name you want to appear in the 
Summary Information as Author for a selected notebook item. The name in this box 
is used by SigmaPlot as the default, but can be changed for individual documents by 
choosing Summary Info from the File menu.

Figure 1�9
The System Panel
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The Graph Defaults
Panel

Graph defaults control attributes that are applied to all new graphs, including:

➤ Size and Position

➤ Font

➤ Settings for Symbols, Lines and Bars

To learn about graph defaults, see �Graph Page Basics� on page 93.

SigmaPlot Help 0

SigmaPlot's online help uses the standard Windows help system. View the Windows 
Help on Help or refer to your Windows documentation for more information on 
using Windows help.

To get help, from the Help menu, choose either SigmaPlot Help to open the help 
search dialog box and search for a specific topic within help, or choose Contents  
to open SigmaPlot Help Contents.

Customer Service If you have any questions concerning your shipment or account, contact your local 
office; see �Contacting SPSS Inc.� on page 21. Please have your serial number ready 
for identification when calling.

Training Seminars SPSS Inc. provides both public and onsite training seminars for SPSS products. All 
seminars feature hands-on workshops. SPSS seminars will be offered in major U.S. 
and European cities on a regular basis. For more information on these seminars, call 
your local office; see �Contacting SPSS Inc.� on page 21.

Figure 1�10
The Graph Defaults Panel
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Tell Us Your
Thoughts

Your comments are important. Please send us a letter and let us know about new and 
interesting applications using SPSS products. Write to SPSS Inc. Marketing 
Department, Attn.: Director of Product Planning, 233 South Wacker Drive, Suite 
1100, Chicago, IL, 60606-6307.

Exiting SigmaPlot 0

When you exit SigmaPlot, all current toolbar and text settings are saved as defaults 
for the next session.

Choose Exit from the File menu, or press Alt+F, then X to leave SigmaPlot. You can 
press Alt+F, or Alt+F4 from any location in the program to quit. 

Getting Technical Support 0

The services of SPSS Technical Support are available to registered customers. 
Customers may call Technical Support for assistance in using SPSS products or for 
installation help for one of the supported hardware environments. To reach Technical 
Support, see the SPSS home page on the World Wide Web at http://www.spss.com , or 
contact us: 

In the U.S.:

Telephone: (415)453-7196
(8:00 A.M. to 5:00 P.M. 
Pacific Time)

Fax: (415)453-7789
Email: scisupport@spss.com

Mail: P.O. Box 7005
San Rafael, CA 
94912-7005

In Europe: 

Telephone: 49 2104 / 95480
Fax: 49 2104 / 95410
Email: scisupport@spss.com

Mail: Schimmelbuschstrasse 25
40699 Erkrath, Germany 

If you are experiencing any kind of problem, please try consulting this manual. If you 
still cannot solve your problem, feel free to contact our Technical Support 
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department. Please be at your computer and be prepared to identify yourself, your 
organization, and the serial number of your system.

Using This Manual 0

The SigmaPlot User�s Guide  is designed to provide you with complete instructions on 
how to use SigmaPlot�s advanced graphing features. Referencing this manual along 
with SigmaPlot, you can create a wide variety of publication-quality scientific graphs 
on your IBM or compatible PC.

Conventions The following conventions are used in this manual:

➤ New terms, such as Graph Wizard are shown in bold italic the first time they are 
introduced.

➤ Important notes or information in this manual are flagged with a Σ symbol.

The User�s Guide includes chapters on Notebook, Worksheet, and Graph Page basics. 
It begins with the QuickStart, which gives you the basics of graph creation. The latter 
part of the book is reference material that covers more complex graph creation and 
details of using SigmaPlot.

Contacting SPSS Inc. 0

If you would like to be on our mailing list, contact one of our offices or distributors 
below. We will send you a copy of our newsletter and let you know about SPSS Inc. 
activities in your area. 

SPSS Inc.
233 South Wacker Drive
Suite 1100
Chicago, IL 6066-6307
Tel: +312.329.2400 
Fax: 312.329.3690
http://www.spss.com/products

Outside the U.S.:
SPSS ASC GmbH
Schimmelbuschstrasse 25
40699 Erkrath, Germany
Tel: +49.2104.9540
Fax: 49.2104.95410 

Or contact the distributor nearest you:
http://www.spss.com/international/asc.html
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Additional Publications 0

Additional copies of SigmaPlot product manuals may be purchased from Prentice 
Hall, the distributor of SPSS Inc. publications. To order, fill out and mail the 
Publications order form included with your system or call toll-free. If you represent a 
bookstore or have an account with Prentice Hall, call 1-800-223-1360. If you are not 
an account customer, call 1-800-374-1200. In Canada, call 1-800-567-3800. 
Outside of North America, contact your local Prentice Hall office.

Except for academic course adoptions, manuals can also be purchased from SPSS 
Inc. 

References 0

We have found the following references very useful for graph design and layout.

M. Brent Charland, Ph.D. 1995. SigmaPlot for Scientists.  Wm. C. Brown 
Communications, Inc., 2460 Kerper Boulevard, Dubuque, Iowa, 52001.

Cleveland, William S. 1985. The Elements of Graphing Data.  Monterey, Calif.: 
Wadsworth, Inc. (408) 373-0728.

Kosslyn, Stephen M. 1994. Elements of Graph Design . New York: W.H. Freeman and 
Company, 

Tufte, Edward R. 1983. The Visual Display of Quantitative Information. Cheshire, 
Conn.: Graphics Press. Available from Science News Books, 1719 N. St. NW, 
Washington, D.C. 20036.

Scientific Illustration Committee of the Council of Biology Editors. 1988. 
Illustrating Science: Standards for Publication. Bethesda, Maryland: Council of 
Biology Editors, Inc. 
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QuickStart

This chapter provides you with a step-by-step introduction to many of SigmaPlot�s 
most common features. 

Creating a graph involves the following:

➤ Organizing data in a worksheet.

➤ Selecting the data columns to graph.

➤ Selecting a graph type and graph style.

➤ Selecting a data format.

➤ Modifying the graph properties.

Entering Data When you start SigmaPlot, the SigmaPlot window appears with an empty worksheet 
and a notebook window. Click anywhere on the notebook window or the worksheet 
to bring them into view. The notebook window looks similar to the Windows 
Explorer. The worksheet looks like a spreadsheet and contains rows and columns.

To make a graph, you must first enter or import data into a worksheet. 

Figure 2�1
A new notebook file

contains an empty
worksheet and a notebook

window

2
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To enter the data:

Click in the cell at row 1, column 1 of the worksheet.

Press the Caps Lock key to capitalize the text and type the first data point shown in 
Figure 2�2, then press Enter. The worksheet cursor moves down one row.

Continue entering the rest of the data shown in Figure 2�2. When you are finished 
with one column, press the Home key and then use the Right Arrow key to move the 
worksheet cursor to move to the second column.

Plotting Graph Data When you are finished entering all the data, drag the mouse over the two column 
titles to select both columns of data.

With two columns of data in the worksheet, now you can create a bar chart using the 
Graph Wizard. To open the Graph Wizard, press the F3 button. 

Figure 2�2
Example of Data Entered

into the Worksheet

Figure 2�3
Data Entered and Selected

in the Worksheet
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First, the Graph Wizard prompts you to specify a graph type. Select the Vertical Bar 
Chart graph type from the scroll down list, then click Next.

Some graph types in SigmaPlot have different styles. You can choose your preferred 
style from the Graph Style scroll down list. Select Simple Bar, and click Next.

Now the Graph Wizard prompts you to select a data format. Select XY Pair from the 
Data Format list, and click Next.

The Graph Wizard prompts you to specify the columns of worksheet data you want 
to graph. Because you selected the columns before you started to create the graph, the 
X and Bar 1 columns are already assigned as your X and Y data in the Selected 
Columns list. If the worksheet columns do not already appear in the Selected 

Figure 2�4
Selecting a Graph Type
from the Graph Wizard

Figure 2�5
Selecting a Graph Style
from the Graph Wizard

Figure 2�6
Selecting a Data Format

from the Graph Wizard
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Columns list, click the anywhere in the worksheet columns to assign them to the 
highlighted option in the Selected Columns list.

Click Finish to make the graph. 

Modifying the Graph You can change the appearance of the graph using the Graph Properties dialog box. 

First, we�ll change the bar fill color. To change the characteristics of the bar chart, 
click the graph bars. A hand appears next to the pointer indicating that the bar chart 
is selected.

Figure 2�7
Selecting Columns from the

Graph Wizard

Figure 2�8
A Vertical Bar Chart
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Now double-click the bars to open the Graph Properties dialog box. Make sure Fills 
in the Settings For list is selected. 

Select the Dark Red fill color option from the Background Color drop down list, 
then click Apply to modify the graph while keeping the Graph Properties dialog box 
open. The graph appears with the dark red bars.

Figure 2�9
Graph Properties Dialog

Plots Panel

Figure 2�10
Result of Changing Bar

Width and Fill Color
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Now let�s change the bar widths. First, make sure that the Graph Properties dialog 
box is open to the Plots panel. Select Widths from the Settings For list. 

Using the pointer, move the Bar Thickness slider to the left so that Needle appears in 
the drop-down list, then click the Apply button. Notice that the bar thickness is thin. 

Now, move the Bar Thickness slider to 100% and click OK to close the Graph 
Properties dialog box. The bar widths change to the largest non-overlapping widths 
possible.

Changing the Graph
Title

To replace the graph title with more meaningful information, double-click the title. 
The Edit Text dialog box appears with the selected label displayed and highlighted.

Type Graph 1 in place of the highlighted text, then  press Enter and type Poster Session 
Presentation. Center the title by selecting the text and then clicking the Center  
button.

To change the font of the text, select Times New Roman from the font drop-down 
list, then click OK to close the Edit Text dialog box. The new title appears on your 
graph.

Figure 2�11
Selecting Bar Width from

the Settings For List

Figure 2�12
Edit Text Dialog Box: Drag

the pointer to select the
text you want to format.
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Modifying Data
Interactively

You can change the data in the worksheet at any time. All graphs that use the same 
data will update to reflect the modification. To make revisions to your data, first 
activate the worksheet by clicking the View Data  button on the toolbar. Then 
select a cell or group of cells with the pointer, and enter new data. For this example, 
type the value 10 in the first cell of the second column and press Enter. View the 
graph by clicking on the View Page  button on the toolbar. Your graph now 
reflects the new data value.

Saving the
Notebook File

To save your notebook, first click the File Save  button in the toolbar to open the 
Save As dialog box. Using the list of folders in the Save In drop-down list, select the 
Samples folder located under the default SigmaPlot folder. Now, press the Tab key to 
place the cursor in the File Name drop-down list box and type QuickStart1 as the file 
name. Click Save.

Notebook files are saved with .JNB extensions. Later, when you return to your 
notebook file, you will see the extension appended to the notebook name in the title 
bar.

Figure 2�13
Dynamically modifying the

bar chart data.

Figure 2�14
Using the Save As dialog

box.
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Importing New Data You can import some more data, then plot it with the second graph. Click the View 
Data  toolbar button to view the worksheet. Imported data appears at the last 
worksheet cursor location, so move the worksheet cursor to row 1 of column 3, then 
press Ctrl+I to open the Import File dialog box. Select MS Excel from the Files of 
Type drop down list, then select QuickStart.xls from the list of files and click Import.

When the Import Spreadsheet dialog box appears, click Import. The data appears in 
the worksheet beginning in column 3. 

Figure 2�15
Import File Dialog Box

Figure 2�16
Worksheet with Imported

Data Columns: The
imported data is located in

columns 3, 4, and 5.
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Labeling Data
Columns

Labeling worksheet columns helps keep track of your variables. Double-click the 
column heading for column 3 and type Health $, then press Enter. Although this 
selects the entire column, pressing the Right Arrow key moves the cursor to the 
column 4 heading. For column 4 type Life Exp M, press Enter, and again press the 
Right Arrow key to move to column 5. In column 5 type Life Exp F, then press Enter. 

Making a Graph
Using the Toolbar

Now let�s make a graph using the imported data. This time, instead of choosing a 
graph type and style with the Graph Wizard, we�ll use the Graph toolbar. 

First, click and drag across the three new columns to select them. 

Figure 2�17
Entering Worksheet

Column Titles
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To select a graph type and style, click the scatter plot button from the 2D graph 
toolbar, and then click the multiple regression lines button from the style toolbar 
which appears. 

The Graph Wizard appears prompting you to specify a data format for your graph. 
Select X Many Y, and click Next.

Figure 2�18
Selecting a
Graph Type

and Style
Using the

Graph
Toolbar

Figure 2�19
Selecting a Data format
from the Graph Wizard
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Now you need to pick the worksheet data to assign to the graph. Because you 
selected the columns before you started to create the graph, the Health $, Life Exp 
M, and Life Exp F columns are already assigned as your X, Y1, and Y2 data in the 
Selected Columns list. If the worksheet columns do not already appear in the 
Selected Columns list, click the worksheet columns to assign them to the highlighted 
option in the Selected Columns list.

If you make a mistake when assigning columns, either highlight the column 
assignment in the Selected Columns list and select the correct column from the 
worksheet, or clear the column assignment by double-clicking it in the Selected 
Columns list, then select the correct worksheet column.

Click Finish. The new graph appears on the page with regression lines for each data 
series.

Figure 2�20
Using the Graph Wizard to

Pick Columns to Plot to
your Graph

Figure 2�21
A Scatter Plot with

Multiple Regression Lines
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Moving the Graphs Because you want to show both graphs on the page, you need to adjust their 
positions. 

First, adjust the Zoom so that you can see the entire graph page. To adjust the Zoom, 
click on the Zoom drop-down list which is in the toolbar, type 30 as a value, and 
click Enter.

To move the scatter plot to the bottom of the page, click on the scatter plot and drag 
its dotted outline to a new position at the bottom of the page.

Now, select the bar chart and drag it to the top of the page. Both the Scatter Plot and 
the Bar chart are visible.

Sizing Graphs on the
Page

To resize the scatter plot, select the graph, then use the small square handles that 
appear on the perimeter. Click the bottom middle handle and drag the dashed 
outline up, so that it shrinks to form a smaller rectangle. When you release the mouse 
button, the graph changes size. 

Aligning the Graphs The easiest way to align graphs and objects is with SigmaPlot�s new snap-to grids, 
rulers, and crosshairs. From the Tools menu Options dialog box, select the Show 
Rulers, Snap-to, and Show Grid check boxes. Select Inches from the Units menu, 

Figure 2�22
Moving the Graphs
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and from the Field Density drop-down list, select 0.25 inches. Select As Lines from 
the Show Grid option. 

Click OK. Grids and rulers appear on the graph page.

Now click the Crosshairs button on the top left corner of the graph page. Crosshair 
lines extend from the pointer tip to the rulers and to the right and bottom of the 
window, and follow the pointer.

With the Snap-to option turned on, the graph snaps to the nearest grid point. Use 
the crosshairs and rulers to further help you align the graphs.

Turn off the grids Show Grid option from the Tools menu Options dialog box. To 
turn crosshairs off, click the crosshairs button again.

Figure 2�23
Selecting Rulers, Grids,

and Snap-to from the Tools
menu Options dialog box.

Figure 2�24
Moving graphs using

crosshairs, rulers, and
grids.
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Changing the X Axis
Scale

The linear scale of the X axis bunches the smaller data values. A log scale would 
better suit the data.

To get a closer look at the scatter plot, click on the Zoom button and use the 
pointer to define a rectangle around the scatter plot. Release the mouse button when 
you have a view that you like.

Click the X axis select it. Now it is enclosed by a rectangular dotted-line.

Next, click the Scale button  on the formatting toolbar.

Figure 2�25
Changing the Zoom:

The Zoom pointer selects a
rectangular region for a

close-up.

Figure 2�26
Selecting the X Axis to

Change the Scale: A
rectangular dotted-line

indicates that the axis is
selected.
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The Graph Properties dialog box opens directly to the Axes Scaling panel. Select Log 
(Common) from the Scale Type drop down list, then click OK to change the scale.

Return the graph to full-page by selecting Fit from the Zoom drop-down list.  

Printing the Graph To print the page using the default settings, click the Print  button.

Renaming Notebook
Sections

You can customize the default names that SigmaPlot assigns to the sections of your 
notebook. For example, to rename the title of the notebook, bring the notebook 
window forward by clicking anywhere in it.

Select the Notebook section (it is labeled Notebook 1*) and use the Summary   
button to open the Summary Information dialog box. Type Bar and Regression in 
the Entry Title edit box. Press the Tab key twice to locate the cursor in the 

Figure 2�27
Graph Properties

Axes Panel

Figure 2�28
Quick Start Graphs: A full-
page view is obtained by

selecting Fit from the Zoom
drop-down list.
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Description box of the Summary Information dialog box. Type a short note to 
describe your graph and click OK. The new section name appears in the notebook 
window. 

Saving the Notebook
File

To save your work, press Ctrl+S. The additions that you made to the graph are saved.

Summary Congratulations! You have performed many of the procedures that you will use in 
creating your own graphs. Here are the features and procedures that were covered as 
you created two graphs and placed them on the same page:

➤ Importing data files and direct data entry.

➤ Changing size, position, and relative alignment of graphs. 

➤ Re-scaling of axes.

➤ Changing graph properties and editing titles. 

➤ Printing. 

➤ Labeling and annotating notebook files.

Figure 2�29
Edit Notebook information

in the Summary dialog box.
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Notebook Basics

The SigmaPlot notebook file contains all of your SigmaPlot data and graphs. The 
notebook file can be exported to other applications, and accept data from other 
applications. This chapter covers:

➤ SigmaPlot notebook organization (see page 39)

➤ Managing a notebook file (see page 42)

➤ Creating notebooks and adding notebook items (see page 43)

➤ Renaming notebooks and notebook items (see page 46)

➤ Opening notebooks and notebook items (see page 47)

➤ Copying, pasting, and deleting notebook items (see page 49)

➤ Saving your work (see page 50)

➤ Exporting data, graphs and text reports (see page 51)

➤ Printing worksheets, pages and reports (see page 52)

SigmaPlot Notebook Structure 0

Each SigmaPlot notebook file contains many different documents arranged as a tree 
structure. Every time you start SigmaPlot, a worksheet opens in the notebook 
window. To make a notebook window active or current, click it. From the notebook 
window, you can open, store, move, and delete notebook sections and items. 

3
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For more information, �Opening Notebook Files and Items� on page 47, and 
�Copying, Pasting and Removing Notebook Items� on page 49.

Modified Notebook
Items

An asterisk (∗) next to a notebook item indicates that the item has been modified 
since the last time the notebook file was saved. 

Figure 3�1
A Notebook Window with

Multiple Sections
Each section can contain
only one worksheet, but

multiple pages, reports, and
equations.
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Opening Multiple
Notebook Items

You can open multiple notebook items. Using the notebook to open and close 
multiple items will help you manage viewing multiple documents. 

Notebook Item
Names

The default startup notebook is named Notebook 1. It contains one notebook section, 
Section 1, and one worksheet, Data 1. When you save your notebook file, the name 
of the file appears at the top of the notebook window. Notebook files use a (.JNB) 
extension. 

The default names given to notebook sections and items are, Section (number), Data 
(number) or Excel (number), and Report (number). Regression equations are named 
when they are created. New items are numbered sequentially.

Worksheets Worksheets contain data you analyze and graph. You can enter data, paste it, or import 
it from other sources. You can also automatically generate data and place it in 
worksheet columns. A worksheet automatically appears each time you start 
SigmaPlot. You can also open or create additional worksheets any time from within 
SigmaPlot. 

You can modify and manipulate worksheet data and appearance by using the 
functions described in �Using Transforms on Data in Excel Workbooks� on page 87.

SigmaPlot automatically calculates some basic statistical values for all worksheet 
columns. You can see these values by choosing Statistics from the View menu, or by 

Figure 3�2
Example of Multiple

Notebook Items
Opened

Note that open items
are shown in the

notebook as
undimmed,

active items.
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pressing F6. Column Statistics are described in �Descriptive Statistics for 
Worksheets� on page 64.

Graph Pages Graph pages are true graphical representations of a printed page that contain graphs, 
text, and other drawn and pasted objects. You can select and modify objects on graph 
pages using the Graph and Object properties dialog boxes, and with the graph and 
drawing toolbars. You can also manipulate objects graphically using your mouse.

A page can contain an unlimited number of graphs and other objects, and you can 
create an unlimited number of pages for each worksheet. You can also paste graphics, 
OLE objects, and other objects onto a page.

Excel Workbooks You can open Excel workbooks in SigmaPlot. If you open an Excel workbook, many 
Microsoft Excel menus and commands appear in SigmaPlot.

Σ You can store and save data in the top sheets of an in-place active Excel workbook; 
however, you can only plot data on one sheet of the Excel workbook. To learn more 
about using Excel in SigmaPlot, see �Using Excel Workbooks in SigmaPlot� on 
page 84.

Reports Reports are text�based pages where you enter, save and print formatted text. You can 
also paste graphics, OLE objects, and other objects into reports.

Regression
Equations

Use equations to preform nonlinear curve fitting using the Regression Wizard. See 
the Programming Guide for more information.

Managing Notebook Sections 0

Notebook sections are place-holders in the notebook window. They contain notebook 
items, but no data. However, they can be named, opened, and closed. You cannot 
have sections within sections.
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You can create as many new sections as you want in a notebook. You may also create 
reports within each section to document the items in each section. Figure 3�3 shows 
several notebook sections containing notebook items.

To expand or collapse a section, double-click the section icon or click the (+) or (-) 
symbol.

Creating New Notebook Files and Items 0

Creating a New
Notebook File

To create a new SigmaPlot notebook file, click the New Notebook toolbar  
button. A notebook with a single worksheet appears.

Creating a
New Section

To create a new notebook section in the notebook:

1. Right-click in the notebook, point to choose New and choose Section. New sec-
tions are appended after the last notebook section.

Another way to create a new notebook section is to copy and paste a section in the 
notebook window. Whenever you copy a section, its contents are pasted at the 
bottom of the notebook window. SigmaPlot names and numbers the section 

Figure 3�3
A SigmaPlot Notebook

Window showing the
tree structure of the

Notebook, with open
and closed sections

Note that each item and
section can have its own
name, and all items can

have separate author and
description information.
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automatically. For example, if you copy notebook Section 3, the new section is named 
Copy of Section 3. 

Copied sections create copies of all items within that section as well.

Creating New
Worksheets

Creating a new worksheet creates it in a new section that is appended to the end of 
the notebook. There can only be one worksheet per section. New Excel worksheets 
are limited to one worksheet only in the workbook.

To create a new SigmaPlot worksheet, click the New Worksheet toolbar button . 
If you have Excel installed, you can click the New Excel Worksheet  toolbar 
button to create a new Excel worksheet that is modified and saved within the 
SigmaPlot notebook.

You can also copy and paste existing worksheets; see �Copying, Pasting and 
Removing Notebook Items� on page 49.

Creating New
Graph Pages

To create a new graph page:

1. Select the section in which you want the page to appear.

2. Click the New Page toolbar button . 

If no page exists for a worksheet, you can automatically create a new page by creating 
a new graph; see �Creating Graphs� on page 160. Any subsequently created graph 
will appear on the current page

To use page templates:

1. From the File menu, point to New, and then choose Graph Page.

2. Select the template you want to use the Type list. Descriptions of the templates 
may appear in the Description box. 

Figure 3�4
Copying a Notebook Section
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3. Click OK to create the new page using the selected template.

Templates consist of preformatted pages along with optional pre-created graphs. 
You can use any page as a template. For more information about using tem-
plates, �Using Graph Pages as Templates� on page 103.

Σ You can also create a new page by copying an existing page. Copied pages also act as 
templates. For more information on copying notebook items, see �Copying, Pasting 
and Removing Notebook Items� on page 49.

Creating New
Reports

To create a new report:

1. Right-click the section where you want the report to be created.

2. Choose New from the shortcut menu.

3. In the notebook window, click the section or item.

4. Choose Report.

The Regression Wizard can automatically generate reports. See the Programming 
Guide for more information.

Creating New
Regression

Equations

To create a new regression equation:

1. Right-click the section where you want the equation to appear, point to New, 
and then choose Equation. 

Creating a new regression equation opens the Regression dialog box which 
requires entry of the proper programming code. See the Programming Guide for 
more information.

The Regression Wizard can also create regression equations.

Figure 3�5
Using the New Dialog Box

to Open a New
SigmaPlot Graph Page
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Renaming Notebook Files and Items 0

Use the Summary Information dialog box to change information that is stored with 
your notebook files, sections, and items. 

To change summary information:

1. Click the Summary button on the right side of the notebook window.

2. Select the Entry Title, Author, or Description box, then type the new name.

3. Click OK to close the dialog box. The new section, or item name appears in the 
notebook window.

In-place Editing
Section and Item

Names

You can also change the name of a notebook section or item without opening the 
Summary Information dialog box. 

1. In the notebook window, click the section or item you want to rename.

2. Click the file or item a second time.

3. Type the new name, and then press Enter. The new section or item name 
appears in the notebook window.

Figure 3�6
 Using the Summary

Information Dialog Box to
Change Name, Author,

or Comment of a
Notebook Item
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Opening Notebook Files and Items     0

Opening
Notebook Files

You can open SigmaPlot files and other types of files as SigmaPlot notebooks. 

To open a notebook file that is stored on a disk:

1. Click the Open  button. The Open dialog box appears.

2. Choose the appropriate drive and directory of the notebook file to open. 

3. Double-click the desired notebook file.

4. If you want to open another type of file , choose the type of file from the Files of 
type list.

5. Click Open.

Σ SigmaPlot 1.0 or 2.0 or SigmaStat files 1.0 are opened as notebook files. 

Opening Worksheets,
Reports, and Pages

You can open a worksheet, report, or page by double-clicking its icon in the 
notebook window. You can also select the item and click the Open button. Open 
worksheets, pages and report are shown in their own window, and appear in the 
notebook as a colored icons.

Double-clicking an item that is already open brings the item�s window to the front.

Opening Multiple Items  You can open as many items as your system�s memory 
allows. However, you can only simultaneously open items associated with the current 
notebook. If you open an item from a different notebook, the current items close, 
and the item in the other notebook opens. 

Opening Excel
Workbooks

You can open Excel workbooks directly into SigmaPlot. You can also instruct 
SigmaPlot to use Excel worksheets by default for all new notebook. See �Using Excel 
as Default Workbooks� on page 85.

Figure 3�7
The Open Dialog Box

Showing Previously
Saved.JNB Files
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If you have set SigmaPlot to always use Excel workbooks as the default worksheet, 
additional file types are available in the Open dialog box. For a list of files that are 
available, �Opening Other File Types With Excel� on page 85.

When opened by SigmaPlot, Excel workbooks open into a SigmaPlot notebook, and 
are saved as notebook files. Excel worksheets appear in the notebook as any other 
notebook. You can create graphs and run transforms and statistics from them as any 
other worksheet. If you want to save the Excel workbook back out to an Excel file, 
use the Export command; see �Exporting Notebook Items� on page 51.

Σ Excel worksheets created within SigmaPlot are limited to a single worksheet. You can 
open Excel workbooks with multiple sheets with SigmaPlot, but you can only use the 
top sheet for graphing and statistics. You cannot add or delete additional sheets. 

Opening Regression
Equations

Regression equations opened from the notebook appear in the Regression Wizard. 
You can use the Regression Wizard to apply the equation model to your data and 
generate a fitted curve for your graph. For more information on using the Regression 
Wizard, see the Programming Guide.

Opening .FIT Files SigmaPlot Version 1, 2 and 3 equation files use the .FIT filename extension. You can 
open a .FIT file as a notebook, then open the .FIT file as a regression equation by 
double-clicking it. 

You can convert .FIT files to regression equations and then copy and paste them like 
any other notebook item. Copy and paste to convert your old .FIT files into a single 
notebook of regression equations that you can use as an equation library. For more 
information on regression equations and .FIT files, see the Programming Guide .

Opening Worksheets
in SigmaStat

You can gain access to and work with worksheets in and from SigmaStat 2.0 using 
SigmaPlot�s Run SigmaStat command.

To open a SigmaStat worksheet in SigmaPlot, you must already be running 
SigmaStat. 

To open a SigmaPlot worksheet in SigmaStat:

1. Select the worksheet you want to view in SigmaStat.

2. Choose Run SigmaStat from the Statistics menu. 

SigmaStat appears displaying the selected worksheet. The worksheet is appended 
to the end of the current SigmaStat notebook.
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Copying, Pasting and Removing Notebook Items 0

Copying and pasting items in your notebook helps you to organize your SigmaPlot 
notebook and easily create copies of important data and graphs. You can copy and 
paste items within a notebook and from one notebook to another.

Σ You cannot copy a worksheet into a notebook section that already contains a 
worksheet. SigmaPlot always creates a new section for pasted worksheets that is 
appended to the end of the current notebook.

Σ Copying and pasting pages and worksheets between sections results in using graph 
pages as templates. To learn about creating and using templates, �Using Graph Pages 
as Templates� on page 103.

To copy and paste a notebook item:

1. Open both the source and destination notebook file windows. The source note-
book for a copied item must be open for a copy to take place.

2. Right-click the item that you want to copy, and choose Copy from the shortcut 
menu.

3. Right-click the section and/or where you want to paste the item and choose 
Paste. The selected item is pasted to the current notebook and section. 

Removing Items
From a Notebook File

To remove an item from a notebook:

1. Select the item and press Delete.

Items removed from a notebook file using the Delete button are removed per-
manently.

Copying a Page to a
Section with No

Worksheet

If you copy a graph page into an empty section or a section that has no worksheet, 
you create an independent page. The independent page retains all its plotted data 
without the worksheet. You can store the pages from several different sections that 
have different data together this way. However, if you ever create or paste a worksheet 
into a section, all independent pages will revert to plotting the data from the new 
worksheet.

Use independent pages as templates, or to draw or store objects. You cannot create 
graphs for an independent page until it is associated with a worksheet (and no longer 
independent). 
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Saving Your Work 0

Be sure to save your work at regular intervals.

To save a notebook file for the first time:

1. Click the Save button . The Save As dialog box appears.

2. Navigate to the directory where you want to save your notebook.

3. Type a name for the notebook in the File Name text box.

4. Click Save to save the notebook file and close the Save As dialog box.

To save changes:

1. To save with the same name and path, click the Save button .

Your file is saved.

2. To save to a new name and path, choose Save As from the File menu. 

3. Enter a new file name.

4. Choose the new drive, directory, and file type.

5. Click Save.

Your file is saved.
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Exporting Notebook Items 0

Use SigmaPlot�s Export command to export worksheet, page and report contents as 
files of different formats. 

You can export a notebook by clicking the notebook icon in the notebook window, 
then choosing Export from the File menu. Use Export to save SigmaPlot 5.0 
notebooks as SigmaPlot version 4.0 or SigmaStat 2.0 files. Note that any features 
exclusively supported by version 5.0 will be lost upon conversion.

Exporting worksheets does not export associated graphs. To export the worksheet 
and the graph, you need to export the graph page to a SigmaPlot Graph (.SPW) file.

Σ You can only export the entire Sigma Worksheet. If you want to export a portion of 
the worksheet, delete the portion you don�t want to export, then export the remainder 
of the worksheet.

To export a SigmaPlot worksheet:

1. Select the worksheet you want to export by opening and viewing it, or selecting 
it in the notebook window.

2. Choose the File menu Export command. The Export File dialog box appears

3. Use the Files of type drop-down list to select a file format. Enter the file name, 
directory, and/or drive for the exported file, then click Export to create the file. 

When you export a SigmaPlot worksheet as a text file, tabs or commas are used to 
separate data columns and data is saved at full precision.

Σ If you want to save a text file with data as it appears in the worksheet rather than at 
full precision, copy the selected data to the Clipboard, paste it into a text editor, and 
save it as a text file.

Exporting Graphs
and Pages

SigmaPlot graphs and graph pages can be exported to other files formats. To export a 
graph or graph page:

1. Select and view the graph page. If you want to export specific graph(s), select the 
graphs you want to export to a file.

2. Choose the File menu Export command. The Export File dialog box appears.

3. Enter the file name, directory and/or drive for the export file destination, then 
click Export.

4. If you chose one of the graphic file formats, a secondary dialog box appears, ask-
ing you to enter some graphic format information.

5. Enter the desired DPI and Color Resolutions; for EPS files, these setting only 
affect the resolutions of the TIFF header, not the actual PostScript resolution. 
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For metafiles, this setting affects only 3D graphs.

The higher the DPI and Color resolutions, the better quality the image, but also 
the larger the file. Limit the DPI and Color resolutions to the capability of the 
intended output device. For example, if you are going to create 600 dpi slide 
output, set the DPI resolution no larger than 600.

6. If you want to export only the selected graph(s) or objects, check the Export 
Selected Only option.

7. Click OK to create the exported file using the specified file name and graphic 
resolutions, if applicable.

Exporting Reports You can only export the entire report. If you want to export a portion of the report, 
delete the portion you don�t want to export, then export the remainder as the file.

To export a SigmaPlot report:

1. Select and view the report window you want to export.

2. Choose Export from the File menu.

3. Use the Save as type drop-down list to select a file format. 

4. Enter the file name, directory, or drive for the export file destination.

5. Click Export to save the file.

Printing SigmaPlot Items 0

Printing Worksheets To print the current worksheet:

1. Select and view the worksheet. If you want to print only a portion of the col-
umns in the active worksheet, select a block from the worksheet.

2. Click the Print button  to print the worksheet using all the default settings. 

3. To print column statistics, select the column statistics worksheet (press F6 or 

click the toolbar  button), then click the Print toolbar button.

4. If you want to set printing options before your print, press Ctrl+P or choose the 

Figure 3�8
Using Export File (Save As

Dialog Box) to Export
a Report
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File menu Print command. The Print Data Worksheet dialog box appears. 

5. Specify whether you want to print the entire worksheet, only the selected cells in 
the worksheet, or a specified range of columns by selecting one of the options 
under the Area to Print heading. 

6. To print the worksheet, click OK after setting your worksheet printing options.

7. If you want to configure your printer settings, click the Setup button. The Print 
dialog box appears.

8. Click OK when you are satisfied with the Printer settings, or click Properties to 
edit the printer properties. Note that the Properties dialog box options vary from 
printer to printer.

Σ Note that in order to print the names of the statistics that appear in the row region of 
the worksheet, you must select to print row titles.

Printing Graph Pages To print a graph page:

1. Select and view the page window.

2. Click the Print button  to print the page using all the default settings. 

3. If you want to set printing options before your print, choose the File menu Print 
command. The Print dialog box appears.

4. Click OK when you are satisfied with the Printer settings, or click Properties to 
edit the printer properties. Note that the Properties dialog box options vary from 
printer to printer.

For more information on printer settings and use of high resolution output devices, 
�Printing Tips� on page 329.

For more information on using Page Setup, �Changing Graph Page Format� on 
page 143.

Printing Reports You can print any report in your SigmaPlot notebook. 

Figure 3�9
The Print Data

Worksheet Dialog Box
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To print reports:

1. Select and view the report window.

2. Click the Print button  to print the report using all the default settings. 

3. If you want to set printing options before your print, choose the File menu Print 
command. The Print dialog box appears.

4. Click OK when you are satisfied with the Printer settings, or click Properties to 
edit the printer properties. Note that the Properties dialog box options vary from 
printer to printer.

Printing Selected
Notebook Items

You can print individual or multiple items from the notebook, including entire 
sections.

To print one or more items or sections from the notebook:

1. Select one or more items or sections from the notebook. 

2. Click the Print button  to print the worksheet using all the default settings. 

Σ If you want to set printing options before printing a report, graph page, or worksheet, 
each item must first be opened. Then press Ctrl+P to open the Print dialog box. 

For information on printing worksheets, �Printing Worksheets� on page 52. For 
information on printing graph pages, �Printing Graph Pages� on page 53. For 
information on printing reports, �Printing Reports� on page 53.
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Worksheets are the containers for the data you analyze and graph. They are 
spreadsheet-like in appearance but are much more limited in function, and are 
column rather than cell oriented. 

Data can be typed in, pasted, or imported from other sources. Data can also be 
automatically generated and placed in worksheet columns by data transforms and 
statistical procedures.

This chapter covers:

➤ Setting worksheet options (see page 56)

➤ Moving around the worksheet (see page 57)

➤ Entering data into a SigmaPlot worksheet (see page 59)

➤ Importing data into a SigmaPlot worksheet (see page 60)

➤ Descriptive statistics for worksheets (see page 64)

➤ Changing data display (see page 67)

➤ Selecting data (see page 77)

➤ Sorting data (see page 77)

➤ Cutting and pasting data (see page 78)

➤ Inserting and deleting columns and rows (see page 79)

➤ Switching data rows to columns (see page 81)

➤ Entering column titles (see page 82)

➤ Using Excel inside SigmaPlot (see page 84)

4
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The following figure provides some worksheet definitions:

Setting Worksheet Display Options 0

The Options dialog box Worksheet panel sets the display for:

➤ Numeric

➤ Date and Time

➤ Statistics

➤ Appearance

Figure 4�1
Example of a

SigmaPlot Worksheet

Row numbers and titles
are listed along the left
side of the worksheet.

Select a cell by clicking
it or using the arrow

keys to scroll to it.
Selected cells are

highlighted.

Column numbers and
titles appear here.

Figure 4�2
The Options Dialog Box
Worksheet Panel Show

Settings For Display Choices
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This panel also enables you to select a numeric display type, change column width 
and decimal places, and turn on and off engineering notation.

For information on Column Statistics, see �Descriptive Statistics for Worksheets� on 
page 64. 

Date and Time
Displays

The Date and Time displays shown in the Options Worksheet panel show the default 
formats for all Date and Time displays in the worksheet. The Format Cells Date and 
Time dialog box also shows the currently selected format. See �Changing Date and 
Time Display� on page 71.

Moving Around the Worksheet 0

You can move around the worksheet using scroll bars or, move the highlighted 
worksheet cursor with the keyboard.

Figure 4�3
The Options Dialog Box

Worksheet Panel Data and
Time Options

Function Keystroke

Move one column right/left → or ←

Move one row up/down ↑ or ↓

Move one window view up/down Page Up, Page Down

Move to end of column End
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Going to a Cell You can move the worksheet cursor to any cell in the worksheet by specifying the 
column and row number in the Go to Cell dialog box. 

To go to a cell:

1. Choose the View Menu Go To command.

2. Enter the desired column and row number. To select the block of cells between 
the current highlight location and the new cell, click the Extend Selection to 
Cell check box. Click OK to move to the new cell.

Using the Worksheet
Shortcut Menu

In addition to the menu commands and toolbar buttons referred to in the body of 
this manual, right-clicking the worksheet displays a shortcut menu. The commands 
on the right-click shortcut menu are the same as the Edit menu: Cut, Copy, Paste, 
Delete, Transpose Paste, Insert Cells, and Delete Cells commands. 

Function Keystroke

Move to end of worksheet End+End

Move to top of column Home

Move to column one, row one Home+Home

Figure 4�4
 Moving to a Specific
Cell in the Worksheet
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Entering Data into a SigmaPlot Worksheet 0

This section describes entering data into SigmaPlot worksheet columns, and 
formatting the columns for numeric, label, or date and time display.

Editing Cells To edit a cell, click it. Make your changes, and press Enter. Note that the edited 
contents replace the current contents unless Insert mode is active. 

To enter data in a SigmaPlot worksheet:

1. Click the cell you want to edit.

2. Type a number, label, or date and time value. 

3. Press Enter to move down one row, or use the arrow keys to move around the 
worksheet. You must press Enter before moving to another column.

Entering Dates
and Times

Dates and times are entered using delimiters. The delimiters used are determined by 
the Windows regional settings. For more information, see �Regional Settings� on 
page 74.

Date Delimiters :   The default date delimiter for most systems is the forward 
slash (/). An entry that displays only two fields of a date value is assumed to be day 
and month. If the second field�s value is greater than 31, months and years are 
assumed. Entries with two delimiters assume month/day/year. If you enter only two 
digits for the year, the current century is implied. Examples are given in the following 
table (the twentieth century is assumed to be the current computer clock setting).

Figure 4�5
The Right-Click
 Shortcut Menu
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Time Delimiters:   The default time delimiter is usually a colon (:). Entries displaying 
two fields of a time value are assumed to be hours and minutes. If PM is not 
specified, hours less than 12 are assumed to be morning hours. An entry with two 
colons assumes hours:minutes:seconds.

Insertion and
Overwrite Modes

Press the Insert key or use the Edit menu Insertion Mode command to switch 
between overwrite and insert data entry modes. 

If in Insertion mode,  �Ins� appears in the status bar. A check mark next to the 
Insertion Mode command in the Edit menu also indicates that the worksheet is in 
insertion mode.

If in Insertion Mode, new data entered in a cell does not erase the previous contents. 
Any existing data in the column is moved down one row. If you paste a block of cells, 
existing data is pushed down and/or to the right to make room for the pasted cells. If 
you cut or clear data, data below the deleted block moves up and/or to the left.

If not in Insertion Mode,  the worksheet is in overwrite mode. Data entered into a 
cell replaces any existing data. If you paste a block of data, the block overwrites 
existing data. 

Importing Files from Other Applications 0

You can import data from other applications into an existing worksheet for graphing, 
worksheet display, or running regressions. When you import data, it appears at the 
position of the worksheet cursor. 

The following file types can be imported into SigmaPlot worksheets:

➤ SigmaPlot 1.0 and 2.0 files (.SPW)

➤ SigmaPlot Macintosh 4 Worksheet

➤ SigmaPlot Macintosh 5 Worksheet

➤ SigmaStat 1.0 files (.SNB) 

➤ SigmaPlot and SigmaStat DOS files (.SPG, .SP5)

➤ TableCurve 2D and 3D files

Value Entered: Resulting Date:

2/2 February 2

2/32 February, 1932

2/2/02 February 2, 1902
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➤ Microsoft Excel files (.XLS)

➤ Lotus 1-2-3 files (.WKS, .WK*)

➤ Quattro/DOS files (.WK*)

➤ dBase files (.DBF)

➤ Plain Text files (.TXT, .PRN, .DAT, .ASC)

➤ Comma Delimited files (.CSV)

➤ SigmaScan

➤ SigmaScanPro Worksheets

➤ SigmaScan Image

➤ Mocha Worksheets

➤ DIF

➤ Axon Text and Binary formats

Σ When you import data from another application that is left-justified, SigmaPlot 
assumes it is text.

To import data:

1. Move the worksheet cursor to the worksheet cell where you want the imported 
data to start.

2. Choose the File menu Import command. The Import File dialog box appears.

3. Use the Files of Type drop-down list to select the type of file you want to import.

4. Change the drive and directory as desired, select the file you want to read, then 
click Import, or double-click the file name. Depending on the type of file, the 
data is either imported immediately, or another dialog box appears. 

SigmaPlot,
SigmaStat,

SigmaScan, Mocha
Worksheets and DIF

If you are importing a SigmaPlot, SigmaStat, SigmaScan, Mocha, or DIF file, a 
dialog box appears prompting you to select a range of data to import.

Select the range of data by specifying the start and end of the range; the default is the 
entire range. 

Click Import to place the data in the SigmaPlot worksheet.
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MS Excel,
Lotus 1-2-3,
Quattro, and
dBase Files

If you want to use an Excel workbook as an actual Excel workbook within SigmaPlot, 
you must open the workbook instead of importing it. Importing places the Excel 
data into a SigmaPlot worksheet, and does not open the workbook as an actual Excel 
workbook. For more information on using Excel workbooks in SigmaPlot, see 
�Using Excel Workbooks in SigmaPlot� on page 84.

When importing a spreadsheet or dBase file, the Import Spreadsheet dialog box is 
used.

Select either the entire spreadsheet or a specified range of cells. Cells are specified 
using the standard 1-2-3 notation (e.g. A1:C50 for a range from cell a1 to cell c50). 
For dBase files, cell letters correspond to fields. When you have finished specifying 
the range to import, click Import. The selected data is imported.

Note that the dialog box indicates whether or not the worksheet is in overwrite or 
insert mode, and where the imported data will begin.

Σ To import spreadsheet data from non-compatible programs, save the spreadsheet as 
either a Lotus or text file, then import that file.

Σ Only the top sheet of an Excel workbook can be imported. If you attempt to import 
another worksheet, you will receive a warning message. If you want to move data 
from other sheets, use Copy and Paste. 

Figure 4�6
Import Spreadsheet Dialog

Box
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Importing
Text Files

If you are importing a text file, the Import Text dialog box appears. Use this dialog 
box to view the text file and to specify other delimiter types, or to build a model of 
the data file according to custom column widths.

Σ A quicker method of importing text is copying the data in your source application, 
then opening SigmaPlot and pasting the data. 

1. To specify a different column separator,  select Delimiter to activate the delim-
iter options; then select the appropriate type. You can select commas, hyphens, 
or any other characters. For example, many databases use semicolons (;) as 
delimiters.

2. To specify a model of the data,  use dashes (-) to specify column widths, and 
bracket characters [ and ] to define the column edges. Use a vertical bar | charac-
ter to indicate a single-character width column. Click Analyze to re-display the 
appearance of the file using the new model.

3. To save text import formats , enter a name into the Format scheme box, then 
click Add. Delete unwanted import formats using the Remove button.

4. To specify a different range,  enter the rows and columns to read, then click 
Analyze. You can use this feature to eliminate file headers and other undesired 
text.

5. When you are finished specifying the file parameters, click Import. The speci-
fied data from the file is imported.

Axon Files SigmaPlot can import data files produced by Axon Instruments, Inc. laboratory 
equipment and data acquisition programs. SigmaPlot imports both text and binary 
data files; if you select one of these options, the Import Axon dialog box appears 

Figure 4�7
The Import Text Dialog Box
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prompting you to select a range of data to import. The File selected is indicated in 
the dialog box title.

Select the range of data by specifying the Row and Column ranges; the default is the 
entire range. Click Import to place the data in the SigmaPlot worksheet. 

Descriptive Statistics for Worksheets 0

SigmaPlot automatically calculates a number of basic statistical values for all the data 
in your worksheet columns. To view the statistics for the currently selected 
worksheet, choose the View menu Statistics command. A check mark appears next to 
the Statistics command. The running calculations performed for each column appear 
in a Column Statistics window for that worksheet. 

To close the Column Statistics window choose the View menu Statistics command 
again, choose the File menu Close command, or click the  button in the upper 
right corner of the worksheet window.

Available Statistics The statistics shown in the Statistics windows are determined by your settings in the 
Statistics Options dialog box (see �Statistics Options� on page 66). Empty cells, 
missing values, and text are ignored in most calculations. The following statistics can 
be displayed in the Column Statistics window. 

Figure 4�8
Import Axon File Dialog Box

Figure 4�9
The Column

Statistics Worksheet
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Mean:  The arithmetic mean, or average, of all the cells in the column, excluding the 
missing values. This is defined by:

Std Dev:  The sample standard deviation is defined as the square root of the mean of 
the square of the differences from their mean of the data samples xi in the column. 
Missing values are ignored.

Std Err:  The standard error is the standard deviation of the mean. It is the sample 
standard deviation divided by the square root of the number of samples. For sample 
standard deviation  s:

95% Conf:  The value for a 95% confidence interval. The end points of the interval 
are given by:

where  is the mean, s is the sample standard deviation, and t(v,z) the t statistic for v 
= n−1 degrees of freedom and z = 1.96 standard normal percentile equivalent.

99% Conf:  The value for a 99% confidence interval. The end points for this interval 
are computed from the equation for the 95% confidence interval using z = 2.576.

Size:  The number of occupied cells in the column, whether they are occupied by 
data, text, or missing values.

Sum:  The arithmetic sum of the data values in the column.
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Min:  The value of the numerically smallest data value in the column, ignoring 
missing values.

Max:  The value of the numerically largest data value in the column.

Min Pos:  The smallest positive value.

Missing:  The number of cells in the column occupied by missing values, denoted 
with a double dash symbol (--).

Other:  Either text or an empty cell.

Statistics Options To display only a portion of the available statistics use the Worksheet Options dialog 
box, then select column statistics to show or hide.

To specify which statistics are shown or hidden:

1. Choose the View menu Statistics command to open the column statistics work-
sheet. Choose the Tools menu Options command, then click the Worksheet tab. 
The Options dialog box appears.

2. Select the statistic(s) you want shown or hidden, then use the Show and Hide 
buttons to move the statistics between the Shown and Not Shown lists.

3. To change the column widths and data display, select the appropriate options. 
For more information on changing data display and column width options, see 
�Sizing Columns and Rows� on page 68.

Figure 4�10
The Statistics Options

Dialog Box
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Printing Statistics To print or export statistics:

1. Choose the File menu Print command. The Print dialog box appears. 

2. Click OK. The options are set in the Print Data Worksheet dialog box that 
appears after clicking OK in the Print dialog box. 

In order to print the name of the statistic, you must select to print the row titles 
by clicking Options, then checking Row Titles by selecting it from the Headers 
options.

For more information on printing worksheets, �Printing Worksheets� on page 52 .

Displaying Worksheet Data 0

Data can be displayed in your worksheet columns as:

➤ Text

➤ Numbers

➤ Date and Time values

➤ Graphic information

Figure 4�11
The Print Data Worksheet

Dialog Box for Columns
Statistics
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You can enter numbers, labels, and dates and times directly into the worksheet. You 
can also convert numbers to dates and times and vice versa with the Format menu 
Cells command. To change column widths, number decimal places, or date and time 
format, choose the Tools Options menu command. These operations are described 
below.

Sizing Columns
and Rows

If the contents of your column exceed the column width, cell contents display as 
pound symbols (####). Label entries are truncated. 

To change a column width,  drag the boundary on the right side of the column 
heading until the column is the size you want.

To change a row height,  drag the boundary below the row heading until the row is 
the size you want.

To adjust column width and row height from the Tools menu Options dialog box:

1. Select the Worksheet tab. 

2. From the Settings For list, select Appearance. 

3. Set column width and row height in the Column Width and Row Height drop-
down lists.

Σ SigmaPlot is only accurate to twenty-one significant digits regardless of how many 
decimal places you specify. 

Figure 4�12
Numbers are displayed in

Column 1, dates are
displayed in Column 2, and

text is shown in Column 3
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Setting Decimal
Places

To set the number of decimal places used for worksheet values:

1. On the Worksheet panel of the Tools menu Options dialog box, enter the value 
in the Decimal Places edit box. The number of decimal places allowed is limited 
by the column width�the maximum number of decimal places cannot exceed 
the column width.

2. Click Apply to apply the changes without closing the dialog box, or OK to 
accept the changes and close the dialog box.

Uses of Text Text entered into worksheet columns can be used as:

➤ Data categories for a plot

➤ Column titles (entered above a column)

➤ Symbols

➤ Tick labels

For information on categories, see �Using a Category Scale� on page 206. Using 
labels in worksheet columns is described in �Using a Worksheet Row for Column 
Titles� on page 82. For information on using text as symbols, see �Using Characters 
and Text as Symbols� on page 180. For information on using customized tick labels 
from a worksheet column, see �Using Custom Tick Labels� on page 223.

Figure 4�14
Changing Worksheet

Column Width
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Changing Numbers
Display

Display numbers in four ways in your worksheet. Set the display with the Tools 
menu Options command. 

To set the numeric display for your worksheet:

1. Select and view the worksheet, then choose the Tools menu Options dialog box. 

The Options dialog box opens. The worksheet panel shows the Numeric setting 
by default.

Numeric Display Description Example

E Notation When 
Needed

Displays worksheet data as scientific notation 
only when the length of the value exceeds the 
width of the cell. The default column width is 
twelve.

12.00

E Notation Always Always displays data as scientific notation. The 
number of decimal places is set in the Decimal 
Places edit box.

12.00e+0

Fixed Decimal Displays data with a fixed number of decimal 
places. Set the number of decimal places in the 
Decimal Places edit box. The number of decimal 
places allowed is limited by the column width�
the maximum number of decimal places cannot 
exceed the column width. The default setting for 
decimal places is two.

12.00

General Displays data exactly as you enter it in the 
worksheet.

12
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2. To set the numeric display, select a Numeric format setting from the second 
drop-down list.

3. To use engineering scientific notation for worksheet values, select the Engineer-
ing Notation check box. This option only applies if you have a scientific nota-
tion format selected.

4. Click Apply to set the options without closing the dialog box, or OK to accept 
the settings and close the dialog box.

Changing Date and
Time Display

SigmaPlot offers you a variety of date/time displays. When you enter a value into a 
date/time formatted cell, SigmaPlot assumes internal date/time information about 
that value from the year to the millisecond. 

For example, if you enter a day and month, you can display the month and year. 
Open the Tools menu Options dialog box and select the Worksheet tab. Select Date 

Figure 4�15
Selecting Numbers Display

Format
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and Time from the Show Settings For drop-down list to view and modify the current 
settings.

To change the display Date format, type one of the following examples into the Date 
edit box, or choose a format from the drop-down list:

Figure 4�16
Selecting a Date Display

Format

Typing: Displays:

M/d/yy No leading 0 for single digit month, day or year

MM/dd/yy Leading 0 for single digit month, day or year

MMMM Complete month

dddd Complete day

yyy or yyyy Complete year

MMM Three-letter month

ddd Three-letter day

gg Era (AD or BC)
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To change the display Time format, type one of the following examples into the 
Time edit box, or choose a format from the drop-down list: 

Day Zero Setting a Start Date is only necessary if you are importing numbers to be converted 
to dates, or converting dates to numbers for export. The starting data must match the 
date used by the other application.

Select a date from the Day Zero drop-down list, or type your own start date. The 
default start date is 1/1/1900. 

Day Zero becomes the number 1.00 when you change from Date and Time to 
Numbers format. The basic unit of conversion is the day; that is, whole integers 

Typing: Displays:

hh or h 12 hour clock

HH or H Military hours

mm or m Minutes

ss or s Seconds

uu or u Milliseconds

H: h: m: s: or u No leading zeroes for single digits

HH: hh: mm: ss: uu Leading zero for single digits

tt Double letter AM or PM

t Single letter AM or PM

Figure 4�17
 The Day Zero

 Drop-down List
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correspond to days. Fractions of numbers convert to times. Zero and negative 
numbers entered into the worksheet convert to days previous to the Day Zero start 
date.

Conversion between date/time values and numbers can occur for the calendar range 
of 4713 BC to beyond the year 4,000 AD. The internal calendar calculates dates 
using the Julian calendar until September, 1752. After that, dates are calculated using 
the Gregorian calendar.

Σ If you convert numbers to dates, a start date is applied. If you convert the dates back 
to numbers, be sure you use the same start date as when you converted them, or they 
will have a different value.

Regional Settings Drop-down lists in the Options dialog box worksheet panel use the current date/time 
settings in your operating system. The Windows Regional Settings control date/time 
delimiters, 12 or 24 hour clock, and AM/PM display.

Date and time display formats may be affected by your operating system�s Regional 
Settings. For example, if your Time Zones are specified as British (English), your date 
values appear as dd/mm/yy. If the setting is US (English), your date values appear as 
mm/dd/yy. If you want to view or modify the current settings, or view alternative 
settings available on your system, click the Regional Settings button, or modify them 
directly from the Windows Control Panel.

Σ Date and time values are entered into the worksheet using the date and time 
delimiters, generally a forward slash (/) or colon (:). For more information on 
entering dates and times, see �Entering Dates and Times� on page 59.

Switching Between
Date and Time and

Numeric Display

You can convert between date/time and numeric display when:

➤ Importing data

➤ Switching numbers to dates

➤ Modifying the display between date, time and date/time

To display worksheet cells in Date and Time format:

1. Open and view the worksheet, and select the data you wish to display in date/
time format.

2. Choose the Format Cells command and choose Date and Time from the drop-
down list. 

3. Select date and time formats from the Date and Time drop-down lists.

4. The sample box changes according to your choice. Click OK. 

The data is displayed showing the date, time, or date and time as specified.

The dates and times that are entered as dates and times are automatically dis-
played as such.
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Using Date/Time
Format with Other

Programs

You can copy date/time values from a SigmaPlot worksheet and paste them into 
other programs, such as an Excel workbook, or, you can copy date/time values from 
another program and paste them into a SigmaPlot worksheet. If the date/time format 
you are pasting is larger than the worksheet column width, you may need to change 
the column width.

Σ If you are copying date/time values from another program to SigmaPlot, make sure 
that the program is displaying dates/times in a format that SigmaPlot accepts as valid 
data entry. For example, if you are pasting dates from Excel, make sure the dates are 
displayed as numbers separated by slashes (/), or whatever date delimiter Windows is 
set to.

To change Excel formats, see your Excel reference, or, with an Excel worksheet active 
in SigmaPlot, choose Microsoft Excel Help from the Help menu to view the topic 
about Date and Time formats.

Keep the following in mind when copying or importing date and time formatted 
data:

➤ Pasted or imported numeric data is not automatically converted to Date and 
Time format. It must be converted using the same start date (Day Zero) that is 
used by the other program.

➤ When copying worksheet values , values are copied as numeric strings, not date/
time. 

➤ SigmaPlot recognizes Date and Time formats imported from Excel, but most 
other non-text dates and times will need to be converted from numbers to dates 
and time.

Figure 4�18
The Format Menu Cells

Dialog Box
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Setting Row and
Column Size

To set row and column size for a selected block of data:

1. Open and view the worksheet, and select a block of data.

For more information on selecting blocks of data, �Selecting a Block of Data� on 
page 77.

2. From the Format menu, choose the Cells dialog box. The Format Cells dialog 
box appears.

The Selected box reflects the selected rows and columns.

3. Set column width and row height from the Column Width and Row Height 
drop-down lists. 

4. Click Apply or OK.

The worksheet appears with new column and row sizes for the selected cells.

5. To apply the row and column formats to the whole worksheet, select Apply to 
Enter Worksheet, and click Apply or OK.

Changing Graph
Appearance

Setting row height and column width from the Format Cells dialog box only changes 
the selected block of data. Set row and column defaults using Appearance tab in the 
Tools menu Options dialog box. For more information, see �Sizing Columns and 
Rows� on page 68.

Figure 4�19
The Format Menu Cells

dialog box Rows and
Columns tab
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Selecting a Block of Data 0

There are several ways to select a block of worksheet cells. You can:

➤ Drag the mouse over the desired worksheet cells while pressing and holding 
down the left mouse button.

➤ Hold down the Shift key and press the arrow, PgUp, PgDn, Home, or End keys.

➤ Use the Go To command (see page 58).

Selecting
Columns and Rows

To select an entire column, move the pointer above or below the column and click or 
drag to highlight the desired column(s).

To select entire rows, move to the left of the rows, then click or drag to select the 
desired row(s).

Selecting the
Entire Worksheet

To select all data in the worksheet,  click the worksheet icon in the upper left corner 
of the window. To select the entire worksheet,  double-click the worksheet icon.

Sorting Data 0

You can sort selected blocks of data in ascending or descending order according to 
the order in a key column. 

Σ Because the sort command sorts data in place, if you want the original data to remain 
intact, copy the data to a new location and sort the copied data.

Figure 4�20
Selecting a Block of

Data in the Worksheet
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To sort selected data:

1. Use the mouse or keyboard to select the data you want to sort. Only the selected 
columns and rows are sorted; unselected values within a column are ignored.

2. Choose the Transforms menu Sort Selection command. The Sort Selection dia-
log box appears. 

3. Select the key column by choosing the appropriate column title or column num-
ber from the Key Column drop-down list, or by selecting the Key Column edit 
box and typing the column title or column number.

Σ If you sort more than one column of data, the key column is used as the sorting index 
for all other selected data. The selected rows in any other columns are sorted 
according to the rows in the key column.

4. Select either Ascending or Descending to sort your data in order of increasing or 
decreasing values. 

5. Click OK to sort the data in place, and close the Sort Selection dialog box.

Cutting, Copying, Pasting, Moving, and Deleting Data 0

Use the appropriate Edit menu commands to Cut, Copy, Paste, and Delete a selected 
cell or block. You can also use the Ctrl+X, Ctrl+C, and Ctrl+V shortcut keys or the 

 toolbar buttons.

The Windows
Clipboard

The Clipboard retains the last cut or copied objects. Subsequent cuts or copies 
overwrite the current Clipboard contents. For information about the Clipboard, see 
�Cutting, Copying and Pasting Graphs and other Page Objects� on page 108.

Figure 4�21
The Sort Selection Dialog

Box
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Cutting and
Copying Data

Cut removes a selected cell or block from the worksheet and copies it to the 
Clipboard. Copy copies data to the Clipboard without deleting it from the 
worksheet.

Pasting Data To paste data, click or move the worksheet cursor to the cell where you want to paste 
the data, or to the upper-left corner of the block. Choose the Paste command, the  
toolbar button, or press Ctrl+V. Any data in the Clipboard is placed in the 
worksheet.

Moving Data Move a block of data by cutting it, selecting the upper-left cell of the new location, 
then pasting the block. To learn more about inserting and deleting entire blocks of 
data, see the following section, �Inserting and Deleting Blocks, Columns, and Rows� 
on page 79.

Deleting Data Use the Clear command to permanently erase selected data. This operation does not 
copy data to the Clipboard, and is faster than cutting.

Inserting and Deleting Blocks, Columns, and Rows 0

To insert and delete columns, blocks of cells, and rows:

1. Select a block, columns, or rows to insert or delete by dragging the mouse over 
the region where you want the empty block to appear, or over the block to 
delete.

The selected region of cells indicates exactly which cells will be inserted or 
deleted.

2. If you want to insert cells in the selected region, choose the Insert menu Cells 
command. 

3. To delete the selected block, columns, or rows, choose the Insert Menu Delete 
Cells command.

4. Select the direction you want the existing data to shift when the empty block is 
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inserted or deleted, or select Columns or Rows.

5. Click OK to insert or delete the block, columns, or rows. The existing data shifts 
in the specified direction.

You can also insert or delete columns by right-clicking the column number and/or 
title, then selecting either the Insert Columns or Delete Columns commands. Specify 
the number of columns you want to insert or delete. If you are inserting columns, use 

Figure 4�22
Inserting an Empty Block
of Data in the Worksheet

Figure 4�23
The Result of Inserting

an Empty Block with
Cells Shifted Down
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the Before drop-down list to indicate which column to place the new columns in 
front of. Inserting columns shifts existing columns to the right. 

If you are deleting columns,  specify the column or starting column of the block you 
want to delete. Click OK. Deleting columns shifts existing columns to the left.

Switching Rows to Columns 0

Occasionally, you may need to rearrange data from a row-oriented format to a 
column orientation, or vice versa. The Edit menu Transpose Paste command pastes 
contents with the row and column coordinates transposed.

To swap data column and row positions:

1. Select the block of data to transpose.

2. Cut or copy the selected data. 

3. Select the cell where you want to begin pasting the data, then choose the Edit 
menu Transpose Paste command. The data is pasted to the worksheet with the 
column and row coordinates reversed. 

Figure 4�24
Insert Columns Dialog Box

Figure 4�25
Results of Switching Rows

to Columns Using the
Transpose Paste Command

The data in rows 1 and 2 was
transpose pasted starting in
column 3. Note that the row

and column positions are
reversed.
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Entering and Promoting Column Titles 0

Column titles label and identify columns of data. They appear in the Graph and 
Regression Wizards when you pick columns, identify columns for legends, and can 
be used instead of column numbers in transforms.

To enter worksheet column titles, either select the column by clicking the column 
title and number box (at the top of each column), or move to the first row of the 
column and press the ↑ arrow key.

Type a column title of up to 15 characters. Press Enter to accept the new column 
title.

Σ You must use at least one text character in every column title. If you need to use a 
number as column title, type a space character (by pressing the space bar) before the 
number.

Using the Column
Titles Dialog Box

To enter or edit a column title:

1. Either move to the column and press F9, or choose the Format menu Column 
Titles command. The Column Titles dialog box appears.

2. Enter the column title. To edit an existing title,  move to that column by clicking 
the Next or Prev buttons, then edit the title.

3. When you are finished editing column titles, click OK to close the Column 
Titles dialog box.

Using a Worksheet
Row for Column

Titles

Enter labels into a row, then use that row for worksheet column titles. This is 
particularly useful for data imported or copied from spreadsheets.

To use a row for column titles:

1. If necessary, enter the column titles you want to use in a single worksheet row.

Figure 4�26
Using Row Contents

as Column Titles
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2. Select the row you want to use as column titles by clicking the row number to 
the left of the worksheet, then press F9 or choose the Format menu Column 
Title command. The Column Titles dialog box appears. Note that the selected 
row is already entered as the row to promote.

3. To delete the original row once it has been promoted, select Delete Promoted 
Row.

4. Click Promote to use the selected row contents as column titles. The Column 
Titles dialog box closes.

Σ All the cells of the selected row are promoted, not just those cells which contain 
column titles. This may affect other data sets in the worksheet.

Using a Cell as the
Column Title

Use the Column Titles dialog box to promote individual cells to column titles.

To promote individual cells:

1. Press F9 or choose the Format menu Column Title command, and click the 
Options button in the Column Titles dialog box.

2. Click Next or Prev to move to the desired column, then enter the row number of 
the cell to use as the column title.

3. Make the Delete Promoted Row option inactive by selecting the checked 
option, then select Promote to use the selected cell contents as the title for the 
current column. 

Editing Column Titles To edit a column title, double-click the column title to select it. Use the keyboard to 
make your changes, then press Enter. The new title appears at the top of the column.

Figure 4�27
Entering Column
Titles Using the
Columns Titles

Dialog Box
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Using Excel Workbooks in SigmaPlot 0

SigmaPlot supports Microsoft Excel workbooks which you can use to create graphs, 
run transforms, and perform regressions and other statistics on your data.

To open a new Excel worksheet, you can click the  button, or choose the File 
menu New command. For more information on creating Excel workbooks, see 
�Creating New Worksheets� on page 44.

Most Excel commands are available when Excel workbooks are viewed, as are the 
Excel toolbars. The SigmaPlot Graph, Statistics, and Transforms menus are also 
available. Note that when an Excel worksheet is in focus, all keyboard shortcuts are 
assigned to Excel�s hotkeys, not SigmaPlot�s.

Σ Excel workbooks created by SigmaPlot are initially limited to a single worksheet. 
Excel workbooks with multiple worksheets that are opened by SigmaPlot as 
notebooks retain all sheets, but only the first sheet can be used for graphs and 
statistics. 

Figure 4�28
A New Excel

Worksheet in
SigmaPlot
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You can unprotect a workbook by choosing the Excel Tools menu Protection 
command, and choose Unprotect Workbook. However, if you do so, you must take 
care not to delete the worksheet that is used by SigmaPlot.

You cannot add, delete or move Excel worksheets or macros within workbooks 
within SigmaPlot until you unprotect the workbook. 

Using Excel as
Default Workbooks

You can use Excel workbooks as the default SigmaPlot worksheet. To set Excel as the 
default, choose the Tools menu Options command, then select the System tab. Select 
the New Notebooks use Excel Workbook option. All new notebooks will use Excel 
workbooks as the default worksheet.

Opening Other File
Types With Excel

Using an Excel workbook as the default SigmaPlot worksheet enables you to use 
Excel�s Open options, and to open file types available to Excel. The following file 
types use the Excel Import filters if Excel workbooks are the default worksheet:

➤ MS Excel

➤ Lotus 1-2-3

➤ dBase

➤ Plain Text

➤ SYLK

Opened data files automatically appear in a new Excel workbook in a new notebook 
file.

Σ Note that some text may be opened all into a single column. Use the Excel Data 
menu Text to Columns command to format this data.

Figure 4�29
Selecting Excel Workbooks

as the Default Worksheet for
New Notebook
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Limitations of
SigmaPlot Functions
in Excel Workbooks

To understand how Excel works with other applications, please see your Excel 
documentation. The following functions are unavailable when working with data in 
an in-place active Excel workbook:

➤ Graphic cells cannot be inserted into an Excel workbook for customized 
sequences of colors, lines, symbols, and patterns. When an Excel workbook is 
the active window, there is no Edit menu Insert Graphic Cells command.

➤ An Excel workbook does not have an associated Statistics worksheet. To view 
statistics for data in an Excel workbook, use Excel�s own statistics, or copy and 
paste the data into a SigmaPlot worksheet. Choose the View menu Statistics 
command to display the statistics worksheet for the active SigmaPlot worksheet.

Additional
Features With

Excel 97

If you are working in Windows 95, Office 97, or Windows NT 4.0, and have a copy 
of Excel, you can use Excel�s advanced Print functions. You can also export Excel 
workbooks to the Excel *.XLS file format with the File menu Export command.

Printing Excel Workbooks:  To specify page setup functions for the active Excel 
workbook, choose the File menu Page Setup command to open the Page Setup dialog 
box. You can modify page, margins, headers and footers, and sheet settings.

Exporting Excel Workbooks:  You can export in-place active Excel workbooks to 
Excel�s native *.XLS file format, as well as any other format supported by Excel. 

To export Excel Workbooks:

1. Select and view the Excel worksheet, then choose the File menu Export com-
mand.

2. Excel�s Save As dialog box is opened. Select the desired format from the Save as 
type drop-down list.

Figure 4�30
Setting Printing Options

Using Excel�s Page
Setup Dialog Box
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3. Specify the drive and directory to save the file in, enter a file name, then click 
Save to save the file.

Σ Under Excel 5.0, export and page setup are not available.

Excel Toolbars An Excel workbook in SigmaPlot always uses Excel toolbar default settings of your 
last Excel session

You can view any of Excel�s toolbars by choosing the View menu Toolbars command. 
Select a toolbar to use from the Excel Toolbars dialog box; the toolbars appear near 
the workbook window.

Σ Switching from or closing an Excel workbook hides any Excel toolbars you may have 
displayed.

Creating SigmaPlot
Graphs With Excel

Workbooks

An Excel worksheet works the same as a SigmaPlot worksheet when creating graphs. 
You can pre-select data before beginning a graph, or click or highlight columns from 
the Graph Wizard.

Using Transforms on
Data in Excel

Workbooks

Transform menu commands and user-defined transforms can be performed on data 
in Excel worksheets. The transform language uses syntax which refers to columns 
numerically, or by the column titles currently assigned. When prompted to pick 
columns, you can select columns as you would on a SigmaPlot worksheet.

To perform user-defined transforms on an Excel worksheet, use the corresponding 
column number in place of the column letter that appears in the gray heading area at 
the top of the column. For example, the transform function:

col(1)=data(1,100)

Figure 4�31
PIcking Data to Plot From

an Excel Worksheet
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corresponds to inserting data values from 1 to 100 into column A of an Excel 
workbook. For more information, see the Programming Guide. 

Using Statistics You can use the statistics menu commands, including the Regression Wizard, with 
Excel worksheets.

When prompted to pick columns, select the columns from the Excel worksheet just 
as you would from a SigmaPlot worksheet. Results for statistics can be placed in 
Excel worksheets as well.

Figure 4�32
Using the Regression
Wizard with an Excel

Worksheet
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SigmaPlot Statistics

This chapter covers:

➤ Running t-tests (see page 89)

➤ Generating data using transforms and regressions (see page 91)

Running Paired and Independent t-Tests 0

A t-test determines if the mean values of two data columns are significantly different 
by testing the hypothesis that the means of the two columns are equal. SigmaPlot can 
perform both paired and unpaired t-tests.

A paired t-test requires columns of equal length, since the data is assumed to be 
before and after data on the same subjects. An independent t-test can be performed 
on differently sized columns, since no relationship is assumed between the groups.

To perform a t-test:

1. Choose t-test or Paired t-test from the Statistics menu. The t-test Column Picker 
dialog box appears.

2. To pick the columns you want to compare, select the columns from the list or 
click the columns in the worksheet. Selected columns are assigned to the high-
lighted group or treatment in the Selected Columns list. 

Figure 5�1
The t-test Column
Picker Dialog Box

5



SigmaPlot Statistics

90 Running Paired and Independent t-Tests

3. Click Finish. SigmaPlot displays results for the t-test.

4. To save the t-test results, copy and paste the data to the worksheet, page, or 
another application.

For each test these values are displayed:

➤ T, the student's t statistic

➤ P, the probability that you are incorrect in stating that the two means are 
different

➤ A statement of whether the two means are significantly different at the
P = .05 level

➤ The Degrees of Freedom, a measure of the sample size  

Calculation of t When performing t-tests, t is defined differently for paired t-tests than for unpaired 
tests. 

Paired Test:  For a paired t-test on data sets {x1, x2, xn} and
{y1, y2, , yn}

  where     and

   where  

Figure 5�2
t-test Results Dialog Box
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Unpaired Test:  For an independent t-test on data sets {x1, x2, , xn1} and {y1, y2, , 
yn2}

  where

                 

Using Transforms and Regressions to Generate Data 0

For an in-depth discussion of transforms and regression, refer to the Programming 
Guide. It contains descriptions and examples of all transform functions and the 
regression wizard, as well as many complete transform and curve fitting examples and 
results.

Using SigmaPlot
Transform Language

One of SigmaPlot's most powerful and flexible features is its extensive mathematical 
transformation language which lets you manipulate and modify worksheet data. You 
can use transforms to create new data by performing functions on existing data, or 
generate calculated or random data, which can then be placed in worksheet columns.

To use transforms:

1. Choose User-Defined from the Transforms menu. The User-Defined Transform 
dialog box opens.

2. Type transform instructions into the edit box. You can enter up to 32 K worth 
of text.

3. Click Execute to perform the transform.

The contents of the transform window can be saved to a file. Since this is a text file, 
you can view or print these files using any word processor. Previously saved 
transforms can be opened in the transform window for execution or modification.

A library of sample transforms has been provided with SigmaPlot; these can be found 
in the XFMS subdirectory of the SPW5 directory. To view these files, click the Open 
button in the User-Defined Transforms dialog box and open a transform file. Most 
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transform examples also include a sample SigmaPlot graph file displaying the results 
of the transform.

The Regression
Wizard

The Regression Wizard is a graphical user interface that provides access to the over 
100 built-in curve-fitting equations and to your own regression models, and steps 
you through the regression process. The Regression Wizard produces plots of your 
fitted curves as well as statistical reports.

Use of the Regression Wizard and SigmaPlot equation library are discussed in detail 
in the Programming Guide .

Figure 5�3
Selecting a Built-in Equation
from the Regression Wizard
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Graph Page Basics

Graph Pages are used to display and modify graphs that plot data from your 
worksheets. You can create as many graph pages as you wish per worksheet. New 
graph pages are associated with the current worksheet, and are placed in the current 
notebook section. This chapter describes how to work with graph pages, including:

➤ Selecting page settings and options (see page 94)

➤ Selecting and modifying basic page objects (see page 95)

➤ Adding graphs to a page (see page 100)

➤ Zooming your view in and out of the page (see page 101)

➤ Using page templates to speed up page and graph creation (see page 103)

➤ Cutting, copying, and pasting graphs and other objects (see page 108)

➤ Using OLE2 to paste, link, and embed objects (see page 109)

➤ Dragging and dropping graphs (see page 118)

➤ Hiding and deleting objects from pages (see page 119)

➤ Drawing shapes and lines (see page 121)

➤ Modifying drawn shape colors and lines (see page 123)

➤ Changing graph and object size, shape and position (see page 126)

➤ Drawing graphs and other objects in front of or behind other objects (see 
page 128)

➤ Grouping multiple objects as one (see page 129)

➤ Aligning objects with each other and with the page (see page 130)

➤ Entering and formatting text labels (see page 133)

➤ Editing and modifying automatic graph legends (see page 138)

➤ Changing graph page size, color, and margins (see page 143)

➤ Selecting and changing custom colors (see page 146)

About Graph Pages Graph pages are true graphical representations of a printed page that contain graphs, 
text, and other drawn and pasted objects. Objects on graph pages are selectable and 
are modified using the Graph and Object properties dialog boxes, and with the graph 
and drawing toolbars. All objects can also be manipulated graphically using your 
mouse. 

6
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A page can contain an unlimited number of graphs and other objects, and you can 
create an unlimited number of pages for each worksheet. You can also paste graphics, 
OLE (Object Linking and Embedding) objects, and other objects onto a page.

Graph pages are created in several ways. �Notebook Basics� on page 39, describes a 
new graph page as a notebook item; see �Creating New Graph Pages� on page 44. 
This chapter describes how to create a new graph page using templates; see �Using 
Graph Pages as Templates� on page 103.

Setting Page Options 0

Graph page properties are controlled with the Options dialog box Page panel. 

Units:  Sets the unit of measurement on the graph page (inches, millimeters, points). 
These units are displayed in the Graph Properties and Object Properties dialog boxes. 
See �Working with Page Objects� on page 95.

Page Undo:  When this box is checked, the Undo and Redo commands are available 
for changes you make to the graph page. Disabling Undo and Redo can speed graph 
page operations significantly; however, page editing cannot be undone.

Stretch Maintains Aspect Ratio:  When this box is checked, resized objects 
maintain their vertical-to-horizontal ratio when dragging a selected graph with 
corner handles. If this option is not checked, objects can be resized 
disproportionately.

Figure 6�1
The Options Dialog Box

Page Tab
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Graph Object Resize with Graph:  When this box is checked, resizing a graph 
automatically resizes objects associated with the graph, (axis labels, tick labels, the 
graph title, and the automatic legend). If this option is unchecked, objects must be 
sized individually. 

Show Rulers:  When this box is checked, horizontal and vertical rulers are displayed 
at the page window borders on the top and left-hand side of the page. If this option is 
unchecked, the rulers are hidden.

Show Grid:  When this box is checked, grids are displayed on the graph page as 
either dots or lines in units as specified in the Units scroll-down list. If this option is 
unchecked, the grids remain hidden.

Grid Density:  Sets the interval and spacing for both x and y grid directions. You can 
choose a density value from the drop-down list, or enter any legitimate value.

Color:  Sets the color of the grid. You can change the grid from its default color of 
Cyan to another color available from the drop-down list.

Snap-to:  When this box is checked, all drawn, resized, or moved objects �snap� to 
the nearest grid point. When drawing or resizing, the current corner or edge being 
dragged is snapped. When moving an object, the upper left corner is snapped. 

Working with Page Objects 0

SigmaPlot menu commands, dialog boxes, and wizards let you to create and modify 
graphs and other page objects. 

The Graph Wizard guides you in selecting the type and style of graph, and in adding 
plots and axes. 

The Graph Properties dialog box customizes the plots, axes, grids planes, titles and 
legends of your graph. It is used for more advanced modifications to your graph. 

The Object Properties dialog boxes modify many graph attributes.

The Text Properties dialog box modifies font and paragraph text attributes.

The Edit Text dialog box is used to enter and modify text.

Selecting Page
Objects

SigmaPlot dialog boxes and menu commands are automatically accessed when you 
select the text, drawn objects, or individual elements on the graph page. To select a 
graph element, make sure you are in selection mode by clicking the drawing toolbar 
Select Object  button, or choosing the Tools menu Select Object command. A 
check mark next to this command indicates that you are in selection mode.
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Selected objects are surrounded with square handles; selected axes and text are 
surrounded by dotted lines.

Selecting Multiple Objects:  To select multiple objects, hold down the Shift key 
while clicking objects, or drag a window completely around the objects you want to 
select. When multiple objects are selected, only the last selected object has solid black 
handles; the other objects have hollow handles.

Selected page objects, including graphs, text, drawn objects, and pasted objects, can 
all be edited, copied, pasted, moved, sized and scaled, and deleted or hidden.

Figure 6�2
Selecting an Axis

Figure 6�3
Selecting Multiple Objects
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The following table summarizes the results of selecting various objects on the graph 
page.

The Graph Wizard The Graph Wizard guides you through a series of dialog boxes to select the type and 
style of graph, and to select worksheet data for plotting. After the graph is created, 
the wizard can be accessed to add or modify plots and axes. 

�Creating and Modifying Graphs� on page 151, discusses using the Graph Wizard at 
length. Step by step instructions for using the Graph Wizard also appears on page 23.

Select: By: Opens:

Graphs Double-click Graph Properties Dialog Box/Plots 
Panel

Plots Double-click Graph Properties Dialog Box/Plots 
Panel

Axes Double-click Graph Properties Dialog Box/Axes Panel

Tick marks Double-click Graph Properties Dialog Box/Axes Panel

Tick labels Double-click Graph Properties Dialog Box/Axes Panel

Axis titles Double-click Edit Text Dialog Box

Legends Double-click Edit Text Dialog Box

Fills or Lines Right-click Object Properties Dialog Box

Figure 6�4
The Graph Wizard
Displaying a List

of Graph Types
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The Graph Properties
Dialog Box

To access the Graph Properties dialog box, double-click anywhere on the graph, or 
choose Graph Properties from the Graph menu. Plots, Axes, Grids and Planes, and 
Titles and Legends panels offer many customizing features. 

For in-depth information, see �Using the Graph Properties Dialog Box to Modify 
Graphs� on page 163. 

The Object Properties
Dialog Boxes

The Object Properties dialog box makes simple modifications to the graph page. The 
Line and Fill panels change fill patterns, lines of your plots and objects. The Size and 
Position panel changes position, scaling and size for all objects. 

For more information see �Drawing Objects on the Page� on page 121.

Figure 6�5
When You Double-click a

Graph, the Graph Properties
Dialog Box opens to the

Data Panel

Figure 6�6
The Object Properties

Dialog Box



Graph Page Basics

Working with Page Objects 99

The Text
Properties Dialog Box

The Text Properties dialog box is used to change attributes of non-editable text, as 
well as attributes for multiple text labels, and making global text changes.

Selecting text properties with no selected text sets the default attributes for new text 
labels.

For more information on the Text Properties dialog box, see �Formatting Text� on 
page 137.

The Edit Text
Dialog Box

The Edit Text dialog box is used to create new text labels and edit existing labels. The 
Edit Text dialog box is opened using the text tool, or by double-clicking a title or 
label.

You can format individual characters within a text string by selecting the text, and 
using the text toolbar buttons in the dialog box.

Use the Edit Text dialog box to:

➤ Create and edit text labels.

➤ Edit graph and axis titles on the page.

➤ Modify automatic legend labels on the page.

For more information on entering and editing text, see �Working with Text on the 
Page� on page 133. 

Figure 6�7
The Text Properties Dialog

Box Has Both Font and
Paragraph Tabs

Figure 6�8
The Text Properties Dialog

Box Has Both Font and
Paragraph Tabs
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Adding Another Page to a Graph 0

You can add additional graphs to the current graph page by:

➤ Creating a new graph.

➤ Copying a graph to the same page.

➤ Copying and pasting a graph from another page.

Σ In the next section you will learn about applying templates. Never use templates to 
add a graph to a page.

Σ To learn about adding additional plots to the same graph, see �Multiple Plots on a 
Graph: Adding New Plots� on page 170.

Creating a New Graph
for the Current Page

If you want to add a graph to a page by creating a new graph, first add the data for 
the new graph in the worksheet associated with the current graph page. View the 
active graph page, then either select a graph from the graph toolbars, choose the 
Graph menu Create Graph command, or click the Graph Wizard button .

To learn more about graphs, see �Creating and Modifying Graphs� on page 151.

Copying a Graph on
the Same Page

One of the quickest and the easiest ways to add a second graph is to copy the one you 
have already created, then modify it; see �Cutting, Copying and Pasting Graphs and 
other Page Objects� on page 108.

Copying and Pasting
a Graph from One

Page to Another

You may copy a graph from a graph page within the current notebook section, or 
from a different notebook section. 

To copy a graph from one page to another:

1. Make the current page active by selecting it or by choosing the graph page name 
from the Window menu.

2. Select the graph you want to copy.

3. Copy the selected graph by clicking the Copy  button, or by pressing 
Ctrl+C, Ctrl+Insert, or choosing the Edit menu Copy command.

4. Make the destination page the current page either by opening it, or if it is 
already open, select the graph page name from the Window menu. A check 
mark next to the page name indicates that it is the active window.

Σ If the destination page is in a different notebook than the source page, you must 
close the source page, and any other open work in the source notebook.

5. Paste the graph to the page by clicking the Paste  button, or by choosing the 
Edit menu Paste command. The graph appears on the current page, and the 
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graph data appears in the worksheet associated with the current page. Another 
method is dragging and dropping, as described in �Dragging and Dropping 
Graphs� on page 118.

To learn about moving and sizing graphs, see �Using Your Mouse to Change Graph 
and Object Size� on page 126. 

Zooming In and Out 0

Use SigmaPlot View menu commands to control display of the worksheet window. 
You can view the page at several different levels of magnification, magnify the page 
centering on a specified page location, or choose a completely unobstructed view of 
the page. 

Viewing the
Full Page

To view the full page without toolbars, title bars, scroll bars, or the status bar, choose 
the View menu Full Screen command. The page is displayed without any 
obstructions. 

To return to normal view of the page, press any key on the keyboard. The screen 
returns to its normal appearance.

Magnifying
the Page.

To change the magnification of the entire page:

1. Change the view using the toolbar drop-down list. You can select a zoom level, 
or enter a custom zoom anywhere between 10 to 2500.

2. You can also click the toolbar custom zoom button  to zoom in on a specific 
region of the page. The pointer changes to a magnifying glass; select a region on 
the page by dragging the mouse, then release the mouse button. The region is 
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zoomed to the selected area.

3. Another way to zoom in on the page is using keyboard shortcuts while viewing 
the page window. The zoom keyboard shortcuts to view the page:

➤ At 50% actual size, press Ctrl+5

➤ At 100% actual size, press Ctrl+1 

➤ At 200% actual size, press Ctrl+2 

➤ At 400% actual size, press Ctrl+4 

➤ Entire page, press Ctrl+F 

➤ Magnified for a specific region, press Ctrl+U 

Using the Zoom
Dialog Box

You can use the Zoom dialog box to change the zoom level to fixed or custom levels.

1. Choose the Zoom command from the View menu. The Zoom dialog box 
appears.

2. Choose the desired zoom level, to fit the page to the window, or to zoom to a 
full screen view. Use the Percent edit box and slider controls to set a specified 
percentage of magnification

Figure 6�9
Using the Zoom Pointer to

Select a Region on the Page

Figure 6�10
The Zoom Dialog Box
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.

Using Graph Pages as Templates 0

Graph page templates  are used to simplify graph and graph page creation and 
modification. You can use templates to create pages and graphs with preset 
properties. For example, if you need to create a set of slides, you can open pages that 
are already set to attributes for slides. 

How to Apply
Templates

There are three methods of using pages as templates:

Figure 6�11
Example of a Graph

Page Zomed in to 200%

Method Result

Using a template from the New 
Page command

Creates a new page with attributes from the 
template applied

Copying a graph page from one 
notebook section to another

Creates a new page in a section, using the 
data in the existing worksheet for graphs 

Overwriting an existing page Replaces the existing page
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To create a new page with attributes from a template:

1. Either open a new notebook with the New command, or open a previously 
existing notebook.

2. Select to create a Graph Page, then select the type of graph page you want to 
open. 

3. Click OK. A new graph page is created using the selected page as a template 
source.

Copying a Page:  The best method of applying a page template to a worksheet is to 
use an existing graph page as a template. The copied page acts as a template using the 
worksheet in the new section. For information on copying pages and other notebook 
items, see �Copying, Pasting and Removing Notebook Items� on page 49.

Σ If you plan to copy a page, set up your worksheet so that the data is in the appropriate 
columns before applying the template. You can also change the columns to plot after 
applying a template by selecting the plot, opening the Graph Properties dialog box, 
and using the Graph Wizard button. For more information on picking different 
columns to plot, see �Picking Different Data for the Current Plot� on page 168.

Overwriting an Existing Page:  When you apply a template to an existing graph 
page, all features of the existing page are lost . 

Figure 6�12
The New Dialog Box with

Graph Page Selected.
Available Templates Are

Listed the Type List.
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To apply a template to an existing page:

1. Make the graph page the active window, then choose the File menu Templates 
command. 

2. To apply a template from the Templates list,  select the template name, then click 
Apply.

To apply a template from a different notebook template file:

1. Click Browse From the Open dialog box.

2. Select the path and file name of the desired SigmaPlot Notebook or template 
file. 

3. Click Open to use the selected notebook template file.

4. Select the template to use from the Templates list of the Templates dialog box.

5. Click Apply.

Template Pages Template pages are ordinary graph pages. Any graph page can act as a template page 
if it is copied to a section or used from the File menu New command to create a new 
page. All attributes from the page�size, color, margins, and orientation�are 
retained. Any graphs and other objects on the page are also duplicated.

Template Graphs:  Template graphs automatically plot the worksheet column data 
that was selected when the graph was created. 

When applying a page to a worksheet, make sure your data is already arranged as 
required, or repick the data for the graph after applying the template. 

Figure 6�13
The Templates Dialog Box
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You can determine which columns are plotted by either looking at the worksheet 
footers, or by opening Graph Properties dialog box for the template graph, and 
viewing the information shown under the Data panel.

Graphs created by templates can be modified like any other graph. See �Creating and 
Modifying Graphs� on page 151.

Templates/Notebooks Templates can be stored as pages in notebook files that have the extension .JNT. 
Template notebooks can be opened and edited like any other notebook file; the 
different extension is only provided for organizational purposes. 

A sample template notebook, TEMPLATE.JNT, is provided with SigmaPlot, and is 
set as the initial template source notebook. The template pages found in this file are 
described in �SigmaPlot Templates� on page 328. 

TEMPLATE.JNT is used as the source for new pages by default. It contains both 
pages with no graphs and pages with graphs . 

You can modify existing pages or add your own graphs or graph pages to 
TEMPLATE.JNT. Simply open the file, open the page you want to modify, then 
save your changes. You can add files by creating new pages or by copying pages from 
your notebooks to TEMPLATE.JNT; see �Adding New Pages to TEMPLATE.JNT� 
on page 107. 

You can also create your own template notebook containing your own customized 
graph pages. Save template notebooks as SigmaPlot Template (.JNT) files, then 
specify that file to be your Template File; see �Changing the Template File Used for 
New Pages� below.

Figure 6�14
The TEMPLATE.JNT

Notebook
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Changing Page
Created by the New

Page Button

The New Page toolbar button  automatically uses whichever page is titled Normal 
as the source for new pages. If you want to modify the attributes of your new page, 
open and modify the Normal page, or replace it with the desired page.

If there is no page named Normal in your template file, the page is formatted 
according to settings found in the SPW5.INI file. See �Troubleshooting� on 
page 387 for more information on modifying these settings. 

Changing the
Template File Used

for New Pages

The template notebook is automatically used when SigmaPlot opens a graph or 
graph page. The file name is set in the System panel of the Options dialog box. 

To change the source file template:

1. Close any open dialog boxes, then choose the Tools menu Options command.

2. Select the System panel.

3. Type the path and file name of the desired template file in the Template File edit 
box. 

4. Click OK. The notebook becomes the default template source. 

Note that if a valid default template source file is not specified, a default page is 
created instead. This page is a letter-sized, white portrait page by default.

Adding New Pages to
TEMPLATE.JNT

You can add a previously created page to the TEMPLATE.JNT notebook. 

To add a page:

1. Choose the File menu Open command.

2. Specify Template Notebook as the file type.

3. Select TEMPLATE.JNT.

Figure 6�15
The Default Template File

Edit Box
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4. Click Open.

5. Open or view the notebook file containing the page you want to add to 
TEMPLATE.JNT.

6. Highlight the page you want to copy, and press Ctrl+C.

7. Highlight the section of TEMPLATE.JNT where you want to add the new 
page.

8. Press Ctrl+V. The page is added to TEMPLATE.JNT.

9. Save and close TEMPLATE.JNT.

10. Choose File New and select Graph page. The page you copied should appear on 
the list.

Cutting, Copying and Pasting Graphs and other Page Objects 0

Cut and copy selected page objects to the Clipboard using the toolbar, or by using 
Edit menu commands.

Cutting and
Copying Graphs

To cut or copy a graph or other page object select the graph or object to cut or copy 
by clicking it. To cut the item, click the toolbar  button, choose the Edit menu 
Cut command, or press Ctrl+X. 

To copy the item, click the toolbar  button, choose the Edit menu Copy 
command, or press Ctrl+C. A copy of the selected graph or object or is placed in the 
Clipboard. Since copied items remain in the Clipboard until replaced, you can paste 
as many copies as you want without having to cut or copy the object each time.

Pasting Objects Clipboard contents can be pasted to any open page, report, or into any other 
Windows application that supports Windows Metafiles or OLE2 (Object Linking 
and Embedding). 

To paste an object to a page, click where you want the object to appear, then press 
Ctrl+V. You can also press Shift+Insert, click the toolbar Paste  button, or choose 
the Edit menu Paste command.

For more information on OLE, see �SigmaPlot and OLE� on page 110. To learn 
about pasting objects and graphs between applications in general, see �Using OLE2 
to Paste, Link, and Embed Objects� on page 109.

Σ The Clipboard is a Microsoft Windows feature. To learn more about how the 
Clipboard works, refer to your Windows User�s Guide.



Graph Page Basics

Using OLE2 to Paste, Link, and Embed Objects 109

Using OLE2 to Paste, Link, and Embed Objects 0

There are various ways to paste SigmaPlot objects into other applications, and vice 
versa. One method is using OLE2 (Object Linking and Embedding), which is fully 
supported by the SigmaPlot page. OLE provides the ability to move or copy 
information among supporting applications, and to use the applications 
interchangeably to modify the data. 

Methods Of
Placing Objects

Data can also be copied or cut and pasted among applications without using OLE2. 
The method of placing objects depends on each application�s implementation. The 
following table shows how objects can be placed:

Type of Object Destination Application

OLE object Can be placed if application supports OLE.

Windows Metafile Can be placed if application doesn�t support OLE, 
but supports pictures.

Enhanced Metafile Can be placed in Windows 95 applications only.

Bitmap Can be pasted in applications that support bitmaps 
only (for example, Microsoft Paint).
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Figure 6�16
A SigmaPlot Graph with

Pasted Artwork



Graph Page Basics

110 Using OLE2 to Paste, Link, and Embed Objects

Σ SigmaPlot always pastes an OLE object if it is available. The SigmaPlot graph and 
report pages support OLE. Graphs (not graph pages) pasted into SigmaPlot reports 
are always pasted as Windows metafiles.

Commands to Place
Objects

SigmaPlot provides the following commands and functions to place, link, and embed 
objects on a graph or report page:

SigmaPlot and OLE SigmaPlot can place and receive OLE and other types of objects, such as scanned 
images, clip art, or text from a word processor. For example, you can place an 
equation created with the Microsoft Word Equation Editor into a SigmaPlot report, 
and edit it with the Word Equation Editor when it changes.

Command or Function Definition and Use

Paste Command Embeds an OLE object, if there is one in the 
Clipboard. Connects to data in the originating 
application but not directly to a file. If there is no 
OLE object in the Clipboard, a non-editable 
picture or text is placed. 

Paste Special Command Allows you to choose Clipboard file types and to 
also embed objects and links.

Insert New Object 
Command

Directly creates and places an OLE object without 
using the Clipboard. Allows embedding the object 
or linking to a file.

Drag and Drop Moves, or copies any Clipboard object (usually 
OLE).

Figure 6�17
Example of an Microsoft

Excel Equation Embedded
into a SigmaPlot Report
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 Linking or
Embedding Objects

Paste Special, Insert Object, and Ctrl+Drag enable you to either link or embed the 
object in the page or report.

Linking appears to place a copy of the object in the destination application, but 
actually only places a reference to it. Therefore, the object is modified every time the 
original file is modified. 

Linking to a file is only available if you create an object using the Paste Special or 
Insert New Object commands, or if you drag and drop an object with the Ctrl key 
held down.

Linking is useful when an embedded object needs to be updated when the file is 
updated. The disadvantage of linking objects is that a referenced file cannot be 
accessed if the locations of either the SigmaPlot file and/or the source file change.

Embedding places a copy of the object in the destination application, and enables 
you to edit it by activating it�s source application when you double-click it. 
Embedding does not use a reference file ; the �file� is actually embedded completely 
in the SigmaPlot file. For example, if a Microsoft Word embedded object has been 
placed in a SigmaPlot report, and you double-click it, Microsoft Word opens. Word 
temporarily runs �under� SigmaPlot. When you are finished editing the item and 
close Word, SigmaPlot remains open. 

Embedding an object has the advantage of keeping all the associated data in one 
place, but can create large files.

Placing SigmaPlot
Objects into Other

Applications

SigmaPlot graphs and reports can be pasted into other applications, and linked or 
embedded for future editing with SigmaPlot. For example, you can paste a SigmaPlot 
graph into a Microsoft Word document (as an OLE object), and use the SigmaPlot 
Graph Properties dialog box to edit it by double-clicking the graph.

When you link to SigmaPlot and double-click the graph or report, the notebook file 
containing the graph/report opens. See �Placing SigmaPlot Graphs into Other 
Applications� on page 112.

You can change the source of any linked object, with the Change Source command. 
See �Viewing and Modifying Object Links� on page 117 .

View as Icon With OLE, the View as Icon feature allows you to place an icon representing the 
application that created the file in your data. For example, if you have a description 
of a graph written in a Microsoft Word document, you can embed it, and display it 
as an icon that shows on the graph page. If you want the object displayed as an icon, 
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check the Display As Icon option. Click the icon to view and edit the object in its 
source application.

Identifying Objects
on the Graph Page

You can determine the type of object on the graph or report page with the Edit menu 
Object command. Select the object, then choose the Edit menu Object command. 
The Object command changes to reflect the file type of the selected object. For 
example, if a bitmap object is selected, the Object command displays Bitmap Image 
Object. 

Placing SigmaPlot
Graphs into Other

Applications

You can copy or cut SigmaPlot graphs to the Windows Clipboard, then paste the 
graph directly into another document, like a word processing or desktop publishing 
page, without having to do any file exporting or importing.

You can also drag and drop graphs directly from SigmaPlot into any other Windows 
95 program that supports OLE2. See �Dragging and Dropping Graphs� on page 118 
for more information.

To paste a graph to another application:

1. Select the graph to cut or copy.

2. Press Ctrl+X or Ctrl+C. The graph is cut or copied.

3. Open or switch to the other application, and click where you want the graph to 
appear.

4. Paste the graph, typically using the Edit menu Paste command. If the graph isn�t 
an OLE object, try the Paste Special command, and select SigmaPlot Graph or 
SigmaPlot Graph Object. 

Figure 6�18
Displaying a Microsoft

Word Document as an Icon
on a Graph Page
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To create a link between SigmaPlot and the other application, click the Paste 
Link button. To insure you are pasting an OLE object, use the Paste Special 
command. If a Paste Special command doesn�t exist, the application probably 
doesn�t support OLE. 

5. The SigmaPlot graph appears in the other application. You can now in-place 
activate the graph by double-clicking it, or open it in SigmaPlot, typically by 
choosing the Edit menu Object command.

If the application does not support OLE or OLE2, the SigmaPlot graph is 
typically pasted as a metafile graphic.

Figure 6�19
Using the Paste Special

Dialog Box to Paste a
Graph from SigmaPlot

to another program
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SigmaPlot graphs pasted with the Edit menu Paste command take their plotted data 
with them in the form of the plotted graph (the worksheet is not shown). If you want 
to view or edit the data, you must open the graph rather than simply editing it.

Pasting Objects onto
a Graph Page

or Report

You can paste contents, including OLE and OLE2 objects, into both page and report 
documents. 

To paste artwork, text from a word processing application, or other objects onto 
a graph or report page: 

1. Open the application and file containing the desired artwork or text, and cut or 
copy the object. 

2. Switch to SigmaPlot and view the graph or report page.

3. Click the location where you want the object to appear, then press Ctrl+V. 

The graphic is pasted to the page. If the object can be an OLE object, SigmaPlot 
always defaults to the OLE object.

4. To paste the object as a specified file type,  choose the Edit menu Paste Special 

Figure 6�20
Example of a

SigmaPlot Graph
Pasted into

Microsoft Word for
Office 97 as an

OLE Object
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command. The Paste Special dialog box appears.

Σ Note that the options available in the Paste Special dialog box depend on the 
type of file being pasted.

5. If you want the object displayed as an icon, click  the Display As Icon option. 
Click the icon to view and edit the object in its source application. 

You can also specify a different icon to display the pasted object. Click Change 
Icon and select a different icon.

6. Click Paste to paste the object as a specified file type. Select Paste Link to paste 
the object as a linked file that can be updated in another application.

Σ The options in the As list change depending on your selection of either Paste or 
Paste Link, and the explanation in the Result box changes depending on your 
selection in the As list. 

7. Select the type of object to paste from the As box, then click OK. The object 
appears at the selected location.

If the object is an OLE2 object, you can double-click the object to edit it with its 
original application directly within SigmaPlot. OLE1 objects are opened and edited 
by the source application when they are double-clicked.

Placing Objects
Without the

Clipboard

You can select objects from applications that are installed on your system and to place 
them into a SigmaPlot graph or report with the Insert New Object command. The 
object types available on your system depend on the applications installed, and 
appear in the Object Type drop-down list of the Insert New Object dialog box.

To insert an object using the Insert Object command:

1. View the report or graph page, and click where you want the insertion point.

2. Choose the Edit menu Insert New Object command. The Insert Object dialog 
box appears.

Figure 6�21
Using the Paste Special
Dialog Box to Paste an
Object from Microsoft

Word to SigmaPlot
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3. If you want to display the new object as an icon,  check the Display As Icon 
check box. 

You can also specify a different icon to display the inserted object. Click the Icon 
button to open the Change Icon dialog box. Choose a different icon from the 
available options, or click the Browse button to search for alternative icons on 
your system. 

4. To create a new object to place on the report or graph page, select the Create 
New option, then choose the type of object from the Object Type list. Click OK 
to open the application associated with the selected object. Create the desired 
object, then use the application�s appropriate Exit command to close the applica-
tion and return to SigmaPlot. The created object is displayed on the graph or 
report page as an embedded object. 

5. To insert an object from an existing file on the report or graph page, selec t the 
Create from File option, then type the path and file name of the desired file in 
the File edit box, or click the Browse button to open the Browse dialog box, 
from which you can select the appropriate path and file name of the object you 
want to place.

6. Select the Link option to place the object on the page as a linked object. When a 
file is linked, it is modified in your graph or report page when it is modified in 
the original application. If the Link option is not selected, the object is pasted as 
an embedded object.

Figure 6�22
The Insert Object

Dialog Box
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7. Click OK to place the object on the report or page. 

Viewing and
Modifying

Object Links

You can view and modify links with the Links dialog box. The Links dialog box 
displays all links associated with the current graph or report page.

To view and modify links:

1. View the graph or report page by selecting it.

2. Choose the Edit menu Links command. The Links dialog box appears display-
ing the path, file name, type of file, and if it is a manually updated or automati-
cally updated link, of all links on the page.

If you do not have any linked objects on the page, the Links box is empty. 

3. To change the updating to either Automatic or Manual, select the unselected 
option. If Automatic updating is selected, the object changes automatically 
when the source file is changed. If Manual updating is selected, you must use the 

Figure 6�23
The Insert Object Dialog Box
After Selecting Create From

File, with the Display as
Icon Option Checked

Figure 6�24
The Links Dialog Box
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Update Now button to update the linked object with any changes made to the 
source file.

4. To edit a linked object, select the object name in the Links dialog box, then click 
Open Source. The source file opens in the appropriate application where you 
can make changes, then exit the application and return to SigmaPlot. 

If Automatic updating is selected, the object reflects the changes; if Manual 
updating is selected, you must click the Update Now button to apply changes to 
the linked object. 

5. To change the source file for a linked object, click the Change Source button. 
Choose the new path and file name, then click OK. The link appears in the 
Links dialog box with the new path and file name. You may need to click the 
Update Now button to view this change in your document.

6. To end the link between an object and its source file, click  the Break Link but-
ton. The object is no longer treated as a linked object.

7. Click OK to close the Links dialog box.

Dragging and Dropping Graphs 0

OLE2 allows you to drag objects between compatible applications within Windows 
95. Additionally, you can drag and drop graphs from one graph page to another. 

To drag a graph into another application, you must be operating within Windows 95 
or NT 4, and the other application must support OLE2.

1. Make sure the other application is open and visible from the desktop, with the 
location where you want to drop the graph also visible.

2. Select the SigmaPlot graph you want placed in the other program, then drag the 
graph from the SigmaPlot page. If you want to drop a copy of the graph, press 

Figure 6�25
The Change Source

Dialog Box
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the Ctrl key while dragging.

3. Move the mouse to the location you want the SigmaPlot graph to appear.

4. Release the mouse; the graph appears at the drop location. You can now edit the 
graph with SigmaPlot in the future by double-clicking.

Note that you can also drag and drop graphs onto the Windows 95 desktop. 
Dropping a graph onto the desktop creates a scrap file that can be dragged into 
another document at a later date.

Dragging and
Dropping Graphs

Between Pages

You can drag a graph from one graph page to another. If the graph is dragged from a 
different notebook section, it will insert its data into the destination section 
worksheet.

To copy or move a graph from one graph page to another:

1. Open the source and destination pages. The pages must still be within the same 
notebook, but can be in different sections.

2. Select the graph and drag it from the original page to the new page. If you want 
to copy rather than move the graph, press the Ctrl key while dragging. 

3. Release the mouse where you want the graph to appear. The graph is placed on 
the new page. If the page is in a different section, the data plotted by the graph is 

copied to the current worksheet .

Hiding and Deleting Objects from the Page 0

Drawn and pasted page objects can be deleted from the page, and graphs, automatic 
legends, automatically created graph titles, plots, and axes can be deleted and/or 
hidden from view. To learn about removing and hiding axes, see �Hiding, 
Displaying, and Deleting Axes� on page 225.

Hiding and Viewing
Graphs on a Page

To control which graphs are displayed on the page:

1. Make the graph page the active window by selecting it, then right-click the 
graph you want to hide and choose Hide.

2. You can also choose the File menu Page Setup command, then select the Graph 
Layout tab to view the Graph Layout panel of the Page Setup dialog box.

3. The graphs on the current page are listed in the Shown box. To hide a graph, 
select it from the list and click the Hide button. The selected graph is moved to 
the Hidden list. (To select multiple graphs, hold down the Shift or Ctrl key 
while making selections.)
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4. To view a hidden graph, select it from the Hidden list and click the Show 
button.

5. Click OK to apply your selections and close the Page Setup dialog box.

Σ Note that hidden graphs do not print.

To learn about showing and hiding plots, see �Showing, Hiding, and Deleting Plots� 
on page 172. 

Hiding Graph
Titles and Legends

Automatically generated graph and axis titles and legends can be hidden from view 
without being permanently removed from the graph page. 

To hide an automatic legend or automatically created graph title:

1. Open and view the page and select the title or legend, then press Delete. You can 
also right-click and choose Hide, or choose the Edit menu Clear command. The 
title or legend is not deleted, only hidden.

2. You can also hide graph titles, axis title, and legends using the Graph Properties 
dialog box. Open the Graph Properties dialog box by double-clicking the graph. 

You can also open the Graph Properties dialog box directly to the Title and Leg-
end panel by right-clicking the legend and choosing Graph Properties.

Figure 6�26
The Graph Layout Panel of
the Page Setup Dialog Box
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3. To hide the graph title, clear the Show Title check box. 

4. To hide the automatic legend, clear the Show Legend check box.

5. To hide axis titles, select the Axes tab, open the Labels panel, and clear the Show 
Axis Title option(s).

6. Click OK to apply the changes and to close the Graph Properties dialog box.

The titles and automatic legend no longer appear on the graph page. Restore the title 
and legend by returning to the Graph Properties dialog box and checking the Show 
Title and Show Legend options.

Removing Graphs,
Plots, Titles,

Legends, and Other
Page Objects

Anything on the graph page can be removed from the page by selecting the object, 
then pressing the Delete key, or choosing the Edit menu Clear command. 

Deleting removes curves, plots and graphs entirely. You can use undo (Ctrl+Z) to 
retrieve these items. When a graph or plot is removed, worksheet data remains intact. 
Delete also completely removes drawn and pasted objects. Note that delete only 
hides titles and legends, and does not remove them permanently. 

Drawing Objects on the Page 0

Use the Tools menu Draw Box, Draw Ellipse, Draw Line, and Draw Arrow 
commands to draw rectangles, ellipses, lines, and arrows, or use the drawing toolbar. 

Σ Any drawn object or text is not attached to the graph until they are grouped with the 
graph, see �Grouping and Ungrouping Objects� on page 129 for more information.

Figure 6�27
Hiding Graph Tiltes and

Automatic Legends Using
the Graph Properties Dialog

Box
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The Drawing Toolbar Use the drawing toolbar to quickly and easily access Tools menu commands. To learn 
about viewing, hiding, and positioning toolbars, see �Viewing and Hiding Toolbars� 
on page 7.

The drawing toolbar buttons are: 

Drawing Objects To draw an object:

1. Click a drawing tool on the drawing toolbar, or choose a drawing command 
from the Tools menu.

2. The pointer has a crosshair appearance when over the graph page. Place the 
pointer over the page where you want the object to begin, press and hold down 
the left mouse button, then drag the pointer to draw the object. 

3. Release the mouse button to finish drawing the object. 

Figure 6�28
Drawing Objects on a Page

Select Object:  Use the Select Object button to select objects on the graph 
page. 

Draw Line: Click this button to draw a line on the graph page.

Draw Arrow: Click this button to draw an arrow on the graph page. 

Draw Box: Use the Draw Box button to draw a box on the graph page. 

Draw Ellipse: Click this button to draw an ellipse on the graph page. 

Text: Click this button to add text, labels, or manually created legends to the 
graph page.
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Modifying Object Colors and Lines 0

Use Format menu commands or double-click selected objects to modify line type, 
thickness, color, line end appearance (arrow heads, etc.), object fill color, pattern, and 
pattern color. These modifications are made through the Object Properties dialog 
box.

Changing Object Fills You may change fill patterns and colors of drawn rectangles and ellipses, and of graph 
symbols, bars, and boxes using the Object Properties dialog box. 

Σ When multiple objects are selected, fill options apply to all selected objects that can 
be filled, including lines.

To change an object�s fill attributes:

1. Select the object(s) to modify, then open the Fill panel of the Object Properties 
dialog box by choosing the Format menu Fill command, by double-clicking the 
selected object, or by right-clicking and choosing Properties. 

2. To change the fill color, choose a color from the Background Color drop-down 
list. (To learn how to customize the color, see �Using Custom Colors� on 
page 146.) Choosing None creates a transparent (hollow) object.

➤ To change the fill pattern of the selected object, choose a pattern and pattern 
density from the Foreground Pattern drop-down list. 

➤ To change the color of the fill pattern lines and edge lines,  choose a color 
from the Foreground Color drop-down list. Choosing None creates a 
transparent pattern and edge line.

➤ To set pattern and edge line thickness, use the Thickness slider control.

3. Click Apply to apply the changes you�ve made to the selected objects without 

Figure 6�29
The Fill Panel of the

Object Properties Dialog
Box



Graph Page Basics

124 Modifying Object Colors and Lines

closing the dialog box, or click OK to apply your changes and to close the dialog 
box. 

Changing Lines For drawn lines and graph lines, you can change line type, color, and thickness.

1. Select the object(s) to modify, then open the Line panel of the Object Properties 
dialog box by choosing the Format menu Line command, by double-clicking 
the selected object, or by right-clicking and choosing Properties.

2. To change line color, select a color from the Color drop-down list. (To learn 
about using custom colors, see on �Using Custom Colors� on page 146.) 
Choosing None creates a transparent line.

To change line type and thickness, use the Type drop-down list and the Thick-
ness slider. Notice that clicking the slider causes the slider to move incremen-
tally, and that dragging it moves it more precisely. 

Σ To change the range of control of the slider, move the slider to one end of the 
selectable range, select the text in the corresponding edit box, and type a new 
numeric value. 

3. Click Apply to apply the changes you�ve made to the selected objects without 
closing the dialog box, or click OK to apply your changes and to close the dialog 
box.

The Object Properties dialog box is also used to add arrowheads and other line 
endings to lines. For more information, see below.

Changing Line
Ending Attributes

Edit line ending attributes for existing lines and arrows, or set the default line 
endings for drawn arrows. Line ending attributes affect only plain lines and arrows, 
not graph lines. 

Figure 6�30
The Line Panel of the

Object Properties Dialog
Box
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1. Select the line(s) to modify, then choose the Format menu Line command, dou-
ble-click the selected line, or right-click and choose Properties. The Object 
Properties dialog box appears.

2. Click the Line End tab, if necessary, to view the Line End panel of the Object 
Properties dialog box. 

3. Add or edit line ends at both the start and end of a line. The Start of Line 
options add or modify the beginning end of the line (where you start drawing 
the line). The End of Line options add or modify the line end at the end of the 
drawn line (where you stop drawing the line by releasing the mouse button).

4. Use the Style drop-down list to change the type of line end used. 

5. Use the Angle and Length slider controls to change arrowhead length and angle. 
The angle is the angle between the arrowhead line and the main line. The Angle 
option is unavailable if the line Style is dotted or plain.

Σ Note that clicking the slider causes the slider to move incrementally, and that 
dragging it moves it more precisely. To change the range of control of the slider, 
move the slider to one end of the selectable range, select the text in the 
corresponding edit box, and type a new numeric value. 

6. Click Apply to apply the changes you�ve made to the selected objects without 
closing the dialog box, or click OK to apply your changes and to close the dialog 
box.

Changing Multiple
Page Objects

When making changes to multiple objects with different properties, the Object 
Properties dialog box options are blank. Only options that are changed are applied to 
selected objects. To learn how to select multiple objects, see �Selecting Page Objects� 
on page 95.       

Figure 6�31
The Line End Panel of the
Object Properties Dialog

Box
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Moving and Sizing Graphs and Objects 0

You can modify graph or object size and position either by using your mouse on the 
page, or by setting specific position, size, and scaling options in the Size and Position 
panel of the Object Properties dialog box.

Using Your Mouse
to Move Graphs

and Objects

To move a graph or object with your mouse, select the desired graph, and drag it to 
the desired position. A dotted outline of the graph follows the pointer indicating the 
location of the moved graph. When you release the mouse button, the graph moves 
to the new position. Graph titles, axis labels, and automatic legends are automatically 
grouped with a graph and move with it. You can move graphs and objects to other 
page windows. 

Using Your Mouse to
Change Graph and

Object Size

The easiest way to adjust the size and shape of a graph is to resize the graph using the 
mouse. You can also specify proportional scaling of graphs and objects so that the 
height and width ratios are maintained, and choose to rescale graph and axis titles 
and tick marks accordingly.

To adjust graph or object size with the mouse:

1. View the page window and click the graph or desired objects to select them; 
selected page objects are surrounded with small square handles.

2. Place the pointer over a handle, then press and hold down the left mouse button 
to drag the handle to a new location. The shape of the pointer changes when 
you move it over a handle, indicating the direction you can stretch the graph or 
object. 

Drag a side handle to stretch or shrink an object horizontally, drag a top or bot-
tom handle to stretch or shrink an object vertically, or drag a corner handle to 

Figure 6�32
Moving a Graph
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stretch an object two-dimensionally. A dotted outline of the resized graph or 
object follows the pointer position. 

Note that dragging a corner handle preserves the aspect ratio (relative height and 
width) of objects by default. Also, graph text, symbols and tick marks are 
rescaled along with the graph. To disable these features, use the Tools menu 
Options command and change these Page option settings; see �Setting Page 
Options� on page 94.

3. Release the mouse button when finished; the graph or object resizes to the indi-
cated size.

Σ Unlike graphs and drawn objects, text labels cannot be stretched or shrunken 
manually. To resize text, change the font size. To learn how to resize text, see 
�Formatting Text� on page 137.

Setting a Specific
Size and Location

To move a graph or object to a specific location on the page, or to scale the graph or 
object to a specific size, use the Object Properties dialog box Size and Position Panel. 

To set graph size and location with the Object Properties dialog box:

1. Select the graph or object on the page by clicking it.

2. Right-click the selected item and choose Object Properties, then click the Size 
and Position tab, or choose the Format menu Size and Position command. 

3. Use the Position slider controls or type new values in the edit boxes to set the 
distance of the selected object from the top and the left of the page.

4. To change the size of the selected object, either use the Height and Width slider 
controls to set the size to specific measurements, or scale the object to a new size 

Figure 6�33
Resizing a Graph
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by selecting the edit boxes displaying a percent, and typing a new percentage.

5. Click OK to apply the changes and to close the Object Properties dialog box.  

Moving Objects to the Front or Back 0

You can move selected objects so that they appear in front of or behind other page 
objects. 

To move an object to the front or back:

1. Select the object to move by clicking it.

2. To move the selected object to the foreground, choose the Format menu Bring 

to Front command, or click the arranging toolbar  button. The selected 
object is drawn in front of all other objects.

3. To move the selected object to the background, choose the Format menu Send 

to Back command, or click the arranging toolbar  button. The selected 
object is drawn behind all other objects.

Σ If more than one object is selected, the selected objects remain in their relative 
front to back positions. Grouped objects, including titles and legends with 
graphs, are moved as a single object.

Figure 6�34
The Size and Position

 Panel of the Object
Properties Dialog Box
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Grouping and Ungrouping Objects 0

The Group command in the Format menu facilitates moving and modifying selected 
items on the page by treating multiple objects as one object. Objects which have been 
grouped must be ungrouped to be modified individually. You can also use the Group 
and Ungroup commands to group and ungroup page objects. Objects and text must 
be grouped with the graph for them to stay in place, and move with the graph if you 
shift the graph�s location.

To group and ungroup objects:

1. Check the Select Object option of the Tools menu.

2. Select the graph, by clicking it, if you wish to attach the graph to the objects or 
text. Next, select the objects and text to group by holding down the Shift key 
while selecting individual objects. Handles will appear around the graph and 
each selected object. 

3. Choose the Format menu Group command, or click the arranging toolbar  
button. The Group command and button are available only when more than 
one object is selected.

All selected objects are grouped and can be selected, moved, sized, aligned, and 
positioned as a single object. 

4. To ungroup a group, select the group, then choose the Format menu Ungroup 

command, or click the arranging toolbar  button. If you have grouped a 
group, you may need to ungroup the objects as many times as they have been 
grouped. 

Figure 6�35
Moving Page Objects to the

Front and to the Back

The figure on the left shows a
circle in front of a square and

a text label. The page on the
right is the same page

showing the circle moved
behind the square and label.
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Aligning Page Objects 0

You can align labels and objects with each other as well as with graphs and axes using 
the Format menu Align command.

1. Select the labels, graphs or other object(s) you want to align by holding down 
the Shift key while selecting individual objects. (You must select more than one 
object to use the Align command.) 

2. Click the arranging toolbar  button or choose the Format menu Align com-
mand. 

3. Choose the appropriate options to align the selected objects vertically, horizon-
tally, or both. Graphical feedback for your selections appears in the lower right 
corner of the dialog box.

4. From the Relative To options, you can select to align selected objects relative to 
Each Other, or to the Page. 

Figure 6�36
Grouped Objects

Note that grouped objects
have only one set of

handles when selected, and
ungrouped

objects have handles
around each selected

objects.

Figure 6�37
The Align Dialog Box
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You must have multiple objects selected if you want to align selected objects rel-
ative to each other. This option moves aligned objects with respect to the last 
selected object, which remains in a fixed position. Note that the last selected 
object can be distinguished from other selected objects by solid rather than hol-
low selection handles.

Page alignment aligns objects using the page margins rather than the page edge, 
and do not move the objects with respect to each other. You can use page align-
ment to place single objects. Margins for each page are set using the File menu 
Page Setup command.

5. Click OK to close the Align dialog box. Selected objects are aligned as specified. 

Working with Grids and Rulers 0

Use grids and rulers to quickly and easily align graphs and objects on the page. You 
can show or hide grids and rulers from the Tools menu Options dialog box, View 
menu, or you can right-click the graph page to open the shortcut menu. Although 

Figure 6�38
Objects Top Aligned with

Respect to the Square



Graph Page Basics

132 Working with Grids and Rulers

visible on the screen, they do not print with the page. Control the grid and ruler 
attributes with the Tools Menu Options dialog box.

Using Rulers Rulers are optionally displayed at the top and left hand side of all graph pages. They 
display the current units set in the Tools menu Options dialog box. You can choose 
between inches, centimeters, or points.

Using Snap-to You can use the Snap-to option whether the grids are either displayed or hidden. 
Select the Snap-to option in the Tools menu Options dialog box, or right-click the 
graph page to select Snap-to. If the Snap-to option is selected, graphs and objects 
snap to the nearest grid.

Using Crosshairs Crosshairs make checking for object alignment easier. To turn on crosshairs, click the 
Crosshairs button on the upper left hand corner of the graph page window. Crosshair 
lines extend from the pointer tip to the rulers and to the right and bottom of the 
window, and follow the pointer. 

To hide crosshairs, click the Crosshairs button again.

Figure 6�39
Using Crosshairs, Grids,

Rulers, and Snap-to
to Align Objects
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Working with Text on the Page 0

Editing Text Use the Edit Text dialog box to add and edit text labels and legends to the graph 
page, in addition to editing automatically created graph and axis titles. SigmaPlot 
automatically creates legends for every plot. You can modify the existing automatic 
legend, or create a new one using the Edit Text dialog box. The Edit Text Toolbar 
offers a variety of modifications options.

Σ Tick and contour labels can be formatted, but not edited for content. To learn about 
formatting text, see �Formatting Text� on page 137.

 Σ For information on modifying Automatic Legends using the Graph Properties dialog 
box, see �Working with Automatic Legends� on page 138. 

 Creating Text Labels You can add an unlimited number of text labels and legends to any graph page. 
SigmaPlot for Windows supports:

➤ All TrueType®, PostScript®, and other fonts installed on your system

➤ Multiple lines of text aligned left, right, or centered, with adjustable line heights

➤ Mixed fonts and other attributes within a single label

➤ Multiple levels of superscripting and subscripting

Figure 6�40
The Edit Text Dialog Box
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➤ Rotation of text in single degree increments

➤ Color using up to 16.7 million different combinations of red, green,
and blue

To create text labels or legends on a page:

1. Select and view the page window it, then click the  tool in the drawing tool-
bar, or choose the Tools menu Text command. This places you into text mode 
until another mode or tool is selected.

2. Click the page where you want the label to begin. The Edit Text dialog box 
appears. 

3. Select the font, character size, and other starting character attributes.

Figure 6�41
Examples of Text Using

Different Fonts,
Superscripting,

Subscripting,
and Different Rotations
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The following table outlines the functions of each button. These buttons act on 
selected text, or set the format for following text.

Note that the Rotation, Alignment, and Line Spacing options affect the entire 
label, not just the selected text, and that Line Spacing is a minimum spacing 
control, not fixed. If you change the height of characters by changing font sizes 
or by adding superscripts or subscripts, the line height adjusts automatically. 

Σ Default Text Properties let: You set default text label attributes by opening the 
Text Properties dialog box with no labels selected. For more information on 
using the Text Properties dialog box, see �Formatting Text� on page 137.

Σ In addition to using the Greek text  button to add a Greek symbol to text, 
you can also select pre-existing text and choose Symbol as the font type in the 
Text Properties dialog box. 

4. Use the keyboard to type your label. To type additional lines, insert a line break 
by pressing Enter. 

Control Function

Set Font

Set Size

Normal Format

Bold

Italic

Underlined

Superscript One Level

Subscript One Level

Toggle to Greek (Symbol) Font

Left Align

Center Align

Right Align

Line Spacing (Multiline Paragraph Only)

Rotation

Color
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To change the attributes of text already typed in the Edit Text dialog box, high-
light it, then click the appropriate button, such as normal font, bold, italics, 
underline, sub or superscript, or symbol.

To switch back to normal text from greek, superscript, or subscript text, click the 

 normal button. 

5. To add legend symbols to your text, click the Symbols button. The Symbol dia-
log box appears.

6. Click Show Legend to activate manually created legend options. Select the 
Graph to apply the legend to from the Graph drop-down list, then choose to 
place the symbol before text or after text using the Placement drop-down list. 

Use the Style drop-down list to control the appearance of the legend you are cre-
ating, then choose the symbol to use for the legend from the Symbol window. 
Symbols and Style options vary depending on the graphs you have created.

Legend symbols added to text using the Edit Text dialog box do not appear in 
the Edit Text dialog box; they appear with the text on the page. 

Click OK to place the symbol in the text and to close the Symbol dialog box.

7. When you are finished entering text, close the Edit Text dialog box by clicking 
OK. 

Editing Text and
Individual Characters

To edit existing text, you can simply click the text if you are text mode, or if you are 
in select mode, double-clicking the text. You can also right-click a label, and choose 
the Edit command. The Edit Text dialog box appears.

Use your keyboard to type new text, or use the Edit Text dialog box buttons to 
modify selected text. 

Figure 6�42
The Symbol Dialog Box
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   Formatting Text If you want only to change the attributes (the formatting) of selected text, use the 
Text Properties dialog box. The Text Properties dialog box sets properties for all 
selected labels, and applies changes to all characters within selected labels. 

Σ If you have complex font and character changes within a label, take care not to 
overwrite these formats with Text Properties dialog box settings.

Global Text Changes:  The Text Properties is useful for formatting multiple labels as 
well as all text on a graph. Select the graph and choose Text Properties, then select the 
attributes you want applied to all graph labels and titles. 

Default Text Properties:  The Text Properties dialog box is used to set the default 
character and paragraph properties for new labels. Open the Text Properties dialog 
box with nothing selected, and set the options you want applied to new text labels.

To format text using the Text Properties dialog box: 

1. Select the text object you want to modify. If you want to modify several text 
objects, hold down the Shift key while clicking the objects, or drag a select win-
dow around all objects

2. Choose the Format menu Text Properties command to open the Text Properties 
dialog box. 

3. To change the font, style, character size, or color of text, or to underline text, 
choose the Font tab.

Σ If you have multiple text objects with different text properties selected, the 
attributes that are not the same appear blank. Do not select an attribute for these 
options unless you want it to be applied to all selected objects. 

4. To change paragraph attributes, including line spacing, alignment, or rotation, 
choose the Paragraph tab.

5. Click Apply to effect the changes you�ve made in the Text Properties dialog box 
without closing the dialog box. To apply your changes and close the dialog box, 
click OK.

Figure 6�43
The Text Properties Dialog

Box Font Panel

Note that the Size option is
blank, indicating that there
are multiple text objects of

different sizes.
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Working with Automatic Legends 0

Legends are used as a key for your graph. They label what the different graph 
symbols, lines, or fills represent. SigmaPlot can automatically create legends for all 
graphs, always placing them below the graph on the left side. Legend entries are 
labeled using the titles of the columns plotted; if there are no column titles, column 
numbers are used instead.

Legends can be moved and modified as any other page object. They also have a 
special set of controls and features. This section describes how to modify and control 
these automatic legend features. 

Figure 6�44
The Text Properties Dialog

Box Paragraph Panel
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You can also add legend symbols to any text label or title. To learn how to add 
symbols to text, see �Creating Text Labels� on page 133.

Displaying and
Hiding Automatic

Legends

You can control the display of automatic legends either for all subsequently created 
graphs, or for a current graph.

To hide an automatic legend for a graph:

1. View the page and click the legend to select it. Press Delete, or use the right-click 
pop-up menu, and select Hide to hide the legend. 

2. To show the legend again, select the graph on the page and choose the Graph 
menu Graph Properties command, or click the graph properties toolbar button. 

3. Select the Title and Legend tab. Check the Show Legend option to display the 
legend. If you do not want the automatic legend for this plot displayed, leave 
this option unchecked.
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Figure 6�45
Example of

a Graph Displaying an
Automatic Legend

The legend uses the column
titles of the data plotted.
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To hide a legend entry for a specific plot or curve:

1. View the page and double-click the legend entry that you want to hide. The Edit 
Text dialog box opens.

2. Click the Symbols option, then clear the Show Legend check box. Click OK, 
then OK again to close the dialog boxes. The legend is now hidden.

3. To redisplay the legend symbol, use the Graph Properties dialog box to redraw 
the legend. Hide the entire legend, apply the change, then show the legend again 
and click OK.

To view or hide automatic legends for all subsequently created plots:

1. Choose the Tools menu Options command, then select the System tab to dis-
play the System options panel of the Options dialog box. 

2. Check the Automatic Legends option to display the legend, or clear it to hide 
the legend. 

Editing Individual
Legend Entries

You can edit and format the text for individual legend entries using the Edit Text 
dialog box. For more information on using the Edit Text dialog box, see �Editing 
Text� on page 133.

1. View the page and double-click the legend entry that you want to edit. The Edit 
Text dialog box opens. 

2. Edit the text of the legend entry as desired. You can also change the legend sym-
bol properties by clicking the Symbol button.

Figure 6�46
The Title and Legend Panel

of the Graph Properties
Dialog Box
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Increasing the Line Spacing for a Legend:  You can increase the spacing between 
legend symbols by increasing the height of the legend box. Click the box to select it, 
then drag the top or bottom handle to increase the height.

Note that you cannot change the widths of automatic legends�these are determined 
automatically by the width of the text. You can edit individual labels and add 
multiple lines. You can also ungroup a legend and format it manually; see 
�Ungrouping a Legend� on page 143.

Editing
Automatic
 Legends

You can edit a legend as a single object. To edit an individual legend entry, see 
�Editing Individual Legend Entries� on page 140.

Figure 6�47
Editing a Legend Entry

Figure 6�48
Increasing Spacing Between

Legend Entries
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To edit an automatic legend:

1. Open the Graph Properties dialog box by double-clicking the graph, or by click-
ing the Graph Properties toolbar button. 

2. Select the Title and Legend tab to display the Title and Legend panel of the 
Graph Properties dialog box. Use the Legend options on the right side of the 
Graph Properties dialog box to edit automatic legends. 

3. To enclose the legend in a box, check the Framed in Box option. To hide a leg-
end box, clear this check box. You can modify the line thickness and fill of the 
legend box by clicking the Line and Fill button.

4. Move the legend symbols either to the right or to the left of text by choosing a 
position from the Placement drop-down list. If you have no legend symbol 
selected, this operates on all legends. If you select a specific entry from the For 
Symbol list, this option affects only that symbol.

5. Use the Style drop-down list to modify the appearance of the symbols for the 
current legend. This option only affects scatter and line plots. If you have no leg-
end symbol selected, this operates on all symbols. If you select a specific entry 
from the For Symbol list, this option affects only that symbol.

6. Enter the text for a legend symbol by selecting the symbol to annotate from the 
For Symbol drop-down list, then selecting the Use Text edit box and typing text. 
Do this for as many legend symbols as you want.

7. To change the text size or style, click the Font button. The Text Properties dialog 
box appears. For more information on using the Text Properties dialog box, see 
�Formatting Text� on page 137.

8. Click OK to apply the changes and close the Graph Properties dialog box. The 
legend is updated as specified.

Figure 6�49
Using the Title and Legend

Panel of the Graph
Properties Dialog Box to Edit

an Automatic Legend
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Ungrouping a Legend You can ungroup the legend entries and box by selecting the legend, then choosing 
the Format menu Ungroup command, or clicking the arranging toolbar Ungroup 
button  (see �Grouping and Ungrouping Objects� on page 129). You can then 
edit each object like an ordinary graphic object or label.

You can also use your mouse to move any of the legend items to a new location, and 
the Format menu Align command, or arranging toolbar  button to align them 
(see �Aligning Page Objects� on page 130). 

Σ Ungrouping a legend removes automatic legend features.

Changing Graph Page Format 0

You can change graph page margins and size with the Page Setup dialog box. This 
dialog box also controls which graphs on a page are displayed or hidden from view, 
and the color of the page. To learn about displaying or hiding graphs on the page, see 
�Hiding and Deleting Objects from the Page� on page 119. To learn about changing 
page color, see �Changing Page Color� on page 145.

Σ Note that the options in the Page Setup dialog box affect both the view of the page 
on-screen, and the printer settings for the page you are printing. To learn more about 
printing pages, see �Printing Graph Pages� on page 53. 

Changing and
Displaying

 Graph Page Margins

To change page margins, and to view or hide margins on the current page:

1. Choose the File menu Page Setup command. The Page Setup dialog box appears 
from which you can select the Margins tab, if necessary, to display the Margins 
panel of the Page Setup dialog box.

2. Use the Top, Bottom, Left, and Right options to specify the width or height of 
the corresponding page margin. You can type values in the edit boxes using any 

Figure 6�50
The Margins Panel of

the Page Setup Dialog Box
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of the available units of measurement; the value is converted to the current mea-
surement units specified in the Options dialog box. Type in for inches, mm for 
millimeters, and pts for points. 

Σ Margins do not affect printing, they are only a guide. The Align dialog box uses 
margins when aligning the page. 

3. Clear or check the Show Margins option by selecting it. If this option is 
checked, margins are displayed on the page. To hide page margins, make sure 
the Show Margins option is not checked.

4. Click Apply to apply changes without closing the dialog box, or click OK to 
apply your changes and close the dialog box.

Σ To learn about changing the unit of measurement used on the graph page, see 
�Changing Page Units of Measurement� on page 145.

Graph Page Size
 and Orientation

To change the size or orientation of the graph page:

1. Open the Page Setup dialog box by choosing the File menu Page Setup com-
mand, then select the Page Size tab, if necessary, to display the Page Size panel of 
the Page Setup dialog box.

2. From the Paper Size drop-down list choose the appropriate size for the page, or 
use the Width and Height options to specify a unique page size.

Σ Note that SigmaPlot does not support heights or widths greater than
32 inches.

3. To switch between portrait (normal) and landscape (sideways) orientation, select 
either the Portrait or Landscape option.

4. Click Apply to apply changes without closing the dialog box, or click OK to 
accept your changes and close the dialog box.

Figure 6�51
The Page Size Panel of

the Page Setup Dialog Box
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Σ If you change the page size and/or orientation, the page changes on the screen, 
but your graphs remain in the same relative position. You may have to move the 
graphs back into position.

Changing Page Units
of Measurement

Use the Page Options dialog box to change the units of measurement used on the 
page. Page units of measurement are important when specifying margins and object 
size and position. These settings are applied to all pages and graph and object 
properties dialog boxes.

To change the unit of measurement used:

1. Choose the Tool menu Options command, then select the Page tab, if necessary, 
to open the Page panel of the Options dialog box.

2. From the Units box, select the unit of measurement to use on the Page. You can 
choose to use inches, millimeters, or points.

3. Click Apply to apply changes, or OK to apply changes and close the dialog box.

Changing Page Color You can change the color of a page using the Page Setup dialog box. This is especially 
useful when creating output for slides or for overhead projectors.

To change the color of a page:

1. Make the page active by selecting it, or by choosing its name from the Window 
menu. A check mark next to the name of the page indicates that the page is 
active.

2. Open the Page Setup dialog box by choosing Page Setup from the File menu. 
Select the Graph Layout tab to open the Graph Layout panel of the Page Setup 
dialog box.

Figure 6�52
The Page Panel of

the Options Dialog Box



Graph Page Basics

146 Using Custom Colors

3. Choose the color to use for the page from the Color drop-down list. Choose 
(custom) to use or create a custom color. To learn more, see �Using Custom Col-
ors� on page 146.

4. Click OK to apply changes and close the dialog box. The page reappears in the 
new color. 

Σ If you want no background color to show up for pasted graphs (e.g., pasting a graph 
into PowerPoint), set the page color to None.

To learn about changing graph backplane color, see �Modifying Grids and Planes� on 
page 230.

Page Color Default
Setting

You can set the default color for a new page by opening the template file and change 
the attributes for the Normal page using the Page Setup dialog box for that page.

If there is no template file or Normal page present, page settings are derived from the 
settings stored in the SPW5.INI file (see �Troubleshooting� on page 387). 

Templates You can overwrite the current page entirely by applying a template to it. This is 
generally not recommended as a means of reformatting the page unless you intend to 
discard all changes made to the page up to this point. For more information on the 
use of page templates, see �Using Graph Pages as Templates� on page 103.

Using Custom Colors 0

Most color drop-down lists have a (custom) option that opens the Color dialog box, 
enabling you to select a custom color from over 16.7 million possible combinations 
of red, green, and blue (24-bit color). These color controls are found in the Graph 
Properties, Object Properties, Options, and Page Setup dialog boxes. 

Figure 6�53
The Graph Layout Panel of
the Page Setup Dialog Box
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Configuring Your
Display for Color

If you want the truest representation of what your colors will appear like when 
printed, you should always set you display to the highest color level possible. Most 
Windows 95 systems support Hi Color (16-bit) or True Color (24-bit) modes. 
Right-click your desktop, choose Properties, select Settings, then set your Color 
palette to the highest possible level.

To select a custom color:

1. Open the dialog box that has the color option in it, and select the Custom 
option from the Color drop-down list. 

If a custom color has not been selected for this option, the Color dialog box 
appears. 

If a custom color has already been defined for this option, the custom color is 
selected. For directions on how to select a different custom color, 
see �Re-defining Custom Colors� on page 149. 

2. Select a color from the Basic Colors list, or click Define Custom Colors to define 

Figure 6�54
Selecting the Custom Color

option from the Text
Properties Dialog Box.

Figure 6�55
The Color Dialog Box
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your own color. The dialog box expands to show a color palette.

3. Click the large color field, or drag your mouse across it to indicate the approxi-
mate color you want to use. If you know the numeric RGB (red, green, blue) 
values of the desired color, you can select each of the Red, Green, and Blue edit 
boxes and type the correct values. The selected color appears box.

4. Use the slider next to the vertical color bar along the right of the dialog box to 
fine-tune the range of the Hue, Saturation, and Luminosity of the selected color, 
or type new values in the edit boxes.

The current custom color is displayed in the Color|Solid box as a gradational 
color and a solid. To change the color assigned to a Custom Color box select the 
box in the list, then specify the new color from the large color field.

5. To select the gradational color, click Add to Custom Colors. The color appears 
in the first available box of the Custom Colors list. 

6. To select the solid version of the color, double-click the solid in the Color|Solid 
box, then click Add to Custom Colors. The color appears in the first available 
box of the Custom Colors list. 

7. Select the color to use from the Custom Color list, then click OK. The Color 
dialog box closes, and you are returned to the dialog box from which you 
opened the Color dialog box.

The color drop-down list that you are using now has the color you created as an 
option with the word (custom) next to it. If the custom color you created is a 
duplicate of a pre-existing system color, the system color is selected instead of 
the (custom) option in the drop-down list.

Figure 6�56
The Color Dialog Box

Color Field
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Re-defining Custom
Colors

If you have already selected a custom color but want to change it, right-click the 
color control (without opening it). Choose the Custom Color command; the Colors 
dialog box opens again. Select a new custom color to use as described above. 

Figure 6�57
Choosing the Custom Color
command from the shortcut

menu for Text Color
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Creating and Modifying Graphs 

This chapter covers the basics of SigmaPlot graph creation and modification. These 
include:

➤ Setting graph defaults (see page 152)

➤ SigmaPlot graph types (page 153) and styles (page 155)

➤ Creating a new graph (see page 160)

➤ Using the Graph Properties dialog box (see page 163)

➤ Naming a plot (page 166) and graphs (page 166)

➤ Modifying an existing graph�s properties (see page 164)

➤ Hiding and showing graphs and plots on the page (see page 172)

➤ Plotting a restricted data range (see page 174)

➤ Handling missing and out-of-range data (see page 175)

➤ Changing scatter plot symbols (see page 176)

➤ Changing line plot lines (see page 185)

➤ Changing bar, box and pie chart fill colors and hatching (see page 188)

➤ Creating custom color, symbol, and line schemes (see page 191)

➤ Changing bar and box plot widths and spacing (see page 193)

➤ Adding and changing drop lines (see page 196)

➤ Modifying axes and grids (see page 199)

About SigmaPlot
Graphs and Plots

A graph is a representation of selected worksheet columns on a graph page. The 
representation, or graph type ( i.e., 3D scatter plot, vertical bar chart, etc.) is selected 
when a plot or graph is created, but can be changed at any time.

Most plot types can graph many worksheet columns, column pairs, or column 
triplets. Each column, or set of columns, is represented as a separate curve or set of 
bars, depending on the plot type. A graph must have at least one plot, but most 
graphs can hold many more plots, each with a different type and style.

Graphs are created using the Graph Wizard. This chapter provides an overview of the 
graph creation process using the Graph Wizard, including descriptions of the 
different graph types and styles available, and common modifications. 

7
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Setting Graph Defaults 0

Σ
Changing graph defaults affects only new graphs created. To change existing graphs, 
select the graph and change its properties with the Graph Wizard or other dialog 
boxes and commands.

Σ
The graph default options are intentionally limited and simple. If you want to use 
more complex graph defaults, use the page templates feature to create complex graphs 
that can be applied to data as a template, bypassing graph creation entirely. For more 
information on using page templates, see �Using Graph Pages as Templates� on 
page 103.

To change your Graph Defaults:

1. Choose the Tools menu Options command, then select the Graph Defaults tab. 

2. Change the graph defaults options as desired. The available options are: 

Σ
The defaults listed for the setting below are simply the settings for the program as 
shipped, and are provided as a reference if you want to restore the original settings.

Size:  The default height and width of all new graphs in height and width in inches, 
millimeters, or points in the appropriate edit boxes. The default height is 3.5 inches, 
and the width is 5 inches. Note that unit type is controlled in the Page panel.

Position:  The default position of the first new graph created on each graph page. 
Any subsequent graphs you create on the same graph page are positioned below the 
first graph, using default offset distances. The default initial location is 3.5 inches 
from the top and 1.75 inches from the left.

Figure 7�1
The Graph Defaults Panel of

Options



Creating and Modifying Graphs

SigmaPlot Graph Types 153

Font:  Select a font to be used to display all standard text labels, graph and axis titles, 
tick labels, and legends. 

Settings for Symbols:  The default symbol types and colors for single and multiple 
curves on a graph. 

Single curves use Circle as the default symbol shape, and Black as the fill color. 
Multiple curves use Doubles as the default scheme, and Black and White as the color 
scheme. 

Settings for Lines:  Default line styles and color for single and multiple curves on a 
graph. 

Single curves use Solid as the default line style, and multiple curves use Monochrome 
as the default line style. Both line colors default to black.

Settings for Fills:  The default bar color for both simple and grouped bar charts. 

Simple bar charts use light gray, and grouped bar charts use Grayscale as the default 
background color scheme. 

Bar Thickness:  You can specify the thickness of each bar with the Bar Thickness 
option. The default bar thickness is 60%.

SigmaPlot Graph Types 0

There are more than a dozen graph types available in SigmaPlot. Choose a graph type 
using the Graph Wizard or the graph toolbar. To learn about making graphs, see 
�Creating Graphs� on page 160.   

Figure 7�2
The Graph Toolbars Display

the Available Graph Types
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Graph Types 
 0

Scatter Plot Plots data as XY points using symbols.

Line Plot Plots data as XY points connected with lines.

Line and 
Scatter Plot

Plots data as XY points using symbols connected with lines.

Polar Plot Plots data using angles and distance from center.

Ternary Plot Plots data on a coordinate system based on three different components which 
always add up to 100%. 

Vertical Bar 
Chart

Plots data as Y points with vertical bars.

Horizontal
Bar Chart

Plots data as X points with horizontal bars.

Box Plot Plots data as the median and percentiles. 

Pie Chart Plots data as a percent of the total. Format data in a single column.

Contour Plot Plots data as XYZ values in 2D space.  Format data columns as: many Z; single 
XY, many Z; or XYZ triplet. See �Arranging Data for Contour Plots and 3D 
Graphs� on page 279.

3D Scatter 
Plot

Plots data as XYZ data points in 3D space.  Format data columns as: many Z; 
single XY, many Z; or XYZ triplet. See page 279.

3D Line Plot Plots data as XYZ data points connected with lines.  Format data columns as: 
many Z; single XY, many Z; or XYZ triplet. See page 279.

 
3D Mesh Plot Plots data as a 3D surface.  Format data columns as: many Z; single XY, many 

Z; or XYZ triplet. See page 279.

 
3D Bar Chart Plots data as Z values on an XY grid.  Format data columns as: many Z; or sin-

gle XY, many Z. See page 279.
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SigmaPlot Graph Style 0

Many graph types have several styles to choose from. When you select a graph type, 
either from the graph toolbar or from the Graph Wizard, you are prompted to 
choose a graph style.

Scatter Plots

Simple Scatter Plots a single set of XY pairs.  Format data columns as: XY pair; single X; or 
single Y.

Multiple Scat-
ter

Plots multiple sets of XY pairs.  Format data columns as: XY pairs; single Y, 
many X; single X, many Y; many X; or many Y.

Simple Regres-
sion

Plots a single set of XY pairs with a regression line.  Format data columns as: 
XY pairs; single X; or single Y.

Multiple 
Regressions

Plots multiple sets of XY pairs with regression lines.  Format data columns as: 
XY pairs; single Y, many X; single X, many Y; many X; or many Y.

Simple Error 
Bars

Plots a single set of XY pairs with error bars.  If using error bar values from the 
worksheet, format data columns as: XY pair; or single Y. If using column 
means as error bar values, format data columns as: single X, many Y; or many 
Y.

Multiple Error 
Bars

Plots multiple sets of XY pairs with error bars.  Format data columns as: single 
X, many Y; or many Y.

Simple Error 
Bars & 
Regression

Plots a single set of XY pairs with error bars and a regression line.  If using error 
bar values from the worksheet, format data columns as: XY pair; or single Y. If 
using column means as error bar values, format data columns as: single X, 
many Y; or many Y.

Multiple Error 
Bars & 
Regressions

Plots multiple sets of XY pairs with error bars and regression lines.  If using 
error bar values from the worksheet, format data columns as: single X, many 
Y; or many Y. If using column means as error bar values, format data columns 
as: single X, many Y; or many Y.

Horizontal 
Error Bars

Plots XY pairs with horizontal error bars.  If using error bar values from the 
worksheet, format data columns as: XY pairs; or single X. If using column 
means as error bar values, format data columns as: single Y, many X; or many 
X.
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Line Plots

Bidirectional
Error Bars

Plots XY pairs with both horizontal and vertical error bars.  Format data col-
umns as XY pairs.

Vertical Point 
Plot

Plots columns of data as Y values.  Format data columns as: many Y; or single 
X, many Y.

Horizontal 
Point Plot

Plots columns of data as X values.  Format data columns as: many X; or single 
Y, many X.

Vertical Dot 
Plot

Plots a column of data as Y values.  Format data columns as: many Y; or single 
X, many Y.

Horizontal 
Dot Plot

Plots a column of data as X values.  Format data columns as: many X; or single 
Y, many X.

Simple 
Straight Line

Plots a single set of XY pairs connecting the data points with straight lines. 
Format data columns as: XY pair; single X; or single Y.

Multiple 
Straight Lines

Plots multiple sets of XY pairs connecting the data points with straight lines. 
Format data columns as: XY pairs; many X; many Y; single X, many Y; or sin-
gle Y, many X.

Simple Spline 
Curve

Plots a single set of XY pairs connecting the data points with a spline curve.  
Format data columns as: XY pair; single X; or single Y.

Multiple 
Spline Curves

Plots multiple sets of XY pairs connecting the data points with spline curves. 
Format data columns as: XY pairs; many X; many Y; single X, many Y; or sin-
gle Y, many X.

Simple Vertical 
Step Plot

Plots a single set of XY pairs connecting the data points with vertical and hor-
izontal lines, starting with vertical. Format data columns as: XY pair; single X; 
or single Y.

Multiple Verti-
cal Step Plot

Plots multiple sets of XY pairs connecting the data points with vertical and 
horizontal lines, starting with vertical. Format data columns as: XY pairs; 
many X; many Y; single X, many Y; or single Y, many X. 
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Line & Scatter Plots

Simple 
Horizontal 
Step Plot

Plots a single set of XY pairs connecting the data points with vertical and hor-
izontal lines, starting with horizontal. Format data columns as: XY pair; single 
X; or single Y.

Multiple 
Horizontal 
Step Plot

Plots multiple sets of XY pairs connecting the data points with vertical and 
horizontal lines, starting with horizontal.  Format data columns as: XY pairs; 
many X; many Y; single X, many Y; or single Y, 
many X.

Simple 
Straight Line

Plots a single set of XY pairs connecting symbols with straight lines.  Format 
data columns as: XY pair; single X; or single Y.

Multiple 
Straight Lines

Plots multiple sets of XY pairs connecting symbols with straight lines.  Format 
data columns as: XY pairs; many X; many Y; single Y, many X; or single X, 
many Y.

Simple Spline 
Curve

Plots a single set of XY pairs connecting symbols with a spline curve.  Format 
data columns as: XY pair; single X; or single Y. 

Multiple 
Spline Curves

Plots multiple sets of XY pairs connecting symbols with spline curves.  Format 
data columns as: XY pairs; many X; many Y; single Y, many X; or single X, 
many Y.

Simple Error 
Bars

Plots a single set of XY pairs as symbols with error bars connected with 
straight lines. If using error bar values from the worksheet, format data col-
umns as: XY pairs; or single Y. If using column means as error bar values, for-
mat data columns as: single X, many Y; or many Y

Multiple Error 
Bars

Plots multiple sets of XY pairs as symbols with error bars connected with 
straight lines. If using error bar values from the worksheet, format data col-
umns as: XY pairs; or single Y. If using column means as error bar values, for-
mat data columns as: single X, many Y; or many Y.

Simple Vertical 
Step Plot

Plots a single set of XY pairs connecting symbols with vertical and horizontal 
lines, starting with vertical.  Format data columns as: XY pair; single X; or sin-
gle Y. 

Multiple 
Vertical Step 
Plot

Plots a multiple sets of XY pairs connecting symbols with vertical and hori-
zontal lines, starting with vertical.  Format data columns as: XY pairs; many X; 
many Y; single Y, many X; or single X, 
many Y. 
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Polar Plots

Vertical Bar Charts

Simple 
Horizontal 
Step Plot

Plots a single set of XY pairs connecting symbols with vertical and horizontal 
lines, starting with horizontal.  Format data columns as: XY pairs; single X; or 
single Y.

Multiple 
Horizontal 
Step Plot

Plots a multiple sets of XY pairs connecting symbols with vertical and hori-
zontal lines, starting with horizontal. Format data columns as: XY pairs; many 
X; many Y; single Y, many X; or single X, many Y. 

Scatter Plots angle and distance data as symbols.  Format data columns as: Theta,  R 
pairs; XY pairs; many Theta; Many R; single Theta, many R; or R, many 
Theta.

Lines Plots angle and distance data points connected with lines.  Format data col-
umns as: Theta, R pairs; XY pairs; many Theta; Many R; single Theta, many 
R; or R, many Theta.

Scatter & 
Lines

Plots angle and distance data as symbols connected with lines.  Format data 
columns as: Theta,  R pairs; XY pairs; many Theta; Many R; single Theta, 
many R; or R, many Theta.

Simple Bar Plots a single column of data as Y values. Format data columns as: XY pair; or 
single Y. 

Grouped Bar Plots multiple columns of data in a series of bars.  Format data columns as: sin-
gle X, many Y; or many Y.

Simple Error 
Bars

Plots data as Y values with error bars.  If using error bar values from the work-
sheet, format data columns as: XY pairs; or single Y. If using column means as 
error bar values, format data columns as: single X, many Y; or many Y.

Grouped Error 
Bars

Plots data as multiple sets of Y values in a series of bars with error bars.  Format 
data columns as: single X, many Y; or many Y. Error bar values are from the 
worksheet.

Stacked Bars Plots multiple columns of data as a series of stacks in bars.  Format data col-
umns as: single X, many Y; many Y.
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Horizontal Bar Charts Histograms plot a single column of frequency data, and can be generated 
automatically using the Statistics menu Histogram command. For more information, 
see �Creating Histograms� on page 253.

Box Plots

Simple Bar Plots a single column of data as X values. Format data columns as: XY pairs; 
single X. 

Grouped Bar Plots multiple columns of data in a series of bars.  Format data columns as: sin-
gle Y, many X; many X.

Simple Error 
Bars

Plots data as X values with error bars.  If using error bar values from the work-
sheet, format data columns as: XY pair; or single X. If using column means as 
error bar values, format data columns as: single Y, many X; or many X.

Grouped Error 
Bars

Plots data as multiple sets of X values in a series of bars with error bars. Format 
data columns as: single Y, many X; or many X. Error bar values are from the 
worksheet.

Stacked Bars Plots multiple columns of data as a series of stacks in bars.  Format data col-
umns as: single Y, many X; or many X.

Vertical Plots the median, 10th, 25th, 75th, and 90th percentiles as vertical boxes with 
error bars. Format data columns as: many Y; or single X, many Y. Error bar 
values are column means.

Horizontal Plots the median, 10th, 25th, 75th, and 90th percentiles as horizontal boxes 
with error bars. Format data columns as: many X; or single Y, many X. Error 
bar values are column means.
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Creating Graphs 0

Create graphs using either the Graph Wizard or graph toolbar buttons.

Σ
If you want to select the worksheet columns to plot before creating your graph, drag 
the pointer over your data. Note that you do not have to select data before you start a 
graph; you can select the columns to plot during graph creation. 

To create a graph using the graph toolbar, select the desired graph type from the 
graph toolbar. If you selected to create a graph type that has more than one style, a 
graph style toolbar appears from which you can choose a style.

After selecting a graph type and style, the graph wizard is opened to the data format 
panel of the Graph Wizard.

Using the
Graph Wizard to

Create Graphs

To create a graph using the Graph Wizard:

1. Choose the Graph menu Create Graph command or click the Graph Wizard  
button. The Graph Wizard appears.

2. Select the type of graph you want to make from the scroll box from the Graph 
Types box, then click the Next button. See �SigmaPlot Graph Types� on page 
153 to learn about the different types of graphs available. 

Σ If you are making a contour plot, 3D scatter plot, 3D line plot, or 3D mesh 
plot, you are not prompted to choose a graph style; proceed to step 6. If you are 
making a pie chart, proceed to step 7. For any other type of graph, continue to 
step 3.

Figure 7�3
Example of Types and Styles

for a Selected Graph Type

Figure 7�4
The Graph Wizard
Displaying a List

of Graph Types
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3. If there is a style available for the graph type you have chosen, the Graph Wizard 
displays the available graph styles. Select the desired graph style, then click Next. 
See �SigmaPlot Graph Style� on page 155  to learn about the different graph 
styles available for different graph types.

If the graph you are making uses error bars, continue to step 4. If you are mak-
ing a polar plot, proceed to step 5. For any other style of graph, proceed to step 
6. 

4. Selecting Data for Error Bars:  If the graph style you have chosen uses error bars, 
you are prompted to choose an error bar source and a value to use for the error 
bars. If you are making a box plot, or a grouped bar chart with error bars, you 
are not prompted for error bar source data. 

Error Bar Source: Choose either Column Means to use the column means as the 
error bar source, or Worksheet Columns to use values you�ve entered in the 
worksheet. You are prompted during data picking (step 7) to specify the column 
to use as error bar source data.

Error Bar Values: If you choose Column Means as the error bar source, specify 
the calculation method to use for error bars. Choose either Mean, Standard 
Deviation, Standard Error, 95% Confidence, or 99% Confidence.

When you have finished setting error bar options, click Next. Proceed to step 6.

Figure 7�5
The Graph Wizard

Displaying a List of
Available Graph Styles

 for a Scatter Plot

Figure 7�6
Using the Create

Graph Dialog Box to Specify
Error Bar Information
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5. Specifying Angular Axis Units for Polar Plots:  If you are making a polar plot, 
you are prompted to specify the angular axis units.

Choose the unit type to use from the Angular Axis Units list. Note that the 
Range Lower Bound and Range Upper Bound options change depending on 
your selection from the Angular Axis Unit list. 

If you don�t see the axis units you want to use for your polar plot listed in the list, 
you can manually edit the Range Lower Bound and Range Upper Bound values 
by selecting them and typing new values. 

Click Next when finished entering axis range values. Proceed to Step 6.

6. Specifying a Data Format:  Specify how your data is formatted by choosing the 
appropriate data format from the Data Format list. To learn about the available 
data formats for the graph you are making, see the description of the graph style 
in �SigmaPlot Graph Style� on page 155 , or if the graph you are making has 
only one style, see �SigmaPlot Graph Types� on page 153 .

Select the appropriate data format from the Data Format list and click Next. 
Continue to Step 7.

7. Picking Data: Specify which worksheet columns correspond to the data for your 
plot. If you selected columns prior to opening the Graph Wizard, your choices 
automatically appear in the dialog box and you can click Finish to create the 
graph.

Figure 7�7
Using the Graph Wizard

to Specify Angular
 Axis Information

Figure 7�8
Using the Graph Wizard to

Specify the Data Format



Creating and Modifying Graphs

Using the Graph Properties Dialog Box to Modify Graphs 163

If you have not already selected columns, note that a single data type is high-
lighted in the Selected Columns box. The highlighted data type indicates the 
data column to select. Begin selecting data either by clicking the corresponding 
column directly in the worksheet, or selecting the appropriate column from the 
Data Columns list. You are prompted to pick X, Y, or Z data, R and theta data, 
and error bar data, if applicable.

Σ If you make a mistake while selecting data, click the wrong entry in the Graph 
Wizard, then select the correct column from the worksheet. You can also clear a 
column assignment by double-clicking it in the Selected Columns list.

8. Repeat the process for every data column. When you have chosen the data 
appropriate for your style of plot, you can click Back to reselect data columns, or 
if applicable, click Next to select data for additional plots. 

9. Click Finish to create the plot and close the Graph Wizard.

To learn about modifying plots see �SigmaPlot Graph Style� on page 155  and 
�SigmaPlot Graph Types� on page 153. To learn about repicking data for an existing 
plot, see �Picking Different Data for the Current Plot� on page 168.

Using the Graph Properties Dialog Box to Modify Graphs 0

Most graph modifications are made using the Graph Properties dialog box. To 
display the Graph Properties dialog box, select the graph to modify and click the 
Graph Properties  button, or choose the Graph menu Graph Properties 
command. You can also double-click a graph to open the Graph Properties 
dialog box.

Modifying Plots and
Axes

To modify a plot or the axes of a selected graph, view the Plots or Axes panel by 
selecting the Plots or Axes tab, and use the Plot or Axis list to specify which plot or 

Figure 7�9
Using the Create

Graph Dialog Box to Pick
Columns to Plot
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axis in the current graph you are modifying. Use the Settings For lists in the Plots and 
Axes panels to access many different plot and axis modification options.

Modifying Grids and
Planes, Titles and

Legends

To modify grids or planes, view the Grids and Planes panel by selecting the Grids and 
Planes tab of the Graph Properties dialog box. Use the Title and Legend panel to 
hide or show graph titles and automatic legends, to hide or show plots, and to make 
modifications to automatic legends.   

To apply your changes, click Apply, or click OK to apply your changes and close the 
Graph Properties dialog box.

Figure 7�10
Using the Plot list on the
Plots Panel of the Graph

Properties Dialog Box
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Selecting a Graph or a Plot 0

To select a graph or plot, view the page window and make sure you are in selection 
mode by choosing the Tools menu Select Object command, or by clicking the 
drawing toolbar  button. Place the pointer over the desired graph or plot and 
click. 

A selected graph is surrounded by small square handles. A selected plot is indicated 
with handles at each deadpanning, or in the case of meshes, four handles 
surrounding the mesh.

Graphs can also be selected by choosing the Graph menu Select Graph command, 
then choosing the name of the graph.

Using Special
Shortcuts

Double-clicking the graph automatically opens the Graph Properties dialog box. For 
more information on using the Graph Properties dialog box, see �Using the Graph 
Properties Dialog Box to Modify Graphs� on page 163 . 

Your can also right-click a selected graph or plot display to view other available 
commands on the Shortcut menu.    

Figure 7�11
Selecting a Plot from a

Graph on the Page

The data points are covered
with square handles.
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Naming Plots 0

The default plot names are numeric; for example, Plot 1, Plot 2, etc. To assign a new 
name to a plot, open the Graph Properties dialog box by clicking the Graph 
Properties toolbar  button, then view the Plots panel by selecting the Plots tab. 
Select the plot to rename from the Plot list, then click Rename to open the Rename 
Item dialog box.

Enter a new name and click OK to apply the new name and close the Rename Item 
dialog box, then click OK again to close the Graph Properties dialog box. 

Naming Graphs 0

The default graph names are numeric, and include the graph type; for example, 2D 
Graph 1, 2D Graph 2, and so on. 

To assign a new name to a graph: 

1. Double-click the graph title that appears above the graph. The Edit Text dialog 

Figure 7�12
Using The Graph Properties

Dialog Box Plots Panel to
Rename a Plot
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box appears.

2. Type in the new name, making any font changes you desire. Click OK to apply 
the new name.   

You can also open the Graph Properties dialog box by clicking the toolbar  
button, then view the Title and Legend panel by selecting the Title and Legend tab. 
Choose the graph to rename from the Title list, then click Rename to open the Edit 
Text dialog box.    

Figure 7�13
Using the Edit Text Dialog

Box from the Page to
Change the Name of a Graph

Figure 7�14
Using the Edit Text Dialog

Box from Graph Properties
to Change the Name of a

Graph
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Picking Different Data for the Current Plot 0

To change data columns for an existing plot:

1. Select the plot to modify by clicking it. Square handles appear over the data 
points for the clicked curve. Do not click the graph, or you will add a plot to the 
graph.

2. Open the Graph Wizard by clicking the Graph Wizard  toolbar button. The 
Graph Wizard - Modify Plot dialog box appears with the Data Format panel dis-
played. The current data format of the selected plot is highlighted. 

You can also modify a plot by double-clicking a graph to open the Graph Prop-
erties dialog box, selecting the plot you want to modify from the Plot list, then 
clicking the Graph Wizard button.

3. To change the way your data is formatted, use the Data Format list to pick a dif-
ferent data format, then click Next. 

4. If you did not change the data format for your graph,  your previous column 
choices are listed in the Selected Columns edit box. Change column assignments 
by clicking the desired assignment in the Selected Columns edit box, then select-
ing the appropriate column from the worksheet or from the data list. 

You can also clear a column assignment by double-clicking it in the Selected 
Columns list.

5. If you did change the data format for your graph,  a single data type is high-
lighted in the Selected Columns list. The highlighted data type indicates the 
data column to pick. Begin picking data either by clicking the corresponding 
column directly in the worksheet, or choosing the appropriate column from the 
data list. Use this method to pick X, Y, or Z data, R and theta data, and error bar 
data, if applicable.

6. If you make a mistake while picking data , click the mistaken entry in the Graph 
Wizard, then choose the correct column from the worksheet. 

Figure 7�15
The Graph Wizard

Displaying the Data
Format for the Current Plot
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7. Repeat the process for every data column. When you have chosen the data 
appropriate for your style of plot, you can click Back to repick data columns, or 
if applicable, click Next to pick data for additional plots. 

8. Click Finish to close the Graph Wizard and view the changed graph. 

Changing Graph Type and Style 0

Plots can be changed using the Graph Wizard; however, once a plot style and type 
have been defined, the styles and types available for you to apply to the created plot 
are limited. If the plot you�ve selected cannot be changed to the plot type or style that 
you want, use the Graph Wizard to create another plot using the desired style and 
type.

To learn about creating new plots, see �Creating Additional Plots� on page 171.

To change graph type and style:

1. Select the plot to modify by clicking it. Square handles should appear over the 
data points for the clicked curve. Do not click the graph, or you will add a plot 
to the graph.

2. Open the Graph Wizard by clicking the Graph Wizard  toolbar button. The 
Graph Wizard opens displaying the data format of the current plot.

You can also modify a graph type and style by double-clicking a graph to open 
the Graph Properties dialog box, selecting the plot you want to modify from the 
Plot list, then clicking the Graph Wizard button.

3. To change plot style,  view the Graph Styles list in the Graph Wizard by clicking 
Back one time. Choose from list of available styles then click Next.

4. To change the plot type,  view the Graph Types list in the Graph Wizard by 
clicking Back twice. Choose from the list of available graph types, then click 
Next. If you selected a 2D scatter, line, bar chart, box plot, or polar plot, you are 

Figure 7�16
The Graph Wizard

Displaying the Graph
Style for the Current Plot
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prompted to select a style for the new plot (see step 3). If you selected a 3D 
graph or contour plot, you are prompted to select a data format (see step 5).

5. Click next until you can select a data format again for the new plot type or style 
from the Data Format list, then click Next. You are prompted to specify which 
worksheet columns to plot. 

6. If necessary, repick the data columns to plot. Otherwise, simply click Finish to 
complete you plot type or style change.

Σ Note that if you are changing a 3D plot to a mesh plot, you may need to interpolate 
your data. For more information on interpolating 3D data, see �Converting 
Unordered XYZ Triplet Data to Mesh Format� on page 287.

Multiple Plots on a Graph: Adding New Plots 0

Graphs can have multiple plots and plot types. Although most 2D graphs with 
multiple curves do not require more than one plot, multiple plots are required if you 
want to mix plot types on a single graph. If you simply want multiple sets of lines, 
symbols, or bars, just plot multiple columns of data for the same plot; see �Creating 
Multiple Curves� on page 257.

Use multiple plots per graph rather than a single plot with many curves only if 
different plot types or styles are required (i.e., placing a bar chart and a line plot, or a 
3D scatter and mesh plot on a graph), if different data formats are required (such as 
XY and Y only for a scatter plot), or if a curve requires a different axis (scale, range, 
etc.)
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2D graphs with multiple plots can also have multiple axes. For information on 
adding multiple axes to a 2D graph, see �Creating Multiple 2D Axes� on page 273. 

Creating
 Additional Plots

Use the Graph Wizard, the Add Plot command, or Graph Wizard  toolbar button 
to add a plot to a selected graph. 

To add another plot to a graph:

1. Select the graph to modify by clicking it. The graph should be surrounded by 
small square handles. Do not click a curve, or you will modify that curve 
instead.

2. Open the Graph Wizard by clicking the Graph Wizard toolbar  button, or by 
choosing the Graph menu Add Plot command. The Graph Wizard opens, dis-
playing all the graph types. 

Note that the styles and types that can be used for a new plot are limited 
depending on the other plot types and styles in the current graph; for example, 

Figure 7�17
Example of a Graph

with Two Plots

Each plot has
 separate Y axes.
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you cannot add a Polar plot to a 2D Cartesian plot, or vice versa. 

If the graph you�ve selected cannot accommodate the plot type or style that you 
want to add, the plot will be created as a new graph. The graph of the new plot 
can be moved over the original graph so that it appears to be in the same graph. 

3. To specify the type of plot to add to the graph, select a plot type from the Graph 
Types list, then click Next. If you selected a 2D scatter, line, bar chart, box plot, 
or polar plot, you are prompted to select a style for the new plot (see step 4). If 
you selected a 3D graph or contour plot, you are prompted to select a data for-
mat (see step 5).

4. If applicable, select the desired plot style from the Graph Styles list, then click 
Next.

5. Select a data format for the new plot from the Data Format list, then click Next. 
You are prompted to specify which worksheet columns to plot. A single data 
type is highlighted in the Selected Columns list. The highlighted data type indi-
cates the data column to pick. 

6. Begin picking data either by clicking the corresponding column directly in the 
worksheet, or choosing the appropriate column from the data list. Use this 
method to pick X, Y, or Z data, R and theta data, and error bar data, if applica-
ble.

7. If you make a mistake while picking data, click the wrong entry in the Graph 
Wizard, then choose the correct column from the worksheet. You can also clear a 
column assignment by double-clicking it in the Selected Columns list.

8. Repeat the process for every data column. When you have chosen the data 
appropriate for your style of plot, you can click Back to repick data columns, or 
if applicable, click Next to pick data for additional plots. 

9. Click Finish to add the plot to the graph and close the Graph Wizard.

Showing, Hiding, and Deleting Plots 0

Occasionally, you may want to remove a plot from a graph without deleting it. Plots 
can be hidden from view without being deleted using the right-click shortcut menu, 
or the Graph Properties dialog box.

Hiding and
Showing Plots

To show or hide a plot:

1. Right-click the plot, then choose Hide from the shortcut menu. The plot is hid-
den, but not removed.

2. To show the plot again, or to hide it using the Graph Properties menu, double-
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click the graph to open the Graph Properties dialog box, then select the Title 
and Legend tab to view the Title and Legend panel.

3. All plots associated with the current graph are listed in the Show box. A check 
mark in the box next to the name of a plot indicates that the plot is displayed. 
Clear a check box by selecting it to hide a plot from view, or check it to show the 
plot.

4. Click OK to apply your changes and to close the Graph Properties dialog box.   

Figure 7�19
Hiding a Plot

Figure 7�20
The Graph Properties Dialog
Box Title and Legend Panel
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Deleting Plots To erase a plot permanently, select the graph, choose the Graph menu Delete Plot 
command, then choose the plot you want to delete. The Graph menu Delete Plot 
command is only available when there are multiple plots in a graph. 

You can delete the individual curves of a plot by selecting a curve on a graph, then 
pressing the Delete key, choosing the Edit menu Clear command, or right-clicking, 
and choosing Clear.

If you delete a plot by mistake, you can use the Edit menu Undo command to restore 
the deleted plot. However, Undo is only available once � until the next command is 
issued.

Sampling Fewer Data Points 0

If you have a graph with a large number of data points, you can plot only a portion of 
the column(s) and/or sample only a portion of the data from the column. This is 
useful if you are interested only in graphing part of the data, or if you want to 
increase drawing speed while working on the graph.

To plot only a portion of your data:

1. Double-click the graph to open the graph properties dialog box. If your graph 
has more than one plot, and it is not the current plot shown, use the Plot drop 
down list to select the desired plot.

2. To plot only a portion of your data, select the Only Rows option under Portions 
of Columns Plotted and enter the range to plot.

3. To sample the column rows by a specified increment, select the box labeled by 
and type a number. Typing a �2� samples every other row and reduces the num-
ber of rows plotted by 50%, typing a �3� samples every third row, and so on. 
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You can also use the By list to select a number of rows plotted.

4. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply, then use the Plot list to modify a different plot. 

Plotting Missing and Out of Axis Range Data Points 0

You can choose to either plot or ignore bad points. Bad points are either missing 
values, or data that lie outside the axis ranges.

To ignore missing and/or out-of-range points:

1. Double-click the graph to open the graph properties dialog box. If your graph 
has more than one plot, use the Plot list if necessary to select the desired plot.

2. Use the Missing Values option under Ignore to plot data without missing values. 
When this option is checked, missing values are not plotted. To plot missing val-

Figure 7�21
The Data Settings

of the Graph Properties
Dialog Box Plots Panel

Figure 7�22
The Data Settings

of the Graph Properties
Dialog Box Plots Panel
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ues, clear the checked option by selecting it.

3. Use the Out of Range Values option to plot data without out of range values. 
When this option is checked, out of range values are not plotted. To plot out of 
range values, clear the checked option.

4. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply then use the Plot list to modify a different plot. 

Changing Symbol Type and Other Symbol Options 0

You can specify the symbol type used either for the symbols in a single curve, or for 
all the curves in a plot. The default is to use the same symbol for a single curve and 
increment symbols for multiple curves. 

Symbols only can be modified (or added to), plots that normally use symbols, i.e., 
scatter plots, line plots, line/scatter plots, bubble plots, polar plots, box plots, 3D 
scatter plots, 3D trajectory plots, and ternary plots.

Σ Note that bubble plots use circles as the default symbol shape. If you choose a 
different symbol shape, you must change the transform function used to translate 
area to diameter. For more information, see �Bubble Plots� on page 244.

To use different symbol types within a single curve, or for each curve, you can 
increment types automatically; see �Automatically Incrementing Symbols� on 
page 178. You can also choose to use your own order of symbols, or to use text as 
symbols. For more information, see �Using Custom Symbol, Fill, Line, and Color 
Increments� on page 191, and �Using Characters and Text as Symbols� on page 180 . 

Σ Note that symbols cannot be incremented for single curves, unless there is only one 
curve within a plot.
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Changing
Symbol Type,

Size, and Color

To change symbol attributes for a plot:

1. Double-click the plot to open the Graph Properties dialog box. If you double-
clicked the plot, the dialog box should open directly to the symbols panel. If not, 
select the Symbols option from the Settings For list.

You can also select the plot, then click the Properties toolbar  button, or 
choose the Graph menu Graph Properties command, then select the Symbols 
option from the Settings For list. 

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the symbols to modify from the Plot list.

2. To change the symbol type for the selected plot,  use the Type list, or choose to 
increment symbols using the one of the symbol schemes. To create a plot that 
displays lines only, turn off symbols by choosing (none).

To learn more about automatically incrementing symbols, see �Automatically 
Incrementing Symbols� on page 178. To learn about using custom symbol 
schemes, see �Using Custom Symbol, Fill, Line, and Color Increments� on page 
191. For information on using text as symbols, see �Using Characters and Text 
as Symbols� on page 180.

3. To change the size of the symbol, use the Size slider control, or select the Size 
edit box, then typing the new value. By default, all symbols in a plot are the 
same size. Use symbols of different sizes by entering symbol sizes in a worksheet 
column, then selecting the column from the Size list. 

4. To change the fill color of symbols for the selected plot, choose a color from the 
Fill Color options Color list, or choose to increment fill colors using the one of 
the incrementing schemes. Turn off symbol fills by choosing none.

To learn more about automatically incrementing symbol fills, see �Automatically 

Figure 7�24
The Symbols Settings of the
Graph Properties Dialog Box

Plots Panel
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Incrementing Symbols� on page 178.  To learn about using custom increment 
schemes, see �Using Custom Symbol, Fill, Line, and Color Increments� on page 
191. 

Use the (custom) option to open the Color dialog box from which you can cre-
ate or choose a custom color. For more information, see �Using Custom Colors� 
on page 146. 

Σ Hollow Symbols are symbols that use (none) as the fill color are hollow, that is, 
they are composed of the edge lines only. Lines, error bars, and graph 
background colors all show through unfilled symbols, which is useful if you have 
many overlapping data points.

5. To change the edge color of symbols, choose a color from the Edge Color list, or 
choose to increment edge colors using the one of the incrementing schemes. 
Turn off symbol edge color by choosing none.

To learn more about automatically incrementing edge color, see �Automatically 
Incrementing Symbols� on page 178.  To learn about using custom increment 
schemes, see �Using Custom Symbol, Fill, Line, and Color Increments� on page 
191.

Use the (custom) option to open the Color dialog box from which you can cre-
ate or choose a custom color. For more information on using custom colors, see 
�Using Custom Colors� on page 146.

6. To control the color of symbol dots and crosshairs, or of text used as symbols 
(see page 180), use the Edge Color option. If a symbol is filled with black and 
has a black edge, then dots and crosshairs automatically default to white. See 
step 5 for information on incrementing the color of symbol dots and crosshairs. 

7. Change the thickness of the symbol edge using the Thickness slider control, or 
by selecting the Thickness edit box, then typing the new value. 

8. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply then use the Plot list to modify symbols on a different plot.

Automatically
Incrementing

Symbols

When incrementing symbols automatically, symbol types are assigned to curves (or 
points, if the plot has only one curve) in the same order the column pairs forming the 
curves are listed in the Graph Wizard. SigmaPlot increments symbols according to 
the selected scheme.

To learn about using custom increment schemes, see �Using Custom Symbol, Fill, 
Line, and Color Increments� on page 191 .

To use automatically incrementing symbol types:

1. Double-click the plot to open the Graph Properties dialog box. If you double-
clicked the plot, the dialog box should open directly to the symbols panel. If not, 
select the Symbols option from the Settings For list.
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You can also select the plot, then click the Properties toolbar  button, or 
choose the Graph menu Graph Properties command, then select the Symbols 
option from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the symbols to modify from the Plot list.

2. To increment symbol types and fill and edge colors automatically, use the Type, 
Fill Color, and Color lists to choose a symbol scheme. For examples of these 
schemes, see �Schemes� on page 335.

Symbol types and colors appear on the curves of the plot in the same order as the 
symbol types and colors in the right-click popup menus of the incrementing 
option (see Step 3). There are seven different incrementing color schemes to 
choose from for both fill and edge colors.

The incrementing symbol types are:

➤ Doubles: Uses two of each symbol, without crosshairs or dots. This scheme 
is designed for use with the Black and White color scheme.

➤ Monochrome: Uses a circle, a crosshair, inverted triangle, square, and 
triangle.

➤ Dotted Doubles: Uses two of each symbol, one symbol with a dot and one 
symbol without a dot.

➤ Incrementing: Uses one of each symbol, without crosshairs or dots.

Σ Increment schemes do not include (none) as a symbol type.

3. To change the first symbol type or color used in the incrementing sequence, 
select Incrementing from the Symbols Type, Fill Color, and Edge Color lists. By 
right-clicking the Incrementing option selected, choose First Symbol or First 
Color from the Shortcut menu, then choose the symbol type or color with 
which to start the incrementing sequence. The Shortcut menus display the order 
of the symbol types and colors in the selected incrementing scheme.
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4. Use the Symbol Size, Fill Color, and Edge options to modify the symbols, if nec-
essary. For more information on modifying symbols, see �Changing Symbol 
Type, Size, and Color� on page 177. 

5. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply then use the Plot list to modify symbols on a different plot.

Using Characters and
Text as Symbols

You can use numbers, characters, and text as symbols by entering them in a 
worksheet column and specifying the column in the Graph Properties dialog box. 
For more information on using symbols from worksheet columns, see �Using 
Custom Symbol, Fill, Line, and Color Increments� on page 191 .

Figure 7�25
Changing the Starting

Symbol for an
Incrementing Sequence

Figure 7�26
Example of Symbol

Schemes on
Scatter Plots

Both graphs use the Doubles
symbol scheme and the Black
and White color scheme. The

first graph has only one
curve; the second has four.
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To specify characters as symbols:

1. Enter the text you want to use as symbols in a worksheet column, in the order 
you want the curve(s) to use them. To use numeric values as symbols, add a 
space after each value in the worksheet. The numbers appear aligned to the left 
and can be assigned as symbols.      

2. You can use all the non-keyboard characters available for the default font. To 
view and access these characters, you can use the Windows Character Map util-
ity. The Windows User's Guide also lists these special characters, along with the 
keystrokes required to enter them .

3. View the page by clicking the toolbar  button, or by choosing the page name 

from the Window menu. 

4. Double-click the plot on which you want to use text symbols. The Graph Prop-
erties dialog box opens to the Symbols settings. 

You can also select the plot, then click the Properties toolbar  button, or 
choose the Graph menu Graph Properties command, then select the Symbols 
option from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the symbols to modify from the Plot list.

5. From the Type list, choose the name of the column that contains the text or 
numeric values you want to use as symbols. The column options for symbols can 
be found at the bottom of the Symbols Type list.

Σ The column option does not appear in the Type list unless text or symbols are 
entered in a worksheet column.

6. To change the font used for your symbol, right-click the Type option, and 
choose the Symbol Font command. This feature is especially useful if you wish 

Figure 7�27
Example of Worksheet
with Plot Symbol Text

Entered in Column 3
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to use Wingdings, Zapf Dingbats, or other iconic or symbolic fonts as a symbol.

Σ The Fill Color and Edge Thickness options do not apply to text and characters.

7. Apply your changes and close the Graph Properties dialog box by clicking OK.

Using Different
Symbol Sizes

By default, all symbols in a plot are the same size. To use symbols of varying sizes, 
enter symbol size values in a worksheet column, then set symbol size using the Graph 
Properties dialog box. For more information on using symbol attributes from 
worksheet columns, see �Using Custom Symbol, Fill, Line, and Color Increments� 
on page 191.

Figure 7�28
Using Text from a Worksheet

Column as the Symbol
Type for the Plot

Change the font for text
symbols by right-clicking

the Type option and
choosing Symbol Font.
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Symbol sizes are assigned to symbols and curves (or points, if the plot has only one 
curve) in the same order the column pairs forming the curves are listed in Graph 
Wizard. 

To use worksheet values for symbol size:

1. In the worksheet containing data for the current plot, select the first cell of an 
empty column.

2. Type the size values to use in the order you want to use them. Since the symbol 
sizes correspond to symbol diameters or widths, make sure that the symbol sizes 
you enter are of a reasonable size, that is, small fractions of inches or only a few 
millimeters or points.

If desired, you can also include the measurement unit for the value. For example, 
for inches type in, for millimeters type mm, or for points type pt.

Σ If you omit the measurement unit, the numeric values in the symbol size 
column are assigned the measurement unit specified in the Page panel of the 
Options dialog box.

3. View the page by clicking the toolbar  button, or by selecting the page name 

from the Window menu.

4. Double-click the plot on which you want to use text symbols. The Graph 
Properties dialog box opens to the Symbols settings. 

You can also select the plot, then click the Properties toolbar  button, or 
choose the Graph menu Graph Properties command, then select the Symbols 
option from the Settings For list.

Figure 7�30
Example of Worksheet

with Symbol Sizes
 Entered in Column 3
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Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the symbols to modify from the Plot list.

5. Use the Size list to choose the worksheet column containing the symbol size val-
ues you�ve entered.

6. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply then use the Plot list to modify symbols on a different plot. 

 Σ When creating a bubble plot, the Graph Wizard automatically prompts you to 
pick a column to specify bubble size. For more information, see �Bubble Plots� 
on page 244.

Figure 7�31
Using the Symbols Panel to
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Changing Line Type and Other Line Options 0

You can change the line type, shape, thickness, and color for all lines in a plot. 
Because plots can also have multiple curves, you can also increment the line types 
and colors for any plot with multiple curves.

Lines can only be modified in or added to plots that normally use lines, i.e., scatter 
plots, line plots, line/scatter plots, polar plots, 3D scatter plots, 3D trajectory plots, 
and ternary scatter, line, and line/scatter plots.

 Changing Plot
Line Attributes

To change the attributes of lines in a selected plot:

1. Double-click the plot to open the Graph Properties dialog box. If you double-
clicked the plot, the dialog box should open directly to the lines panel. If not, 
select the Lines option from the Settings For list.

You can also select the plot. Click the Graph Properties toolbar  button or 

choose the Graph menu Graph Properties command, then select the Lines 
option from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot from the Plot list. 

2. To change the line type for the lines on the selected plot, choose a line from the 
Type list, or choose to increment lines using one of the line schemes.   Choose 
(none) to turn off lines for the selected plot.

To learn more, see �Automatically Incrementing Symbols� on page 178.    To 
learn about using custom increment schemes, see �Using Custom Symbol, Fill, 
Line, and Color Increments� on page 191.

Σ To create a plot that displays symbols only, turn off lines by choosing (none).

Figure 7�33
The Lines Settings

of the Graph Properties
Dialog Box Plots Panel
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3. Change the thickness of the line using the Thickness slider control, or by select-
ing the Thickness edit box, then typing the new value. 

4. To choose a line shape, use the shape list. Select straight lines, upper or lower 
step lines, vertical or horizontal midpoint step lines, or smoothed lines (spline 
curves). 

5. To change the color of the lines in the selected plot, select a color from the Color 
list, or choose to increment line color using the one of the incrementing 
schemes. Select (none) to create transparent lines.

Use the (custom) option to open the Color dialog box from which you can cre-
ate or choose a custom color. For more information on using custom colors, see 
�Using Custom Colors� on page 146. 

6. To control the layering of plot lines, use the Layering list to place lines in front 
of or behind plot symbols. 

Σ Hollow symbols (with fills of None) will always show plot lines. 

7. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply then use the Plot list to modify lines on a different plot.

Automatically
Incrementing Lines

To learn about using custom line schemes, see �Using Custom Symbol, Fill, Line, 
and Color Increments� on page 191 .

To use automatically incrementing line types:

1. Double-click the plot to open the Graph Properties dialog box. If you double-
clicked the plot, the dialog box should open directly to the lines panel. If not, 
select the Lines option from the Settings For list.

You can also select the plot, click the Graph Properties toolbar  button or 

choose the Graph menu Graph Properties command, then select the Lines 
option from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the lines to modify from the Plot list.

2. To alternate line types and colors automatically, use the Type and Color lists to 
choose a line scheme. 

For examples of these schemes, see �Schemes� on page 335.

Line types and colors appear on the curves of the plot in the same order as the 
line types and colors in the right-click popup menus of the incrementing option 
(see Step 3). There are two line type incrementing schemes: Incrementing and 
Monochrome. There are seven different incrementing color schemes to choose 
from for line colors.
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Σ Note that Windows is limited in its ability to supply the true colors for lines by 
the number of system colors available. For the best representation of true line 
colors, set your display to either HiColor (16-bit) or TrueColor (24-bit).

3. To change the first line type and color used in the incrementing sequence, right-
click the incrementing option selected in the Type and Color lists, choose First 
Line or First Color from the Shortcut menu, then choose the line type or color 
with which to start the incrementing sequence. 

4. Use the Line Thickness, Shape, Line Color, and Layering options to modify the 
lines, if necessary. For more information on modifying lines, see �Changing Plot 
Line Attributes� on page 185.

5. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply then use the Plot list to modify lines on a different plot.   

Figure 7�34
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Changing Patterns and Fill Colors 0

You can modify and increment the background colors, patterns, and pattern colors 
used for plots. 

Fill colors and patterns can only be modified or added to plots that normally use fills, 
i.e., bar charts, box plots, pie charts, 3D bar charts, and ternary plots.

 Changing Plot
Fill Patterns
and Colors

To change the fill attributes in a selected plot:

1. Double-click the plot to open the Graph Properties dialog box. If you double-
clicked the plot, the dialog box should open directly to the Fills panel. If not, 
select the Fills option from the Settings For list.

You can also select the plot, click the Graph Properties toolbar  button or 

choose the Graph menu Graph Properties command, then select the Fills option 
from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the fills to modify from the Plot list. 

2. To change the background fill color, choose a color from the Background Color 
list, or choose to increment fill colors using the one of the incrementing 
schemes. Turn off background fills by choosing (none).

To learn more about automatically incrementing fills, see page 189. To learn 
about using custom increment schemes, see page 191. 

Use the (custom) option to open the Color dialog box which you can use to cre-
ate or choose a custom color. For more information on using custom colors, see 
�Using Custom Colors� on page 146. 

Figure 7�36
The Fills Settings of

the Graph Properties
Dialog Box Plots Panel
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1. To change the foreground fill pattern and edge color, choose a color from the 
Color list, or choose to increment pattern and edge colors using the one of the 
color schemes. Turn off pattern and edge colors by choosing (none). 

2. Design Tip: Modern laser printing and color slides have removed much of the 
need for using hatch marks and other line patterns for bar and pie charts. The 
use of gray shades and colors should be encouraged whenever possible.

3. To learn more about automatically incrementing colors, see page 189. To learn 
about using custom incrementing schemes, see page 191. 

Use the (custom) option to open the Color dialog box from which you can cre-
ate or choose a custom color. For more information on using custom colors, see 
�Using Custom Colors� on page 146. 

4. To change the fill pattern and density for the selected plot, choose a fill pattern 
from the Pattern list, or choose to increment fill patterns using one of the fill 
schemes. Turn off fill patterns by choosing (none).

5. Change the thickness of the pattern lines and edges using the Thickness slider 
control, or by selecting the Thickness edit box, then typing the new value. 

6. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply then use the Plot list to modify fills on a different plot .

Automatically
Incrementing

Chart Fills

When incrementing fills automatically, different fill colors and patterns are assigned 
to each bar, box and pie chart slice in the plot. If you are incrementing fills for a 
grouped bar chart fill colors and patterns are assigned to each group in the plot in the 
same order the column pairs forming the groups are listed in Graph Wizard. 

To learn about using custom increment schemes, see page 191.
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To use automatically incrementing fills:

1. Double-click the plot to open the Graph Properties dialog box. If you double-
clicked the plot, the dialog box should open directly to the fills panel. If not, 
select the Fills option from the Settings For list. 

You can also select the plot, click the Graph Properties toolbar  button or 

choose the Graph menu Graph Properties command, then select the Fills option 
from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the fills to modify from the Plot list. 

2. To alternate fill colors and patterns automatically, use the Color and Pattern lists 
to choose a scheme. Colors and patterns appear in the bars, boxes, or pie chart 
slices of the plot in the same order as the Shortcut menu of the incrementing 
option (see Step 3).

For examples of these schemes, see �Color, Symbol, Line, and Fill Schemes and 
Codes� on page 335.

There are two line type incrementing schemes: Monochrome and Incrementing. 
There are seven different incrementing color schemes to choose from for line 
colors.

3. To change the color or fill pattern used in the incrementing sequence, right-click 
the incrementing option selected in the Pattern and Color lists, choose First Pat-
tern or First Color from the pop-up menu, then choose the pattern or color to 
start the incrementing sequence. 

4. Use the other Fill settings to modify the fills, if necessary. For more information 
on modifying fills, see �Changing Plot Fill Patterns and Colors� on page 188 .

5. Apply your changes and close the Graph Properties dialog box by clicking OK, 

Figure 7�38
Changing the Starting

Fill Color for an
Incrementing Sequence
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or click Apply then use the Plot list to modify fills on a different plot. 

Using Custom Symbol, Fill, Line, and Color Increments 0

When using a series of incremented symbols, fills, lines, or colors you have defined, 
the increment scheme is assigned to curves (or points, if applicable) in the same order 
the columns plotted for the curves are listed in the Graph Wizard. 

To use a series of incremented symbols, fills, lines, or colors you have defined:

1. View the worksheet by clicking the Worksheet toolbar  button, or by choos-

ing the name of the worksheet from the Insert menu. A check mark next to the 
name of the worksheet indicates that it is the current window. 

2. Open the Insert Graphic Cells dialog box by choosing the Edit menu Insert 
Graphic Cells command, then select the Colors, Lines, Symbols, or Patterns tab 
to view the appropriate panel. 

Σ Custom Solid and Hollow Symbols Using symbol types from a column specifies 
the symbol shape only. If you want to change the symbol fills, create another 
color column and use it as the symbol fill colors. Typically, white is used for 
�hollow� symbols, and black for solid symbols.

3. Select the first cell in an empty column, then double-click the color, line, sym-
bol, or fill pattern in the Insert Graphic Cells dialog box you want to place in the 
cell.

Σ Do not mix graphic cell types within the same column; for example, place colors 
in one column, symbols in a different column, fills in yet another column, and 

Figure 7�39
Using the Insert Graphic

Cells Dialog Box to Specify
a Custom Line Sequence
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lines in a fourth column. However, you can use multiple columns to define 
several different increments of the same graphic cell type. For example, you can 
have several columns containing colors of differently ordered increments. 

4. Continue adding to the column, in the order you want the curves to use the col-
ors, lines, symbols, or patterns. The order of the curves is the order in which 
they appear in the Selected Columns list in the Graph Wizard. Click Close when 
finished. 

5. View the page by clicking the toolbar  button, or by choosing the page name 

from the Window menu. A check mark next to this command indicates that the 
page is active.

6. Double-click the plot to open the Graph Properties dialog box. If you double-
clicked the plot, the dialog box should open directly to the desired panel. If not, 
select the option from the Settings For list.

You can also select the plot, choose the Graph menu Graph Properties com-
mand, then select the desired option from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot to modify from the Plot list.

7. From the Symbols Type, Fills Foreground Pattern, or Lines Type lists, or any of 
the Color lists, choose the name of the column which contains the appropriate 
graphic cells. 

8. If you are applying a large number of colors or other property schemes, you may 
wish to turn off your automatic legend, which will attempt to display your first 
25 different data points. Select the Titles and Legends tab, and clear the       

Figure 7�40
Assigning Custom

Symbol Colors in a
Worksheet Column to a

Plot
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Show Legend option.

9. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply then use the Plot list to modify different plots

Σ To set a custom color select  Custom from the Color drop down list. To 
subsequently change it, right-click the Color control and choose Custom Color

Entering Graphic
Cells Manually

You can also add graphic cells to the worksheet by entering the code in the cell. If you 
want to enter symbols using codes, just enter the code for the symbol type in the cell. 
See �Color, Symbol, Line, and Fill Schemes and Codes� on page 335 for a list of all 
these codes. 

Generating Color
Gradients with

a Transform

You can also use the RGBCOLOR transform function to add colors to worksheet 
cells and columns. The RGBCOLOR.XFM sample transform included with 
SigmaPlot demonstrates how to create a color gradient corresponding to a data 
points value. You can also use the RGB transform to transform a third or fourth 
variable to color and add another dimension to your graph. For more information on 
the use of this transform, see the Programming Guide .

Changing Bar and Box Widths and Spacing 0

Control the amount of space between bars and boxes, and between grouped 2D bars 
by adjusting the percent of the maximum possible widths of both the individual bars 
and the bar groups.
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To control bar and box width and spacing for bar charts and box plots:

1. Double-click the plot to modify, then select Widths from the Settings For list, or 

select the plot, then click the  properties toolbar button. 

2. To change the width and spacing between bars for all bar charts and box plots, 
change the Bar Thickness option. The wider the bars or boxes, the less space 
between them. The narrower the bars or boxes, the more space between them. 

3. To change the width and spacing between groups of 2D and 3D bars, change 
the Group Spacing options. This option is only available for grouped and 3D 
bar charts. SigmaPlot sets grouped bar widths and spacing to as wide or as nar-
row and as far or as close as possible given the corresponding spacing or width 
setting. 

4. To set a constant width for all bars or boxes, select Uniform Widths from the 
Widths list. This is the default setting. If the bars are set to Uniform Width, the 
Bar Thickness setting has the same effect on all bars. For more information on 
using the Uniform and Variable width settings, see �Uniform versus Variable Bar 
Widths� on page 196. 

5. To set potentially uneven widths for bars and boxes, select Variable Widths from 

Figure 7�42
The Widths Settings

of the Graph Properties
Plots Panel
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the Widths list. If the constant column values are uneven, the bars will vary in 
width according to the corresponding axis values. For more information on 
using the Uniform and Variable width settings, see �Uniform versus Variable Bar 
Widths� on page 196.

If the bars are set to Variable Width, the Bar Thickness option changes bar 
widths according to the percent of their total widths, so that wide bars are more 
affected than thin bars.

Σ Note that bars created with a single plot are never allowed to overlap. However, 
you can create bars using separate plots and overlap them; see �Spacing Bars 
from Different Plots� on page 250.  

6. To create a needle plot , use the Bar Thickness slider to set bar widths to the nar-
rowest possible widths. 

7. To change bar alignment,  use the Align list. Choose either Center, Left, or 
Right. By default, bar chart bars are centered at the data point. Use the Align 
options to alternately draw the bars right aligned or left aligned with the data 
points.
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8. Click Apply to apply changes without closing the dialog box, or click OK to 
apply changes and close the dialog box.

Uniform versus
Variable Bar Widths

Uniform bar widths set all individual bars to the same width, using the width of the 
narrowest bar. If the values which the bars are plotted along are unevenly 
incremented, the bar widths still remain constant.

Variable bar widths set the widths to be as wide as possible, as determined by the Bar 
Thickness and Group Spacing settings. If the values which the bars are plotted along 
are evenly incremented, this option has no effect. However, if the values which the 
bars are plotted along are unevenly incremented, the bar widths will vary according 
to their corresponding values. 

Adding and Modifying Drop Lines 0

Drop lines can be used to produce dot plots and other types of graphs which connect 
data points to their axis values. You can add drop lines from plotted data points to 
either or both axes in a 2D scatter, line, or line/scatter plot, or to any or all back 
planes in a 3D scatter or trajectory plot. Drop lines are drawn for every curve in a 
plot. 
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Graphs with Drop Lines
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Drop lines always fall toward the minimum of a range; for example, if a Y axis range 
were reversed, a drop line to the X axis would fall to the top of the graph rather than 
the bottom.

Use the Drop Lines settings of the Graph Properties Plots panel to create new drop 
lines, and to modify existing drop line type, thickness, and color.

To add or modify drop lines for a selected plot: 

1. Double-click the plot to modify, then select Drop Lines from the Settings For 

list. You can also select the plot, then click the Graph Properties toolbar  but-

ton or choose the Graph menu Graph Properties command.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the drop lines to modify from the Plot list.

2. Check the plane (for 3D graphs) or axis (for 2D graphs) to add drop lines to by 
selecting the appropriate check box. Drop lines are added to any and all planes 
or axes that are selected. To turn off drop lines for a plane or axis, clear a checked 
box by selecting it.

3. Use each of the Type lists to specify the type of line to use for selected drop lines.

4. To adjust line thickness, use the Thickness slider controls, or select the appropri-
ate Thickness edit box and type the new value. 

5. Use the Color lists to set drop line color. Select any of the listed colors, or choose 
(custom) to select or define a custom color. To learn more, see �Using Custom 
Colors� on page 146. 

6. Apply your changes and close the Graph Properties dialog box by clicking OK, 
or click Apply, then use the Plot list to modify different plots.

Figure 7�48
The Drop Lines Settings
of the Graph Properties
Dialog Box Plots Panel

 for a 2D Scatter Plot
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Drop Lines for a
Single Point

Drop lines are useful for indicating the position of a single point in a curve. However, 
since drop lines are always drawn for every point in a plot, to show a single drop line, 
you need to create a second plot which graphs only the desired data point, then add 
drop lines to the single-point plot. If you don�t want the symbol to show for the 
point, set the symbol type to (none).   
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Modifying Axes and Grids 0

Axes are the scales or rulers along which data is plotted. An axis is always associated 
with at least one plot on a graph, and determines the scaling of the plot.

➤ 2D Cartesian graphs have an X axis (horizontal), and a Y axis (vertical). 

➤ 3D graphs have X and Y axes forming the base of the graph, and a Z axis as the 
vertical axis. 

➤ Polar plots use an angular axis drawing the circumference of the plot, and radial 
axes drawing the radius. For more information, see �Modifying Polar Axes� on 
page 361.

➤ Ternary graphs have X, Y, and Z axes arranged in a triangular shape. For more 
information, see �Modifying Ternary Axes� on page 374.

Each axis consists of pairs of lines that can be moved and modified independently. 
Tick marks are short lines along the axis that represent scale intervals. Tick marks can 
be displayed and modified for each axis. Grid lines are attached to the graph planes, 
and can be drawn at tick intervals for all axes. Most axis modifications are made using 
the Axes panel of the Graph Properties dialog box. This dialog box is described in 
�Working with Page Objects� on page 95.
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Working with Axis Titles and Tick Labels 0

SigmaPlot automatically labels graph axes with titles and tick labels. Axis titles can be 
modified like any other text label. Tick labels are automatically generated; for 
information on how to edit tick labels, see �Changing Tick Labels� on page 217.

Changing an
Axis Title

To edit an axis title, double-click it on the page, and use the Edit Text dialog box to 
make your changes to the title. 

For more information on how to use the Edit Text dialog, see �Working with Text on 
the Page� on page 133.

You can also rename an axis title from within Axis tab of the Graph Properties dialog 
box. Double-click the axis, then click Rename. The Edit Text dialog box opens.

Rotating Axis Titles To rotate an axis title, open the Edit Text dialog box by double-clicking the title, then 
use the Rotation list to select a degree of rotation for the selected label.

Figure 7�50
Editing an Axis Title
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Viewing and
 Hiding Axis Titles

and Tick Labels

The easiest way to hide a graph title or label is by clicking on it and pressing delete. 
You can also use the Graph Properties dialog. To view or hide axis titles:

1. Access the Axes panel of the Graph Properties dialog box by double-clicking the 
desired axis, and select Labels from the Settings For list. 

2. To view or hide the axis title , select or clear the appropriate check box in the 
Show Axis Title options. 

To view or hide Major Tick labels , select Major Ticks from the Apply to list, 
then check or clear the appropriate options from the Major Tick Labels check 
boxes.

To view or hide Minor Tick labels , select Minor Ticks from the Apply to list, 
then check or clear the appropriate options from the Minor Tick Labels check 
boxes.

3. Click OK to apply your changes and to close the dialog, or Apply to apply your 
changes without closing the Graph Properties dialog.

Moving an Axis Title You can move an axis title by dragging it with the mouse, just like any other text 
label, or by choosing the Format menu Size and Position command. To learn more 
about moving labels and other page objects, see �Using Your Mouse to Change 
Graph and Object Size� on page 126.

Σ Note that axis title position, relative to the axis, remains constant when the axis or 
graph is moved.

Figure 7�51
The Labels Settings of
 the Graph Properties

 Dialog Box Axis Panel
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Changing Axis Range 0

Axis range is the values of the starting and ending points of an axis. Choose to set axis 
range automatically or manually.

To change the axis range: 

1. Select the axis to modify, then click the  Axis Scale button on the Properties 
toolbar.

You can also double-click the axis, then select Scaling options from the Settings 
For list. 

2. To automatically set the axis range,  select Automatic. SigmaPlot automatically 
determines the axis range based on the data plotted.

3. To manually set the axis range,  select Manual then type beginning and ending 
axis range values in the From and To edit boxes.

Note that Date/Time axes display the ranges in date and time units.

4. Apply axis range settings by clicking Apply, or apply changes and close the dialog 
box by clicking OK. 

Figure 7�52
The Scaling Options

Available on the Axes
 Panel of the Graph

Properties Dialog Box
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Changing Axis Scales 0

You can control the axis units and increments used in representing your data. Axis 
scale and range are modified with the Scaling settings of the Graph Properties dialog 
box Axes panel. 

You can also use transforms and tick labels and intervals from worksheet columns to 
create your own custom axis scales; see �Using a Custom Axis Scale� on page 208.

Changing Scale Type To change an axis scale:

1. Select the axis to modify, then click the  Axis Scale button on the Properties 
toolbar.

You can also double-click the axis, then select Scaling options from the Settings 
For list.

2. From the Scale Type list, select the desired axis scale type. The default axis scale 
is Linear for all numeric data, Category for text data, and Date/Time for date 
and time data. 

3. Apply the new scale type to the selected axis by highlighting your choice and 
clicking OK. The selected axis appears using the new scale type.

Figure 7�53
Using the Scale Type list

from the Axes Panel of the
Graph Properties Dialog Box
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Axis Scale Types Linear:   A standard base 10 numeric scale. (This scale is recommended for a date 
axis when an exact representation of spacing depicted by dates is not required. 
Otherwise, use the date/time scale.)

Common Log:  A base 10 logarithmic scale.

Natural Log:  A base e logarithmic scale.

Probability:  The inverse of the Gaussian cumulative distribution function. The 
graph of the sigmoidally shaped Gaussian cumulative distribution function on a 
probability scale is a straight line. Probabilities are expressed as percentages with the 
minimum range set at 0.001 and the maximum range value set at 99.999. The 
default range depends on the range of the actual data.

Probit:  A scale similar to the probability scale; the Gaussian cumulative distribution 
function plots as a straight line on a probit scale. The scale is linear, however, with 
major tick marks at each Normal Equivalent Deviation (N.E.D. = X − µ)/σ) plus 
5.0. At the mean (X = µ) the probit = 5.0; at the mean plus one standard deviation 
(X = µ + σ) the probit = 6.0, etc. The default range is from 3 to 7. The range limit 
for a probit axis scale is 1 to 9.

Logit:  Uses the transformation

where a = 100 and . The default range is 7 to 97. Like the probability 
and probit scales, the logit scale �straightens� a sigmoidal curve.
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Category:  A scale which uses numerical values or text from a worksheet column 
used to generate a plot. Each distinct entry in the column is a separate category 
against which the corresponding data values are plotted. This scale is commonly used 
for bar charts or other plots used to graph different categories of data.

Any plot generated by plotting a column containing any text versus a column 
containing data will use a category axis automatically. For more information on 
plotting data versus categories, see �Using a Category Scale� on page 206.

You can select a category scale for numeric data, and each unique value will be treated 
as its own category.

Σ If a column contains more than one instance of the same category, the category 
appears only once, and all corresponding data is plotted within that category.   

Date/Time:  Date and time formatted data are automatically plotted using a Date/
Time axis scale. This scale is specifically designed to handle true calendar date and 
time units, labeling and spacing. 
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➤ For directions on plotting date and time data, see �Using a Date and Time 
Scale� on page 207.

➤ For directions on changing date and time labels, see �Changing Date and Time 
Tick Labels� on page 221.

➤ For directions on changing data and time intervals, see �Tick Intervals for Date/
Time Axes� on page 213.

Although you can plot numeric data as date and time, you should first view these 
numbers as dates and times in the worksheet to make sure they are sensible values.

For more information on displaying numbers as dates or times,  see �Switching 
Between Date and Time and Numeric Display� on page 74. 

Note that if a worksheet cell is a label, it won�t be plotted as a date and time value. In 
this case, you may want to reenter the label as a date and time value; see �Entering 
Dates and Times� on page 59.

Using a Category Scale 0

Use the category scale type by plotting a column containing categories against other 
columns of data values.

To plot a column of text as categories:

1. Enter your category data (text) into a worksheet column, and your correspond-
ing data into other worksheet columns.

If you want to select worksheet data before creating the graph, select the work-
sheet columns to plot before creating your graph by dragging the pointer over 
both the category and data columns. Note that you do not have to select data 
before you start a graph; you can select the columns to plot during graph cre-
ation.

2. Create the graph using the graph toolbar or the Graph Wizard. If you did not 
already select your data from the worksheet, click the worksheet columns to 
assign them to the highlighted option in the Selected Columns list. 
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Plot your category column as the category axis data type, and pick your other 
column(s) as the corresponding data type. Click Finish to create the graph.

Using a Date and Time Scale 0

SigmaPlot graphs date and time data from worksheet columns as specific calendar 
dates and times against which corresponding data values in other columns are 
plotted. 

To create a plot using a date/time scale:

1. Enter dates or times into a column of a worksheet. For example, enter 1/1, 2/1, 
3/1, etc., indicating months and days. For more information on entering date 
and time data, see �Entering Dates and Times� on page 59.

Figure 7�58
Plotting Category Data

Using a Category Scale
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2. Enter corresponding data into a separate worksheet column or columns.

If you want to select worksheet data before creating the graph, select the work-
sheet columns to plot before creating your graph by dragging the pointer over 
both the category and data columns. Note that you do not have to select data 
before you start a graph; you can select the columns to plot during graph cre-
ation.

3. Create the graph using the graph toolbar or the Graph Wizard. If you did not 
already select your data from the worksheet, click the worksheet columns to 
assign them to the highlighted option in the Selected Columns list. 

4. Plot your date and time column as the date/time axis, and pick your other col-
umn(s) as the corresponding axis. Click Finish to create the graph.

Using a Custom Axis Scale 0

Use the transform language to transform your data for a new axis scale, then use tick 
intervals from a column to the place correct ticks marks and labels.

For example, to use an Extreme Value Distribution scale, apply the transform:

f(y)=ln(ln(100/(100-y)))

and for the Arrhenius scale, use the transform:

f(y)=1-273/(T+273)

Figure 7�59
 A Worksheet With
Dates in Column 1
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Apply the transform to both your original interval values and data, then plot the 
transformed data using the transformed intervals as the tick mark values, and the 
original interval data as tick labels. 

For more information on using tick intervals from a column, see page 215. For more 
information on using tick labels from a column, see page 223.

For an example of an Extreme Value Distribution axis scale, refer to the Programming 
Guide

Changing Tick Mark Intervals 0

Use the Graph Properties dialog box to modify tick intervals. For information on 
changing tick marks for polar plots, see �Working with Axis Titles and Tick Labels� 
on page 200. For information on changing tick marks for ternary graphs, see 
�Changing Ternary Axis Tick Marks and Tick Labels� on page 381. 

Σ The Tick Intervals options vary depending upon the axis scale used. There are no tick 
interval options for category axes.

Changing Linear and
Probit Scale Tick

Mark Intervals

To change the tick intervals for linear and probit axis scales:

1. Double-click the tick marks you want to change. The Graph Properties dialog 
box will open to the Axes panel, Ticks options. 

Figure 7�60
A Graph Using the

Arrhenius Scale

You can skip labeling
tick intervals by using
empty cells in the tick

label column.
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You can also double-click an axis, then select the Ticks option from the Settings 
For list.

2. To change tick intervals, use either the Major or Minor Tick Interval options, 
depending on what you have selected in the Apply To list. 

Use the Axis list to modify tick marks on a different axis, or use the Apply To list 
to switch to modifying major or minor tick marks.

3. If you are modifying major ticks, use the Major Ticks Intervals list to choose an 
interval. Choose Automatic to have SigmaPlot automatically determine the 
interval to use, or choose Manual, to manually set major tick mark intervals. 

4. If you select Manual, enter interval values by selecting the Every and From edit 
boxes and typing new values. The value in the Every edit box specifies how often 
major tick marks appear, and the From value specifies where on the axes major 
tick marks begin appearing.

Custom Tick Intervals: The Major Tick Intervals list also enables you to choose 
major tick interval values from the worksheet. For more information on how to 
specify custom tick intervals, see �Custom Tick Intervals� on page 215.

Figure 7�61
The Axes Major Tick

Intervals Options for a
Linear Axis
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5. If you are modifying minor ticks, select an interval from the Minor Tick Inter-
vals list, or enter your own. Custom tick intervals are not available for minor 
ticks.

6. Click Apply to keep the dialog box open, or click OK to apply your changes and 
close the dialog box.

Tick Intervals for
Log Axes

Log axis major tick marks can only be specified automatically or from a column. 
However, you can select specific intervals for log scale minor ticks. 

To change log scale minor tick intervals:

1. If necessary, change the axis scale to a log axis. For directions on changing axis 
scales, see �Changing Axis Scales� on page 203.

2. Double-click the tick marks you want to change. The Graph Properties dialog 
box will open to the Axes panel, Ticks options. 

Figure 7�62
The Axes Minor Tick
Intervals Options for

a Linear Axis

Figure 7�63
The Axes Minor Tick

Intervals Options
for a Log Axis
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3. Use the Apply to list to switch to Minor Ticks. Check all minor tick intervals 
you want to appear, and clear those you want hidden.

Natural Log and
Logit Scales

Natural log and logit scales have only Automatic and from column Tick Intervals 
options. No minor tick marks are available for these axes, so the Apply to option is 
dimmed.

Natural log intervals occur at every factor of e. Logit ticks occur at 7, 10, then every 
ten until 90, then 95 and 97.

Figure 7�64
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Tick Intervals for
Probability Scales

Probability scale axes have no minor ticks, but have three different settings for major 
tick intervals, coarse, medium, and fine, as well as the option to set tick intervals 
from a worksheet column.

To specify the tick mark density, double-click the tick marks, then change the 
Density setting to the desired value.

Tick Intervals for
Date/Time Axes

SigmaPlot automatically sets both major and minor tick intervals that are computed 
from the data range. You can also manually set Major Ticks and Minor Ticks.

To set tick intervals for a date/time axis:

1. Double-click the tick marks you want to change. The Graph Properties dialog 
box will open to the Axes panel, Ticks options.

2. Select a tick interval type. Tick intervals are defined by the unit Type used and 
the Count selected. Dates fall at 12:00 AM of the first day for that period.

The major tick interval options available are limited by the data range. You are 
prevented from selecting time units that would create too many tick marks.

3. If desired, change the Count option to increase the period between tick occur-
rences. For example, you could set ticks to occur every other Type date by 
changing the Count to 2, or every fifth by changing the count to 5.

Figure 7�66
The Axes Tick Intervals

Options for a
Probability Axis
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Counts must be positive integers.

4. To set minor tick intervals, use the Apply to list to switch to Minor Ticks.

5. Select the minor tick Type and Count. Any time unit equal to or smaller than 
the Major interval type can be used as the Minor interval type. 

Σ Take care that you do not select a minor interval that creates hundreds or even 
many thousands of minor tick marks.

Changing Tick Mark Appearance 0

Use the Graph Properties dialog box to modify tick appearance including tick length 
and color. You can also specify tick mark direction, or hide tick marks altogether. 

For information on changing tick marks for polar plots, see �Working with Axis 
Titles and Tick Labels� on page 200.

For information on changing tick marks for ternary graphs, see �Changing Ternary 
Axis Tick Marks and Tick Labels� on page 381. 

Tick Mark Direction To turn tick drawing on and off and to select tick directions for both sides of an axis:

1. Double-click the tick marks you want to change. The Graph Properties dialog 
box will open to the Axes panel, Ticks options.

2. Select an option from the Direction list for either axis. You can:

➤ Select Outward, to point tick marks away from the graph.

➤ Select Inward to point tick marks toward the inside of the graph.

➤ Select Both to point tick marks in both directions.

➤ Select (none) to hide tick marks.

Figure 7�68
The Axes Tick

Direction Options
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Directions for tick marks are independent for either side of the axis.

Hiding Tick Marks To simply hide tick marks, click the tick marks on the page and press Delete, or 
right-click and select Hide from the shortcut menu.

Changing Tick Mark
Line Attributes

To change tick mark length, color, and thickness:

1. Double-click the tick marks you want to change. The Graph Properties dialog 
box will open to the Axes panel, Ticks options. 

2. Use the Apply To list to modify either Major Ticks or Minor Ticks. 

3. To change tick length and thickness, use the Tick Line options Length and 
Thickness slider controls. Move the slider control by dragging it with the mouse 
or by clicking the scale, or set the tick length and thickness to specific values by 
selecting the Length and Thickness edit boxes and typing a value. 

4. To change tick color, use the Tick Line options Color list. Choose from any of 
the listed colors, or select (custom) to use a pre-defined custom color or create 
your own color. Choose (none) to create transparent tick marks.

For more information on using custom colors, see �Using Custom Colors� on 
page 146.

Custom Tick Intervals 0

You can specify major tick locations by entering major tick values into a worksheet 
column, then selecting that column from the Graph Properties dialog. 

Custom tick intervals are not available for minor ticks. 

Figure 7�69
The Ticks Settings

of the Graph Properties
Dialog Box Axes Panel
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To specify tick intervals:

1. Enter the desired tick marks into an empty worksheet column, then double-click 
the tick marks you want to change. The Graph Properties dialog box will open 
to the Axes panel, Ticks options.

2. Select the Major Tick Intervals Ticks option, and select the column number or 
title of the column you want to use for major tick marks. Click Apply or click 
OK to apply the settings and close the dialog.

Σ Note that the numeric values of the intervals are automatically used for tick labels, 
and that you can modify them like any other tick labels.  

Figure 7�70
Selecting a Column for Tick

Label Intervals

Figure 7�71
A Graph with Custom Tick

Intervals from Column 3
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Changing Tick Labels 0

SigmaPlot can display tick labels in a variety of ways: for both major and minor tick 
marks, standard numeric labels, time and series labels, or values and text from a 
worksheet column. You can also add a suffix or prefix to all major or minor tick labels 
on a selected axis, and modify the calculation and precision of numeric labels, view 
different dates and times, select among many different series labels, and change the 
font and other text attributes.

Changing Tick Label
Font and Other
Text Attributes

To change the font size, style, or color of tick labels:

1. Right-click the tick labels, then choose Text Properties. You can also double-
click the axis, select the Tick Label option from the Settings For list, then click 
the Font button. 

2. Make your desired font changes. Change text attributes for tick labels the same 
way you would for any text label.

You can also use the Rotation option in the Paragraph panel, but no other Para-
graph settings are applied to tick labels.

To learn more about using the Text Properties dialog, see �Formatting Text� on 
page 137.

Viewing and Hiding
Tick Labels

You can hide tick labels by selecting the labels and pressing Delete, or right-clicking 
the labels and choosing Hide.

You can also hide and show tick labels from the Graph Properties dialog:

1. Double-click the axis, then select the Labels option from the Settings For list. 

2. If necessary, select either Minor Ticks or Major Ticks from the Apply To list.

Figure 7�72
Selecting a Column for Tick

Label Intervals
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3. Use the Minor Tick Labels or Major Tick Labels options to display or hide tick 
labels for the current axis. A check indicates that the tick labels are shown.

Changing Tick
Label Type

You can change the type of tick label used for all axis types except for category axes. 

For date/time tick labels,  see �Changing Date and Time Tick Labels� on page 221. 

To change all other tick label types for all other axes:

1. Double-click the tick labels you want to change. You can also double-click the 
axis, and select Tick Labels from the Settings For list.

2. If necessary, use the Apply To list to select to either Major Ticks or Minor Ticks.

3. To use a numeric type of tick label,  select Numeric from the Type list, then use 
the Label Notation options 

4. To use a series type of tick label, select Series from the Type list.

Note that if you want to plot data versus true calendar dates, you should have 
entered date and time data in the worksheet, and use a date/time axis scale.

Formatting Numeric
Tick Labels

To format numeric tick labels:

1. Double-click the tick labels of the axis you want to change. The settings for Tick 
Labels appear in the Graph Properties dialog box. 

2. Use the Apply To list to select to modify either Major Ticks or Minor Ticks.

Figure 7�73
Changing the Tick

Label Type
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3. Use list to specify which type of numeric display to use. Choose from: 

➤ Scientific Notation

➤ Scientific Notation, for large numbers

➤ Engineering Notation

➤ Engineering Notation, for large numbers

Scientific Notation and Engineering Notation use scientific notation or engi-
neering notation to display numbers. Scientific Notation or Engineering Nota-
tion for large numbers use scientific or engineering notation only when numbers 
exceed a specified range. Use the Below and Above lists to specify the range 
beyond which scientific notation or engineering notation is used.

For log axes, you can select to display number, only the Exponent, or both the 
Base and Exponent.    

For linear axes, you can Always Use Scientific Notation, or use it only When 
Needed for large numbers. To specify when scientific notation is needed, enter 
the Lower and Upper ranges in the boxes, expressed in log units.

Figure 7�74
Selecting Numeric Tick

Label Notation
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4. To divide numeric tick label values by a specific number, enter a divisor in the 
Factor Out box. A value of 2 divides label values in half, a factor of 0.5 doubles 
the tick label values, etc. 

5. Use the Precision options to specify the number of places used to display 
numeric tick labels. Select Automatic to let SigmaPlot automatically determine 
precision, or select Manual, then select the number of decimal places to use from 
the Places list. 

Formatting Series
Tick Labels

To format series tick labels:

1. Double-click the tick labels of the axis you want to change. The settings for Tick 
Labels appear in the Graph Properties dialog. 

2. Use the Apply To list to select to modify either Major Ticks or Minor Ticks.

3. Select the Label format Series list to specify the kind of series to use.

4. Use the Length list to set the number of characters to use for the tick label.

5. Use the Start At list to specify which series item to begin labeling tick marks 
with, then use the Step By list to set the frequency, or increment, of series items 
to use. 

For example, if you are using a Days of the Week series, you might choose to 
start with Monday, and to step labeling by 2 days at a time. Tick labels appear as 
Monday, Wednesday, Friday, Sunday, Tuesday , etc.

6. Use the After and Repeat From lists to re-start tick labeling from a specified 
point. 

For example, if you were using a Days of the Week series, and were stepping by 2 
days at a time, you might use the After and Repeat From lists to specify that after 
Friday, repeat the series from Monday. Tick labels appear as Monday, Wednes-
day, Friday, Monday, Wednesday, Friday,  etc. 

Figure 7�76
Selecting Series Tick

Label Format
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7. Click Apply to keep the dialog box open, or click OK to apply your changes and 
to close the dialog box.

Adding a Prefix or
Suffix to Tick Labels

To add a suffix or prefix to the major or minor tick labels on a selected axis:

1. Double-click the axis you want to change, and select the Labels option from the 
Settings For list. 

2. Use the Apply To list to select to modify either Major Ticks or Minor Ticks.

3. To add a prefix or suffix to the major or minor tick labels, type the prefix or suf-
fix into the appropriate Add to Tick Labels box. All labels on the selected axis 
appear with the specified suffix or prefix.

You can use any keyboard or extended characters. Use the Windows Character 
map accessory program, or Alt+Numeric keypad combinations to enter 
extended characters like degrees symbols (Alt+0176). 

4. Click Apply to keep the dialog box open, or OK to apply the changes and close 
the dialog box. 

Changing Date and
Time Tick Labels

To change the format of date/time tick labels,  use the Graph Properties panel. 
Entering values in these boxes is similar to entering date/time values in the 
worksheet.

To change date and time tick label format:

1. Double-click the tick labels of the axis you want to change. The settings for Tick 
Labels appear in the Graph Properties dialog box. 

Figure 7�77
Entering a Suffix for Major

Tick Labels
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2. Use the Apply To list to modify either Major Ticks or Minor Ticks.

3. To change the display Date format, select a format from the list, or use the fol-
lowing table to enter a new label, using any additional characters as delimiters 
(e.g., slashes, commas, spaces, etc.). As you enter a different format, the Sample 
window shows an example of the label. 

4. To change the display Time format, select a format from the list, or use the fol-
lowing table to enter a new label, using any additional characters as delimiters 
(e.g., colons, spaces, etc.). As you enter a different format, the Sample window 
shows an example of the label.

Figure 7�78
Changing Date/Time

Tick Labels

Typing: Displays:

M/d/yy No leading 0 for single digit month, day or year

MM/dd/yy Leading 0 for single digit month, day or year

MMMM Complete month

dddd Complete day

yyy or yyyy Complete year

MMM Three-letter month

ddd Three-letter day

gg Era (AD or BC)
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5. Click Apply to keep the dialog box open, or OK to apply the changes and close 
the dialog box.

   Using Custom
Tick Labels

You can enter text and numbers into worksheet columns and use them as major tick 
labels.

1. Enter the labels you want to use in a worksheet column, in the order you want 
them to appear. If you want to have minor labels, enter them in the right adja-
cent column. 

You can skip specific labels by leaving an empty cell for that tick mark when 
entering the labels into the worksheet column.    

2. Open the Graph Properties dialog box to the Axes panel Tick Label settings by 
double-clicking the axis tick labels you want to modify.   

Typing: Displays:

hh or h 12 hour clock

HH or H Military hours

mm or m Minutes

ss or s Seconds

uu or u Milliseconds

H: h: m: s: or u No leading zeroes for single digits

HH: hh: mm: ss: uu Leading zero for single digits

tt Double letter AM or PM

t Single letter AM or PM 
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3. Select the column used for major labels from the Type list. Labels for minor con-
tours are automatically taken from the column to the right of the major tick 
labels.

4. If you want to change the font used for the tick labels, click the Font button. 
You can use the Symbols font for Greek characters, and the Wingdings and 
other symbol fonts for iconic labels.

5. Click OK to apply changes and close the dialog box, or click Apply to apply 
changes without closing the dialog box.

Figure 7�79
Selecting a Columns as the

Source for the Tick Labels

Figure 7�80
Tick Labels from a Column

using the Symbol Font
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Hiding, Displaying, and Deleting Axes 0

Hiding and
Displaying Axes

Control the display of axes using the Lines settings of the Graph Properties dialog 
box Axes panel. 

The easiest way to hide an axis is to select it, then press Delete. The axis is hidden 
rather than deleted. You can also hide an axis by right-clicking the axis, then 
choosing Hide.

To view, hide or modify the display of an axis:

1. Double-click the axis (you can double-click hidden axes as well). The Graph 
Properties dialog box opens to the Axes Lines options. 

2. Use the Show/Place Axes check boxes to control the display of axes in your 
graph. Check an axis to display that axis, or clear an axis to hide it. Hidden axes 
hide all ticks and labels associated with that axis.

3. Click Apply to apply your changes without closing the dialog box, or OK to 
apply your changes and close the dialog box.

Σ 3D axes can be hidden, but if frame lines are active, or if the graph has grid lines, a 
line will remain present. To learn about working with frame lines, see �Frame Lines 
for a 3D Graph� on page 296. For more information on grid lines, see �Displaying 
Grid Lines and Backplanes� on page 230 . 

Figure 7�81
The Lines Settings of
the Graph Properties

Dialog Box Axes Panel
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Moving Axes 0

2D axes can be moved with your mouse, or to a precise location with the Graph 
properties dialog box. 3D axes cannot be moved, but they can be hidden from view. 
For information on hiding 3D axes, see �Hiding, Displaying, and Deleting Axes� on 
page 225. 

 Moving 2D Axes
Manually

To move a 2D axis with the mouse, select the axis and drag it to a new position. Y 
axes move only horizontally and X axes only vertically. Moving ternary graph axes 
changes the axis range and scale, along with the size and shape of the graph. Axis 
titles move with the axis.

Moving Axes to a
Precise Location

Use the Lines settings in the Graph Properties dialog box Axes panel to position axes 
a precise distance from the graph origin. (For ternary plots see �Modifying Ternary 
Axes� on page 374.)

Figure 7�82
Moving an Axis

by Dragging
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1. Double-click the axis you want to move. The Graph Properties dialog box opens 
to the Axis Line options.

2. Use the slider controls in the Show/Place Axes options to change the percentage 
in the Top and Bottom boxes for X axes or Left and Right boxes for Y axes, or 
select the value in the edit boxes and type a new value. 

Locations are described as the percentage of the graph dimension the axes lie 
from the original position. To move an axis up or right, enter a percent greater 
than 0 (positive). To move an axis down or left, enter a percent less than 0 (neg-
ative). The defaults are 0.0%, and Normal.

3. Click Apply to apply your changes, or OK to apply your changes and close the 
dialog box. 

Axis Line and Color Thickness 0

To change the line of an axis from Graph Properties:

1. Double-click the axis to open the Axes Lines options. You can also right-click 
the axis and choose Graph Properties.

2. Use the Line Properties options to set a new line color and thickness. Choosing 
(none) as the color makes the axis transparent, and choosing (custom) as the 
color opens the Custom Color dialog box. For more information on custom col-
ors, see �Using Custom Colors� on page 146.

3. Click Apply to apply your changes, or OK to apply your changes and close the 
dialog box. 

Figure 7�83
Moving an Axis Using
the Graph Properties

Dialog Box Axes Panel
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Σ Note that 3D graph frame lines are drawn over axes lines and may obscure 3D axes 
modifications. For more information on frame lines, see �Frame Lines for a 3D 
Graph� on page 296. 

Using the Object
Properties Dialog Box

You can also change axis line attributes by right-clicking the axis and choosing Object 
Properties. You can also select the axis, then choose the Format menu Line command 
or click the  button. 

To learn more about using the Object Properties dialog box to change line 
appearance, see �Changing Lines� on page 124. 

Setting Axis Breaks 0

You can set axis breaks for 2D Cartesian graphs over specific ranges, at a specific 
location along the axis, and you can change the major tick intervals that occur after 
the break. You can also use several different break symbols. 

Creating an
 Axis Break

To create an axis break:

1. Double-click the axis where you want to add the break, then select Breaks from 
the Settings For list. 

Figure 7�84
The Line Panel of the Object

Properties Dialog Box
Note that the Type option
 is unavailable for axes.
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2. To display the break, check the Show Break option by selecting it, then enter the 
range of the axis break using the Break Range options. 

Select the Omit box and type the starting point of the break, then select the To 
box and type the last point of the break.

 Modifying Break
Appearance

3. Use the Position slider control to specify the break position. The location of the 
break is determined as a percent of the total axis length, from the origin.

4. Use the Gap Width slider control to set the width of the space between break 
lines.

5. Enter the post break tick mark interval to use by selecting the Post Break edit 
box and typing a value. The default value is the interval specified for the axis 
range.

Note that tick values from a column are not applied to the post-break interval.

6. Select a break symbol type from the Symbol list, then use the Length, Color, and 
Thickness options to set axis break appearance.

7. Click Apply to apply changes without closing the dialog, or click OK to apply 
changes and close the dialog box.

Figure 7�85
The Graph Properties

Dialog Box Axes Panel
Breaks Settings
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Displaying Grid Lines and Backplanes 0

Display and modify grids for each graph plane using the Graph Properties dialog 
box. Grid lines are associated with both a backplane and one of the two axes which 
form the plane. If a graph has multiple axes, the axes used are the original pair.

You can choose to turn on and modify grid lines for both major and minor tick 
intervals. Tick intervals are controlled using the Graph Properties dialog box Axes 
panel Scaling settings (see page 203).

Modifying Grids
and Planes

To change major or minor grid lines:

1. Double-click the graph to modify. You can also select the graph, then click the 

 toolbar button or choose the Graph menu Graph Properties command.

2. Select the Grids and Planes tab. If your graph is a 3D graph, select the plane to 
modify from the Plane list. 

Σ When modifying a 2D graph, only one plane is available.
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3. To select a background color for the selected plane, use the Background options 
Color list. Select any of the listed colors, or select (custom) to use or create a cus-
tom color. To learn about using custom colors, see �Using Custom Colors� on 
page 146.

Select (none) to create a transparent plane. Transparent planes are especially use-
ful when superimposing graphs over one another. 

4. Use the Grid list to select a grid to modify or display. You can modify major or 
minor grid lines for any axis of the selected plane.

The grid lines available for Cartesian plots are X, Y, and Z for 3D plots. The grid 
lines for polar plots are for the Angular and Radial axes. Ternary plots have X, Y 
and Z direction grid lines.

5. To change grid line style and thickness,  use the Style and Thickness options. 
Choose a line style from the Style list, then use the Thickness slider control to 

Figure 7�87
Selecting the Backplane

Figure 7�88
Selecting the Grid Lines
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set line thickness, or select the Thickness edit box and type a thickness value. 

6. Change grid line color  using the Grid Lines options Color list. Choose any of 
the listed colors, or choose (custom) to use or create a custom color. Choose 
(none) to create transparent grid lines. 

To learn about using custom colors, see �Using Custom Colors� on page 146.

7. Use the Layering list to move the grid behind or in front of the plot. This feature 
is especially useful for bar charts. 

8. Click Apply to keep the dialog box open, or click OK to apply changes and close 
the dialog box.

Hiding and Viewing
Grid Lines

To view hidden grid lines, or hide visible grid lines, open the Graph Properties dialog 
box to the Grids and Planes panel, then choose the Plane and Grid to modify from 
the Plane and Grid lists.

Hide grid lines by choosing (none) from the Grid Lines options Style list, or display 
grid lines by changing the style to a style other than (none). 
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Working with 2D Graphs

This chapter describes two dimensional graphs and procedures specific to 2D graphs. 
To learn about making general graph modifications, like changing symbols, lines, or 
fills, see �Creating and Modifying Graphs� on page 151. Modifications to pie charts, 
polar plots, and ternary plots are discussed in �Working with Pie, Polar, and Ternary 
Plots� on page 351. For information on modifying axes, see �Modifying Axes and 
Grids� on page 199.

This chapter covers:

➤ Different 2D plot types and their attributes (see page 234)

➤ Creating a basic 2D plot (see page 238)

➤ Creating a plot with error bars (see page 240)

➤ Creating a bubble plot (see page 246)

➤ Creating a grouped bar chart (see page 247)

➤ Spacing bars for overlapping bar charts (see page 250)

➤ Creating a grouped bar chart with error bars (see page 250)

➤ Computing a histogram (see page 253)

➤ Creating a graph that plots multiple lines, bar or data sets using the same style 
(see page 257)

➤ Modifying and customizing error bar appearance (see page 257)

➤ Changing box plot appearance (see page 263)

➤ Plotting and modifying linear regression lines (see page 264)

➤ Adding and modifying reference lines (see page 271)

➤ Adding multiple axes (see page 273)

About 2D Plots 2D Cartesian (XY) plots can be created from many worksheet columns or column 
pairs. Each column is represented as a separate curve, set of bars, or box, depending 
on the plot type. 2D graphs must have at least one plot, but can hold many more 
plots, each with a different type and style. 

Linear or polynomial regressions with confidence and prediction intervals, and 
reference lines can be drawn for each curve. To learn about plotting with regressions, 
see �Regression Lines� on page 264. For information on adding reference lines, see 
�Adding Reference Lines� on page 271.

8



Working with 2D Graphs

234 2D Plot Types

2D Plot Types 0

Scatter, Line, and
Line/Scatter Plots

Scatter, line, and line/scatter plots graph data as symbols, as lines only with no 
symbols, or as symbols and lines. Line shapes can be straight segments, splines, or 
steps. Drop lines to either axis can be added to any of these plot types, and error bars 
can be added to plots with symbols. Linear or polynomial regressions with 
confidence and prediction intervals can be drawn for each curve.

For more information on adding drop lines, see �Adding and Modifying Drop Lines� 
on page 196. Creating scatter and line/scatter graphs with error bars is described in 
�Creating Plots with Error Bars� on page 240. 

Bar Charts Bar charts plot data either as vertical or horizontal bars. They originate from zero in 
either a positive or negative direction. Simple bar charts plot each row of data as a 
separate bar, and grouped bar charts plot multiple columns of data, grouping data in 
the same rows. Stacked bar charts plot data as segments of a bar; each data point is 
drawn as a bar segment starting where the previous data point ended.

Use the Graph Properties dialog box to modify bar width, bar fill colors, and bar fill 
patterns. Error bars can be added to simple and grouped bar charts. To learn more 
about grouped bar charts, with or without error bars, see �Creating Grouped Bar 
Charts� on page 247. To learn about using the Graph Properties dialog box to 
modify bar fills and colors, see �Adding and Modifying Drop Lines� on page 196.

Box Plots Box plots graph data as a box representing statistical values. The boundary of the box 
closest to zero indicates the 25th percentile, a line within the box marks the median, 
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and the boundary of the box farthest from zero indicates the 75th percentile. 
Whiskers above and below the box indicate the 90th and 10th percentiles. In 
addition, the mean and outlying points can be graphed. For information on 
modifying box plots, see �Modifying Box Plots� on page 263.

Σ Note that a minimum number of data points is required to compute each set of 
percentiles. At least three points are required to compute the 25th and 75th 
percentiles, five points to compute the 10th percentile, and six points to compute the 
5th, 90th, and 95th percentiles. If SigmaPlot is unable to compute a percentile point, 
that set of points is not drawn. 

Arranging Data for a 2D Plot 0

Data for SigmaPlot graphs is always organized by columns. Data used for the X 
values of a graph must be placed in a single column, and the data for the 
corresponding Y values must be placed in another column.

When creating a graph, you will be asked what format your data is in. The following 
data formats are used for all 2D plots.

Σ For information on creating a graph, see �Creating and Modifying Graphs� on page 
151. For information on creating another plot for an existing graph, see �Multiple 
Plots on a Graph: Adding New Plots� on page 170.
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Data for a
Single Curve

(XY Pair)

If the graph you are creating uses only one set of X and Y values, enter all X data in 
one column, and all corresponding Y data in another column. These columns do not 
need to be adjacent or the same length (missing values are ignored).

Data for
Multiple Curves

(XY Pairs)

If the graph style you are creating plots more than one curve, place as many 
additional X and Y values in worksheet columns as you want to plot. X and Y data 
can be entered in the worksheet in consecutive columns, or in any order you want.

Using the Same
Column for

Multiple Curves
(Single X or Y vs.

Many Y or X)

SigmaPlot can graph many curves using the same X or Y data column. There is no 
need to duplicate a column that is used for more than one curve; for example, enter 

Figure 8�4
Data for a 2D Graph

Arranged and Picked as XY

Data is placed into two
columns.

Figure 8�5
Data for a  2D Graph

Arranged and PIcked as
Multiple XY Pairs

Each x and y variable go into
separate columns.
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the X data into only one column, and enter the corresponding Y data into as many 
columns as you have curves. Order and length of columns doesn�t matter.

Using Row Numbers
for X or Y Values

(Single X; Single Y;
Many X; or Many Y)

SigmaPlot can also graph data as only X or Y values, and use the row numbers of the 
columns as the corresponding Y or X coordinates. If you want to graph data as only 
X or Y values, enter the data for each plot into a column, and do not enter data for 
corresponding coordinates.

Column Averaged
Error Bar Plots

Certain graph styles plot data by representing the mean of an entire column as a 
single data point. In these cases, place the values you want represented as a single X or 
Y value into one column.

Figure 8�6
Data for a 2D Graph

Arranged and Picked as X
Many Y

Data for the single x variable
is placed in one column, and

the multiple y variables are
placed in separate columns.

Figure 8�7
Data for a 2D Graph

Arranged and Picked as
Many Y Only

Each y variable is placed in
its own column. No x

variables are required.
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Creating 2D Plots 0

To create a scatter plot, line plot, line/scatter plot, simple bar chart, or box plot:

1. If you want to select worksheet data before creating the graph, select the work-
sheet columns to plot before creating your graph by dragging the pointer over 
your data. Note that you do not have to select data before you start a graph; you 
can select the columns to plot during graph creation.

2. Select the desired graph type and style from the graph toolbar or open the Graph 

Wizard by clicking the toolbar  button, or by choosing the Graph menu Cre-
ate Graph command. The Graph Wizard appears.

Σ During the graph creation process, the left side of the Graph Wizard changes 
depending on what is selected on the right side of the dialog box.

3. If you did not use the graph toolbar to open the Graph Wizard, select the type of 
graph you want to make from the scroll box in the dialog box. Use the scroll bar 
to view the entire list. Highlight the desired graph type by selecting it, then click 
the Next button. 

Figure 8�8
The Graph Wizard
Displaying a List

of  Graph Types
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4. If you did not use the graph toolbar to open the Graph Wizard, the Graph Wiz-
ard displays the available graph styles in the scroll box. Highlight the desired 
graph style, then click Next.

5. Specify how your data is formatted by choosing the appropriate data format 
from the Data Format list. The data formats available depend on the graph type 
and style you are making. Choose the appropriate data format, then click Next.

For information on the available data formats for the graph you are making, see 
the description of the graph style in �SigmaPlot Graph Style� on page 155 . 

6. Specify which worksheet columns correspond to the data for your plot. If you 
selected columns prior to opening the Graph Wizard, your choices automatically 
appear in the dialog box and you can click Finish to create the graph.

If you have not already picked columns, note that a single data type is high-
lighted in the Selected Columns list. This shows the data type you are picking a 
column for. Begin picking data either by clicking the corresponding column 
directly in the worksheet, or choosing the appropriate column from the Data 
Columns list. Repeat this process for every column you are using to create your 
graph.

7. If you make a mistake while picking data, select the wrong entry in the Graph 
Wizard, then choose the correct column from the worksheet. You can also clear a 

Figure 8�9
The Graph Wizard

Displaying a List of
Available Graph Styles

 for a Scatter Plot

Figure 8�10
Using the Graph Wizard to

Specify the Data Format
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column assignment by double-clicking it in the list. 

8. When you have finished picking data, click Finish to create the plot and close 
the Graph Wizard.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard 
to pick different data columns for your plot, or to add another plot to your graph. 
For more information on making general modifications to your plot, see �Creating 
and Modifying Graphs� on page 151.

Creating Plots with Error Bars 0

In a Line and Scatter Plot with Error Bars, the means of each column are plotted as 
the Y value, with the standard deviations represented by error bars.

Use the Graph Wizard to create 2D plots with error bars. Scatter plots, line/scatter 
plots, or simple bar charts can be created with error bars. To learn about creating 
grouped bar charts with error bars, see �Creating Grouped Bar Charts� on page 247.

Σ To add error bars to a pre-existing plot, you must change the plot type. For more 
information, see �Changing Graph Type and Style� on page 169. 

To create a plot with error bars:

1. If you want to select worksheet data before creating the graph, select the work-
sheet columns to plot before creating your graph by dragging the pointer over 

Figure 8�11
Using the Create

Graph Dialog to Pick
Columns to Plot

Figure 8�12
Examples of

Some 2D Plots with
Error Bars

The third graph is an
example of a scatter

plot with multiple error
bars and two plots to
distinguish between

the two data sets.
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your data. Note that you do not have to select data before you start a graph; you 
can select the columns to plot during graph creation.

2. Select the desired graph type and style from the graph toolbar. You can also click 

the toolbar  button, or choose the Graph menu Create Graph command. 
The Graph Wizard appears. 

Σ Note that during the graph creation process, the left side of the Graph Wizard 
changes depending on what is selected on the right side of the dialog box.

3. If you did not use the graph toolbar to open the Graph Wizard, select the type of 
graph you want to make from the scroll box in the dialog box. Use the scroll bar 
to view the entire list. Highlight the desired graph type by selecting it, then click 
the Next button. 

4. If you did not use the graph toolbar to open the Graph Wizard, the Graph Wiz-
ard displays the available graph styles in the scroll box. Highlight the desired 
graph style with error bars, then click Next. 

Figure 8�13
The Graph Wizard
Displaying a List

of  Graph Types

Figure 8�14
The Graph Wizard

Displaying a List of
Available Graph Styles

 for a Scatter Plot
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5. Use the Error Bar Source list to pick an error bar source and a value to use for 
the error bars. Choose either Column Means to use the column means as the 
error bar source, or Worksheet to use values you�ve entered in a worksheet col-
umn. You are prompted during data picking (Step 8) to specify the column to 
use as error bar source data.

6. If you chose to use a worksheet column as the error bar source, click Next. If you 
chose Column Means as the error bar source, use the Error Calculation list to 
specify the calculation method to use for error bars. Choose either Mean, Stan-
dard Deviation, Standard Error, 95% Confidence, or 99% Confidence, then 
click Next.

Σ Note that X column averaged plots require a constant Y column value, and Y 
column averaged plots require a constant X column value.

7. Specify how your data is formatted by choosing the appropriate data format 
from the Data Format list. The data formats available depend on the graph type 
and style you are making. Choose the appropriate data format, then click Next.

For information on the available data formats for the graph you are making, see 
the description of the graph style in �SigmaPlot Graph Style� on page 155 . 

8. Specify which worksheet columns correspond to the data for your plot. If you 
selected columns prior to opening the Graph Wizard, your choices automatically 
appear in the dialog box, and you can click Finish to create the graph.

Figure 8�15
Using the Create

Graph Dialog to Specify
Error Bar Information

Figure 8�16
Using the Graph Wizard to

Specify the Data Format
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If you have not already picked columns, note that a single data type is high-
lighted in the Selected Columns box. This shows the data type you are picking a 
column for. Begin picking data either by clicking the corresponding column 
directly in the worksheet, or choosing the appropriate column from the Data 
Columns list.

9. If you are making a graph with simple error bars or a graph with multiple 
error bars using worksheet columns as the source for error bar data,  you are 
prompted to choose columns for error bar data. Repeat the data picking process 
for every column you are using to create your plot.

10. If you are making a graph with multiple error bars using column means as the 
source for error bar data,  you can create a graph using a single plot, or a graph 
with multiple plots. Use multiple plots if you want to use different symbols to 
distinguish between data sets (see Figure 8�12 on page 240). 

11. To create a single plot graph, choose data for every column you are using to 
make the graph. To create a graph of multiple plots, choose data for the first 
plot, then click Next to pick data for the next plot. Repeat this process for as 
many plots as necessary.

12. If you make a mistake while picking data, click the wrong entry in the Graph 
Wizard, then choose the correct column from the worksheet. You can also clear a 
column assignment by double-clicking it in the Selected Columns list. Use the 
Back button to access previous Graph Wizard panels.

13. When you have finished picking data, click Finish to create the plot and close 
the Graph Wizard.

Figure 8�17
Using the Graph Wizard -

Create Graph Dialog
to Pick Columns for the
 First Plot in the Graph

Notice the Next button is
enabled so that you can

create an additional
plot for the graph.
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To learn about modifying error bar information, see �Changing Error Bar Color, 
Line Thickness, and Cap Width� on page 258. To learn about repicking data for an 
existing plot, see �Picking Different Data for the Current Plot� on page 168. 

Bubble Plots 0

Bubble plots are XY scatter plots that use symbols to represent not only XY locations, 
but also a third dimension represented by the size of the symbol. Bubble plots are 
frequently used to plot population density, epidemiological data, or other similar 
data sets where a third variable can be clearly illustrated by the size of the symbols. 

Arranging Data for
Bubble Plots

Data for bubble plots can either be X, Y data in two separate columns or single X or 
single Y data in one column. In both cases, an additional column is needed to 
indicate bubble size values. Since the bubble size column corresponds to symbol 
diameter, you must convert the data for your third variable to diameters. 

Bubble plots must have at least one plot, but can hold many more plots using 
different data formats if appropriate. The bubble plot type has available only the 
default scatter style. You can change the symbol type; however, if you use something 
other than a circle you will need a different equation to transform area to diameter.

Using X, Y Values for
Bubble Plots

Bubble plot X, Y data is arranged in the same way as other 2D plot X, Y data, with all 
X values in one column and all Y values in another. However, whether you are 
plotting XY Pair, Single Y, or Single X data, bubble plots require an additional 
column to indicate bubble size.

Bubble Plot
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Data for Bubble Size SigmaPlot can graph bubble plots using XY pair, Single Y, Single X, and bubble size 
data. Bubble size values must be entered in a separate column. Each value 
corresponds to the diameter of the symbol, in whatever page units are being used. If 
you want bubble size to correspond to area data, you must convert your area data to 
diameters before creating the bubble plot.

Converting Area Data
to Diameters

If you want your bubble plot to display area data, you must run this transform where 
area is the source column number and the diameter is the results column number. 
This transform is derived from the formula for the area of a circle.

To convert your area data into diameters   Press F10 or choose the Transforms 
menu User-Defined command; the User-Defined Transform dialog box appears. 
Now type the transform function as follows:

pi=3.14159265359
col(diameter)=sqrt(col(area)*factor/pi)

where diameter is the column number for your diameter data, area is the column 
number for your original data to be represented by area, and factor is some number to 
increase or decrease the magnitude of your data to a reasonable range. 
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It is very important to reduce the diameters of your symbols to a reasonable size 
before plotting them. 

Click Execute and your new data appears in the worksheet.

Σ If you change the symbol shape, you must use a different equation to transform area 
data.

Creating a Bubble
Plot

To create a bubble plot:

1. Select the worksheet columns to plot before creating your graph by dragging the 
pointer over your data. Note that you do not have to select data before you start 
a graph; you can select the columns to plot during graph creation.

Σ Bubble plot data must include bubble size values to specify plot symbol 
diameter. If you have area data to plot, you must convert it to diameters. For 
information on how to do this, see �Converting Area Data to Diameters� on 
page 245.

2. Open the Graph Wizard by clicking the Graph Wizard  button or by choos-
ing the Graph menu Create Graph command. The Graph Wizard appears.

3. Select Bubble Plot as the graph type by highlighting it in the dialog box list. 
Then click the Next button.

4. The Graph Wizard prompts you to select the data format appropriate to the data 
you are plotting. Select the appropriate format and click Next.

Figure 8�19
Transforming Area
Data to Diameters
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5. When you have selected all the columns to plot, including the Bubble Size col-
umn, click Finish to create the graph . The Graph Wizard closes and the bubble 
plot appears displaying the plotted data.

Grouped Bar Charts 0

Grouped bars are created by picking multiple columns for a single plot. Data points 
within the same row appear within the same group, and each additional column adds 
another bar to each group. There are as many groups as there are rows of data.

The order of the bars for each group is determined by the order of the column pairs 
in the list. To change the bar orders within groups, change the order the column pairs 
appear in the list by using the Graph Wizard to repick column data. For more 
information about repicking data, see �Picking Different Data for the Current Plot� 
on page 168. 

Use the Graph Wizard to create grouped bar charts with or without error bars. If 
creating a grouped bar chart with error bars, error bar values must be from worksheet 
column values entered prior to creating the plot. You are prompted during graph 
creation for error bar worksheet columns. 

Creating Grouped Bar
Charts

To create a grouped bar chart:

1. If you want to select worksheet data before creating the graph, select the work-
sheet columns to plot before creating your graph by dragging the pointer over 
your data. Note that you do not have to select data before you start a graph; you 
can select the columns to plot during graph creation.

2. Select the Horizontal or Vertical Bar Chart button from the graph toolbar, then 
selecting either the Grouped Bar Chart, or Grouped Error Bars button. You can 

also click the toolbar  button or choose the Graph menu Create Graph com-
mand. The Graph Wizard appears.

Σ Note that during the graph creation process, the left side of the Graph Wizard 
changes depending on what is selected on the right side of the dialog box.
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3. If you did not use the graph toolbar to open the Graph Wizard, select to make 
either a Vertical or Horizontal Bar Chart, then click Next. 

4. If you did not use the graph toolbar to open the Graph Wizard, the Graph Wiz-
ard displays the available graph styles in the scroll box. Select either Grouped 
Bar, to create a grouped bar chart, or Grouped Error Bars to create a grouped bar 
chart with error bars, then click Next.

5. To plot a grouped bar chart using a category axis, enter the category data as 
labels into one worksheet column, and select the X many Y data format.

6. Specify how your data is formatted by choosing the appropriate data format 
from the Data Format list. The data formats available depend on the graph type 
and style you are making. Choose the appropriate data format, then click Next.

Figure 8�21
The Graph Wizard
Displaying a List

of  Graph Types

Figure 8�22
The Graph Wizard

Displaying the
Graph Styles
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For information on the available data formats for the graph you are making, see 
the description of the graph style in �SigmaPlot Graph Style� on page 155 . 

7. Specify which worksheet columns correspond to the data for your plot. If you 
selected columns prior to opening the Graph Wizard, your choices automatically 
appear in the dialog box and you can click Finish to create the graph.

If you have not already picked columns, note that a single data type is high-
lighted in the Selected Columns box. This shows the data type you are picking a 
column for. 

Begin picking data either by clicking the corresponding column directly in the 
worksheet, or choosing the appropriate column from the Data Columns list. 
You are prompted to choose columns to plot, and columns for error bar data. 
Repeat this process for every column you are using to create your graph.

8. If you make a mistake while picking data, select the wrong entry in the Graph 
Wizard, then choose the correct column from the worksheet. You can also clear a 
column assignment by double-clicking it in the Selected Columns list.

Figure 8�23
Using the Graph Wizard to

Specify the Data Format

Figure 8�24
Using the Create

Graph Dialog to Pick
Columns to Plot

Notice that this dialog box
also prompts you for the
columns with the data to

use as the error bar values.
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9. When you are done picking data, click Finish to create the plot and close the 
Graph Wizard.

To learn about modifying error bar information, see �Changing Error Bar Color, 
Line Thickness, and Cap Width� on page 258. To learn about repicking data for an 
existing plot, see �Picking Different Data for the Current Plot� on page 168.

Spacing Bars from
Different Plots

Normally, you use only a single plot for a bar chart. However, if you need to create a 
bar chart with two or more different axes scales, or a chart with overlapping bars, you 
must use multiple plots.

SigmaPlot does not automatically space bars from different plots; however, you can 
manually space bars by grouping your data column(s) with column(s) containing 
missing or empty data. This creates bar groups with null values and leaves room for 
other bars. When picking columns to plot, pick the missing columns in a different 
order for each plot, so that the bars do not overlap.

To overlap bars, plot your bar values versus a column of evenly incremented values 
rather than by row numbers.

Grouping Column
Averaged Bars

You cannot create a grouped bar chart with error bars using column averaging; the 
bars do not group or space correctly. However, you can copy the worksheet means 
and standard deviations from the statistics window, then plot this data as a grouped 
bar chart with error bars. 

To create a bar chart with grouped column averaged bars:

1. Open the statistics window for the worksheet by choosing the View menu Statis-

tics command, or by clicking the toolbar  button.

2. Select the block of data in the statistics window that consists of the means and 

Figure 8�25
Bars graphed with
different plots that

both overlap and are
spaced differently by

using different x
increments.

The bar widths for
both plots are set

to variable.
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standard deviations (or other statistic) of the first set of bars, then choose Copy 
from the right-click pop-up menu.

3. Select the first row of an empty column in the worksheet, then choose the Edit 
menu Transpose Paste command. The first pasted column of data is the means, 
and the next column is the standard deviations (or other statistic). For more 
information on using the transpose paste feature see �Switching Rows to Col-
umns� on page 81. 

You can alternately copy then transpose paste the standard errors or confidence 
values instead of the standard deviations. The only difference is that two separate 
copy and paste operations are required. You can use the Worksheet Column Sta-
tistics Options to turn off display of all statistics except for the ones you are 
interested in. 

4. Repeat the copy and transpose paste procedure for the remaining sets of bars. 
Each pair of means and standard deviation columns you create adds an addi-
tional bar to each group.

5. To plot the results, select a vertical or horizontal bar chart graph type with 
grouped error bars from the graph toolbar. Select the desired data format. If you 
already have a graph, repick the plotted data by selecting the plot to modify, 

then clicking the toolbar  button.

6. If you select X Many Y as the data format, pick your constant value column 
(either a row number or a single column), then pick the first column of means as 
your data column, and the first column of standard deviations as the associated 
error bar column. 

Figure 8�26
Example of Transposed

Pasted Data

The data in columns
13 and 14 of the worksheet

are transposed from the
selected data in rows 1

and 2 of the Column
Statistics window.

Column 13 contains
the means of the column

data and column 14 contains
the standard deviations

of the data.
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7. Continue picking the columns of means and error bars for each set. Click Finish 
when done. 

8. Use the Graph Properties dialog box to edit the bar chart fills and widths as 
desired. For more information on modifying the appearance of bar charts, see 
�Changing Patterns and Fill Colors� on page 188 and �Changing Bar and Box 
Widths and Spacing� on page 193. 

Figure 8�27
Picking Data to Plot for a

Grouped Bar Chart
with Error Bars
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Creating Histograms 0

Histograms are step, needle, or bar charts that represent counts of the datapoints that 
fall within specified ranges. The Histogram Wizard guides you through the steps in 
creating a histogram: generating frequency data, specifying the number of buckets or 
intervals, and selecting a graph style. 

The Histogram Wizard allows you to specify an even bucket size into which to 
partition the source data. The range of each interval is identical; the total range is the 
data minimum to the data maximum. The number of bars, steps, or needles 
displayed is generally equal to the number of buckets.

To create a histogram with an uneven bucket size , see �The Histogram Transform 
Function� on page 255. For a more detailed explanation of the histogram transform 
function, see the Programming Guide .

Using the Histogram
Wizard

To use the Histogram Wizard:

1. Enter the data you want to analyze in an empty column of the active worksheet.

2. Choose the Statistics menu Histogram command to open the Histogram Wiz-
ard.

Figure 8�29
The Histogram Wizard �

Pick Data Dialog
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3. You are prompted to specify the worksheet column that corresponds to the 
source data for the histogram. If you selected the worksheet column prior to 
opening the Histogram Wizard, your column choice automatically appears in 
the Selected Column list.

If you have not selected the source column, pick the data by either clicking the 
column directly in the worksheet, or choosing the appropriate column from the 
Source for Histogram list.

4. Select the column for your output or frequency data. Pick the output column by 
clicking the column in the worksheet and click Next. 

5. Specify the number of buckets you want to use. If you attempt to type text or 
values less than 1 or greater than 1000, the value will be rejected and the edit 
box will display the default value. Click Next to specify the graph style you want 
to use for your histogram.

6. Specify the graph style from the list that appears in the Histogram Wizard 
Graph Style dialog box. View a preview of each graph style by selecting it from 
the list; a preview of the graph appears in the left-hand panel of the dialog box. 

Select None if you do not require a graph of your frequency data. Click Finish to 
create the graph and close the Histogram Wizard dialog box. 

7. If you choose None, SigmaPlot displays the worksheet with the output 

Figure 8�30
The Histogram Wizard �

Buckets Dialog Box

Figure 8�31
The Histogram Wizard �
Graph Style Dialog Box
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column containing the histogram frequency data. 

8. If you choose to create a graph, the graph appears on the active graph page, or a 
new page if the worksheet has no associated graph pages. The X axis represent-
ing the buckets is titled Bin, and uses a category scale. The Y axis representing 
the frequency or the number of data points in each bin, is titled Frequency, and 
uses a linear scale. 

For more information about modifying axes, see �Modifying Axes and Grids� on 
page 199.

The Histogram
Transform Function

If you need to use uneven bucket sizes for a histogram, use SigmaPlot�s built-in 
histogram transform function :

1. Enter your data to analyze in column 1 and your bucket values in column 2.

The numbers in column 2 are used as the upper bounds (inclusive) of the histo-
gram interval ranges. The number of data points that fall within each specified 
range is counted. The number of histogram bars is equal to the number of inter-
val upper bounds entered. The number of values that fall beyond the largest 
upper bound is also counted.

2. After entering the appropriate data into columns 1 and 2, choose the Transforms 
menu User-Defined command, or press F10.

Figure 8�32
Example of a Histogram

Created Using the
Histogram Wizard
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3. Enter the transform: col(3)=histogram(col(1),col(2))

4. Click Execute. The histogram data is saved to column 3. To graph the data, plot 
column 3 as a bar chart. 

5. Save as HISTOGRM.XFM.

Set the Bar Thickness control in the Graph Properties dialog box to 100%. For 
more information on modifying bar chart appearance, see �Changing Patterns 
and Fill Colors� on page 188 and �Changing Bar and Box Widths and Spacing� 
on page 193. Alternately, you can graph it as a line plot and choose a stepped 
line shape. 

For details on the histogram transform function, see the Programming Guide .

Figure 8�33
Graphing the results of

the HISTOGRM.XFM
transform as a bar chart.
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Creating Multiple Curves 0

You do not have to create multiple plots to obtain multiple curves. To plot more than 
one curve, choose any of the plot styles described as Multiple and add additional 
columns, or column pairs to the list of curves in the Graph Wizard. 

The order of the curves is determined by the order of the column pairs in the Graph 
Wizard. To change the curve order, repick columns by selecting them in the Graph 
Wizard, then clicking the worksheet. 

Modifying Error Bars 0

Error bars can be computed for scatter, line/scatter, and bar charts. Error bar values 
are selected when you pick the data for a plot and can be computed using values in a 
worksheet column or using column means (see �Creating Plots with Error Bars� on 
page 240).

Σ Error bars cannot be added to existing plots; however, you can select the desired plot 
on the page and change its plot type and style so that it includes error bars. To learn 
about changing graph type and style, see �Changing Graph Type and Style� on 
page 169. 

Figure 8�34
Plot Styles that Include

Multiple Curves
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Changing Error
Bar Color, Line
Thickness, and

Cap Width

Use the Graph Properties dialog box to change error bar color, cap width, line 
thickness, mean computation method, and direction. 

Note that error bar values are not selected from this dialog box; only the appearance 
of error bars is affected. Error bar values are determined when data is picked to plot.

To change error bar appearance:

1. Double-click the plot to open the Graph Properties dialog box, and select the 
Error Bars option from the Settings For list.

You can also select the plot and click the  button, or choose the Graph menu 

Graph Properties command, then select Error Bars from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the error bars to modify from the Plot list. 

2. Select a color to use for error bars from the Line Color list. Choose (custom) to 
use a custom color, or to create your own color. For more information, see 
�Using Custom Colors� on page 146.

3. Use the Thickness and Cap Width slider controls to change line thickness and 
error bar cap width, or select the Thickness and Cap Width edit boxes and type 
a new value. 

4. Apply your changes and close the dialog box by clicking OK, or click Apply to 
apply changes without closing the dialog box.

Figure 8�36
The Lines Settings

of the Graph Properties
Dialog Plots Panel
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Changing Error
Bar Directions

You can specify error bar direction using two different methods: absolute and 
relative. Absolute error bars can be specified to point in either a positive or negative 
direction; relative error bars can be specified to point either towards or away from 
zero. 

To change error bar direction: 

1. Double-click the plot to open the Graph Properties dialog box, and select the 
Error Bars option from the Settings For list.

You can also select the plot and click the  button, or choose the Graph menu 

Graph Properties command, then select Error Bars from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the error bars to modify from the Plot list.

2. To always point error bars in one direction, choose Absolute from the Direction 
list, then check either X or Y Positive or Negative. An X positive absolute direc-
tion always points right; a Y positive direction always point up. An X negative 
absolute direction always points left; a Y negative absolute direction always 
points down. 
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3. To orient error bar directions relative to zero, select Relative, and select X or Y 
From Zero or To Zero. A relative to zero direction always points toward or away 
from zero. This option is useful for bar charts that have negative values.

4. Apply your changes and close the dialog box by clicking OK, or click Apply to 
apply changes without closing the dialog box.

Customizing Error
Bar Directions

Control the error bar direction used for each data point by entering error bar 
directions into a worksheet column. 

To use custom error bar directions:

1. Select the first cell in an empty worksheet column, then enter the codes for the 
error bar directions. The codes for the directions are:

Σ Note that the codes you type in the worksheet can be either upper or lower case. 

2. Double-click the plot to open the Graph Properties dialog box, and select the 
Error Bars option from the Settings For list.

-80 -60 -40 -20 0 20 40 60 80 -80 -60 -40 -20 0 20 40 60 80

Figure 8�38
The bar chart on the left

uses X error bars with
an absolute negative

direction. The bar chart
on the right uses a relative

direction towards zero.

Direction Code

Absolute Positive Positive or P

Absolute Negative Negative or N

Relative From Zero From Zero or F

Relative To Zero To Zero or T

Absolute or Relative, Both Directions Both, PN or FT
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You can also select the plot and click the  button, or choose the Graph menu 

Graph Properties Dialog command, then select Error Bars from the Settings For 
list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the error bars to modify from the Plot list.

3. Use the Direction list to choose the name of the column which contains the 
error bar direction codes. 

Changing the Mean
Computation Method

If you are using a log axis scale, you can choose between calculating the column 
means arithmetically (the default) or geometrically on a log scale.

To change the mean computation method:

1. Double-click the plot to open the Graph Properties dialog box, and select the 
Error Bars option from the Settings For list.

You can also select the plot and click the  button, or choose the Graph menu 

Graph Properties command, then select Error Bars from the Settings For list.

Σ If you opened the Graph Properties dialog box without first selecting the desired 
plot, choose the plot that contains the error bars to modify from the Plot list.

Figure 8�39
Error Bars

Using Custom
Directions from

Worksheet Columns
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2. Select the desired mean computation from the Mean list under the Computa-
tion heading.

3. Apply your changes and close the dialog box by clicking OK, or click Apply to 
apply changes without closing the dialog box. 

Σ This option is only available for log axis scales.

Changing Error
Bar Source

The method used to generate error bars is selected when creating a graph. You can 
select to generate error bars for your plot by plotting the means of worksheet 
columns as single data points and computing the error bars values from column 
statistics (column averaging), or using data in worksheet column(s) as error bar values 
(see �Creating Plots with Error Bars� on page 240).

To change the error bar source after you�ve created the graph:

1. Select the graph or plot to modify by clicking it. A selected graph or plot is sur-
rounded by small square handles. 

2. To change the error bar source from column means to values you entered in the 

worksheet, or vice versa, click the Graph Wizard button . 

3. Use the Graph Wizard Error Bar Source option to change the error bar source to 
the new type, then click Next.

4. Pick the appropriate worksheet columns, then click Finish. The graph appears 
with the new error bars. 

Figure 8�40
The Graph Wizard - Modify

Plot mode is used to
change the error bar

source for a plot.
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Modifying Box Plots 0

Modifying Box Plot
Fills, Widths,
and Symbols

The fill, width, and symbol settings for the boxes can be modified using the 
appropriate Graph Properties Plot panel settings. 

➤ For changing the symbols used to display extreme data points, see �Changing 
Symbol Type and Other Symbol Options� on page 176.

➤ For changing box fill color and patterns (including edge and whisker color), see 
�Changing Patterns and Fill Colors� on page 188.

➤ For changing box widths, see �Changing Bar and Box Widths and Spacing� on 
page 193.

Changing Other Box
Plot Attributes

To add a mean line, change which outliers are displayed, and change the 10th and 
90th percentile whisker cap widths:

1. Double-click the plot to open the Graph Properties dialog box, and select the 
Box Options from the Settings For list.

You can also select the plot and click the  button, or choose the Graph menu 

Graph Properties command, then select Box Options from the 
Settings For list.

2. To display a mean line in addition to the median line,  use the Box Plot Mean 
Line Options. Check the Display Mean Line box by selecting it to display the 
mean line. If the box is not checked, the mean line is not displayed.

3. To modify the mean line,  choose a mean line type from the Line Type list, then 
select a line thickness and color using the Thickness and Color options. 

Selecting (none) from the Line Type or Color lists creates a transparent mean 
line. Selecting (custom) from the color list enables you to use a custom mean 
line color, or to create a new color. 
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For more information, see �Using Custom Colors� on page 146.

4. To change how outliers are handled,  use the Handling Outliers list. Choose 
either to Show Each Outlier (outside the 10th and 90th percentiles), or only to 
Show 5th/95th Percentiles. To hide outliers, or modify outlier symbols, use the 
Symbols settings. For more information on modifying symbols, see �Changing 
Symbol Type and Other Symbol Options� on page 176.

Σ Note that at least six data points are required to compute the 5th and 95th 
percentiles, and that there may not be any points beyond the 10th and 90th 
percentiles.

5. To modify whisker cap width,  use the Whisker Caps option Width slider con-
trol, or select the Width edit box and type a new value.

6. Click Apply to apply changes without closing the dialog box, or click OK to 
apply changes and close the dialog box.  

Regression Lines 0

You can automatically compute and draw linear and polynomial regressions with 
confidence and prediction intervals. The regression equation can be computed using 
all the data in a plot, or individually for each curve in a multiple-curve plot. 
Polynomial curves can be fitted up to the 10th order.

Regressions for column averaged data are computed using all the data from the 
columns, not from just the mean value. Regressions are computed and drawn linearly 
on nonlinear (e.g., log, probability, etc.) axis scales.

Figure 8�41
The Box Options Settings

of the Graph Properties
Plots Panel
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Regression equation coefficients, R2 values, and predicted values can be viewed and 
copied to the Clipboard.

To perform nonlinear regressions and curve fits, such as sigmoidal, exponential, and 
peak functions use SigmaPlot�s Regression Wizard. The Regression Wizard provides 
an extensive set of equations for curve fitting. For a complete description of these 
capabilities, see the Programming Guide .

SPSS's SigmaStat statistical program also provides comprehensive linear and 
nonlinear regression diagnostics and results, and is designed to interface directly with 
SigmaPlot.

Creating a Graph with
a Regression Line

You can add a first order regression to a graph by selecting one of the graph styles that 
has a regression. These styles are available for scatter plots; �Scatter Plots� on page 
155. If you want to add a regression line to a non-scatter plot, follow the directions 
below.

Figure 8�42
A scatter plot before and

after a 1st order regression
with 95% confidence and

prediction intervals
was added.
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Modifying and
Adding Linear

Regression Lines

To modify or add an automatically calculated regression to a plot:

1. Select the plot to fit a line to by clicking it, then choose the Statistics menu Lin-
ear Regression command. Select the Regression Line tab to display the Regres-
sion Line panel.

2. Select either Each Curve to draw a regression for the data in each curve of the 
selected plot, or All Data In Plot to draw a single regression for all of the data in 
the selected plot. A check mark indicates that the regression will be drawn; hide 
a regression line by clearing the box.

Σ If neither box is checked a regression is not drawn. If both boxes are checked, 
regressions are drawn for each curve and for all the data in the plot.

3. To specify the order of the regression, choose the desired order from the Order 
list. You can use up to 10th order polynomials as regressions; the default is 1st 
order (a linear regression). 

4. Select the type of line to use for the regression from the Line options Type list. 

5. Use the Color list to specify the color of the regression line. Use a predefined 
color, or choose (custom) to use a custom color or to create a custom color. If 
creating regression lines for multiple curves, use one of the many available color 
schemes to increment line colors. Choosing (none) creates a transparent regres-
sion line. 

For more information, see �Using Custom Colors� on page 146.

6. Use the Thickness slider control to change line thickness, or select the Thickness 
edit box and type a value to use for line thickness.

7. Regression lines normally extend over the range of the data. To set the extent of 
regression line(s) all the way across the graph, select the Extend to Axes option. 

8. To force a regression line through the origin (0,0), select the Pass Through Ori-
gin option. Note that the regression line will not actually touch the axes unless 
the Extend To Axes option is also selected. 

Figure 8�43
The Regression Line

Panel of the Linear
Regression Dialog Box
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9. Click Apply to apply changes without closing the dialog box, or click OK to 
apply changes and close the dialog box.

For a description of the calculation of confidence and prediction intervals, see 
�Linear Regression, Confidence, and Prediction Calculation� on page 268.

Viewing and
Saving Regression

Equation Results

If you want to view and save the coefficients of the regression(s), select the Results tab 
of the Linear Regression dialog box. The Results panel appears displaying regression 
equation results. 

The regression equation coefficients, correlation coefficient  R2, and function results 
are displayed for each regression curve computed. If you computed confidence and 
prediction intervals, these values are also displayed. 

Click Copy to copy the results and paste them into the worksheet, a report, or any 
other Windows application. For a description of the calculation of confidence and 
prediction intervals, see �Linear Regression, Confidence, and Prediction Calculation� 
on page 268.

 Adding Confidence
and Prediction

Intervals

SigmaPlot can draw lines which describe either the 95% or 99% confidence and 
prediction intervals around a regression line.

Confidence intervals, also called the confidence interval for a regression, describe the 
range where the regression line values will fall a percentage of the time for repeated 
measurements. 

Prediction intervals, also called the confidence interval for the population, describe 
the range where the data values will fall a percentage of the time for repeated 
measurements. 

Σ Note that you must compute a regression in order to compute confidence and 
prediction lines. To learn about adding regression lines, see �Modifying and Adding 
Linear Regression Lines� on page 266.

Figure 8�44
The Results Panel of the

Linear Regression Dialog
Box
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To add prediction and confidence lines:

1. Choose the Statistics menu Linear Regression command, then select the Confi-
dence Intervals tab from the Linear Regression dialog box.

2. Choose the method of prediction to use from the Method list. Select either 95% 
or 99% for confidence and prediction intervals.

3. Select the Confidence Interval and/or Prediction Interval option and select a line 
type and color, then use the thickness slider control or edit box to set line thick-
ness. Line color, type, and thickness options work identically to the regression 
line type, color, and thickness options.

4. Click Apply to apply options, or OK (or Close) to apply options and close the 
dialog box.

For information on viewing confidence and prediction interval results, see �Viewing 
and Saving Regression Equation Results� on page 267.

Linear Regression,
Confidence, and

Prediction
Calculation

 Regression Calculation:  SigmaPlot linear regression uses least squares to fit a set of 
data points (xi, yi) i = 1, ..., n to a polynomial of order p where:

In vector-matrix notation this problem is formulated as:

where the n x 1 vector containing the y i data is:

Figure 8�45
The Confidence Intervals

Panel of the Linear
Regression Dialog Box

y β0 β1x β2x 2 ... βpx p+ + + +=

Y Xβ ε+=

Y y1 y2 …yn=
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and the n x (p +1) design matrix is:

 is a (p + 1) x 1 vector of parameters to be estimated:

ε is an n x 1 vector of residuals.

The solution for the least squares estimates of the parameters  is:

SigmaPlot uses the Cholesky decomposition to invert the  matrix (see Dongarra, 
J.J., Bunch, J.R., Moler, C.B., and Stewart, G.W., Linpack User's Guide , SIAM, 
Philadelphia, 1979). This produces the regression curve

For further details on matrix linear regression, refer to chapter 2 of Draper, Norman, 
and Smith, Harry, Applied Regression Analysis, Second Edition , John Wiley & Sons, 
Inc., New York, 1981.

 Confidence
Interval Calculation

Given a set of n data points (xi, yi) from two columns in the worksheet, SigmaPlot 
computes the pth order polynomial regression:

where (b0, b1, ..., bp) are the p + 1 estimated parameters and  is the Y value 
predicted for any x0.

X

1 x1 x1
2 … x1

p

1 x2 x2
2 … x2

p

… … … … …
1 xn xn

2 … xn
p

=

β

β β0 β1… βp
=

β

b X′X( ) 1– X′Y=

X′Y

y b0 b1x0 b2x0
2 … bpx0

p+ + + +=

y0 b0 b1x0 b2x0
2 … bpx0

p+ + + +=

y0
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The confidence interval for this calculated regression is defined by the two 
confidence limits:

where X0 is the (p +1) x 1 vector defined by:

X is the n x (p +1) design matrix:

s is obtained from the variance about the regression:

and the t value for n − p − 1 degrees of freedom and the standard normal percentile 
equivalent z (z = 1.96 or 2.576 for 95% and 99% confidence intervals respectively) is 
computed from a six term rational polynomial approximation taken from Sahai, H. 
and Thompson, W., �Comparisons of Approximation to the Percentile of t, χ2, and 
F Distributions,� Journal of Statistical Computation and Simulation , 1974, Vol. 3, pp. 
81-93. 

Prediction
Interval Calculation

The prediction interval is calculated using the following equation:

y0 t n p– 1–( )s X′0 X′X( ) 1– X0±

X0 1 x0 x0
2 … x0

p=

X

1 x1 x1
2 … x1

p

1 x2 x2
2 … x2

p

… … … … …
1 xn xn
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p

=

s2
yi yi–( )2

n 2–( )
---------------------

i 1=

n
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y0 t n p– 1–( )s 1 X′0 X′X( ) 1– X0+±
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Adding Reference
Lines

You can add horizontal or vertical lines at specific locations using the Graph 
Properties Plots panel Reference settings. Reference lines can be used to draw lines at 
specific values, to set quality control limits, and specify other reference values.

Σ Bar and stacked bar charts automatically place a reference line at the zero value. 

Up to five reference lines can be added. All lines can be drawn only horizontally or 
vertically as a set. The Reference settings display the current calculation, line type, 
label, and color for each line. 

Σ One set of five reference lines, either horizontal or vertical, can be drawn for each 
plot. If you need more than five lines or need both horizontal and vertical lines, you 
must create an additional plot. For information on creating multiple plots, see 
�Multiple Plots on a Graph: Adding New Plots� on page 170.

Drawing
Reference Lines

To draw reference lines:

1. Double-click the plot to open the Graph Properties dialog box, and select the 
Reference option from the Settings For list.

You can also select the plot and click the  button, or choose the Graph menu 

Graph Properties command, then select Reference from the Settings For list.
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Figure 8�46
Graphs Using

Reference Lines

Reference lines can be drawn
at both constants and at
automatically calculated

statistics.
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2. Select a reference lines to draw by selecting its check box. You can add up to five 
lines for each plot. The default names and calculations are the names commonly 
used when employing reference lines for quality control charts.

3. To change the reference line name, select the line from the list, then edit the 
Label box for that line. 

To display the label next to the reference line, check either the Left and/or Right 
check boxes for horizontal reference lines, or Top and/or Bottom check boxes for 
vertical reference lines. 

4. To change the value or statistic used for the line, select an option from the Calc 
list. 

If you are not using a mean as the calculation, type a value to multiply the statis-
tic by, or a value to use as a constant, in the box next to the Calc list. The calcu-
lation options apply only to the reference line highlighted in the Graph 
Properties dialog box list of reference lines.

To set the reference line value to a specific value, select the Constant Calc 
option, and enter the value to the right.

Automatically calculated statistics are derived from the plot data. All data points 
graphed, including multiple columns of data, are used for reference line calcula-
tions. 

5. Use the Appearance options to set a line type, thickness, and color for the high-
lighted reference line. Each reference line can have separate line attributes.

6. Use the Direction list to draw reference lines horizontally or vertically. 

7. Use the Layering list to draw reference lines either Behind or In Front of the 
selected plot. 

Figure 8�47
The Reference Settings of

the Graph Properties
Dialog Plots Panel
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8. Click Apply when finished modifying the current reference line, then highlight 
another reference line to continue modifying reference lines, or click OK.

Creating Multiple 2D Axes 0

 About Axes
and Plots

New pairs of X or Y axes can be created if you have more than one plot on a graph 
and you want to scale these plots differently. 

Σ Additional axes can only be created for 2D Cartesian plots. 

To learn about adding a plot to a graph, see  �Multiple Plots on a Graph: Adding New 
Plots� on page 170. More more information on working with grids and axes, see 
�Modifying Axes and Grids� on page 199.

Creating
Additional Axes for

Multiple Plots

If you have more than one plot on a graph and want to use multiple axes, use the 
following steps to add additional axes.

To create additional an additional axis:

1. Right-click the plot you want to add a new axis for.

2. Choose Add New Axis. The Graph Wizard appears.

You can also select the graph to modify, then choose the Graph menu Add Axis 
command to open the Graph Wizard � Add Axis dialog box. This command remains 
dimmed until you create additional plots. 

If necessary, select the plot to add the new axis to, then click Next.

3. Select to create either a new X axis or Y axis for the specified plot.

Figure 8�48
Using the Graph Wizard -

Add Axis Dialog Box to
Select the Plot for the New

Axis
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4. Click Next. 

5. Select which side of the graph to add the new axis to. You can add the new axis 
to the left, right, top, or bottom of the graph. Selecting an Offset location moves 
the new axis slightly to the side, top, or bottom of the original axis.   

6. Click Finish to add the new axis according to the specified settings. The New 
axis appears on the graph, and the plot re-scales to reflect the new axis. 

Figure 8�49
Selecting to Create a New

Y Axis for the Selected Plot

Figure 8�50
Specifying Where to Place

the New Y Axis on the Graph
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Creating Multiple
Axes for a Single Plot

If you want to use two or more X or Y axes for a single plot (for example, to show two 
different units of measurement), you can create a plot which graphs empty columns, 
then add an axis to the empty plot.

1. Add a second plot to that graph. Right-click the graph and choose Add New 
Plot, or select the graph, then use the graph toolbar or the graph wizard. The 
plot type does not matter, so long as it is a 2D Cartesian plot.

2. Pick any data format. When prompted to select the data to plot, pick empty col-
umns.

3. To create multiple axes, use the Graph menu Add Axis command. Create an axis 
for this �dummy� plot at the desired location

4. Select the new axis, then use manual scaling to set the appropriate range and tick 
interval for the new axis. This scale is often a linear transformation of the oppo-
site axis scale, for example, a Celsius scale to a Fahrenheit scale.    

To learn more about creating and modifying axes, see �Modifying Axes and Grids� 
on page 199.
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The second temperature
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Notes 0
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Working with 3D and Contour 
Graphs

This chapter describes 3D graphs and procedures specific to 3D graphs. To learn 
about making general graph modifications like changing symbols, lines, or fills, see 
�Creating and Modifying Graphs� on page 151. 

This chapter covers:

➤ Basic 3D plot types and styles (see below)

➤ Arranging data for contour Plots and 3D graphs (see page 279)

➤ Creating 3D scatter, trajectory, and bar charts (see page 283)

➤ Creating mesh plots (see page 285)

➤ Converting unordered XYZ triplet data to mesh format (see page 287)

➤ Changing mesh plot attributes (see page 291)

➤ Changing the rotation and lighting for 3D graphs (see page 292)

➤ Understanding 3D axis placement (see page 296)

➤ Modifying the frame lines for 3D graphs (see page 296)

➤ Generating more data for mesh plots (see page 298)

➤ Generating data for a 3D function (see page 300)

➤ Creating contour plots (see page 302)

➤ Modifying contour lines and labels (see page 304)

3D Plots 0

3D (XYZ) plots can be created from many worksheet columns or column triplets. 
XYZ plots must have at least one plot, but can hold many more plots, each with a 
different type and style. Graphs can be rotated and shading can be added to enhance 
the height and depth of mesh and bar charts. To learn about rotating graphs, see 
�Changing Graph Perspective, Rotation, and Shading� on page 292. For information 
on adding a light source to 3D graphs to produce shading, see �Changing the View 
of a 3D Graph� on page 292.

9
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3D Scatter and
Trajectory Plots

3D scatter and trajectory plots graph data as symbols, as lines only with no symbols, 
or as symbols and lines. Use the Graph Properties dialog box Plots panel Symbols 
settings to add symbols to a trajectory plot, or the Lines settings to add lines to a 
scatter plot. To learn about modifying or adding symbols and lines, see �Changing 
Symbol Type and Other Symbol Options� on page 176, and �Changing Line Type 
and Other Line Options� on page 185. 

Drop lines to any back plane can be added to either of these plot types. For more 
information on adding drop lines, see �Adding and Modifying Drop Lines� on 
page 196. 

Mesh Plots Mesh plots graph 3D data as a continuous surface with a mesh. Use the Graph 
Properties dialog box to modify mesh lines, color, transparency, and to enable the 
light source for shading. To learn more about modifying meshes, see �Changing 
Mesh Lines and Fill Color� on page 291 and to learn about using the light source, see 
�Changing the View of a 3D Graph� on page 292. 

3D Bar Charts Create bar charts in 3D space using 3D data. Modify 3D bar charts by changing fill 
color and pattern, and adjusting bar width and spacing.

Figure 9�1
Examples of

a 3D Scatter Plot and
a Trajectory Plot

Figure 9�2
Examples of

a Mesh Plot with No
Fill Color and with a

Gradient of Colors
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For information on changing bar chart fill color and pattern, see �Changing Patterns 
and Fill Colors� on page 188. To learn about modifying bar width and spacing, see 
�Changing Bar and Box Widths and Spacing� on page 193. 

Arranging Data for Contour Plots and 3D Graphs 0

Organize data for SigmaPlot graphs by column. Typically, data for contour plots and 
3D graphs is composed of X, Y, and Z value columns, or one or more Z columns and 
optional X and Y columns. 3D bar charts, scatter plots, and line plots can use any 
three columns as XYZ data; however, contour and mesh plots require a strict 
arrangement of the data.

Σ   If multiple Z columns are plotted, they must be continuous, that is, they all must be 
next to each other. The X and Y columns can be located anywhere.

Data for
3D Bar Charts,

3D Scatter Plots,
 and 3D Line Plots

Data for 3D bar charts, scatter plots, and line plots can be arranged either as XYZ 
triplet data, multiple columns of Z data, or as a single column for Y values, a single 
column for X values, and multiple columns for Z values. For each of these graph 
types, the data in each row is graphed as a data point. For bar charts, each column of 
Z data is plotted as a row parallel to either the X axis, with Y values as the constants.

If you are formatting XYZ triplet data, you also can use one of the multiple Z 
column formats designed for 3D mesh plots. For more information, see �Data for 
Contour and Mesh Plots� on page 280. 

Σ 3D bar charts cannot use XYZ triplet data; however, you can plot your data using the 
X,Y, many Z format without having more than one Z column. For 3D scatter plots, 
the data can be entered in any order. 

Figure 9�3
An Example of a

3D Bar Chart
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Data for Contour and
Mesh Plots

Data for a contour or mesh plot requires XYZ coordinates for each intersection of a 
rectangular mesh. 

The arrangement of this data for the three possible methods of picking columns to 
plot are described in the following sections.

X, Y, and Z Data in Three Columns:   To plot three columns as the X, Y, and Z 
values of a contour or mesh plot, the data must be in long form mesh format. This 
format assigns the proper Z value to each X and Y point in the mesh, in the required 
order. 

For example, for the table of X, Y, and Z values shown above, the three column mesh 
format must be arranged as: 

 Y1 Y2 Y3  Y4

X1 Z1 Z4 Z7 Z10

X2 Z2 Z5 Z8 Z11

X3 Z3 Z6 Z9 Z12

X data Y data Z data

X1 Y1 Z1

X2 Y1 Z2

X3 Y1 Z3

X1 Y2 Z4

X2  Y2 Z5

X3 Y2 Z6

X1 Y3 Z7

X2 Y3 Z8

X3 Y3 Z9

X1 Y4 Z10

X2 Y4 Z11

X3  Y4 Z12
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This arrangement places the XYZ data point coordinate values in the required order. 
The XYZ columns must be the same length.

 X and Y Columns vs. Many Z Columns: You can also place the X and Y data in 
single columns, then place the corresponding Z data in many continuous columns. 
This method may work best if you have XYZ data laid out in a table, or if you have 
irregularly incremented X or Y values. 

To use this option, your Z columns must be contiguous, you should have as many Z 
columns as you have Y rows, and the Z columns should be the same length as the X 
column.

The data in the first Z column is assigned to the first Y value, the data in the second 
Z column to the second Y value, etc. 

Figure 9�4
Data Arranged in

Long Form Mesh Format

X data Y data Z data

X1 Y1 Z1 Z4 Z7 Z10

X2 Y2 Z2 Z5 Z8 Z11

X3 Y3 Z3 Z6 Z9 Z12

Y4
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The data in each row of the X column is assigned as the X value for the data in the 
same row in the Z columns. 

The X and Y data must be strictly ascending or descending. Note that in this case, 
you can use columns of uneven length. Extra X, Y, or Z values created by uneven 
columns are not plotted, as mesh plots cannot graph missing values.

Z Data vs. Row and Column Numbers: You can also plot columns as Z values 
versus the cell columns and row numbers as the X and Y values. 

This is the appropriate column assignment option to use: for mesh plots and 3D Bar 
Charts where X and Y values are evenly and equally spaced; for example, when 
graphing pixel intensity data for an image.

All data is assigned as a Z value, and the Z columns must be contiguous. To use this 
format for a mesh plot, no special data arrangement is required other than equal 
column length. The rows and columns of the cells can be used as either the X or Y 
values.

Figure 9�5
XYZ Data Arranged
as One X Column,

One Y Column, and
Many Z Columns

Figure 9�6
Mesh Plot Data Arranged

as Z Data Versus Row
and Column Numbers
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Creating 3D Scatter Plots, Trajectory Plots, and Bar Charts 0

To create a 3D scatter plot, trajectory plot, or bar chart:

1. If you want to select worksheet data before creating the graph, select the work-
sheet columns to plot by dragging the pointer over your data. Note that you do 
not have to select data before you start a graph; you can select the columns to 
plot during graph creation.

2. Select the desired graph type and style from the graph toolbar. You can also click 

the toolbar  button, or choose the Graph menu Create Graph command. 
The Graph Wizard appears. 

Σ Note that during the graph creation process, the left side of the Graph Wizard 
changes depending on what is selected on the right side of the dialog box. 

3. If you did not use the graph toolbar to open the Graph Wizard, select the type of 
graph you want to make from the scroll box in the dialog box. Use the scroll bars 
to view the entire list. Select the desired graph type, then click the Next button. 

4. Specify how your data is formatted by choosing the appropriate data format 
from the Data Format list. The data formats available depend on the graph type 
you are making. Choose the appropriate data format, then click Next.

Scatter and trajectory plots can use any data format; however, bar charts are lim-
ited to XY Many Z or Many Z only. For more information on the available data 
formats for the graph you are making, see the description of the graph type in 

Figure 9�7
The Graph Wizard
Displaying a List

of Graph Types
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�SigmaPlot Graph Types� on page 153. 

5. Specify which worksheet columns correspond to the data for your plot. If you 
selected columns prior to opening the Graph Wizard, your choices automatically 
appear in the dialog box and you can click Finish to create the graph.

If you have not already picked columns, note that a single data type is high-
lighted in the Selected Columns box. This shows the data type you are picking a 
column for. Begin picking data either by clicking the corresponding column 
directly in the worksheet, or choosing the appropriate column from the Data 
Columns list. Repeat this process for every column you are using to create your 
graph.

6. If you make a mistake while picking data, select the wrong entry in the Graph 
Wizard, then choose the correct column from the worksheet.

7. When you are done picking data, click Finish to create the plot and close the 
Graph Wizard.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard 
to pick different data columns for your plot, or to add another plot to your graph. 
For more information on making general modifications to your plot, see �Creating 
and Modifying Graphs� on page 151.  

Figure 9�8
Using the Graph Wizard to

Specify the Data Format

Figure 9�9
Using the Graph Wizard to

Pick Columns to Plot
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Creating Mesh Plots 0

When you create a mesh plot you can choose between solid and transparent mesh 
with discrete or gradient shading. A transparent mesh can be used to highlight the 
relationship of one mesh plot to another on the same graph.

To create a 3D mesh plot:

1. If you want to select worksheet data before creating the graph, select the col-
umns to plot by dragging the pointer over your data. Note that you do not have 
to select data before you start a graph; you can select the columns to plot during 
graph creation. For more information on data formats for mesh plots, see �3D 
Plots� on page 277.

2. Select the desired graph type and style from the graph toolbar. You can also click 

the toolbar  button, or choose the Graph menu Create Graph command. 
The Graph Wizard appears. 

Σ Note that during the graph creation process, the left side of the Graph Wizard 
changes depending on what is selected on the right side of the dialog box. 

3. If you did not use the graph toolbar to open the Graph Wizard, select the type of 
graph you want to make from the scroll box in the dialog box. Use the scroll bars 
to view the entire list. Select the desired graph type, then click the Next button. 

Figure 9�10
The Graph Wizard
Displaying a List

of Graph Types
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4. Specify how your data is formatted by choosing the appropriate data format 
from the Data Format list. Choose either XYZ triplet data, many Z columns, or 
single X and Y columns with many Z columns, then click Next.

Σ 3D mesh plots use an XYZ coordinate system; the data points are graphed as 
intersections of a mesh grid. If you select Many Z as the data format, SigmaPlot 
uses column numbers as the X values, and row numbers as the Y values. If you 
are using XYZ triplet data, you may need to reformat the data. For more 
information on using XYZ triplet data for a mesh plot, see �Converting 
Unordered XYZ Triplet Data to Mesh Format� on page 287.

5. Specify which worksheet columns correspond to the data for your plot. If you 
selected columns prior to opening the Graph Wizard, your choices automatically 
appear in the dialog box and you can click Finish to create the graph.

If you have not already picked columns, note that a single data type is high-
lighted in the Selected Columns box. This shows the data type you are picking a 
column for. Begin picking data either by clicking the corresponding column 
directly in the worksheet, or choosing the appropriate column from the Data 
Columns list. Repeat this process for every column you are using to create your 
graph.

6. If you make a mistake while picking data, select the wrong entry in the Graph 
Wizard, then choose the correct column from the worksheet.

Figure 9�11
Using the Graph Wizard to

Specify the Data Format

Figure 9�12
Using the Create

Graph Dialog Box to Pick
Columns to Plot
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7. When you are done picking data, click Next to pick data for an additional mesh 
plot, or click Finish to create the plot and close the Graph Wizard.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard 
to pick different data columns for your plot, or to add another plot to your graph. 
For more information on making general modifications to your plot, see �Creating 
and Modifying Graphs� on page 151. For information on changing mesh attributes, 
see �Changing Mesh Lines and Fill Color� on page 291. 

Converting Unordered XYZ Triplet Data to Mesh Format 0

To convert a three column XYZ scatter plot to a mesh plot or take 3D scatter data 
and create a 2D contour plot, you can interpolate the mesh grid and graph the new 
data points as a contour or mesh plot. 

Σ Note that because the inverse distance algorithm looks at the value of every original 
data point when calculating the value for each interpolated data point, large data sets 
will take a long time to process.

To interpolate mesh data:

1. Choose the Transforms menu Interpolate 3D Mesh command. The Interpolate 
Mesh Column Picker dialog box appears prompting you to select the source col-
umn for the X data.

2. Select the column with the original X data from the worksheet or the Data 
Source list. The selected column is assigned as the X Source in the Selected Col-
umns list and you are prompted to select the Y data source. 

3. Select the Y and Z columns from the worksheet or the Data Source list. You are 
prompted to select the X data destination column.

4. Select the X, Y, and Z destination columns as prompted, then click Finish. The 
Interpolate 3D Mesh dialog box appears.

Figure 9�13
Selecting the Data

Columns to Interpolate
from the Interpolate

Mesh Column Picker Dialog
Box
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5. If desired, change the Minimum and Maximum for the X and Y values to new 
beginning and ending values for the X and Y ranges. The X and Y Minimum 
and Maximum options display the minimum and maximum X and Y mesh val-
ues for the mesh. The default values are the smallest and largest values in the X 
and Y columns. 

6. If desired, change the X and Y Intervals options. This is the number of intervals; 
the number of spaces created between the mesh lines.

7. If desired, change the Weight option value used to determine the weight of dis-
tant points in effecting the interpolation of values. Using a smaller weight results 
in a mesh that passes further away from the original data. A larger weight places 
greater emphasis on the nearest data points, resulting in a mesh passing closer to 
the data. For examples of the effects of different weight values, see Figure 9�16.

Σ If you use a low weight value and your original data points do not fall on the 
mesh intersections, the resulting mesh will not pass through the original data. 
You can either ensure that each original data point falls on a mesh intersection 
(using the Number of X and Y Values options), or use a higher weight value.

8. Click OK. Three columns of data�X, Y, and Z�are placed in the previously 
selected columns.

9. To graph the data, choose the Graph menu Create Graph command and create 
either a new contour plot or 3D mesh plot. For an existing 3D scatter plot, 

select the plot, click the toolbar Graph Wizard button , click Back, select 3D 

Mesh Plot, select XYZ as the data format, then repick the interpolated data as 
the data to plot.

For instructions on plotting XYZ data as a mesh plot, see �Creating Mesh Plots� on 
page 285. 

Effects of
Weight Values

The effect of changing the weight value varies from data set to data set. The effect 
depends on the differences in the Z values, the ratio of the number of original data 
points to the number of interpolated data points, and the number of grid lines (X 
and Y values). Low weights tend to produce a surface with spikes at the data points; 
large weights produce step-like surfaces.

Figure 9�14
The Interpolate

3D Mesh Dialog Box
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You may have to experiment with different weight values to determine the best 
results. Weights between 2 to 5 are generally recommended. For a mathematical 
description of the weight value, see the following section, �Inverse Distance Method� 
on page 289.

 Inverse
Distance Method

SigmaPlot uses an inverse distance method to generate Z values for an evenly spaced 
XY grid from XYZ triplet data.

Given n (x,y,z) triplets (x1,y1,z1), (x2,y2,z2),(xn,yn,zn), and a mesh of Xint uniformly 
spaced X intervals from xmin to xmax and Yint uniformly spaced Y intervals from ymin 

Figure 9�15
A Scatter Plot and a

Mesh Plot of the
Interpolation Results

The interpolation used a
weight of 3.0.

Figure 9�16
The Effect of Different

Weight Values on
Mesh Interpolation

From top left clockwise:
original scatter data,

 weight value of 1, a weight
of 2, and a weight of 3.

Note that for a weight
of 1, the mesh does not

pass through the highest data
points, as the XY coordinates

of the mesh points do not
coincide with the original

data points.
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to ymax, interpolated Z values are computed, corresponding to the X and 
Y values at the intersection of the  grid.
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where:

p is the distance weight value that can be specified in the Interpolate 3D Mesh. 

Changing Mesh Lines and Fill Color 0

To modify mesh lines and fill color:

1. Open the Graph Properties dialog box to the Plots panel by double-clicking the 
plot. If you double-clicked the plot, the dialog box should open directly to the 
Mesh panel. If not, select the Mesh option from the Settings For list. 

You can also select the plot, click the Graph Properties toolbar  button or 

choose the Graph menu Graph Properties command, then select the Mesh 
option from the Settings For list. 

2. To change the color of the mesh,  use the Fill Colors options. Use the Color list 
to set a mesh color; selecting (none) creates a transparent mesh, selecting (cus-
tom) enables you to use a custom color or to create a color of your own (see 
�Using Custom Colors� on page 146), and selecting one of the color schemes or 
color columns increments the mesh from bottom to top using a color array. For 
information on using custom colors from a column, see �Using Custom Sym-
bol, Fill, Line, and Color Increments� on page 191.

3. Select the Transparent check box to make your mesh translucent; objects behind 
it will be visible. Using the transparent option enables you to more clearly show 

wi xi x–( )2
yi y–( )2+[ ]

p
2
---–

=

Figure 9�17
The Mesh Settings of the

Graph Properties Dialog Box
Plots Panel
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the intersections between two or more 3D meshes. 

Σ You need to set your display to High Color (16 bit) or True Color (24 bit) for 
this feature to work properly. You may check your system�s color capabilities 
under the Windows Display Properties Settings.

4. If you are using a color scheme, use the Transition list to specify how the colors 
flow across the grid. Choose Discrete to use an increment with a clear shift 
between colors, or choose Gradient to use an increment with a gradual shift 
between colors. 

Σ The Transition list is available only when using a fill color scheme.

5. To change mesh lines,  use the Lines options. Use the Color list to change line 
color. Selecting (none) creates transparent mesh lines, and selecting (custom) 
enables you to use or create a custom color. For more information on using cus-
tom colors, see �Using Custom Colors� on page 146. 

6. Use the Thickness slider control to change line thickness, or select the Thickness 
edit box and type a new thickness value.

7. Click Apply to apply your changes without closing the dialog box, or click OK 
to apply your changes and close the dialog box.

Changing Graph Perspective, Rotation, and Shading 0

Modify the view of the 3D graph by changing perspective and rotation of the graph, 
and by enabling a light source to add shading. 

Changing the View
of a 3D Graph

To change the perspective of a 3D graph, rotate a graph, and enable the light 
source:

1. Double-click the plot to open the Graph Properties dialog box, then click the 

3D View tab. You can also select the plot, click the Graph Properties toolbar  

button or choose the Graph menu Graph Properties command, then select the 
3D View tab. 

2. From the Settings For list, choose Rotation to view the rotation, perspective and 
light source options. Note that this panel has a Preview box that shows how the 
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current settings affect the selected graph.

3. To rotate the graph, use the Horizontal View and Vertical View slider controls, 
or select the edit boxes and type a horizontal or vertical value. 

Σ Horizontal and vertical values are in degrees. Rotate the graph horizontally from 
0° to 360°, or vertically from −90° to +90°. The recommended Horizontal View 
is 205°, and the Vertical View is 25°

The three solid red axes displayed in the Preview box of the 3D View panel are 
the origin axes for the rotation, and are used as reference when determining the 
angles of rotation. The rotation is displayed in the axes degrees from 0°. The ori-
gin used to determine the degree from the horizontal or vertical is the intersec-
tion of the three axes.

When both rotation angles are set to 0°, the origin as you see the graph, is the 
left bottom rear corner.

Σ The origin axes are not related to the axes marked with ticks and tick labels, but 
act as the zero point for tick labels and data.

Figure 9�18
The Rotation Settings of

 the Graph Properties
 3D View Panel

Figure 9�19
A 3D graph with a horizontal

rotation of 0°, a vertical
rotation of 0°, and a

perspective of 20.
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4. To change the perspective of the graph,  use the Perspective slider control, or 
select the perspective edit box and type a new value. 

Σ The Perspective value is based on the �depth� of the graph. A perspective of 0% 
means that the graph has no depth; 100% means that the graph has maximum 
depth. The recommended perspective is 20%.

5. To enable the light source and create shading on your graph,  check the Enable 
Light Source check box by selecting it. If the check box is not checked, the light 
source is not applied to the graph.

Figure 9�20
A 3D graph with a horizontal

rotation of 0°, a vertical
rotation of 45°, and a

perspective of 20.

Figure 9�21
A 3D graph with a horizontal

rotation of 45°, a vertical
rotation of 45°, and a

perspective of 20.

Figure 9�22
A 3D graph with a
perspective of 0.
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Σ You need to set your display to High Color (16 bit) or True Color (24 bit) for 
this feature to work properly. You may check your system�s color capabilities 
under the Windows Display Properties Settings. 

Σ Trajectory and scatter plots are not affected by the light source option.

Figure 9�23
A 3D graph with a
perspective of 50.

Figure 9�24
A 3D graph with a

perspective of 100.

Figure 9�25
The graph on the right

has the light source
option selected.
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6. To return to the 3D View settings you had before applying any changes,  click 
Revert To Original Settings.

7. Click Apply to apply changes, or OK to apply changes and close the dialog box. 

3D Graph Axis Placement 0

3D axes are always at the following positions:

X: bottom right front
Y: bottom left front
Z: left front 

Axis Placement
During Graph

Rotation

When you rotate the view of a 3D graph, SigmaPlot automatically repositions the 
visible axes to the front of the graph so that the axes do not become positioned 
behind the graph.

For more information on rotating 3D graphs, see �Changing Graph Perspective, 
Rotation, and Shading� on page 292.    

Frame Lines for a 3D Graph 0

Drawing, Modifying,
and Hiding

Frame Lines

Drawing a 3D graph frame completes the �cube� surrounding the plotted data. 
Normally, these lines are hidden. You can use a frame to mark the origin axes, or to 
mark the 3D extent of the graph.

Σ Frame lines are unrelated to the lines used to draw axes and planes, and are controlled 
independently of those lines. Frame lines are drawn over the axes.

To add frame lines, modify frame lines, or hide frame lines from view:

1. Double-click the plot to open the Graph Properties dialog box, then click the 

3D View tab. You can also select the plot, click the Graph Properties toolbar  

button or choose the Graph menu Graph Properties command, then select the 
3D View tab. 
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2. From the Settings For list, choose Frame Lines. The frame line options appear. 

3. Use the Frame Lines list to modify frame lines Relative To Viewer, or Relative To 
Graph Origin.

Relative To Viewer: If the frame is oriented from your perspective, one set of 
lines is composed of the three cube edges closest to you, and the other lines are 
the remaining sides of the cube. The position of these lines is independent of the 
graph's rotation. This is the default position.

Relative To Graph Origin: If the frame is drawn according to the origin, one set 
of the lines is drawn over the origin axes (see page 293), and the other lines draw 
the remainder of the cube. The position of these lines is dependent on the 
graph's rotation.

Figure 9�26
The Frame Lines Settings

of the Graph Properties
3D View Panel

Figure 9�27
These graphs use the
Viewer as the point of

reference. The graph on the
left draws only the �front�
lines, and the right graph

draws only the �back� lines.

The position of these lines
is independent of the

graph rotation.
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4. Hide frame lines, or add frame lines to your graph by selecting or clearing the 
appropriate Show check box. Checked frame lines are drawn. 

Σ A graph cannot display frame lines for both the Relative To Viewer and Relative 
To Graph Origin perspectives. If Relative To Graph Origin is selected from the 
Frame Lines list, the Show check boxes for Relative To Viewer are cleared 
automatically, and vice versa. 

5. Use the Type list to change frame line type, and the Color list to change frame 
line color. Choosing (none) from either list creates transparent frame lines. 
Choosing (custom) from the color list enables you to use or create a custom 
color. For more information on using custom colors, see �Using Custom Colors� 
on page 146.

6. Use the Thickness slider control to the modify frame line thickness, or select the 
thickness edit box and type a new thickness value.

7. Click Apply to apply changes without closing the dialog box, or click OK to 
apply changes and close the dialog box. 

Generating More Data for a Mesh Plot 0

The Transforms menu Interpolate 3D Mesh command can be used to increase the 
number of contours or grids in an existing mesh plot by generating additional mesh 
data. This method only applies to mesh data arranged in three column format.

1. View the worksheet, and choose the Transforms menu Interpolate 3D Mesh 
command.

2. Select the current X, Y, and Z mesh data columns, then select the destination 
columns, and click Finish.

Change the X and Y Intervals to be exactly twice the current number of X and Y 

Figure 9�28
These graphs use the Origin

as the point of reference.
The graph on the left draws

only the origin lines, and the
right graph draws only the

non-origin lines.

The position of these lines
is dependent on the

graph rotation.
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mesh intervals. Note that the default displayed value does not reflect the number 
of X or Y intervals in the current mesh.

Note that if you create more than twice the original intervals, the resulting mesh 
contains the �peaks� and �valleys� associated with inverse distance interpolation.

3. Enter a weight of at least 5, then click OK. Three columns of interpolated mesh 
data�X, Y, and Z�are placed in the previously selected columns. 

4. Select the plot, click the toolbar  button, accept the existing data format, 
click Next, then repick the interpolated mesh data as the data for the current 3D 
graph. For instructions on plotting XYZ data, see �Creating Mesh Plots� on page 285.  

Figure 9�29
Mesh Plots Before

and After Interpolation
For More Grid Points

The original number of X
and Y values is 5 each; the

numbers used for the
interpolation are 9 each.
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Generating Data for a 3D Function 0

You can use the MESH.XFM transform to generate XYZ mesh data for any 3D 
function. The transform results are automatically placed in worksheet columns 1, 2, 
and 3, so make sure these columns are empty, or edit the transform to specify new 
columns.

To use the MESH.XFM transform:

1. Choose the Transforms menu User-Defined command or press F10. The User-
Defined Transform window opens.

2. Click Open, then open the MESH.XFM file in the SPW5\XFMS directory. The 
transform appears in the edit box. 

3. Select the edit box, move to the line below the comment 

4. Enter your function here and then type in your function using the transform 
language. You can erase the existing example function. For an explanation of 
transform syntax, see the Programming Guide .

5. Enter the X and Y ranges and increments. Replace the existing x_min, x_max, 
x_increment, y_min, y_max, and y_increment variable values with your own.

6. When finished, click Execute. The X values are placed in column 1, the Y values 
in column 2, and the Z values in column 3.

Figure 9�30
Generating XYZ Mesh Data

for a 3D Function Using
the MESH.XFM Transform
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Note that you can redirect the results to different columns by changing the col-
umn numbers in the transform.

7. To create the graph, choose the Graph menu Create Graph command and select 
3D Mesh Plot as the graph type, XYZ Triplet as the data format, then select col-
umn 1 as the X column, column 2 as the Y column, and column 3 as the Z col-
umn (or whatever column you specified in the transform). 

For more information on plotting XYZ data, see �3D Plots� on page 277. For an 
in-depth discussion of transforms, refer to the Programming Guide . 

Figure 9�31
A Graph of the Sample Data

Generated by the
MESH.XFM Transform
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Creating Contour Plots 0

Contour graphs plot 3D data on an XY coordinate system with the Z data (vertical) 
indicated with lines at specified Z intervals. 

To create a contour plot:

1. If you want to select worksheet data before creating the graph, select the work-
sheet columns to plot by dragging the pointer over your data. Note that you do 
not have to select data before you start a graph; you can select the columns to 
plot during graph creation.

2. Select a contour graph from the graph toolbar. You can also click the toolbar  
button, or choose the Graph menu Create Graph command. The Graph Wizard 
appears. 

Σ Note that during the graph creation process, the left side of the Graph Wizard 
changes depending on what is selected on the right side of the dialog box. 

Figure 9�32
Examples of Contour Plots
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3. If you did not use the graph toolbar to open the Graph Wizard, select Contour 
Plot as the graph type, then click Next. Use the scroll bars to view the entire list. 

4. Specify how your data is formatted by selecting the appropriate data format 
from the Data Format list. Choose either XYZ triplet data, many Z columns, or 
single X and Y columns with many Z columns.

Σ Contour plots use an XYZ coordinate system. If you select Many Z as the data 
format, SigmaPlot uses column numbers as the X values, and row numbers as 
the Y values.

Σ If you are using XYZ triplet data, it may need to be reformatted as mesh data. 
For more information on using XYZ triplet format, see �Converting Unordered 
XYZ Triplet Data to Mesh Format� on page 287.

5. Click Next. The Graph Wizard prompts you  to specify which worksheet col-
umns correspond to the data for your plot. If you selected columns prior to 
opening the Graph Wizard, your choices automatically appear in the Selected 
Columns list, and you can click Finish to create the graph.

If you have not already picked columns, note that a single data format is high-
lighted in the Selected Columns list, indicating the data type you are picking a 
column for. 

Figure 9�33
The Graph Wizard
Displaying a List

of Graph Types

Figure 9�34
Using the Graph Wizard to

Specify the Data Format
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6. Pick data either by clicking the corresponding column directly in the worksheet, 
or choosing the appropriate column from the Data list. Repeat this process for 
every column you are using to create your graph.

If you make a mistake while picking data, click the wrong entry in the Selected 
Columns list, then select the correct column from the worksheet. You can also 
clear a column assignment by double-clicking it the Selected Columns list.

7. Click Finish when you are done picking your data. The Graph Wizard closes 
and the specified contour plot appears. 

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard 
to pick different data columns for your plot, or to add another plot to your graph. 
For more information on making general modifications to your plot, see �Creating 
and Modifying Graphs� on page 151. 

Modifying Contour Plots 0

Modifying contour plots involves:

➤ Picking new data for the plot (see �Picking Different Data for the Current Plot� 
on page 168).

➤ Changing contour line attributes, and hiding or displaying lines (see 
�Displaying and Changing Contour Lines� on page 305).

➤ Modifying back plane color and grid lines (see �Modifying Grids and Planes, 
Titles and Legends� on page 164 ).

➤ Changing the vertical (Z data) range and scale (see �Changing Contour Vertical 
(Z Data) Range and Scale� on page 306).

Figure 9�35
Using the Create

Graph Dialog Box to Pick
Columns to Plot
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➤ Changing X and Y axis and tick attributes (see �Modifying Axes and Grids� on 
page 199).

➤ Changing and displaying contour labels (see �Displaying and Modifying 
Contour Labels� on page 307).

To modify a contour plot, select the graph and open the Graph Properties dialog box. 
To learn about selecting graphs and using the Graph Properties dialog box, see 
�Using the Graph Properties Dialog Box to Modify Graphs� on page 163 , and 
�Selecting a Graph or a Plot� on page 165. 

Displaying and
Changing

Contour Lines

To hide, display, and modify contour plot lines:

1. Open the Graph Properties dialog box to the Contours settings in the Plots 
panel by double-clicking the plot, selecting the Plots tab, then select Contours 
from the Settings For list.

You can also select the plot, click the Graph Properties toolbar  button or 

choose the Graph menu Graph Properties command, then select the Contours 
option. 

2. Display or hide contour lines, by selecting the Major and Minor check boxes. 
Checked options display the lines, and cleared options hide the lines. 

3. Specify the line type of major and minor contour lines,  by selecting a line type 
from the Major and Minor  lists. Select one of the incrementing schemes to 
increment contour line types, or select (none) to create transparent lines. 

To learn about using custom increment schemes, see �Using Custom Symbol, 
Fill, Line, and Color Increments� on page 191.

4. Set the thickness of the contour lines using the Thickness slider control, or by 
typing a new value in the Thickness edit box.

Figure 9�36
The Contours Settings of

 the Graph Properties
Dialog Box Plots Panel
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5. Select the color of the contour lines from the Color list. You can choose from 
several predefined color schemes, or select (none) to create transparent lines. 
Select the (custom) option to create a custom color. For more information see 
�Using Custom Colors� on page 146. 

6. Click Apply to make the changes, or OK to apply your changes and close the 
Graph Properties dialog box. 

Changing Contour
Vertical (Z Data)
Range and Scale

Use the Graph Properties Range settings to select the scale type and set the vertical 
range used by the contour lines. 

To set the scale and range used by contour lines:

1. Double-click the plot to open the Graph Properties dialog box. Select the Plots 
tab, then select Scale from the Settings For list. 

You can also select the plot, click the Graph Properties toolbar  button or 

choose the Graph menu Graph Properties command, then select the Scale 
option.

2. Select a linear or log vertical scale from the Scale Type list. The linear scale uses a 
standard base 10 numeric scale, and the log scale uses a base 10 logarithmic 
scale.

3. To automatically set the range,  select Automatic. SigmaPlot automatically 
determines the vertical range based on the Z data plotted.

4. To manually set the range,  select Manual, then type the beginning and ending 
range values in the From and To edit boxes.

5. Click Apply to assign the range settings without closing the dialog box, or OK to 
apply the range settings and close the dialog box. 

Figure 9�37
The Scale Settings of
the Graph Properties

Dialog Box Plots Panel
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Displaying and
Modifying

Contour Labels

Use the Graph Properties dialog box Label settings to toggle contour line labels on/
off, add prefixes or suffixes to labels, and rotate labels relative to the contour line. For 
information on modifying contour X and Y axis tick labels, �Changing Tick Labels� 
on page 217.

To add, hide, or modify contour line labels:

1. Open the Graph Properties dialog box to the contour label settings by double-
clicking the contour plot, selecting the Plots tab, then selecting Labels from the 
Settings For list.

You can also select the plot, click the Graph Properties toolbar  button or 

choose the Graph menu Graph Properties command, then select the Labels 
option.

2. Display or hide contour labels,  by selecting the Major and Minor Contour 
Label options. Selected options display labels, and cleared options hide labels.

3. Select the Align With Contour Line option to align contour labels parallel to the 
contour line. Clear the option to align the contour labels parallel to the X axis.

4. Use the Label Frequency slider to control how many labels appear for the con-
tour lines. Move the slider toward Fewer to reduce the number of contour labels, 
or move the slider toward More to increase the number of contour labels. 

5. Type the prefix or suffix to add to the contour labels in the Prefix and Suffix edit 
boxes. To separate a suffix or prefix from the tick label, type a space before a suf-
fix or after a prefix.

6. Select Apply to assign the contour label settings without closing the dialog box, 
or click OK to apply the settings and close the dialog box.

Figure 9�38
The Labels Settings of

the Graph Properties
Dialog Box Plots Panel
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Changing Contour
Label Text Attributes

Changing the text attributes for both major and minor contour labels involves 
changing the font, style, size, and color of the text. 

To open the Text Properties dialog box: 

1. Double-click the contour plot, select the Plots panel, then select Details in the 
Settings For list. 

You can also select the plot, click the Graph Properties toolbar  button or 

choose the Graph menu Graph Properties command, then select the Details 
option

2. When the Details settings appear, select the Font button. To learn about using 
the Text Properties dialog box, see �Formatting Text� on page 137. 

Changing
Numeric Contour

Label Settings

Use the Graph Properties Detail settings to modify numeric contour labels.

To change numeric contour labels:

1. Open the Graph Properties dialog box by double-clicking the plot, selecting the 
Plots tab, then selecting Details from the Settings For list. The numeric contour 
settings appear.

2. To use a numeric type of contour label,  select Numeric from the Type list, then 
use the Label Notation options.

3. Specify which type of numeric display to use by selecting the a notation from the 
Use list. 

The Scientific Notation and Engineering Notation options always use scientific 
notation or engineering notation to display numbers. F or large numbers 
options, use scientific or engineering notation only when numbers exceed a 
specified range. Use the Beyond lists to specify the range beyond which scientific 
notation or engineering notation is used.

Figure 9�39
The Details Panel for

Contour Labels
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For log scale, you can select to display number, only the Exponent, or both the 
Base and Exponent. 

For linear scale, you can always use scientific notation, or only when needed. If 
you use scientific notation only when needed, set the range to by typing values 
in the Lower and Upper ranges in the edit boxes. These values are expressed in 
log units.

4. Use the Precision options to specify the number of places used to display 
numeric tick labels. Select Automatic to let SigmaPlot automatically determine 
precision, or select Manual, then select the number of decimal places to use from 
the Places list. 

5. To use a series type of contour label, choose Series from the Type list, then 
select the type of series to use from the Series list. 

6. Select the number of characters to use for the labels from the Length list. 

7. Select the series item to begin labeling tick marks with from the Start At list, 
then select the frequency or increment for the series from the Step By list. 

8. Use the After and Repeat From lists to restart tick labeling from a specified 
point. 

9. To use values or text from a worksheet column, enter the values or text in a 
worksheet column, then choose the column containing tick labels from the 
Series list. 

10. To change the font size, style, or color of text labels, click the Font button to 
open the Text Properties dialog box. To learn about using the Text Properties 
dialog box to format text, see �Formatting Text� on page 137.

11. Click OK to apply your changes and to close the dialog box.   

Figure 9�40
The Series Labels Settings

for Contour Labels
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Using the Report Editor

The SigmaPlot Report Editor is an easy-to-use text processor for annotating and 
documenting your graphs and data. The Report Editor features a complete text 
editor and OLE2 insertion and editing. It is also used by the Regression Wizard to 
report regression results.

This chapter covers:

➤ Creating new reports (see page 312)

➤ Setting report view, toolbar and ruler options (see page 312)

➤ Setting the margins and paper size for a printed report (see page 314)

➤ Using the ruler (see page 315)

➤ Setting tab stops (see page 316)

➤ Indenting paragraphs (see page 317)

➤ Changing text appearance and paragraph alignment (see page 318)

➤ Inserting the current date and time (see page 319)

Figure 10�1
The Report Editor Window

10
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Creating Reports 0

Reports can be created with the New command (see �Creating New Notebook Files 
and Items� on page 43), or with the Regression Wizard. For information on 
generating a report from the Regression Wizard, see the Programming Guide .

To create a new report:

1. Right-click the section where you want to create the report, choose New, and 
choose Report. A report window opens and a new report is added to the selected 
section.

2. To create a report using the New command, select the section where you want 
the report to appear, then choose the File menu New command.

3. Select Report from the New list, then click OK. The new report is added to the 
selected section.

Setting Report Options 0

To set any of these options, choose the View menu Report Options command to 
open the Options dialog box.

Σ These settings apply to the current report, but not to other open reports. To have 
these settings apply to subsequently opened or created reports, make your changes, 
then close the page. Newly opened or created reports will use these settings.

Figure 10�2
The Report Editor Options

Panel
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Setting Ruler Units The Options Panel is used to select the ruler units and enable or disable automatic 
word selection.

To open the report Options dialog box:

1. Select the report window you want the options to apply to, then choose the 
View menu Report Options command.

2. To set the Measurement units to Inches, Points, Centimeters, or Picas,  select 
the appropriate box. 

3. To enable Automatic Word Selection , select this option. Automatic Word Selec-
tion causes whole words to be selected when dragging the mouse across text in 
the report.

Toolbar and
Text Display

The View panel sets the word wrapping behavior, and controls toolbar and ruler 
display.

To change your report view options:

1. Select the report window you want the options to apply to, then choose the 
View menu Report Options command. 

Figure 10�3
The Report Editor

Options Panel

Figure 10�4
The Report Editor Options

View Panel
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2. To set Word Wrap, you can select one of the following options. The Word wrap 
options only affect how text appears on your screen, not when printed. 

3. To show or hide the Ruler and Toolbar, select or clear the Format bar or Ruler 
options.

Setting Report Page Size and Margins 0

The report Page Setup dialog box is used to set report margins, paper orientation, 
paper size, and paper source. 

Σ These settings apply to the current report, but not to other open reports. To have 
these settings apply to subsequently opened or created reports, make your changes, 
then close the page. Newly opened or created reports will use all of these settings.

To open the Page Setup dialog box:

1. Select the report window you want the options to apply to, then choose the File 
menu Page Setup command. The Page Setup dialog box for the report appears.

The page sample at the top of the dialog box reflects changes made to all of the 
options.

2. To select the Paper Size and Source, select an option from the drop-down lists. 
The available options depend on the current selected Printer.

3. To view which printer is selected, click the Printer button. You can use the Page 

Figure 10�5
The Page Setup Dialog Box
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Setup printer dialog box to select and setup any printer configured for your sys-
tem.

4. To change the paper orientation, select either Portrait or Landscape (sideways). 

5. To change the margins, enter the desired values into the four Margins boxes. 
The current ruler units are displayed in the Margins title.

Using the Report Editor Ruler 0

The Report Editor ruler can be used to view margins and to both view and modify 
report page tabs and paragraph indents. 

The ruler indicates:

➤ Usable page column width (as defined by Page Setup for the Report; see �Setting 
Report Page Size and Margins� on page 314)

➤ Default tabs

➤ User-defined tabs

➤ Left and right paragraph indents

➤ First line indent

The ruler is also used to specify tabs and indents. See �Setting Tabs� on page 316 and 
�Setting Paragraph Indents� on page 317.

Setting Ruler Units The ruler units are set using the report Options dialog box (see �Setting Ruler Units� 
on page 313). These settings apply to the current report as well as to subsequently 
created reports.

Showing and Hiding
the Ruler

You can toggle ruler display by choosing the View menu Report Ruler command. 
This command hides or shows the rulers for individual reports.

Figure 10�6
The Report

Editor Ruler

Left Indent

First-Line 

Manual Tab Stop Default Tab Stop Right Indent
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Setting Tabs 0

All tab stops are shown on the report ruler. The default tab stop is 0.25" regardless of 
the current units. Tab stops made for individual and selected paragraphs, and are 
saved with reports.

To set a tab:

1. Select the paragraph(s) for which you want to change the tab stops. To select 
multiple paragraphs, drag the mouse over the paragraphs.

2. Click the ruler where you want to place a tab. A tab marker appears at the 
clicked location. 

3. To move a tab, drag the tab marker to another location on the ruler. To delete a 
tab, drag the tab marker off the ruler. 

You can also set tabs from the Tabs dialog box:

1. Choose the Format menu Tabs command. This command is only available while 
viewing a report window.

Figure 10�7
Setting a Tab Stop

From the Ruler
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2. Specify tab stops in the Tab stop position edit box by entering the tab location. 
Tab locations must be entered using the current ruler units.

3. Click Set to add the tab setting to the list. Click Clear to remove a selected set-
ting. Click Clear All to remove all tab settings. 

Σ Note that all tabs are left-aligned.

Setting Paragraph Indents 0

You can set left, right, and first line indents for individual paragraphs. These settings 
are saved with the report.

To paragraph indents:

1. Select the paragraph(s) for which you want to change the indents. To select mul-
tiple paragraphs, drag the mouse over the paragraphs.

2. To change the left indent, drag the  marker by the point (top). To move both 
the left and first line indents, drag the marker by the bottom.

Figure 10�8
Setting Tab Stops from

the Tabs Dialog Box

Figure 10�9
The Report Editor Ruler
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3. To change the right indent, drag the  on the bottom right side of the ruler.

To change the first line indent, drag the  marker at the top left of the ruler. To 
create an indented line, drag the marker to the right of the left indent. To create 
a hanging indent, drag the marker to the left of the left indent.

Formatting Text And Paragraphs 0

You can change report text attributes such as font, font size, color, and style of 
selected text using the formatting toolbar.

To modify text with the Formatting Toolbar:

1. Select the text you want to modify. You can select individual characters, words, 
paragraphs, or the entire report.

2. To format character font, size, weight, angle, underlining, or color, use the for-
matting toolbar buttons.

3. To set paragraph alignment,  use the formatting toolbar buttons for left, center, 
and right paragraph justification.

4. To add bullets a to selected paragraph , click the Bullets button . To 

remove bullets, click the Bullets button again.

Figure 10�10
Examples of Paragraph

Indent Formatting
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You can also choose the Format menu Bullet Style command or right-click the report 
page and select Bullet Style. Bullets are applied to the selected text. 

Inserting the Current Date and Time into a Report 0

To insert the current date and time into reports:

1. Select the report and click where you want to insert the Date or Time, then 
choose the Edit menu Insert Date and Time command.

2. Select the date and time format from the list, then click OK. The current date 
and time are inserted as text at the specified location. 

Σ Note that the list of available date and time formats depends on your Regional 
Settings. You can view or modify the Regional Settings directly from your 
Windows control panel.

Figure 10�11
The Date and Time Dialog

Box
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Sample Graphs

The sample graphs included with SigmaPlot can be found in the SAMPLES.JNB 
notebook, in the SigmaPlot program folder.

Example 1: Scatter
Plot with Error Bars

This is a scatter graph of symbols with error bars and a line plot draw through the 
symbols. If you don�t have your fitted line data, you can use SigmaPlot�s Regression 
Wizard to create the data for curves.

Scatter Plot with Error Bars and Fitted Curves
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Example 2: Grouped
Bar Chart with

Error Bars

This bar chart plots two data columns along with two error bar data columns, and 
uses a Y axis break.

Grouped Bar Chart with Error Bars
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Example 3:
Population Pyramid

A population pyramid created by using a stacked bar chart and tick labels from a 
column.
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Example 4: Bar and
Line Chart with

Two Y Axes

This graph plots a line and bar chart on the same graph with different Y axes. The 
bar chart has a width of 100% and the same color for both fill and edge.

Example 5: Box Plot This is a Tukey box plot with varying box widths, taken from a worksheet column. 
The X axis is a category axis. 
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Example 6: Bubble
Plot

This is a bubble chart of two sets of xy data. Each bubble plot is a separate plot, since 
symbol sizes apply to entire plots, as opposed to individual curves.

The legend is created using legend symbols for a dummy plot that graphs area data 
transformed to reasonable symbol sizes.

Example 7: Fan Plot This is a polar plot with a restricted angular axis arc and radial axis length. The radial 
axis positions are moved to the stop and start angles of the graph.
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Example 8: 3D Mesh
and Scatter

This is a graph of up to two 3D scatter plots and a mesh plot on a single graph. 

Example 9: 4 Up Line
and Step Plots

This is a set of four line graphs, each with one set of x and two sets of y data plotted 
as a line and a step plot, respectively.
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Example 10: Ribbon
Plot

A ribbon plot is created by a series of one interval wide meshes. You can use the 
RIBBON.XFM transform file to convert columns of data into mesh ribbons.

Three Ternary Graphs This graph is actually composed of three separate ternary graphs with different axis 
ranges and directions.
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SigmaPlot Templates 0

The following templates are stored in Template.JNT. Open Template.JNT, or your 
own template source, as you would any ordinary notebook. 

Template: Effect:

Graph Pages

Normal Default page template, white, 8 1/2 x 11 letter-sized
(International version is A4 portrait).

Landscape Creates a page in landscape orientation.

A4 Creates an A4 page size. 
(International versions substitutes US Letter).

Legal Creates a page in legal orientation.

Blue Slide Creates a blue page suitable for slides.

Black Slide Creates a black page suitable for slides.

Graphs

Scatter Plot Graphs your data as a standard scatter plot. The data source is 
Columns 1 and 2.

Bar Chart for Slide Graphs your data as a standard bar chart with a black graph 
color and blue page. The data source is Columns 1 and 2.
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Printing Tips 

SigmaPlot relies entirely on Windows font and printer drivers for all of its output. 
These drivers were installed with Windows, or came with the printer and were 
installed separately.

The precise options and settings available for each driver vary. Options available for 
the drivers provided with Windows are described in the Windows User�s Guide. Your 
printer vendor should have provided documentation for any drivers shipped with 
your printer.

Screen and Printer
Fonts

All TrueType and PostScript fonts are fully supported using the Windows Fonts 
control panel and Adobe Type Manager. Some tips on using both TrueType and 
PostScript fonts are provided below.

For more information on the Windows Fonts control panel, see the Windows User�s 
Guide. For more information on Adobe Type Manager, see the documentation 
provided by the program supplier.

Using TrueType Fonts 0

TrueType fonts are recommended if you are printing to printer(s) connected directly 
to your computer and are using a Windows compatible driver (provided either with 
Windows or by the printer vendor). Windows automatically renders TrueType fonts 
correctly in SigmaPlot both on your screen and printer.

TrueType fonts are controlled from the Windows Control Panel. Use the Fonts 
control panel to add, remove, and enable or disable use of TrueType fonts.

Additional TrueType fonts are provided with many other applications and can also be 
purchased as separate packages. SigmaPlot can use any correctly installed TrueType 
font.

B
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Substituting Printer
Fonts

For printers with their own built-in fonts, such as PostScript printers and later 
models of Hewlett Packard LaserJet printers, the printer setup dialog box option 
allows automatic substitution of the built-in fonts for TrueType fonts. These options 
are found in the advanced options of the style options log for that printer. 

Σ Many high resolution typesetters and slidemakers still only support PostScript fonts, 
and not TrueType fonts. If you plan to take or send a printer file to a service bureau 
to output on a typesetter, color printer, or slidemaker, you should contact them and 
make sure they support the kind of fonts you want to use. If you must use non-
TrueType fonts, you can disable TrueType fonts using the Fonts control in the 
Windows Control Panel.

Using PostScript Fonts 0

PostScript fonts can only be used when printing to PostScript or PostScript 
emulating printers. If you installed a PostScript printer driver, the PostScript fonts 
appear as printer fonts in the different font lists. 

PostScript fonts are only available if you installed a Windows PostScript printer 
driver when you installed Windows or by using the Windows Setup program, or if 
you are using Adobe Type Manager. You do not have to actually have a PostScript 
printer to install a PostScript printer driver. You will need to install the driver if you 
plan to use an outside service to print graphs on their PostScript compatible device 
(see below).

When is PostScript
Required?

Many high resolution typesetters and slidemakers still only support PostScript fonts, 
and not TrueType fonts. If you plan to take or send a printer file to a service bureau 
to output on a typesetter, color printer, or slidemaker, you should contact them and 
make sure they support the kind of fonts you want to use.

About Adobe
Type Manager

PostScript fonts are not accurately rendered on your screen unless you have Adobe 
Type Manager installed. Windows will substitute similar fonts and display the widths 
correctly on the screen, and the fonts will print correctly. However, you can only 
install additional PostScript fonts using Adobe Type Manager. 

Adobe Type Manager was included in earlier versions of Windows and can also be 
purchased independently or bundled with many other applications.
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Optimizing Printer Output 0

Use Maximum
Resolution

Some printers have a draft or lower resolution mode; if you are printing to a printer 
with variable resolution settings, make sure that the resolution is set to the highest 
level.

Use TrueType Fonts Windows comes with TrueType fonts automatically installed. With TrueType fonts, 
you can access a wide range of typefaces. For more information about using TrueType 
fonts, see page 329.

Σ Note that some printing and slidemaking services do not yet support TrueType fonts; 
substituting printer fonts or using Adobe Type Manager generally solves this 
problem.

Thicken Lines For full sized graphs, the default line thicknesses may be too thin. Thicker lines will 
be easier to read. You can use set default line options using the Format menu Line 
command to change line widths all at once. For more details, see �Changing Multiple 
Page Objects� on page 125.

Use Halftoning If you are printing colors to a black and white printer, or are using different levels of 
gray, you can often improve the �dither� pattern using halftoning settings, available 
under the Advanced Options, for most laser printers. Laser printers default to a 
halftone screen of only 60, but can often handle up to 100. If you are producing high 
resolution at 1200 dpi, a halftone of 120 is possible, and at 2400 dpi, you can use a 
screen frequency of 150 (magazine quality).

Printing to High Resolution Typesetters and Slide Makers 0

There are a few points you should keep in mind when producing graphs for image 
setters and slide makers. Many of these are general design and layout principles that 
can be applied to any graph. 

➤ Don�t use hairline line widths. Although hairline may appear fine on laser 
printed output, it will be too thin for image setters and slide makers. You can use 
set default line options using the Format menu Line command to change line 
widths all at once (see �Changing Multiple Page Objects� on page 125 ).

➤ Many journals and magazines don�t accept color, so consider using a gray scale 
for fill colors. If you are producing slides, color generally achieves a better effect. 
Avoid the use of fill patterns (hatching) whenever possible, and never mix 
patterns and colors; this tends to be confusing.

➤ Don�t use too many different fonts type faces (no more than two) on one page. 
Also, many publications accept only san serif fonts (such as Helvetica or Arial). 
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You can format text labels and set default text options using the Format menu 
Text Properties command (see �Formatting Text� on page 137).

➤ Don�t use small point sizes. For a full page graph, you don�t want to use point 
sizes smaller than 24 points.

➤ Don�t use too many different colors, and watch your color combinations. Don�t 
use red and green together, since many people are red-green color blind, and 
don�t use red and blue together, because the human eye has difficulty focusing 
on both (unless you are trying to achieve a �3D� effect).

➤ For slides, a dark background, such as black, dark gray or dark blue, creates the 
best effect. Use light colored lines and text when you have a dark background. 
For changing the background color, use the File menu Page Setup command (see 
�Changing Page Color� on page 145).

➤ For publications that accept color graphs, a light graph background color sets off 
the graph from the page. For changing the background color, use the File menu 
Page Setup command; for more information, see �Changing Page Color� on 
page 145.

For other principles of graphing, you can refer to the resources listed under 
�References� on page 22.

Printing to Files 0

SigmaPlot can print pages to a disk file using any available Windows printer drivers, 
including PostScript using a PostScript printer driver, and HPGL using any Hewlett 
Packard plotter driver. PostScript files are required by many digital typesetters and 
slidemakers, and HPGL files can be imported into many word processors, desktop 
publishing, and drawing applications. 

You can also create any other kind of printer file, that can be printed at a later date by 
sending the file to the printer. The kind of file created is entirely dependent on the 
printer driver used. 

To print to a file rather than a printer:

1. Choose Print from the File menu, and check the Print to File option in the Print 
dialog box.

2. Click OK, then enter the file name for the output file. Click OK to create the 
print file.

Types of Files PostScript: PostScript files are created when you use a PostScript printer driver to 
print file. PostScript files can be �dumped� to another printer or high-resolution 
output device later. Use PostScript files if you want to take graph pages to a 
typesetting or slide-making service. 
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Σ You do not need to have a PostScript printer connected to install and use a PostScript 
printer driver. 

EPS: Encapsulated PostScript files are scalable line art graphic files. You can export 
graphs and pages to EPS files using the File menu Export command; see �Exporting 
Graphs and Pages� on page 51.

Σ Note that EPS files contain no scaling information and are not designed to be sent to 
a printer. If you attempt to print an EPS file directly to a printer, you may receive 
unpredictable results.

HPGL: Hewlett Packard Graphics Language files use the Hewlett Packard pen 
plotter language. HPGL files are created when you use a Hewlett Packard plotter 
driver to print to a file.

Many applications are able to read these files, some with great sophistication. 
Although HPGL files contain all color and line width information, not all 
applications will import this information correctly.

If possible, avoid using thick lines in HPGL files; increasing line thickness increases 
the size of the HPGL file dramatically. Labels also add to file size.

If you are directing HPGL output to a file for later �dumping� to a plotter, make sure 
that you have selected Hardware Handshaking in the Settings dialog box.

Some programs, such as Ventura Publisher, are designed to handle and interpret large 
and complex HPGL files. 
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Notes 0
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Color, Symbol, Line, and Fill 
Schemes and Codes 

Schemes 0

Color Schemes The colors used along with the equivalent graphic cell code is provided for each color 
scheme.

  

  

Black & White @rgb(0,0,0)

@rgb(255,255,255)

Gray Scale @rgb(0,0,0)

@rgb(192,192,192)

@rgb(64,64,64)

@rgb(224,224,224)

@rgb(32,32,32)

@rgb(128,128,128)

Earth Tones @rgb(128,0,0)

@rgb(192,192,0)

@rgb(96,0,0)

@rgb(255,128,0)

@rgb(128,64,0)

@rgb(128,128,0)

C
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Ocean @rgb(0,0,128)

@rgb(0,128,255)

@rgb(0,0,96)

@rgb(0,128,128)

@rgb(0,64,128)

@rgb(0,224,224)

Forest @rgb(0,64,0)

@rgb(0,255,0)

@rgb(0,128,0)

@rgb(192,255,0)

@rgb(64,192,0)

@rgb(255,255,0)

Muted Rainbow @rgb(128,0,0)

@rgb(255,128,0)

@rgb(192,192,0)

@rgb(0,128,0)

@rgb(0,128,128)

@rgb(0,64,128)

@rgb(128,0,128)

Incremented @rgb(0,0,0)

@rgb(255,255,255)

@rgb(255,0,0)

@rgb(0,255,0)

@rgb(255,255,0)

@rgb(0,0,255)
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Symbol Schemes Doubles:  Circle, Circle, Down Triangle, Down Triangle, Square, Square, Diamond, 
Diamond, Up Triangle, Up Triangle, Hexagon, Hexagon

Monochrome:  Circle, + (cross), Down Triangle, Square, Up Triangle

Dotted Doubles:  Circle, Dotted Circle, Down Triangle, Dotted Down Triangle, 
Square, Dotted Square, Diamond, Dotted Diamond, Up Triangle, Dotted Up 
Triangle, Hexagon, Dotted Hexagon)

Incrementing:  Circle, Square, Up Triangle, Down Triangle, Diamond, Hexagon

Line Schemes Monochrome:  Solid, Dotted, Short Dash, Dot-Dot-Dash, Long Dash, Dot-Dash, 
Medium Dash

Incrementing:  Solid, Long Dash, Medium Dash, Short Dash, Dotted, Dot-dash, 
Dot-dot-dash

Fill Pattern Schemes Monochrome:  Solid, None, Right-rising Fine, Cross Hatched Fine, Left-rising Fine, 
Horizontal Fine 

Incrementing:  None, Right-rising Fine, Right-falling Fine, Cross Hatched Fine, 
Horizontal Fine, Vertical Fine, Grid Fine

@rgb(255,0,255)

@rgb(0,255,255)

@rgb(128,128,128)

@rgb(192,192,192)

@rgb(128,0,0)

@rgb(0,128,0)

@rgb(128,128,0)

@rgb(0,0,128)

@rgb(128,0,128)

@rgb(0,128,128)
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Graphic Cell Codes 0

You can sequence plot lines, symbols, and fill patterns from an order that appears in a 
column. These sequences can be placed into a column using the Edit menu Insert 
Graphic Cells command. You can also directly type the �@� code for these symbols 
into a cell. Correctly typed codes appear as a graphic in worksheet cells. 

The codes for the symbols, lines, and patterns are shown below.

Symbol Codes Codes for filled and unfilled (a fill color of none) symbols, as well as dotted and 
crossed symbols, are available.

Use the (none) symbol type when you want to create curves which alternate between 
lines only and symbols only. 

Code Symbol Type

@symbol(1,0) (none)

@symbol(1,3) dot only 

@symbol(1,5) crosshair only

@symbol(2,0) hollow circle

@symbol(2,1) solid circle

@symbol(2,3) dotted solid circle

@symbol(2,2) hollow circle with crosshair

@symbol(2,5) solid circle with crosshair

@symbol(2,6) hollow circle with crosshair

@symbol(3,0) hollow square

@symbol(3,1) filled square

@symbol(3,2) dotted hollow square

@symbol(3,3) dotted filled square

@symbol(3,4) hollow square with crosshair 

@symbol(3,5) filled square with crosshair

@symbol(4,0) hollow triangle up

@symbol(4,1) filled triangle up

@symbol(4,2) dotted hollow triangle up
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@symbol(4,3) dotted filled triangle up

@symbol(4,4) hollow triangle up with crosshair

@symbol(4,5) filled triangle up with crosshair

@symbol(5,0) hollow triangle down

@symbol(5,1) filled triangle down

@symbol(5,2) dotted hollow triangle down

@symbol(5,3) dotted filled triangle down

@symbol(5,4) hollow triangle down with crosshair

@symbol(5,5) filled triangle down with crosshair

@symbol(6,0) hollow diamond

@symbol(6,1) filled diamond

@symbol(6,2) dotted hollow diamond

@symbol(6,3) dotted filled diamond

@symbol(6,4) hollow diamond with crosshair

@symbol(6,5) filled diamond with crosshair

@symbol(7,0) hollow hexagon

@symbol(7,1) filled hexagon

@symbol(7,2) dotted hollow hexagon

@symbol(7,3) dotted filled hexagon

@symbol(7,4) hollow hexagon with crosshair

@symbol(7,5) filled hexagon with crosshair
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Line Codes 0

Codes for all available line types are provided. Use the (none) line type when you 
want to create curves which alternate between lines only and symbols only.

Fill Pattern Codes 0

Codes for pattern types using the Windows default pattern density are provided. Use 
the (none) pattern when you want unfilled bars or boxes. The fill color of bars and 
boxes is controlled by the Fill dialog box Background Color options. 

Code Line Type

@line(1) (none)

@line(2) solid

@line(3) long dash

@line(4) medium dash

@line(5) short dash

@line(6) dot

@line(7) dash-dot

@line(8) dash-dot-dot

Code Fill Pattern

@pattern(1) (none)

@pattern(2) solid

@pattern(3) rising right

@pattern(5) rising left

@pattern(6) diagonal cross hatch

@pattern(7) horizontal lines

@pattern(8) vertical lines

@pattern(9) horizontal cross hatch  
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The SPW5.INI File

Many system and option settings for SigmaPlot are saved in the SPW5.INI file, 
which can be found in your Windows directory. You can modify some of the settings 
in SPW5.INI directly by editing the file with the Windows Wordpad or another text 
editor; however, make sure you create a backup file before editing SPW5.INI. Take 
great care in modifying this file. SPW5.INI is used to handle the files that SigmaPlot 
shares with other programs, and changing these settings can lead to unpredictable 
results.

Note that only those entries that are considered useful are discussed below.

Last Opened File
Types

[Application]
Last Open Filter=1
Last Import Filter=1
Last Export Filter=8

These setting under the [Application] heading determine the default open, import 
and export file types. Note that these are reset when new file types are selected from 
the Open, Import and Export dialog boxes.

The number corresponds to Last used type from the [Open Filter], [Import Filter] 
and [Export Filter] lists. See �Changing the File Type Orders� on page 342.

Regression Wizard [Nonlinear Regression]
OneEditWindow=0
LastSection="3D"
LastEquation="Lorentzian"

The OneEditWindow setting can be used to display the Regression (edit code) dialog 
box as a single window in the style of previous versions of SigmaPlot. To set display 
to a single text window, set OneEditWindow=1. A setting of 0 creates multiple edit 
windows.

The LastSection and LastEquation settings determine the default category and 
equation opened upon startup of the Regression Wizard. These are saved each time 
an equation is both selected and run on data.

D
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SigmaPlot Program
Window Size
and Position

[Settings]
WindowPos=0,1,-1,-1,-4,-4,168,22,930,669

The WindowPos settings determine the SigmaPlot application window state, size and 
location upon opening. 

The first two settings determine the state of the window on startup:

0,1 = in window
0,2 = minimized 
2,3 = maximized

The next two settings can be ignored. This setting does not apply to Windows 95.

The next pair of settings are unused.

The last four settings determine the Window size and position. They are the pixel 
screen coordinates for the top left x, top left y, lower right x, lower right y of the 
window, respectively.

When the SigmaPlot window is closed, the size and position on close is saved to this 
setting. 

Changing the File
Type Orders

File types listed in all of the SigmaPlot file dialog boxes (e.g. Open, Export, Import, 
etc.) are listed under the following headings. The name as it appears in order in the 
list is followed by the extension of the file type. You can change the order that these 
files appear in your file dialog boxes by changing the order they appear in these lists.

If an import filter is required, the DLL used as the filter is specified before the file 
extension(s); do not change the import filter assigned to the file type.

Σ Do not modify the [Export Page] heading; it is required to support export of 
SigmaPlot 1.0 and 2.0 files. The [Export Page Info] heading is used to support 
graphic file export.

[Open Filters]

SigmaPlot Notebook=,*.JNB

Template Notebook=,*.JNT

Regression Library=,*.JFL

SigmaPlot 1.0, 2.0=JS~IJXFF|JD~IJXFF,*.SPW

SigmaPlot Curve Fit=FIT,*.FIT

SigmaPlot Macintosh 4=JS~ISPGF|JD~ISPGF,*.*

SigmaStat 1.0=JS~IJXFF|JD~IJXFF,*.SPW

SigmaPlot DOS=JS~ISPGF|JD~ISPGF,*.SP5;*.SPG

SigmaStat DOS=JS~ISPGF|JD~ISPGF,*.SP5
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MS Excel=JS~WKW_F|JD~WKW_F,*.XLS

Lotus 1-2-3=ImpOpenX|ImpOpenX,*.WKS;*.WK1;*.WK3;*.WK4

DBase=ImpOpenX|ImpOpenX,*.DB2;*.DB3;*.DBF

Quattro Pro=ImpOpenX|ImpOpenX,*.WQ1;*.WKQ

Paradox=ImpOpenX|ImpOpenX,*.DB

Symphony=ImpOpenX|ImpOpenX,*.WK1;*.WR1;*.W RK;*.WKS

Systat=ImpSystat|ImpSystat,*.SYS

Plain Text=JS~IASCF|JD~IASCF,*.TXT;*.PRN;*.DAT;*.ASC

Comma Delimited=JS~IASCF|JD~IASCF,*.CSV

SigmaScan, SigmaScan Pro 
Worksheets=JS~IJXFF|JD~IJXFF,*.SPW

Mocha, SigmaScan Image 
Worksheets=JS~IJXFF|JD~IJXFF,*.MOC

DIF=JS~IDIFF|JD~IDIFF,*.DIF

[Open Excel Filters]

EXCEL

SigmaPlot Notebook=,*.JNB

Template Notebook=,*.JNT

Regression Library=,*.JFL

SigmaPlot 1.0, 2.0=JS~IJXFF|JD~IJXFF,*.SPW

SigmaPlot Curve Fit=FIT,*.FIT

SigmaPlot Macintosh 4=JS~ISPGF|JD~ISPGF,*.*

SigmaStat 1.0=JS~IJXFF|JD~IJXFF,*.SPW

SigmaPlot DOS=JS~ISPGF|JD~ISPGF,*.SP5;*.SPG

SigmaStat DOS=JS~ISPGF|JD~ISPGF,*.SP5

MS Excel=EXCEL,*.XL*

Lotus 1-2-3=EXCEL,*.WK*

Quattro PRO/DOS=EXCEL,*.WQ*

dBase=EXCEL,*.DBF

Plain Text=EXCEL,*.TXT;*.PRN;*.CSV
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SYLK=EXCEL,*.SLK

SigmaScan, SigmaScan Pro 
Worksheets=JS~IJXFF|JD~IJXFF,*.SPW

Mocha, SigmaScan Image 
Worksheets=JS~IJXFF|JD~IJXFF,*.MOC

DIF=JS~IDIFF|JD~IDIFF,*.DIF

[Import Filters]

SigmaPlot 1.0, 2.0 Worksheet=JS~IJXFF|JD~IJXFF,*.SPW

SigmaPlot Macintosh 4 Worksheet=JS~ISPGF|JD~ISPGF,*.*

SigmaPlot Macintosh 5 Worksheet=JS~IJXFF|JD~IJXFF,*.*

SigmaStat 1.0 Worksheet=JS~IJXFF|JD~IJXFF,*.SPW

SigmaPlot DOS Worksheet=JS~ISPGF|JD~ISPGF,*.SP5;*.SPG

SigmaStat DOS Worksheet=JS~ISPGF|JD~ISPGF,*.SP5

MS Excel=JS~WKW_F|JD~WKW_F,*.XLS

Lotus 1-2-3=ImpOpenX|ImpOpenX,*.WKS;*.WK1;*.WK3;*.WK4

DBase=ImpOpenX|ImpOpenX,*.DB2;*.DB3;*.DBF

Quattro Pro=ImpOpenX|ImpOpenX,*.WQ1;*.WKQ

Paradox=ImpOpenX|ImpOpenX,*.DB

Symphony=ImpOpenX|ImpOpenX,*.WK1;*.WR1;*.WRK;*.WKS

Systat=ImpSystat|ImpSystat,*.SYS

Plain Text=JS~IASCF|JD~IASCF,*.TXT;*.PRN;*.DAT;*.ASC

Comma Delimited=JS~IASCF|JD~IASCF,*.CSV

SigmaScan, SigmaScan Pro 
Worksheets=JS~IJXFF|JD~IJXFF,*.SPW

Mocha, SigmaScan Image 
Worksheets=JS~IJXFF|JD~IJXFF,*.MOC

DIF=JS~WKW_F|JD~WKW_F,*.DIF

Axon Binary=JS~AXF_F|JD~AXF_F,*.ABF;*.DAT

Axon Text=JS~AXF_F|JD~AXF_F,*.ATF
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[Export Notebook]

SigmaPlot 3.0 Notebook=,,*.JNB

SigmaStat 2.0 Notebook=,,*.SNB

[Export Worksheet]

SigmaPlot 3.0 Notebook=,,*.JNB

SigmaStat 2.0 Notebook=,,*.SNB

SigmaPlot 2.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW

SigmaPlot 1.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW

SigmaPlot Macintosh 5 
Worksheet=JS~EJXFF|JD~EJXFF,SPW,*.SPW

Excel 4=JS~WKW_F|JD~WKW_F,XLS4,*.XLS

Excel 3=JS~WKW_F|JD~WKW_F,XLS3,*.XLS

Lotus 1-2-3 v1.0=ExpOpenX|ExpOpenX,WKS,*.wks

DBase II=ExpOpenX|ExpOpenX,DB2,*.dbf

DBase III=ExpOpenX|ExpOpenX,DB3,*.dbf

Quattro Pro v1.0=ExpOpenX|ExpOpenX,WQ1,*.wq1

Paradox v3.0=ExpOpenX|ExpOpenX,DB,*.db

Symphony v1.0=ExpOpenX|ExpOpenX,WRK,*.wrk

Systat=ExpSystat|ExpSystat,SYS,*.sys

Comma Delimited=JS~WKW_F|JD~WKW_F,CSV,*.CSV

Tab Delimited=JS~WKW_F|JD~WKW_F,TAB,*.TAB

Plain Text=JS~WKW_F|JD~WKW_F,TXT,*.TXT

SigmaScan, SigmaScan Pro=JS~EJXFF|JD~EJXFF,SPW,*.SPW

Mocha, SigmaScan Image=JS~EJXFF|JD~EJXFF,MOC,*.MOC

DIF=JS~WKW_F|JD~WKW_F,DIF,*.DIF

[Export Page]

SigmaPlot 3.0 Notebook=,,*.JNB

SigmaStat 2.0 Notebook=,,*.SNB

SigmaPlot 2.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW



The SPW5.INI File

346

SigmaPlot 1.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW

[Export Page INSO]

SigmaPlot 3.0 Notebook=,,*.JNB

SigmaStat 2.0 Notebook=,,*.SNB

SigmaPlot 2.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW

SigmaPlot 1.0=JS~EJXFF|JD~EJXFF,SPW,*.SPW

Bitmap=EBBMP2.FLT,BMP,*.BMP

TIFF=EBTIF2.FLT,TIF,*.TIF

MetaFile=EMWMF2.FLT,WMF,*.WMF

Encapsulated PostScript=EMPS_2.FLT,EPS,*.EPS

JPEG=EBJPG2.FLT,JPG,*.JPG

Paper Size
Definitions

These are the paper size settings for the Page Setup dialog box for printed graph 
pages, given in 1/254".

[Paper Names and Sizes]; 

US Letter=, 2159, 2794

US Legal=, 2159, 3556

US Letter Small=, 2159, 2794

US Legal Small=, 2159, 2970

A4=, 2099, 2970

Text Defaults These are the default options for newly created text, as set in the Text Options dialog 
box. These are reset each time the Text Options dialog box is opened and changed 
with no text selected.

[Text Options]

Name=Arial

Italic=0

Weight=400

Underline=0

Size=20

Color=0l
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LineSpacing=139

Alignment=2

Rotation=0

Default Worksheet Option

You can choose to have the Date and Time worksheet options appear by default 
instead of the Number defaults. Set SHOWNNUMERIC=1 if you want numbers to 
appear first, or set it to 0 if you want Date and Time to appear first.

[DWWPREFINIT]

SHOWNUMERICS=1

Recent Equation
Libraries

List of all Equation Libraries selected from the library panel of the Regression 
Wizard. You can change this list by editing the files under this heading.

[Recent Equation Library List]

Library1=C:\PROGRA~1\SPW5\Standard.jfl

Library2=C:\MYDOCU~1\Custom.jfl

Macro Preferences These are the default options for macros, as set in the Tools menu Options dialog 
box. 

[Macro Preferences]

FontSize=10

FontName=Courier New

HighlightBuiltin=0x00808000

HighlightComment=0x00008000

HighlightError=0x000000FF

HighlightExtension=0x00800000

HighlightReserved=0x00FF0000

HighlightBreak=0x00000080

HighlightExec=0x0000FFFF

MacroDefaultNotebook=C:\Program Files\SPW5\SigmaPlot 
Macro Library.jnb

Toolbar=1

RequireDefinitions=1
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Last Saved Files List of the last four saved files. You can change this list by editing the files under this 
heading.

[Recent File List]

File1=C:\WIN95\Desktop\samples.jnb

File2=C:\SPW5\SAMPLES.JNB

File3=C:\My Documents\Example.JNB

File4=C:\SPW5\TEMPLATE.JNT

Graph Page Size [PageW]

DefaultPageWidth=8500

DefaultPageHeight=11000

These are the page heights and widths used for new pages in the absence of a 
template file or if there is no page named Normal in the template file.

Metafile Bitmap Use
for 3D Files

[PageW]

hmetares=300

MetaBitmap=1

By default SigmaPlot generates 3D plots using a bitmap rather than a metafile. The 
hmetares setting determines the default resolution of that bitmap. This setting is 
changed to match the resolution of exported graphic files.

The MetaBitmap setting determines whether a bitmap or metafile is used to render 
the 3D plot; 1=use a bitmap, 0=use a metafile. A bitmap is recommended if any 
gradient, lighting, and transparency is used. If you never use these setting, you can 
change MetaBitmap=0.

Grids, Rulers, Snap-
to and Crosshair

Settings

[pagew]

CrossHairsEnabled=0

GridShown=1

GridSpacing=250

GridDots=0

GridColor=0xffff80

RulersShown=1

GridSnap=0
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These settings under the [pagew] heading determine the default grids, rulers, snap-
to, and crosshair features; 1=show, 0=don�t show.

Edit Text Dialog Box
Position

[Dialog Positions]

Edit Text=302,349

These setting control the location where the Edit Text dialog box for graph page 
appears when opened. When the dialog box is moved and OK is clicked, this setting 
is updated.

Graph Properties
Dialog Box Automatic

Apply

[PageDialogs]

AlwaysApply=1

When switching between the certain panels of Graph Properties dialog box, a 
prompt dialog box appears asking if you want to apply the changes before switching 
panels. If you click the Don�t show this again; always Apply check box, this prompt is 
removed. 

You can re-activate this prompt by changing AlwaysApply=0.

Graph Default
Settings

The settings for the graph defaults are provided as a reference in the event you would 
like to restore the settings to the original values using the SPW5.INI file.

[Graph Defaults]

Graph Height In MilliInches=3500

Graph Width In MilliInches=5000

Graph Position Left In MilliInches=1750

Graph Position Top In MilliInches=3500

Font=Arial

Page Color=16777215

Single Curve Symbol Color=0

Single Curve Symbol Color Repeat=2

Figure D�1
The Apply Changes Prompt
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Multi Symbol Color=0

Multi Symbol Color Repeat=61696

Single Curve Symbol Type=2

Single Curve Symbol Type Repeat=2

Single Curve Symbol Type Adornment=0

Multi Curve Symbol Type=2

Multi Curve Symbol Type Repeat=61952

Multi Curve Symbol Type Adornment=512

Single Curve Line Color=0

Single Curve Line Color Repeat=2

Multi Curve Line Color=0

Multi Curve Line Color Repeat=2

Single Curve Line Type=2

Single Curve Line Type Repeat=2

Multi Curve Line Type=2

Multi Curve Line Type Repeat=62464

Single Curve Bar Color=12632256

Single Curve Bar Color Repeat=2

Multi Curve Bar Color=0

Multi Curve Bar Color Repeat=61697

Bar Width=600
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Working with Pie, Polar, and Ternary 
Plots

This chapter describes procedures specific to pie charts, polar plots, and ternary plots. 
To learn about making general graph modifications, like changing symbols, lines, or 
fills, see �Creating and Modifying Graphs� on page 151. 

This chapter covers: 

➤ Creating pie charts (see below)

➤ Changing pie chart slice settings (see page 354)

➤ Creating polar plots (see page 356)

➤ Basic polar plot attributes (see page 360)

➤ Changing polar plot angular axis (see page 362)

➤ Changing plot radial axes (see page 364)

➤ Modifying polar plot radial axis tick marks and tick labels (see page 366)

➤ Creating ternary graphs (see page 369)

➤ Basic ternary graphs attributes (see page 374)

➤ Moving ternary plot axis titles (see page 375)

➤ Changing ternary plot axes ranges and scaling (see page 376)

➤ Modifying ternary plot tick marks and tick labels (see page 381)

E
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Pie Charts 0

Pie charts plot a single worksheet column by representing each data point in the 
column as a pie slice. Each data point in the column is graphed as a slice size 
equivalent to the data point's percent of the sum of all the data. 

The first pie slice starts at 0° (3 o'clock) by default. Additional slices are added 
counterclockwise, in the order the data points occur in the column.

Arranging Data for a
Pie Chart

To organize data for a pie chart, place data in a single worksheet column.

Figure E�1
Pie Charts

30% 25%

15%

10%
20%

Figure E�2
Arranging Data for

 a Pie Chart

All data is placed into a single
column.
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Making a Pie Chart 0

To make a pie chart:

1. If you want to select worksheet data before creating the graph, select the work-
sheet column to plot before creating your graph by clicking your data. Note that 
you do not have to select data before you start a graph; you can select the col-
umn to plot during graph creation.

2. Click the Pie Chart button in the graph toolbar. The Graph Wizard appears. 

You can also open the Graph Wizard by clicking the  toolbar button or by 
choosing the Graph menu Create Graph command

3. If you did not use the graph toolbar to open the Graph Wizard, select Pie Chart 
as the type of graph to make from the scroll box in the dialog box, then click 
Next. 

4. Specify which worksheet column corresponds to data for your plot. If you 
selected a column prior to opening the Graph Wizard, your choice automatically 
appears in the dialog box and you can click Finish to create the pie chart.

If you have not already picked columns, note that �Pie� is highlighted in the 
Selected Columns box. This shows which data you are picking a column for the 
pie chart. Pick a column either by clicking the corresponding column directly in 
the worksheet, or selecting the appropriate column from the Data for Pie list.

5. If you make a mistake while picking data, click the wrong entry in the Graph 

Figure E�3
The Graph Wizard
Displaying a List

of Graph Types
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Wizard, then select the correct column from the worksheet.

6. When you are done picking data, click Finish to create the pie chart and close 
the Graph Wizard.

Use the Graph Properties dialog box to modify the pie chart, or reopen the Graph 
Wizard to pick a different data column for your plot. For more information on 
making general modifications to your plot, see �Creating and Modifying Graphs� on 
page 151. 

Σ You cannot add plots or axes to pie charts. 

Modifying Pie Charts 0

Modifying pie charts includes:

➤ Picking new data for the graph (see �Picking Different Data for the Current 
Plot� on page 168).

➤ Changing fill color and patterns of pie chart slices (see �Changing Patterns and 
Fill Colors� on page 188).

➤ Rotating the pie chart (see the following section).

➤ Adding exploded pie slices to the pie chart (see the following section).

To modify a pie chart, select the graph and open the Graph Properties dialog box. To 
learn about selecting graphs and using the Graph Properties dialog box, see �Using 
the Graph Properties Dialog Box to Modify Graphs� on page 163 , and �Selecting a 
Graph or a Plot� on page 165. 

Rotating the
Pie and Adding

Exploding Slices

To rotate the pie, or add an exploding slice:

1. Double-click the pie chart to open the Graph Properties dialog box. If you dou-
ble-clicked the pie chart, the dialog box should open directly to the Pie Slices 
panel. If not, select the Pie Slices option from the Settings For list. 

2. To rotate the pie, use the Counterclockwise From slider control to change the 
starting angle shown in the First Slice option or type a new starting angle value 

Figure E�4
Using the Create

Graph Dialog Box to Pick
Columns to Plot



Working with Pie, Polar, and Ternary Plots

Pie Charts 355

in the Counterclockwise From edit box. Increasing the starting angle for the first 
slice moves the starting slice counterclockwise. Start the first slice at any angle 
from the default of 0° (3 o�clock) to 359°.

3. To explode one pie slice, choose Single Slice from the Exploded Slices list, and 
choose the number of the slice to explode from the Slice list. By default, the first 
slice begins at 0° and proceeds counterclockwise. If you have not rotated the pie 
chart, the slice number corresponds to the worksheet row number.

Σ Choosing No Exploded Slices replaces any exploded pie slices. 

4. To explode multiple slices, close the Graph Properties dialog box then view the 
worksheet and select an empty column. For each row you want to emphasize 
with an exploding slice, type a 1 in the same row as the data point.

5. Open the Graph Properties dialog box to the Pie Slices settings of the Plots panel 
and select the column containing exploding slice data from the Exploded Slices 
list.

6. Select the Many Slices option under Exploding Slices, and enter the column 
number containing the slice numbers.

7. Click Apply to apply changes without closing the dialog box, or click OK to 
apply changes and close the dialog box. 

Figure E�5
The Pie Slices Settings
of the Graph Properties

Plots Panel
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Polar Plots 0

Polar plots show data in an  format where r is the distance from the origin 
of the graph, and theta (θ) the angle described by a line passing through the center of 
the graph and the plotted data point, and another line passing through the horizontal 
center of the graph. 

Polar plots are useful for showing data where one value ( θ) is modular in nature, like 
a clock. An example of this is a graph that shows average temperatures of differing 
geographical regions during the days of a month, or months of a year. 

Figure E�6
A Pie Chart with Many

Exploding Slices
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Arranging Data for Polar Plots 0

Data for polar plots can be entered in either one of two ways:

➤ R, θ values

➤ X,Y coordinates

Data for Radial and
Angular Values

(R, Theta)

To arrange data using θ (angular) and R (radial) values, enter all θ values in one 
column, and enter the corresponding R values in another column. Data is plotted as 
θ versus R, which is similar to X,Y plots in organization, but differs from X,Y plots in 
that R is usually the dependent variable. 

Using X,Y Values
 for Polar Plots

Polar plot X,Y data is arranged the same as 2D plot X,Y data, with all X values in one 
column, and all Y values in another column; however, polar plots are plotted as R,θ 
pairs defined as:

 and 

where R is the radius, and θ is the angle of the data point.

Data for
Multiple Curves

Since SigmaPlot can graph more than one curve per plot, place as many additional θ, 
R values, or X,Y coordinates, as you want to plot in worksheet columns.

Using Data from
One Column for
Multiple Curves

SigmaPlot can also graph many curves using the same column as the θ or R data (or, 
X or Y data). There is no need to duplicate a column that is used for more than one 
plot; for example, enter the θ data into only one column, and enter the 
corresponding R data into as many columns as you have curves.

R x2 y2+= θ y
x
-- 

 atan=

Figure E�8
Theta, R Data for

a Polar Plot
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Making Polar Plots 0

To use SigmaPlot to create a polar plot:

1. If you want to select worksheet data before creating the graph, select the work-
sheet columns to plot by dragging the pointer over your data. Note that you do 
not have to select data before you start a graph; you can also select the columns 
to plot during graph creation.

If you want to select worksheet data before creating the graph, select the work-
sheet column to plot before creating your graph by clicking your data. Note that 
you do not have to select data before you start a graph; you can select the col-
umn to plot during graph creation.

2. Click the Polar Plot button in the graph toolbar, then select the style of polar 
plot you want to create. The Graph Wizard appears.

You can also open the Graph Wizard by clicking the  toolbar button or by 
choosing the Graph menu Create Graph command. 

3. If you did not use the graph toolbar to open the Graph Wizard, select Polar Plot 
as the graph type. Use the scroll bars to view the entire list. 

4. Click Next. The Graph Wizard displays the available polar plot styles. Select the 
desired graph style, then click Next.

Figure E�9
The Graph Wizard
Displaying a List

of Graph Types

Figure E�10
The Graph Wizard

Displaying a List of
Available Graph Styles

 for a Polar Plot
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5. Set the number of units on the angular axis by choosing a unit type from the 
Angular Axis Unit list, then click Next. Note that the Range Lower Bound and 
Range Upper Bound options change depending on your selection from the list. 
For more information on polar axes, see �Modifying Polar Axes� on page 361.

Σ If you don�t see the axis units you want to use for your polar plot listed in the list, 
you can type the desired values in the Range Lower Bound and Range Upper 
Bound edit boxes. 

6. Specify how your data is formatted by selecting the appropriate data format 
from the Data Format list. 

7. Click Next. The Graph Wizard prompts you to  specify which worksheet col-
umns correspond to the data for your plot. If you selected columns prior to 
opening the Graph Wizard, your choices automatically appear in the Selected 
Columns list, and you can click Finish to create the graph.

If you have not already picked columns, note that a single data type is high-
lighted in the Selected Columns box, indicating the data type you are picking a 
column for. 

8. Pick your data either by clicking the corresponding column directly in the work-
sheet, or choosing the appropriate column from the Data list. Repeat this pro-
cess for every column you are using to create your graph.

If you make a mistake while picking data, click the wrong entry in the Graph 
Wizard, then select the correct column from the worksheet. You can also clear a 

Figure E�11
Choosing an Angular Axis

Unit from the Angular Axis
Unit list

Figure E�12
Using the Graph Wizard to

Specify the Data Format
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column assignment by double-clicking it in the Selected Columns list. 

9. Click Finish when you are done you picking data. The specified polar plot 
appears.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard 
to pick different data columns for your plot. For more information on making 
general modifications to your plot, see �Creating and Modifying Graphs� on page 
151. 

Modifying Polar Plots 0

Modifying polar plots involves:

➤ Picking new data for the plot (see �Picking Different Data for the Current Plot� 
on page 168).

➤ Changing line and symbol type, size, and color (see �Changing Symbol Type 
and Other Symbol Options� on page 176 and �Changing Line Type and Other 
Line Options� on page 185).

➤ Modifying back plane color and grid lines (see �Modifying Grids and Planes� on 
page 230). 

➤ Modifying angular and radial axes (see �Modifying Polar Axes� on page 361).

To modify a polar plot, select the graph and open the Graph Properties dialog box. 
To learn about selecting graphs and using the Graph Properties dialog box, see 
�Using the Graph Properties Dialog Box to Modify Graphs� on page 163 , and 
�Selecting a Graph or a Plot� on page 165 . 

Figure E�13
Using the Create

Graph Dialog Box to Pick
Columns to Plot
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Modifying Polar Axes 0

Polar plots have a radial axis and an angular axis. The angular axis describes a circle 
and uses arcs or degrees (θ, or theta) as the scale. There are both outer and inner 
angular axes.

The radial axes are �spokes� of the circle and scale the distance from the center of the 
circle (the radius, or R). There are four radial axes, referred to as spokes 1-4. 

Σ Axis breaks cannot be created for either radial or angular axes. 

Angular Axes The angular axes can be drawn along the inner and outer circumferences of the 
graph. By default, the inner axis is not displayed. Angular axes can be modified by:

➤ Changing axis titles (see �Working with Axis Titles and Tick Labels� on page 
200).

➤ Displaying or hiding either axis (see �Hiding, Displaying, and Deleting Axes� on 
page 225).

➤ Changing axis lines (see �Axis Line and Color Thickness� on page 227 ).

➤ Changing axis scaling, range, and rotation (see �Changing Angular Axis Scaling 
and Position� on page 362).

➤ Changing the amount of polar arc displayed (see �Changing Angular Axis 
Scaling and Position� on page 362).
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0 20 40 60 80

0

20

40

60

80

020406080

0

20

40

60

80

A
ng

ul
ar

 D
at

a

0

30

60

90

120

150

180

210

240

270

300

330

0

30

6090120

150

180

210

240 270 300

330

Figure E�14
A Diagram of the Axes

of a Polar Plot

Radial Axis

Inner Angular Axis

Radial Axis

Angular Axis



Working with Pie, Polar, and Ternary Plots

362 Changing Angular Axis Scaling and Position

➤ Changing tick marks (see �Changing Tick Mark Intervals� on page 209).

➤ Changing axis tick labels (see �Changing Tick Labels� on page 217 ).

Radial Axes The radial axes are drawn along the radius of the graph, and by default are displayed 
as four axes extending from the center of the graph to the outer edge of the graph. 
Each of the radial axes is a representation of the same data, so the range and scale 
must be the same for each radial axis; however, you can modify the color, tick marks, 
labels, location, and display of each radial axis independently. Radial axes can be 
modified by: 

➤ Displaying or hiding any axis (see  �Modifying Radial Axes Lines and Position� on 
page 364).

➤ Changing display of axis and tick label titles (see �Displaying and Changing 
Radial Axis Ticks and Labels� on page 366). 

➤ Changing axis lines (see �Modifying Radial Axes Lines and Position� on page 364 ).

➤ Changing axis scaling (see �Changing Axis Scales� on page 203 ).

➤ Changing tick marks (see �Changing Tick Mark Intervals� on page 209).

➤ Changing axis tick label type (see �Changing Tick Labels� on page 217 ).

Changing Angular Axis Scaling and Position 0

Angular Axis Scaling Polar plot angular axis scale and range settings control the axis units and increments 
used to plot data. You can modify axis scale, range, units, and rotation using the 
Scaling settings of the Graph Properties dialog box Axes panel.

To change an axis scale, range, units, and rotation:

1. Select the axis, then click the toolbar button. 

2. To change the axis scale used, choose the desired axis scale type from the Scale 

Figure E�15
The Angular Axis Scaling

Settings of the Graph
Properties Dialog Box

Axes Panel
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Type list. 

For descriptions of the different scale types available, see �Axis Scale Types� on 
page 204, and �Using a Custom Axis Scale� on page 208 .

3. To change the measurement units of the angular axis, use the Angular Axis 
Units list. If you don�t see the axis units you want to use for your polar plot listed 
in the list, choose Other, then type new axis range values in the Range Lower 
Bound and Range Upper Bound boxes. If using a pre-defined measurement 
unit, the Range Lower Bound and Range Upper Bound box values are entered 
automatically. 

Σ The only effect of changing units is to change the pre-defined axis range. This 
range can be manually changed regardless of the current units.

4. To change the displayed arc of the polar plot,  use the Arc slider control. A set-
ting of 360° displays the entire circle, 270° displays three-quarters of the circle, 
90° displays half of the circle, and so on. 

Σ If you change the arc of the angular axis, the axis range remains the same. The 
current axis range appears along the new distance of the arc. 

5. To rotate the plot,  use the Start Angle slider control. The default is 0 ° (3 
o�clock). Rotation is counterclockwise.

6. Apply axis scaling settings by clicking Apply, or apply changes and click OK to 
close the dialog box. 

Moving Angular
Axis Positions

You can drag both inner and outer angular axes closer or further from the center of 
the graph. Just select the axis, and move it using the mouse.

To set exact locations for angular axes:

1. Double-click an angular axis. The Graph Properties dialog box Axis Line 
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options panel appears. 

2. Use the slider controls in the Show/Place Axes options to change the percentage 
in the Outer and Inner boxes axes, or select the value in the edit boxes and type 
a new value. 

Locations are described as the percentage of the distance the axes lie from the 
center of the graph. To move an axis out, increase the percent. To move an axis 
inward, decrease the percent. 

3. Click Apply to apply your changes, or OK to apply your changes and close the 
dialog box. 

Modifying Radial Axes Lines and Position 0

Control polar plot radial axes line settings using the Lines settings of the Graph 
Properties dialog box Axes panel. 

Moving and
Positioning
Radial Axes

To move a radial axis:

1. Select the axis on the page.

2. Use the mouse to drag it to a new location. Radial axes spin about the center of 
the graph like the spokes of a wheel. 

To set radial axis positions to exact degree positions:

1. Double-click a radial axis. The Graph Properties dialog box opens to the Axis 

Figure E�17
Moving an Angular Axis

Using the Graph Properties
Dialog Box Axes Panel
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Line options.

2. To move a radial axis,  use the Show/Place Axes slider controls to set a new loca-
tion, or select the edit boxes and type new values. The axis location is in degrees 
from 0° (3 o�clock). The defaults are 0 °, 90°, 180°, and 270°.

3. To offset an axis from the center of the graph,  use the Axes Start slider control 
to change the length of the radial axes. 

Setting the slider to 0% draws the axis from the center of the graph outward, 
25% draws the axis beginning a quarter of the distance from the center, 50% 
draws it half the distance from the center, and so on. 

4. Click Apply to apply your changes, or OK to apply your changes and close the 
dialog box.

Changing Radial
Axes Lines

To display and modify radial axes lines:

1. Double-click a radial axis. You can also right-click the axis and choose Graph 

Figure E�18
Moving Radial Axes Using

the Graph Properties
Dialog Box Axes Panel
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Properties, or select the axis and click the  button. 

2. To view or hide a radial axis,  use the Spoke 1, 2, 3, or 4 check boxes. The Show/
Place Axes edit boxes display the axis location on the graph. 

3. To change line color and thickness,  use the Line Properties options. 

4. Click Apply to apply your changes, or OK to apply your changes and close the 
dialog box.

Displaying and Changing Radial Axis Ticks and Labels 0

Use the Graph Properties dialog box Axes panel Labels settings to display polar radial 
axis labels, and modify tick labels. Angular axes labels are analogous to standard 
Cartesian graph titles and labels. However, radial tick marks and labels have 
additional positioning options.

Other than display and position, polar plot tick marks and labels have the same 
options as Cartesian graph tick marks and labels.

Changing Axis
Title and Tick

Labels Display

To view, hide, or move titles and tick labels on the radial axes:

1. Double-click a radial axis.

Figure E�20
Selecting a Color for the

Radial Axes
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2. Select the Labels option from Settings For list. 

3. Select either Minor Ticks or Major Ticks from the Apply To list, then use the 
Major (or Minor) Tick Labels options to move or hide the major or minor tick 
labels on the radial axes. 

4. Selecting (none) hides the labels, and choosing Clockwise or Counterclockwise 
moves the label from one side of the axis to the other.

5. Click Apply to apply your changes, or OK to apply your changes and close the 
dialog box.

Hiding Tick Marks You can simply hide tick marks by clicking the ticks and pressing the Delete key. You 
can also right-click the labels and choose Hide.      

Figure E�21
Selecting a Tick Label

Direction for a Radial Axis
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Radial Axis Tick
Mark Direction

You can specify the direction for radial axis tick marks for each pair of radial axes.

1. Double-click any radial axis tick mark. 

2. Select either Minor Ticks or Major Ticks from the Apply To list.

3. Use Direction options to change the tick directions on the radial axes. You can 
only change the directions for Spokes 1 and 3 together, and for 2 and 4 together.

Selecting Inward orients the ticks clockwise, and Outward points the ticks coun-
terclockwise. 

4. Selecting Both directions draws ticks both clockwise and counter-clockwise, and 
selecting (none) hides the tick marks.

5. Click Apply to apply your changes, or OK to apply your changes and close the 
dialog box.

Figure E�22
Selecting a Tick Mark
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Ternary Graphs 0

Ternary graphs plot data on an XYZ coordinate system in the form of three variables 
that add up to 100% or 1. These variables are typically the normalized proportions of 
three substances and are plotted on three axes generally arranged as an equilateral 
triangle. These graphs are also commonly referred to as triangle plots.

Ternary Plot Styles You can create ternary scatter, line, and scatter and line plots. These graph data as 
symbols, as lines only with no symbols, or as symbols and lines, respectively. Line 
shapes can be straight segments or spline. 

Arranging Data for a Ternary Graph 0

Data for ternary plots can be XYZ data in three separate columns or SigmaPlot can 
extrapolate a third column from data pairs in two columns. Ternary graphs must 
have at least one single or multiple-curve plot, but can hold many more plots, each 
with a different style and data format. If your raw values do not add up to 100% or 
1, SigmaPlot can convert them to normalized ternary data. If you have XY, YZ, or 
YZ pair data, SigmaPlot can compute the third-column values shown in the resulting 
graph.

Σ For more information on creating another plot for an existing ternary graph, see 
�Multiple Plots on a Graph: Adding New Plots� on page 170.

Data for a
Single-Curve Plot
(Ternary Triplets)

If you are creating a graph with a single-curve plot using only one set of XYZ values 
whose sum is 100% or 1, enter all X data in one column, all Y data in another 
column, and the corresponding Z data in another column. The columns do not have 
to be adjacent to one another, but they must be the same length. Ternary triplet data 
should always add up to 100% or 1. For information how to convert data whose sum 
is not 100% or 1, see �Normalizing Ternary Data� on page 370. 
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Data for a Multiple-
Curve Plot

(Ternary Triplets)

If you are creating a graph with a multiple-curve plot using multiple sets of XYZ 
values where the sum of each set is 100% or 1, enter into worksheet columns as many 
additional ternary triplet data sets as you want to plot. Each set of ternary triplet data 
is a separate plot-curve. All ternary triplet data sets should add up to 100% or 1. For 
information how to convert data whose sum is not 100% or 1, see �Normalizing 
Ternary Data� on page 370.

Data for a Single or
Multiple-Curve Plot

(Ternary XY, YZ,
or XZ Pairs)

If you are creating a graph with a single or multiple-curve plot using XY, YZ, or XZ 
pairs, enter all X, Y, or Z data in one column, and the corresponding X, Y, or Z pair 
values in another column. As long as all data pairs use a percentage or unitary scale, 
SigmaPlot will compute the third-column data shown in the resulting graph.

Σ SigmaPlot computes third-column data for plotting only. Computed third-column 
data is not displayed in the worksheet.

Normalizing
Ternary Data

To create a ternary graph using data whose sum is not 100% or 1, first convert the 
raw XYZ data into normalized ternary triplet data by using the Normalize Ternary 
Data transform.

To normalize ternary data:

1. Choose the Transforms menu Normalize Ternary Data command. The Normal-
ize Ternary Data Column Picker dialog box appears prompting you to select the 
source column for the X data.

2. Select the column with the original X data from the worksheet or the Data 
Source list. The selected column is assigned as the X Source in the Selected Col-

Figure E�25
Multiple Columns of Triplet

Percentage Data for a
Ternary Plot
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umns list and you are prompted to select the Y data source. 

3. Select the Y and Z columns from the worksheet or the Data Source list. You are 
prompted to select the X data destination column.

4. Select the X, Y, and Z destination columns as prompted and click next. You are 
prompted to select the type of scale for which you would like to normalize the 
data.

5. Select Percentage Scale (0-100) or Unitary Scale (0.0 to 1.0), then click Finish. 
The normalized ternary data appears in the previously selected worksheet col-
umns.

6. To graph the data, select a ternary plot from the Graph toolbar, choose the 
Graph menu Create Graph command, or select the Graph Wizard button and 
create a new ternary plot using the normalized ternary data in the previously 
selected worksheet columns.

Figure E�26
Selecting the Data

Columns to Normalize from
the Normalize Ternary Data

Column Picker Dialog Box

Figure E�27
Selecting the Scale Type

from the Normalize Ternary
Data Column Picker Dialog

Box
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Creating Ternary Graphs 0

To create a ternary plot:

1. Select the worksheet columns to plot before creating your graph by dragging the 
pointer over your data. You do not have to select data before you start a graph; 
you can select the columns to plot during graph creation.

Σ Ternary plot data set (triplet or pair) must be based on a percentage or unitary 
scale with the sum of all values being 100% or 1. If your data does not add up to 
100% or 1, use the Normalize Ternary Data transform. For more information, 
see �Normalizing Ternary Data� on page 370.

2. Click the Ternary Plot button in the graph toolbar.

3. Select the style of ternary plot you want to create. The Graph Wizard appears. 

You can also open the Graph Wizard by clicking the  toolbar button or by 
choosing the Graph menu Create Graph command. 

4. If you did not use the graph toolbar to open the Graph Wizard, select Ternary 
Plot as the graph type by highlighting it in the dialog box list. Then click the 
Next button. 

5. The Graph Wizard prompts you to select a ternary graph style. Highlight the 
desired style, then click Next.

Figure E�28
Selecting Ternary Plot from

the Graph Wizard
List of Graph Types

Figure E�29
Selecting a Graph Style
from the Graph Wizard
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6. The Graph Wizard prompts you to select the data format appropriate to the data 
you are plotting. Select the appropriate format and click Next.

7. The Graph Wizard prompts you to select the columns containing the data to 
plot. If you selected columns prior to opening the Graph Wizard, your choices 
automatically appear in the dialog box and you can click Finish to create the 
graph.

If you have not already picked columns, begin picking them now by either 
selecting them in the worksheet or choosing the columns from the Data Col-
umns list. When you have selected all the columns to plot, click Finish to create 
the graph.

Σ If you make a mistake picking columns, highlight the wrong entry in the Graph 
Wizard, then choose the correct column either in the worksheet or from the 
column list.

8. The Graph Wizard closes and the ternary graph appears displaying the plotted 
data.

Use the Graph Properties dialog box to modify the plot or to open the Graph 
Wizard to pick different data columns to plot or to add another plot to your 
graph. For more information on making general modifications to ternary plots, 
see �Creating and Modifying Graphs� on page 151. For detailed information on 
modifying ternary axes, see �Modifying Ternary Axes� on page 374.

Figure E�30
Selecting a Ternary Graph

Data Format from
the Graph Wizard

Figure E�31
Selecting Columns to Plot

Using the Graph Wizard
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Modifying Ternary Graphs 0

Modifying ternary graphs involves:

➤ Picking new data for the plot (see �Picking Different Data for the Current Plot� 
on page 168).

➤ Changing line and symbol type, size, and color (see �Changing Symbol Type 
and Other Symbol Options� on page 176 and �Changing Line Type and Other 
Line Options� on page 185).

➤ Modifying backplane color and grid lines (see �Modifying Grids and Planes� on 
page 230).

➤ Changing axis properties, including range and direction (see �Modifying 
Ternary Axes� on page 374).

To modify a ternary graph, select the graph and open the Graph Properties dialog 
box. To learn about selecting graphs and using the Graph Properties dialog box, see 
�Using the Graph Properties Dialog Box to Modify Graphs� on page 163 , and 
�Selecting a Graph or a Plot� on page 165. 

Modifying Ternary Axes 0

Ternary axes are drawn to represent increases in data value in a counter-clockwise 
direction by default. Axis direction can be reversed, indicated by a reversal of tick 
labels, and the tick direction changes accordingly. 

Because ternary axes are interdependent, any modification in the scale type or range 
of one of the axes is reflected in the other axes, and may alter the shape and size of the 
graph. You can modify the color and thickness of axis lines, the appearance of tick 
marks and tick labels, location and rotation of axis titles, and display of each ternary 
axis independently.

Ternary axes can be modified similarly to other graph axes. The following sections 
cover: 

➤ Changing display of axis titles (�Modifying Ternary Axis Title Location� on page 
375). 

➤ Changing axis range, scale, and direction (see �Changing Ternary Axis Range, 
Scale, and Direction� on page 376).

➤ Changing axis tick labels (see �Modifying Tick Label Display� on page 384).

➤ Changing axis tick marks (see �Modifying Ternary Tick Mark Line Appearance� 
on page 383). 
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To learn more about displaying or hiding any axis see  �Hiding, Displaying, and 
Deleting Axes� on page 225. For more information on changing axis lines, see �Axis 
Line and Color Thickness� on page 227 .

Σ Axis breaks cannot be created for ternary axes. 

Modifying Ternary Axis Title Location 0

You can position axis titles of ternary graphs either at the apex or along the length of 
the axis. You can also rotate them to a position parallel to the axis.

To reposition a ternary graph axis title:

1. Double-click the axis with the title you want to change.

2. Select Labels from the Settings For list.

To identify which axis is associated with and axis title, keep in mind that the title 
at the apex is always at the 100% point or maximum for that axis.

3. Select the desired location from the Show Axis Title list.

4. Choose None to hide the axis title.

5. To rotate the axis title parallel to the axis, check the Axis Title check box in the 
Rotate with Axis options. 

6. Click Apply.

Figure E�32
Selecting a Ternary Axis

Title Position
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7. Continue to modify the titles of the other axes. Specify the axis title you want to 
change using the Axis list, then make the desired changes. When you have fin-
ished, click OK to close the dialog box. 

Changing Ternary Axis Range, Scale, and Direction 0

Ternary axis scale type and range settings control the units and increments used to 
plot the data. Axis scale, range, and direction are modified using the Scaling settings 
of the Graph Properties dialog box Axes panel. Axis range can also be modified by 
dragging a selected axis. Modifying ternary axis range can alter the size and even the 
shape of the graph. 

Modifying Axis
Range by Dragging

You can modify axis range by dragging a selected axis or apex. Because ternary axes 
are interdependent, dragging an axis to modify its range can change the ranges of the 
other axes. 

Dragging an apex modifies the ranges of the two axes which form the apex; reducing 
the maximum of an axis range introduces a fourth axis, creating a trapezoid graph. 
Dragging a selected axis toward or away from the center of the graph modifies all 
three axis ranges by the same increment, maintaining the original shape of the graph. 

To modify ternary axis ranges:

1. View the ternary graph.

2. Select either an apex or an axis which you want to modify.
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3. A selected apex displays a black, square selection handle and is surrounded by a 
dotted line; a selected axis displays a selection handle at the center point of its 
range and is surrounded by a dotted line.

4. Drag either the apex or the axis toward or away from the center of the graph. 
The axis ranges adjust accordingly.

Σ Modifying axis ranges of ternary graphs often introduces additional axes. These 
axes are the second axes of each �pair� of axis lines. An axis which appears as a 
result of moving an apex is paired with the axis opposite the apex which moved. 
Additional axes can be modified and are controlled in the same way as the three 
original ternary axes using the Axes panel of the Graph Properties dialog box.

Figure E�34
Dragging an Axis to Rescale

a Ternary Plot Range
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Using the Graph
Properties Dialog Box

to Modify Ternary
Axis Range

You can also modify ternary graph ranges using the Graph Properties dialog box: 

1. Double-click the angular axis and select the Scaling option from the Settings For 
list.

2. Use the slider controls for X Range, Y Range, and Z Range to change individual 
axis ranges or type the new range in the corresponding edit box. 

Σ Note that when you change the Minimum for any axis, the maximums for the 
other axes adjust automatically. Changing the Maximum for any axis does not 
require changing the ranges for other axes.

3. When you have finished, click Apply to make the changes or OK to apply the 
changes and close the dialog box. The graph appears with new axis ranges.

Σ Increasing an axis range minimum reduces the size of the ternary graph because 
it is always reduces the other axis range maximums. Reducing the maximum of a 
ternary axis range changes the graph shape.

Ternary Scale Type All ternary axes on a single graph use either the default Percentage (0-100) scale or 
the Unitary (0.0-1.0) scale. Data used by each scale should be within the required 
ranges for each scale.

Graph creation determines the graph scale. There should be no need to change the 
scale unless a mistake was made during graph creation. Changing the scaling from 
Percentage to Unitary can also hide out-of-range data.

To change ternary axis scale type:

1. Double-click the angular axis.

Figure E�36
The Graph Properties Dialog

Box Axes Panel Showing
Settings for Scaling
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2. Select the Scaling option from the Settings For list. 

3. Select the new axis scale type from the Scale Type list.

4. Click OK to make the change and close the dialog box.

Σ
When you change the axis scale type for one axis, it is changed for all axes. 

Changing Ternary
Axis Direction

Ternary graph axes show data increasing in either a clockwise or counter-clockwise 
direction. Modifying axis direction changes all three axes; ternary axes are 
interdependent.   

Ternary graph axes have interdependent axis ranges from 0 to 100, where 0 to 100 is 
the default setting. The axis range and scale control the axis units and increments 
used to plot data. 

To modify the axis direction: 

1. From the Axes panel of the Graph Properties dialog box, select Scaling from the 
Settings For list. 

2. Select the axis you wish to modify from the Axis list.

3. Select the new axis direction from the Direction list.

Figure E�37
The Graph Properties Dialog

Box Axes Panel Showing
Settings for Scaling
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Click OK to apply changes and close the dialog box. The tick directions change on 
all three axes and the axis ranges reverse.

Changing the axis directions inverts the 0-100 direction of the labels and changes the 
direction of the tick marks. However, axis titles only move if they are positioned 
along an axis, not at an apex. Apex position for each variable remain constant 
regardless of axis direction

Figure E�39
The Graph Properties Dialog

Box Axes Panel Showing
Settings for Scaling
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Changing Ternary Axis Tick Marks and Tick Labels 0

Ternary axes tick marks indicate the precise location of each value at specific intervals 
determined by the axis range. Tick marks and tick labels along ternary axes have both 
direction and origin. Every tick location can have tick marks and labels pointing in 
clockwise, counter-clockwise, both clockwise and counter-clockwise, and 
perpendicular directions, independent of the actual direction of the data.

Tick and Tick Label
Directions and

Ownership

Tick marks and labels indicate which values correspond to the plotted data points by 
the direction they lean in. The direction also indicates which axis the tick is actually 
controlled by. This can be a different axis than the tick mark is actually drawn on. 

For example, the default ticks for the X axis are drawn leaning in a clockwise 
direction on the bottom axis. These tick marks also correspond to the counter-
clockwise tick marks on the Y axis. If you change the tick mark attributes for X axis 
ticks, you can affect tick marks that are actually drawn on a different axis.

The following figure best illustrates tick mark and label ownership.
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Modifying Ternary
Tick Marks Direction

and Intervals

Use the Graph Properties dialog box to modify tick appearance including tick length 
and color. You can also specify to view or hide tick marks, which side of the axis they 
extend from, and the tick interval.

1. Double-click the tick marks you want to change. You can also double-click the 
axis, then select Ticks from the Settings For list. 

2. Use the Apply To list to modify either Major Ticks or Minor Ticks. 

3. To turn tick drawing on and off and to select tick directions for both sides of 
an axis line, use the Direction lists. The second list is only available if a ternary 
plot range change has created a secondary axis.

Select an Out, In, or In and Out option to display tick marks on the selected 
axis out from the center of the graph, in toward the center of the graph, or both 

outward and inward. Select a clockwise, counter-clockwise, both, or 90 0 option 
to select the tick mark direction along the axis. Select (none) to hide tick marks. 

4. To change major tick intervals,  use the slider control or type a new value 
directly into the Major Tick Intervals edit box.

Figure E�42
Ternary Graph Tick

Direction Options

Figure E�43
Graph Examples of Tick

Marks Pointing, Counter-
clockwise, Clockwise,

Both, and 90 °
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5. To change minor tick intervals,  select a new value from the Minor Tick Inter-
vals list.

The same tick intervals are used for all axes.

6. Click Apply.

7. Use the Axis list to modify tick marks on a different axis, or use the Apply To list 
to switch to modifying major or minor tick marks.  

8. Click OK when finished to close the dialog box.

Modifying Ternary
Tick Mark Line

Appearance

To change tick mark display, length, color, and interval: 

1. Double-click the tick marks you want to change. You can also double-click the 
axis, then select Ticks from the Settings For list. 

2. Use the Apply To list to modify either Major Ticks or Minor Ticks. 

3. To change tick length and thickness,  use the Tick Line options Length and 
Thickness slider controls. Drag the slider control with the mouse or set the tick 
length and thickness to specific values by typing directly in the Length and 
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Thickness edit boxes. 

4. To change tick color,  use the Tick Line options Color list. Choose from any of 
the listed colors, or select (custom) to use a pre-defined custom color or create 
your own color. Choose (none) to create transparent tick marks.

For more information on custom colors, see �Using Custom Colors� on 
page 146.

5. Click Apply.

6. Use the Axis list to modify tick marks on a different axis, or use the Apply To list 
to switch to modifying major or minor tick marks.  

7. Click OK when finished to close the dialog box. 

Modifying Tick
Label Display

Tick labels are drawn using directions clockwise, counter-clockwise, and both 
clockwise and counter-clockwise. Tick label direction is controlled independently of 
the data direction. Tick labels can also be turned off, have a prefix or suffix added, 
and be rotated along the angle of the axis line. 

The tick label text can also be modified. For more information, see �Formatting 
Numeric Tick Labels� on page 218.

To modify tick label display along an axis:

1. Double-click the axis you want to change. 

2. Select Labels from the Show Settings For list. 

3. To view or hide axis tick labels, check or clear the Major (or Minor) tick Labels 
check boxes. Depending on the selected axis, the check boxes are Top, Bottom, 
Left, or Right.

4. To change the direction of the axis tick labels, check or clear the Clockwise and 
Counter-clockwise (CCW) check boxes. Both directions can be drawn at once. 

Figure E�46
The Graph Properties Dialog

Box Axes Panel Showing
Settings for Labels
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To draw tick labels at the 90 ° tick position, uncheck both direction options .

5. To add a suffix or prefix to the major or minor tick labels on ternary axes, choose 
either Major Ticks or Minor Ticks from the Apply To list, then use the Add To 
Major (or Minor) Tick Labels options to type a prefix or suffix to the major or 
minor tick labels.

6. To rotate major or minor tick labels parallel to their axis, choose either Major 
Ticks or Minor Ticks from the Apply To list, then check the Tick Labels check 
box in the Rotate With Axis options.

7. Click Apply. 

8. Use the Axis list to modify tick labels on a different axis, or use the Apply To list 
to switch to modifying major or minor tick labels. 

9. Click OK when finished to close the dialog box. 

Σ Tick labels and tick marks are controlled by their axis of origin, but may be drawn on 
axes other than their own.
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Troubleshooting

This appendix provides you with tips for resolving common problems and gives 
advice for improving SigmaPlot performance on your system. It includes:

➤ Installation suggestions

➤ Ways to reduce or eliminate memory and other errors

➤ Solutions to common printing problems

➤ Tips on improving printing speed

➤ Inserting special characters

➤ Inserting SigmaPlot graphs into WordPerfect

Troubleshooting Installation Problems 0

Certain conditions in your Windows Setup may interfere with the installation of 
your new version of SigmaPlot. This section describes how to resolve most common 
difficulties.

General Advice for
Windows 95 Users

Install in SafeMode  SAFEMODE is a mode of running Windows 95 that is 
designed specifically for troubleshooting problems and for the installation of new 
applications. In this mode, all Terminate and Stay Resident (TSR) programs will not 
be run, and the video display will be set to a generic VGA mode.

To install SAFEMODE, restart your computer, and when the words �Starting 
Windows 95" appear on the screen, press F8. Select SafeMode from the Microsoft 
Windows95 Startup Menu. When the Windows95 screen appears, begin installation.

Common Questions,
Explanations,
and Solutions

Question:   My installation stalls and gives this message: �Cannot copy file 
THREED.VBX to \WINDOWS\SYSTEM, file already in use,� followed by, 
�THREED.VBX is out of date, installation procedure cannot continue....�

Explanation:  This problem may occur if you attempt to install while other 
Windows applications are running in the background. For instance, Microsoft Office 
makes use of the system-wide file VBRUN300.DLL. This means that this file cannot 

F



Troubleshooting

388 Troubleshooting Installation Problems

be copied to \WINDOWS\SYSTEM if you are running Microsoft Office while 
attempting to install SigmaPlot.

Solution:  In this case, follow these steps:

1. Quit the installation procedure. Check to see which applications are currently 
running in the background by bringing up the Windows Task List on screen 
(Press CTRL+ESC on your keyboard). See �Install in SafeMode� on page 387 .

2. Keep a backup copy of the file on your system while preventing the Setup pro-
gram from identifying it.

Choose the File Manager Search command to examine files in your \WIN-
DOWS\SYSTEM directory and to find the file THREED.VBX. The Search 
Results windows should show the file, THREED.VBX. Then choose the File 
menu Rename command to rename the file THREED.VBX as THREED.OLD 
and close the File Manager.

Copy the file from the SigmaPlot installation disk to your \WINDOWS\SYS-
TEM directory.

Σ If you are prevented from renaming the file in Windows, you can instead 
rename the file in DOS. Exit Windows, then use the DOS RENAME command 
by typing:

C:\WINDOWS\SYSTEM>REN THREED.VBX THREED.OLD

3. You are now ready to try the installation again. The Setup program should 
install successfully.

Question:  My installation stalls and gives this message: �Cannot copy file 
VBRUN300.DLL to \WINDOWS\SYSTEM, file already in use. The installation 
procedure cannot be continued,� or, �Visual Basic Applications running, close 
applications.�

Explanation:  This problem may occur if you attempt to install while other 
Windows applications are running in the background. For instance, Visual Basic 
applications make use of the system-wide file VBRUN300.DLL. This means that 
this file cannot be copied to \WINDOWS\SYSTEM if you are running a Visual 
Basic application while attempting to install SigmaPlot.

Solution:  In this case, follow these steps:

1. Quit the installation procedure. Check to see which applications are currently 
running in the background by bringing up the Windows Task List on screen 
(Press CTRL+ESC on your keyboard). Quit ALL applications other than 
Program Manager.

2. Keep a backup copy of the file on your system while preventing the Setup pro-
gram from identifying it.
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Choose the File Manager Search command to examine files in your \WIN-
DOWS\SYSTEM directory and to find the file VBRUN300.DLL. The Search 
Results windows should show the file. Then choose the File menu Rename com-
mand to rename the file VBRUN300.DLL as VBRUN300.OLD and close the 
File Manager.

Copy the file from the SigmaPlot installation disk to your \WINDOWS\SYS-
TEM directory.

Σ If you are prevented from renaming the file in Windows, you can instead 
rename the file in DOS. Exit Windows, then use the DOS RENAME command 
by typing:

C:\WINDOWS\SYSTEM>REN VBRUN300.DLL VBRUN300.OLD

3. You are now ready to try the installation again. The Setup program should 
install successfully.

Question:  The installation starts fine, but as soon as �Initializing Setup� appears on 
the screen, my computer crashes.

Explanation:  Problems like this are usually linked to a video driver conflict. 
Switching the video driver you are currently using to a standard Microsoft VGA or 
SVGA driver will probably solve the conflict.

Solution:  Here are the steps to make the setup changes:

1. Quit the attempted installation and double-click the Windows Setup icon 
(usually located in the Main group of the Windows Program Manager). Under 
the setting Display, you will see the name and resolution details (if any) of the 
video driver you are currently using. Write down the full details of the current 
settings so that you can return to those settings later.

2. Choose the Options menu Change System Settings command, scroll the list of 
video display options and choose either VGA or SVGA from the list. You will be 
prompted to install the �Current� or newer driver; choose �Current�, then 
restart Windows for the change to take effect.

3. Attempt to reinstall once you are back in Windows. If you are unsuccessful, you 
may need to contact the manufacturer of your graphics card to update the driver.
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SigmaPlot Errors 0

After installation, if you double-click the SigmaPlot icon and get an error message 
such as the one shown below, there are a number of possible solutions.

Important Network
Information

As of SigmaPlot version 3.02, ALL workstations running SigmaPlot from a network 
must have FULL access to the application directory. Each time SigmaPlot is 
launched, it creates small files in the network application directory, and deletes them 
when it closes. If SigmaPlot cannot write to and erase from the application directory, 
it will not be able to run its counting routine and will not launch correctly.

Look in your SigmaPlot application directory for LOCKFILE.SYS. Delete the 
LOCKFILE.SYS file and then attempt to restart SigmaPlot.

Make sure that you have not exceeded the number of seats allocated on your network 
site license. If you have questions about the number of users allowed on your site, 
you can contact SPSS at:

Telephone: (510) 412-2900 

Fax: (510) 412-2909

Single-User
Solution

To resolve the error when NOT running from a network:

1. Check to see if you have another instance of SigmaPlot running on your system 
by viewing the windows task list. In Windows NT press Ctrl+Esc, and on 
Windows 95 press Ctrl+Alt+Del.

2. Check to make sure that you filled in the registration information because Sig-
maPlot will not run if you have not entered your registration number. Instead, 
an error message like, �unable to initialize properly...too many users or Sigma-
Plot is not properly registered,� will appear.

If you have entered the registration information, but somehow the file got cor-
rupted or tampered with, you can delete the file USERDATA.TXT from the 
application directory, and then double-click on the SigmaPlot Registration icon 
to re-enter the data.

3. Exit and Restart Windows. 

Figure F�1
The Too Many

Users Warning
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Resolving Printing Problems 0

Common Printing
Problems

Problem:  My Hewlett Packard Deskjet 600c prints text characters too far apart, 
with a space between each pair of characters.

Explanation:  This printer driver uses 2-cartridges, one for black and the other for 
color. The black cartridge supports three different resolutions: Best (600x600), 
Normal (600x300), and Econo (300x300). The color cartridge always prints at 
Econo (300x300) independent of the black settings.

Solution:  Change the default setting from Normal (600x300) to either of the 2 
selections, 600x600 or 300x300, to avoid getting any of the spacing problems for 
text characters.

Problem:  While printing from SigmaPlot, objects on the screen look fine, but one 
of the following errors shows up: �Printer Busy,� �Memory Overflow Error,� �Printer 
Overrun�, or it prints no text, a blank page, or won�t print at all.

Solution:  Try the following steps:

1. Update the printer driver to the latest version by obtaining the available printer 
driver from either the printer company or the SPSS Technical Support 
Department. To determine the current version of your driver go to the printer 
control panel (Settings/Printers from the Start bar in Win95) and select the 
desired printer by clicking it.

2. If you are using a Hewlett Packard Laserjet IV or above, or a compatible printer, 
select Raster as Graphics Mode. In Win95, this can be found under Settings / 
Printers / Properties / Graphics.

If the above does not work, try using a different printer driver. For example, the 
Apple Laserwriter II driver is a Postscript driver, and using this when printing to a 
Postscript printer will often yield good results.
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Improving Printing Speed in SigmaPlot 0

Printing speed is influenced by your system�s configurations and not by SigmaPlot. 
When printing, the �Updating Page� message appears and indicates that SigmaPlot is 
sending a �map� of the page through Windows. SigmaPlot waits for the Printer 
Driver within Windows to give the �go ahead� messages after each page segment is 
sent.

The following are some configuration variables to check.

The Spooler  Make sure that the Windows spooler is up and running. In 
Windows95, it is selected in the START/Settings/Printers/Properties/Details/Spool 
Settings.

Printer Memory and Hard-Disk Space   These are also factors in printing speed. 
The more printer memory and hard-disk space available, the faster the printing 
occurs.

Graphics Mode  Choosing the correct graphics mode for a type of graph can make a 
difference for HP Laserjet IV or above, or any compatible printer. Printing on 
HPGL/2 (vector type) mode is faster than Raster (bitmap type), unless you are 
printing a graph with error bars, in which case it is the other way around.

Pasting Special Characters 0

From time to time, you may need to put some characters or symbols onto your 
graphs or presentations. These symbols can be found in the Character Map dialog 
box. In Windows 95, the Character Map is located in the Accessories group.

Once a symbol is selected, the appropriate keystrokes that are necessary for this 
particular symbol shows in the bottom right corner.

Figure 1�1
Character Map Dialog Box
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For example, if you select the heart symbol, the bottom right corner shows 
�Keystroke: Alt+0169.� To insert the heart symbol into your graph, press the Alt key 
and then the numbers 0, 1, 6, and 9, while keeping the Alt key depressed. Release the 
Alt key and the heart will appear. For better appearance, make sure the font selected 
in SigmaPlot matches the font selected in the Character Map dialog box. If using the 
key pad, make certain that the Num Lock is set on.

Inserting SigmaPlot Graphs into WordPerfect 0

There are two basic ways to get a SigmaPlot graph into a WordPerfect document. 
One is to copy and paste the graph and the other is to insert the graph as a picture.

Copy and Paste or
Paste Special

In SigmaPlot, select the object you would like copied into your WordPerfect 
document. Choose the Edit menu Copy command to place the object on the 
Clipboard.

Now open your WordPerfect document and place the cursor where you want the 
Clipboard contents copied. Choose the Edit menu Paste command. You can also 
choose the Edit menu Paste Special command to paste a picture of a graph. For more 
information about inserting page objects, see �Cutting, Copying and Pasting Graphs 
and other Page Objects� on page 108.

Insert the Graph
as a Picture

To insert your SigmaPlot for Windows graph as a picture, first convert your 
SigmaPlot file into a graphical format that WordPerfect can read. 

The graphical formats available to output a SigmaPlot graph are EPS (Encapsulated 
PostScript), WMF (Windows MetaFile), BMP (Windows Bitmap), TIFF, and JPEG. 
For direction on exporting graphs and pages to files, see �Exporting Graphs and 
Pages� on page 51.

Once your graph is saved in a format that WordPerfect will accept, open your 
WordPerfect document and choose the File menu Insert command, then select File 
from the list. In the Insert File dialog box, set the List Files of Type to All Files, then 
select the file you want to insert into WordPerfect and click OK.
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Glossary

95% or 99% Confidence Lines  See Confidence Line.

Angular Axes  The angular axes of polar plot are drawn along the inner (if 
applicable) and outer circumferences of the graph. By default, the inner axis is not 
displayed, but if your radial axes are offset from the center of the graph, you can 
choose to display the inner angular axis. See also Polar Plot, Radial Axes.

Apex  The maximum/minimum or tip of the triangle for ternary plot axes.

ASCII File  See text file. (ASCII stands for American Standard Code for Information 
Interchange.)

Aspect Ratio  The Aspect Ratio option allows for resizing of graphs and objects 
without distortion. To maintain the aspect ratio (the ratio of length to height) of a 
graph or object during manual resizing, make sure the Stretch Maintains Aspect 
Ratio option is checked in the Options. 

AUTOEXEC.BAT  A DOS file that automatically executes a series of commands when 
DOS is booted.

Axis  In a Cartesian graph, an axis indicates the direction and range of X, Y, or Z 
values. In SigmaPlot, axes define the origin and scaling of a plot, and include tick and 
label definitions.

Multiple axes for 2D graphs can be created using the Graph menu Add Axis 
command. Because each 2D Cartesian plot can be associated with only one set of X 
and Y axes, you can only create new axes if your graph contains multiple plots. 
However, since a graph can contain an unlimited number of plots, you can create an 
unlimited number of X and Y axes for a graph. 

Σ Note that an unlimited number of plots can share a single axis.

Axis Break  A range along the axis where portions of a plot are omitted. If there is a 
large empty range between two sets of data, you can use an axis break to omit the 
empty range.

Axis Direction  For ternary axes, the direction that the data increases. This can be 
counter-clockwise (by default) or clockwise.
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Axis Label  Axis titles and tick labels. Axis titles can be automatically taken from the 
Axis name (as shown in the Axis panel of the Graph Properties dialog box) or 
manually typed using the Tools menu Text command. Tick labels can be numeric, 
time series, or taken from a worksheet column. See also Tick Labels.

Axis Pair  The top and bottom or left and right pairs in an axis. Each axis in the pair 
can be moved or turned on or off independently using the Lines settings of the Axes 
panel in the Graph Properties dialog box.

Axis Range  The minimum and maximum values of an axis, controlling the scale 
and extent of the plotted data. SigmaPlot uses default axis ranges unless you specify 
the range manually in the Scaling settings of the Axes panel in the Graph Properties 
dialog box. Major tick intervals are also controlled by the axis range.

Axis Placement  The position of an axis relative to the origin and �extent� of the 
graph. The graph extent is the size of the graph as indicated in the Object Properties 
dialog box. Use the Lines settings of the Axes panel in the Graph Properties dialog 
box to change axis positions.

Placement is described as a percentage of the axis distance from the original position 
with respect to the graph extent, where 0% is the original position. Axis position can 
also be changed by selecting an axis and dragging it.

Axis Title  See Axis Label.

Axon File  The format produced by an Axon Instruments data acquisition device. 
This file format can be read into SigmaPlot worksheets using the Import command.

Backplane  The plane at the back of a graph formed by the axes. Grid lines are 
attached to backplanes. Backplanes are selected and modified using the Grid and 
Planes panel of the Graph Properties dialog box.

Bad Points  Any of three types of data points: 1) data that fall outside the range 
specified for the axes; 2) empty, missing, or non-data cells; 3) data outside the legal 
range for an axis, for example, a non-positive value on a logarithmic scale. You can 
ignore bad points using the Data settings of the Plots panel in the Graph Properties 
dialog box.

Bar Chart   A plot which graphs data as vertical or horizontal bars with bar lengths 
equal to the data values. If you plot more than one column of data, the data is plotted 
as groups of bars. Select a plot, then use the Graph Wizard � Modify Plot dialog box 
to change a plot to a bar chart. See also Plot Type and Stacked Bar Chart.

Base (of an exponent)  The number that is raised to the exponential power (for 
example, 10 or e).

Bitmap  A general description for an image composed of individual bits, or pixels. 
Also a term for the Window bitmap graphic file format.

The resolution of a bitmap is dependent on the dpi, or dots per inch, it is created 
with. Because the number of pixels that compose a bitmap is constant, making a 
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bitmap appear smaller increases its relative resolution by increasing its dpi. 
Conversely, making a bitmap larger reduces the dpi and its resolution.

Block  1) A selected, rectangular region of worksheet cells. Blocks can be copied, 
deleted, pasted, transposed, sorted, printed, and exported. 2) A transform language 
function that operates on worksheet blocks.

BMP  See Bitmap

Box Plot  A plot type that displays the 10th, 25th, 50th, 75th, and 90th percentiles 
as lines on a bar centered about the mean, and the 5th and 95th percentiles as error 
bars. The mean line and data points beyond the 5th and 95th percentiles can also be 
displayed. See also Plot Type.

Bubble Plots  A special case of scatter plot where a third dimension is graphed using 
the areas of the symbols.

Cartesian  A graph using a rectangular XY (or XYZ) coordinate system. SigmaPlot 
can create both 2D and 3D Cartesian graphs. See also Coordinate System.

Category Scale   A scale which uses numerical values or text from a worksheet 
column used to generate a plot. Each distinct entry in the column is a separate 
category against which the corresponding data values are plotted. 

Cell  1) A location on the worksheet that holds a single data value or label, described 
by its column and row number. 2) A transform language function that specifies the 
coordinates and contents of a worksheet cell.

Clipboard   The Windows data buffer where cut or copied data and graphics are 
stored. Press Ctrl+V or use the Edit menu Paste command to paste Clipboard 
contents to the worksheet or page. Note that data and graphics are stored in the same 
Clipboard, so cutting additional data or objects overwrites current Clipboard 
contents. Cleared (deleted) data or graphics bypasses the Clipboard and leaves the 
current contents intact.

Codes (graphic cell)   Graphic cell codes can be typed into a worksheet column to 
sequence different types for plot lines, symbols, and fill patterns. You can also use the 
Edit menu Insert Graphic Cells command to sequence lines, colors, symbols, and fill 
patterns. 

Coefficient  A real number that multiplies a variable in an algebraic expression. See 
also Correlation Coefficient and R Value.

Column Averaging  Plotting the mean value of each column. This is most often used 
as a means of creating error bars. Standard deviation, standard error, or 95% or 99% 
confidence values can be used as error bar values.

Column  The SigmaPlot worksheet consists of columns and rows. A column 
generally holds a range of numbers to be plotted as a set. This set can be X, Y, or Z 
values, plotted against another column or against their row numbers. Columns can 
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also be plotted as pie chart slices, or averaged and plotted as a single data point. See 
also Pie Chart and Column Averaging.

Columns can also hold labels, and sequences of custom symbol or line types, fill 
patterns, error bar directions, and colors.

Column Statistics  A collection of statistics computed for each column. Open the 
Column Statistics window by choosing the View menu Column Statistics command.

Common Log Scale  An axis type that plots data along a logarithmic scale with base 
10. See also Natural Log Scale.

Confidence Line  For a regression line, there is a probability that any given data 
point will fall within a certain distance from the line. A confidence interval is the 
region where a data point will fall with a specific degree of probability. SigmaPlot can 
calculate 95% and 99% confidence intervals.

Contour Plot  Contour plots are a rendering of three dimensional data in two 
dimensions. The z, or vertical, dimension is represented by drawing lines that follow 
the XY coordinates of specific z intervals. Topographic maps are an example of 
contour plots.

CONFIG.SYS  A DOS file that installs device drivers and sets system parameters 
when you turn on or restart your computer.

Coordinate System  A system that defines the method of defining data point 
placement on a graph. SigmaPlot supports 2D and 3D Cartesian graphs, polar plots, 
ternary plots, and pie charts. 

➤ Cartesian graphs use two or three rectangular axes to describe data point 
location. 

➤  A polar plot describes data using angle and radius within a circular region. 

➤ Ternary graphs plot data along three axis ranges that have a sum of 100%. 

➤ A pie chart uses polar coordinates to assign slice sizes to data point values. 

A graph's coordinate system is fixed when you create the graph and cannot be 
changed. See also Plot.

Copy  Place selected worksheet data or graphic objects in the Windows Clipboard 
without removing the data or objects. The Clipboard contents can be placed 
elsewhere on the worksheet or page by pressing Ctrl+V or selecting the Edit menu 
Paste command or Edit menu Paste Special command.

Correlation Coefficient (R)  R, or the measure of closeness of a regression to the 
data. Specifically, it is the covariance divided by the product of the sample standard 
deviations. SigmaPlot calculates the correlation coefficient for linear regressions.

Cubic Spline Interpolation  A mathematical formula connecting data points with a 
smooth curve. It can be roughly described as a running interpolation of cubic 
polynomials. 
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Cursor  Specifically, the blinking vertical entry bar for text, or the current cell 
highlight on the worksheet. See also Pointer.

Curve  The graphical display of a single data set, either a line/scatter curve or a set of 
bars or boxes. SigmaPlot data sets are the data in a single worksheet column or in a 
set of XY or XYZ columns. A plot can consist of multiple curves where more than 
one set of data columns are plotted. See also Plot.

Curve Fit  See Nonlinear Regression.

Cut  Remove selected data or graphics and place them in the Windows Clipboard. 
Press Ctrl+X or use the Edit menu Cut command to cut data or graphics. Cut 
displaces any current Clipboard contents. Only the last cut item can be pasted. Note 
that data and graphics use the same Clipboard.

The Clipboard contents can be placed at any selected worksheet or page location by 
pressing Ctrl+V or choosing the Edit menu Paste command or Edit menu Paste 
Special command. Clipboard contents can also be pasted into other Windows 
applications. See also Paste.

Data Set A column or set of worksheet columns that have been picked to plot. 
Column assignment labels at the bottom of the worksheet indicate the data sets for 
the currently selected plot. See also Plot and Curve.

Date/Time Scale  An axis that plots true calendar dates and times using real time 
increments.

Delimiter  A symbol or character used to separate data fields within a data file 
format; for example, white space, commas, semicolons, or colons.

Dialog Boxes  Windows of commands and options that appear on the screen. Use 
dialog box options to view and change graph and program settings.

DOS Shell   Used to access the DOS prompt from within Windows to run DOS 
commands. The DOS window mays not contain enough memory to run large 
applications.

Drag   Move the mouse while holding down the left mouse button. Dragging is used 
to move objects, stretch objects, or select regions.

Drop Lines    Lines which can be added to 2D and 3D plots which use symbols. 

Edges  This term refers to the outline of bar chart bars, symbols, box plot boxes, pie 
chart slices, and the lines in a 3D graph mesh grid. Edge color is determined by the 
color of the fill pattern. Edge thickness can be modified using the Fills settings of the 
Plots panel in the Graph Properties dialog box. 

Edit Text Dialog Box  A dialog box used to enter or edit text labels or symbols on the 
graph page.

Embed   Use the Edit menu Paste Special to embed an object on a graph page. 
Embedding an object on the page places a copy of the object on the graph page and 
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enables you to edit the object by activating the object�s source application when you 
double-click it, but does not change the original file from which the object was 
pasted. 

Encapsulated Postscript File (EPS)  Encapsulated PostScript files are scalable line 
art graphic files. Use this file format to export SigmaPlot graphs to other word 
processor and graphic applications. To create an EPS file, you must have a correctly 
installed Postscript printer driver supported by Windows. 

Error Bar  A graphical display of the data variability. Error bar values can be 
automatically calculated through column averaging, or they can be entered in the 
worksheet columns.

Error Bar Column  A data column containing error bar values.

Error Bar Direction  The error bar direction can be specified for each curve or for 
each data point within a curve. These directions can be absolute (always up or 
down), relative (toward or away from zero), or both.

Excel Workbook   The file format for Microsoft Excel, which can be opened and 
used in its native format by SigmaPlot.

Exploding Pie Slice  A slice in a pie chart that is separated from the rest of the chart 
for emphasis.

Exponent  The power to which the base is raised. See Base.

Export   Save worksheet data or a graph page from SigmaPlot to a file, for use with 
other programs. Choose the File menu Export command to export files.

Fills  Fills include pattern of lines and colors that fill bar chart bars, pie chart slices, 
3D graph mesh grids, 3D bar fills, and drawn objects. Fill patterns affect the color of 
bar, box, and slice edges and mesh grid lines. Fills and edges are specified using the 
Fills settings of the Plots panel in the Graph Properties dialog box. Use the Format 
menu Fill command for drawn objects.

Film Recorder  A hardcopy device used to print SigmaPlot graphs on a slide or 
photo for presentation. Slidemakers are a type of film recorder.

Font  A style or type of character. TrueType fonts are available from the Windows 
system. Other fonts, such as PostScript and Hewlett Packard fonts, are only available 
if the printer drivers are installed.

Frame Lines  Lines which are drawn to complete the �cube� outlining a 3D 
Cartesian graph. Frame lines can be drawn using either the viewer or the origin as the 
reference. Use the Frame Lines settings in the 3D View panel of the Graph Properties 
dialog box to turn on/off frame lines.

Gaussian  1) A continuous probability distribution defined by two parameters, 
mean, and variance. Also called the normal distribution. 2) A  transform language 
function used to generate random normally distributed data.
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Geometric Mean  The mean obtained by taking the antilog of the mean of the 
logarithm of the original variable. Error bars created using the logarithm of the 
variable are equidistant from the geometric mean when displayed on a logarithmic 
scale. This option is only available when using logarithmic axes. 

You can use the geometric mean instead of the arithmetic mean when using error 
bars. See Error Bar and Column Averaging.

Graph  In SigmaPlot, a graph is an object on the page of specific size and location, 
associated with a coordinate system. Back planes, plots, and axes are attached to 
graphs. Graphs can contain multiple sets of plots. 2D graphs can have multiple axes. 
Graphs are created with the Graph Wizard or Graph menu Create Graph command.

See also Back Plane, Coordinate System, Page, and Plot.

Graph Defaults  A limited set of graph attributes that can be set to apply to newly 
created graphs. Graph defaults do not affect existing graphs.

Set graph defaults using the Tools menu Options. command.

Graph Style  The style of a graph determines the appearance of data on the graph. 
The style you can assign to a graph depends on the graph type. The Graph Wizard 
lists the available graph styles once you have selected a graph type. 

Graph Type  The kind of representation for graphed data. SigmaPlot can produce 
2D line and/or scatter plots, bar and stacked bar charts, Tukey box plots, line and/or 
scatter polar plots, contour plots, and 3D line and/or scatter, bar charts, and mesh 
plots. Pie charts do not have different plot types. 

Graphic Object  See also Object.

Any object appearing on the page and capable of being moved; for example, text, 
lines, boxes, ellipses, and graphs.

Grid  Horizontal or vertical lines incremented according to the tick mark intervals of 
the associated Cartesian axes. Grid lines are modified using the Grids and Planes 
panel of the Graph Properties dialog box.

Grid lines are attached to graph back planes. See also Back Plane and Tick Marks.

Grouped Bar Chart See Bar Chart.

Help System  A system of indexed screens linked by hypertext providing on-line 
information about SigmaPlot commands and operations. Press F1 to view the 
Contents screen of the help system, or choose one of the Help menu commands to 
get additional help information.

Related topics are linked through highlighted words on the screen; selecting these 
brings up the entry for that topic.

Histogram  A representation of frequency distribution showing the number of 
occurrences within specified intervals, usually displayed as a bar or step chart.
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The histogram of a worksheet column can be generated and plotted by choosing the 
Statistics menu Histogram command, or by using the histogram transform function. 

Hot Key  A quick method of selecting menu commands and dialog box options. A 
letter in the command or option appears highlighted; pressing that letter selects the 
command or option. See also Keyboard Shortcut.

Import  Transfer data from a file to the SigmaPlot worksheet for plotting or other 
operations. SigmaPlot recognizes text, .DIF, .Lotus 123, Quattro, Excel, SigmaPlot 
(*.SPW, *.SP5, and *.SPG), Mocha worksheets, and other file formats.

Choose the File menu Import command to select files to import.

Increment  See Scheme

Insert  A data entry mode where existing data is moved aside to make room for 
entered data. When typing text labels on the page, you are always in insert mode.

To switch between insert and overwrite modes on the worksheet, press Insert or 
choose the Edit menu Insertion Mode command. Worksheet data is moved down 
one row. 

When entering text, press the Insert key to toggle between insert and overwrite 
modes. In insert mode, characters are moved to the right to make room for the new 
characters. See also Overwrite.

Inverse Distance Interpolation  Inverse distance interpolation is a method of 
generating an evenly spaced XY mesh from XYZ data points. The Z value for each 
interpolated data point is calculated using the Z values of all original data points. The 
weight given the value of the nearer original data points versus the farther data points 
can be modified. 

JPEG  A compressed bitmap graphic file format commonly used on the World Wide 
Web. See also Bitmap.

Label  Any text string, including tick labels, axis titles, and text entered using the 
Tools menu Text command. Tick labels are modified using the Tick Labels settings 
of the Axes panel in the Graph Properties dialog box. 

Text labels manually placed on the page can be modified by double-clicking them or 
using the Format menu Text Properties command. See also Axis Label, Rotation, 
Label Size, Font, and Tick Labels.

Label Size  The size of text label characters, specified in points (one point =  
inch).

Landscape  Orientation of a page so that page width is greater than page height. 
Page orientation is controlled using the File menu Page Setup command or Printer 
Properties options in the Print dialog box. See also Orientation (Page) and Portrait.

Legend  An explanation of the symbols on a graph. Legends are inserted by choosing 
the Tools menu Text command, selecting a location on the page, then selecting the 

1 72⁄



Glossary

403

Symbols button to specify the graph, placement of symbols, and legend style to use 
for the legend.

Line Graph  A plot type in which data points are connected by lines. Line graphs and 
trajectory graphs are 2D Cartesian graphs or 3D Cartesian graphs using a line plot 
type. Use the Graph Wizard � Modify Plot dialog box to change a plot type and style. 
See also Scatter Plot and Plot Type.

Linear Curve Fit or Linear Regression   A linear regression of plotted data 
performed to a specified order. SigmaPlot can calculate 1st to 10th order regressions, 
and save the coefficients and R values to the worksheet. Use the Statistics menu 
Regressions command to perform regressions. See also Confidence Interval and 
Regression.

Linear Axis Scale  An axis scale in which values along the axis increment 
arithmetically.

Link   Use the Edit menu Paste Special command to place a linked object on the 
graph page. Linking the object appears to place a copy of the object on the page, but 
actually only places a reference to the original object file, and modifies the object 
every time the original file is changed. 

Logarithmic Scale  See Common Log and Natural Log.

Logit Scale  An axis scale based on the logit equation 

Menu Bar  A list of menus appearing at the top of the SigmaPlot screen. These 
menus can be selected with a mouse, or by pressing Alt and the first letter of the 
menu name. When one menu appears, the adjacent menu can be pulled down by 
pressing → or ←. 

Mesh Plot  A mesh plot is a 3D Cartesian plot of an even XY grid from XYZ data 
points, generating a surface. The worksheet data for mesh plots must be in a specific 
order to create the mesh. 

Mesh data can be generated from scatter data using inverse distance interpolation. 
See also �Inverse Distance Interpolation .�

Metafile  A standard Windows graphic file format, also known as a Windows picture 
file. Metafiles are a vector, or line-based file format, as opposed to a bitmap format. 
Metafile graphics are printed at the highest resolution a printer is capable of, no 
matter what size they are scaled to.

Natural Log Scale  An axis type that plots data along a logarithmic scale using 
base e.

Logit ln
y
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Normalize Ternary Data  Raw data must be converted to unitary data (0-1) or 
percentage data (0-100) in order to be plotted on a ternary graph. The Transforms 
menu Normalize Ternary Data command does this conversion for you.

Notebook File   SigmaPlot notebook files are files that contain worksheets, graph 
pages, reports, and regression equations. Notebook files are provided as a means for 
automatic file organization, enabling you to keep separate notebooks for separate 
groups of data. 

Novice Prompting  Messages alerting you to certain situations or which double 
check some choices (for example, telling you that data contains missing values or 
asking for confirmation before clearing data). Novice prompting can be disabled 
using the Tools menu Options command.

OLE2   Objects pasted from the Clipboard to a graph page can be linked, embedded, 
or placed on the page as a generic object without any kind of file reference. Linked 
and embedded objects use OLE2, Object Linking and Embedding version 2. 

Open  Load a file into SigmaPlot, either a .JNB (notebook) file,.JNT (template 
notebook) file, or any other file format supported by SigmaPlot.

Options  Settings used to customize SigmaPlot behavior and to set program defaults. 
Use the Tools menu Options command to access the Options dialog box.

Orientation (page)  Describes the orientation of a page. Page orientation can be 
either portrait (right-side up) or landscape (sideways).

Page orientation is controlled using the File menu Page Setup command or Printer 
Properties options in the Print dialog box. See also Portrait and Landscape.

Orientation (text)  Describes the rotation of a text label around an axis so the text 
reads left to right, top to bottom, or bottom to top. The orientation is entered as the 
number of degrees the label is to be rotated from the left-to-right. Also called 
rotation.

Origin Axes  For 3D Cartesian graphs, the axes intersecting at the X,Y, and Z 
coordinates closest to zero. The origin axes are used as a point of reference when 
rotating the view of a 3D graph, and appear as red lines in the 3D View panel of the 
Graph Properties dialog box. See also Rotation (3D Graph).

Overwrite  A data or text entry mode in which newly typed characters replace 
characters already on the screen. See Insert.

Page (graph)  A SigmaPlot item where graphs, labels, and graphic objects are 
drawn. The page displays the current graph(s) and other objects as they appear when 
printed. 

You can use Tools menu drawing commands and the Edit menu and Format menu 
commands to directly edit, move, resize, delete, and paste graphs and objects on the 
page.
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Paste  Place the contents of the Clipboard at the selected location. On the 
worksheet, the upper left corner of the Clipboard data block appears at the 
highlighted cell. On the Page, the Clipboard contents are offset from the original 
object�s position.

Press the Ctrl+V, Shift+Ins, click the Paste toolbar button, or choose the Edit menu 
Paste command to paste data or graphics.

Paste Special  Place the contents of the Clipboard as an object of specified file 
type, as an embedded object, or as a linked file object.

Percentage Scale  A scale ranging from 0-100 as the absolute minimum and 
maximum, used for ternary graphs.

Perspective  A 3D graph view option, controlling the apparent �depth� of the 
graph. Use the Rotation settings of the 3D View panel in the Graph Properties dialog 
box to change a 3D graph's perspective.

Pie Chart  A graph where each data point in a column is represented as a pie slice 
equivalent to its percentage of the total.

Plane  See Backplane.

Plot  The graphed results of paired sets of data columns. 2D and 3D Cartesian plots 
can contain multiple curves, and 2D and 3D Cartesian graphs can contain multiple 
plots. Plots are created when you create a graph using the Graph menu Create Graph 
command, or added to an existing graph using the Graph menu Add Plot command.

Each plot is also associated with a set axes. All curves in a plot must use the same plot 
type. See also Axis, Curve, Graph, and Plot Type.

Note that 2D Cartesian, 3D Cartesian, polar, ternary, and pie charts are considered 
different coordinate systems. See also Cartesian, Polar Plot, Ternary Plot, Pie Chart, 
and Coordinate System.

Point (pt)  A unit of measure used in typesetting. Seventy-two points equal one inch. 

Pointer  The tool controlled by the mouse used to choose commands, select dialog 
box options, select data on the worksheet, and select and modify page objects. 
Sometimes called the cursor.

The pointer is usually arrow shaped. On the page, the shape of the pointer changes 
according to its current function.

Polar Plot   Polar plots show data in an  format where r is the distance 
from the origin of the graph, and theta ( θ) is the angle described by a line passing 
through the center of the graph and the plotted data point, and another line passing 
through the center of the graph horizontally on the page. 

Portrait  Orientation of the page so that the height is greater than the width. Page 
orientation is controlled using the File menu Page Setup command or Printer 
Properties options in the Print dialog box. See also Landscape and Orientation.

r f θ( )=
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Position  Defines the position of a graph on a page. Graph position is displayed in 
the Size and Position panel of the Object Properties dialog box, accessed by right-
clicking a selected graph, and choosing Properties from the popdown menu. You can 
also use the Format menu Size and Position command to center and align selected 
graphs and objects with respect to the page.

Preferences  See Options.

Probability Scale  An axis scale in which a sigmoidally shaped curve identical to the 
Gaussian cumulative distribution function appears as a straight line.

Probit Scale  An axis scale identical to the probability scale, except that it is 
expressed in terms of standard normal deviates increased by five. A probability of 0.5 
(50%) corresponds to 0 standard normal deviates, or five probits. One standard 
normal deviate on either side of zero encompasses 68.2% of the area under the 
normal curve. A probit of 6 (1+5) corresponds to the 84.1% probability and a probit 
of 4 (-1+5) corresponds to the 15.9% probability (68.2% = 84.1% - 15.9%).

Quality Control Lines  See Reference Lines.

R Value  The correlation coefficient, or square root of R2. R2 is sometimes called the 
coefficient of determination and is a measure of the closeness of fit of a scatter graph 
to its regression line where R2 = 1 is a perfect fit. 

SigmaPlot calculates R when performing all regressions. See also Correlation 
Coefficient and Regression.

Radial Axes   The radial axes of a polar plot are drawn along the radius of the graph, 
and by default are displayed as four axes extending from the center of the graph to 
the outer edge of the graph.

Reference Lines  Horizontal or vertical lines on a Cartesian graph drawn at specific 
values. The value can be computed as either the mean of the data, a specified 
multiple of a specific statistic above or below the mean, or a specific number. The 
statistics available are standard deviation, standard error of the mean, and 95% or 
99% confidence intervals.

Regression  Regression is most often used by scientists and engineers to visualize 
and plot the curve that best describes the shape and behavior of their data. 

Regression procedures find an association between independent and dependent 
variables that, when graphed on a Cartesian coordinate system, produces a straight 
line, plane or curve. This is also commonly known as curve fitting.

SigmaPlot uses a least squares method to curve fit your data. Choose the Statistics 
menu Regression Wizard command to pick an equation and run the curve fitter. You 
can also define any equation using the SigmaPlot transform language. See also 
Transform. 
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Regression Coefficients The coefficients a0,...,a10 calculated for polynomial 
(linear) regressions. SigmaPlot can save these regression coefficients to the worksheet. 
See Regression.

Regression Equation (Library Notebook)   A notebook file which stores sets of 
regression equations, which can be viewed, browsed, open and run by the Regression 
Wizard.

Regression Order  The exponent of x in the polynomial regression y = a 0 + a1x + 
a2x2 +...+ a10x10. SigmaPlot can calculate up to 10th order regressions. See also 
Regression.

Regression Wizard  A graphical wizard interface used to guide you trough nonlinear 
regression (curve fitting) procedures. See Regression.

Report  A text document that supports text and paragraph formatting and object 
pasting. Reports are saved to notebooks. Reports are also produced by running the 
Regression Wizard.

Rich Text Format (RTF)  A text file format that supports complex text and paragraph 
attribute formatting. The SigmaPlot report is stored in RTF.

Rotation (3D Graph)  The vertical and horizontal angles of rotation for a 3D 
Cartesian graph. These indicate the number of degrees the origin axes are from the 
absolute 0,0,0 origin. 

Use the Rotation settings in the 3D View panel of the Graph Properties dialog box to 
change the rotation of a 3D graph. See also Origin Axes.

Rotation (Text)  See Orientation (Text).

Scatter Plots  A plot type where a symbol represents each data point. Scatter plots 
are 2D or 3D Cartesian graphs using a scatter plot type. 

Select the plot, then use the Graph Wizard � Modify Plot dialog box to change a plot 
to a scatter plot. See also Line Graph and Plot Type.

Scheme  Symbols, lines, colors, and fill patterns can be sequenced by using schemes. 
Schemes can be customized by right-clicking the property options list, then selecting 
First from the popdown menu to specify the order of the sequence. Schemes can also 
be created by entering graphic cell codes into a worksheet column.

Scientific Notation A form for expressing numbers using the letter e to represent the 
power of 10. For example, the scientific notation for 10.0 is .

Scroll Box  A dialog box option containing a list of items. You can scroll up or down 
to reveal more selections. Selected scroll boxes have a scroll bar appearing along the 
right side. You can use the mouse to drag the scroll bar up or down, or click the up 
and down arrow buttons.

Section   Sections are a subdivision of the notebook file which is a compound file 
used to save all data and graphs in SigmaPlot. Notebook sections are individual 

1 10
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�folders� that contain notebook items. Notebook items are worksheets and graph 
pages you have created using SigmaPlot. 

Each notebook section may contain only one worksheet, but can contain unlimited 
pages. Within sections, notebook items are indicated as worksheets or graph pages by 
icons that appear next to item names. 

Select (object)  To choose an object on the page in order to perform an operation 
(such as move or delete) on it. Graphs, axes, text labels, and drawn objects can be 
selected. Items can only be selected when the Tools menu Select Object command is 
checked.

To select an object, click while the pointer is over the object. Selected objects are 
surrounded by square handles or a dotted line. You can select multiple objects by 
dragging a dotted-line box completely around the objects, or by holding down the 
Shift key while selecting individual objects.

Series Labels  Tick labels that are automatically incremented in time units (days, 
months, or years), or in an alphabetic or numeric sequence. Series tick labels are 
selected using the Tick Labels settings of the Axes panel in the Graph Properties 
dialog box.

SigmaLink   Links SigmaPlot to worksheets from open copies of SigmaStat or 
SigmaScan. Choose the File menu SigmaLink command, or press Ctrl+L to link 
worksheets. 

Sort  To arrange items in an ascending or descending order. Selected blocks of 
worksheet data can be sorted using the Transforms menu Sort Selection command. If 
you sort more than one column, all columns are sorted according to the selected key 
column.

Spline Curve  A smooth curve passing through all the data points of a scatter graph. 
SigmaPlot uses a cubic spline interpolation to generate the curve. Use the Plot menu 
Lines/Options command to change a line to a spline shape.

Stacked Bar Chart  A bar chart plot type where each bar is divided to represent each 
category. SigmaPlot plots each row in the selected columns as a stack in a bar.

Standard Deviation (Std Dev)  A measure of the spread of the data about the mean. 
The sample standard deviation is the square root of the ratio of the sum of the 
squares of the residuals divided by degrees of freedom (the number of data points, 
minus one).
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Standard Error (of the Mean) The standard deviation of the mean, computed by 
dividing the sample standard deviation by the square root of the sample size.

Swap File  Windows makes use of virtual memory swapping temporary buffers and 
information to a swap file specified in the Virtual Memory settings in the Control 
Panel. You can use a swap file to optimize the performance of SigmaPlot on your 
system. 

Symbol  The figure (such as a circle or triangle) used to represent a data point in a 
line or scatter plot. Plot symbols are modified using the Symbols settings of the Plots 
panel in the Graph Properties dialog box. 

Template  All of the settings for a page except for the data. Use templates to create 
complicated sets graphs from existing pages.

SigmaPlot includes a template notebook file containing several page templates you 
can use to create new pages with specific attributes. You can also create your own 
page templates and save them in a Template Notebook file (*.JNT), or use a graph 
page as a template by copying it into a different section. 

The SigmaPlot Notebook Template file, TEMPLATE.JNT, is located in the program 
directory. Use the File menu New command to create pages from these templates. 

Ternary Plot  A graph that plots the proportions of three values on using three axes. 
The proportion that each value is equal to its percentage of the whole, and 
coordinates for each data point on the graph add up to 100%.

t-Test  A statistical test used to determine if there is a difference between the means 
of two samples. Also called Student's t-test. Use the Statistics menu 
t-test and Paired t-test commands to perform a t-test for two worksheet columns.

Text Box  A dialog box option used to enter text information, such as file names or 
values.

Text File  A �plain text� file format widely used by word processing, desktop 
publishing, and spreadsheet programs. SigmaPlot can import and export text files.

Tick Labels  Labels (usually numeric) which appear next to axis tick marks, 
indicating the value of each tick. Alphabetic characters can be added as prefixes or 
suffixes to the numbers. You can also use date and time, category, or series labels. 

Choose the Tick Labels settings of the Axes panel in the Graph Properties dialog box 
to modify tick labels. See also Axis Range.

Tick Marks  Marks along an axis indicating the precise location of each value at 
specific intervals. Major tick mark intervals are determined by the axis range. Minor 
tick marks create a specified number of intervals between major tick marks. 
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Tick mark intervals are also used as grid line intervals. See also Axis Range and Grid. 
Use the Ticks settings of the Axes panel in the Graph Properties dialog box to specify 
major and minor tick intervals. 

Tick Origin  The value used to compute the starting tick mark locations along an axis 
(usually zero). The actual starting value is determined by the range and major tick 
increment. If the origin is less than the beginning of the axis range, the tick 
increment is added to the tick origin until the axis range is reached. 

The tick origin is specified in the Ticks settings of the Axes panel in the Graph 
Properties dialog box. See also Axis Range.

TIFF  Tagged Image Format File. This is one of the most common bitmap graphic 
formats used by both PCs and Macintoshes, and is the native file format for many 
graphic programs, such as Adobe Photoshop. See also Bitmap.

Toolbar  Toolbars are floating palettes containing buttons to execute many common 
File, Edit, View, Format, Tools, and Graph menu commands and to select a graph 
type and style with a single click. These include selecting text, line, box, and ellipse 
drawing modes, inserting legends, grouping objects, and moving objects to the front 
or back of the page. 

You can view the function of a toolbar button using Tool Tips. Move the mouse 
pointer over the button, and leave it there for a moment without clicking to view the 
Tool Tip.

Transform  A mathematical equation that generates data, either by performing 
calculations on columns of data in the worksheet, or by producing series of random 
or automatically incremented numbers.

Transforms are created using the Transforms menu User-defined command. See the 
Programming Guide  for a complete description of transform functions.

Transparent Meshes  Turning a 3D mesh plot transparent enables you to more 
clearly show the intersections between two or more 3D meshes. You must have a 
High Color (10 bit) or True Color (24 bit) video card for this feature to work 
properly. You may check your system�s color capabilities under the Windows Display 
Properties Settings.

Transpose Paste Switches the orientation of worksheet data so that columns 
become rows and rows become columns.

Use the Edit menu Transpose Paste command to paste Clipboard data with rows and 
columns transposed.

Unitary Scale  An axis scale with an absolute range of 0-1, used by ternary plots.

Worksheet  Worksheets are the containers for the data you analyze and graph. They 
are spreadsheet-like in appearance but are much more limited in function, and are 
column rather than cell oriented.



Glossary

411

A worksheet opens automatically every time a SigmaPlot notebook is open. You can 
also open a worksheet any time you are using SigmaPlot. You can enter worksheet 
data manually, import it, or, in some cases, data is automatically placed in worksheet 
columns by SigmaPlot. Some functions are available for displaying and manipulating 
worksheet data.

Whiskers   Indicate the 10th and 90th percentiles of a box plot. Whisker cap width 
can be modified and color can also be applied to whiskers.

Error bars are sometimes referred to as whiskers.

Zoom  Enlarge or shrink the view of the current page. Click the toolbar zoom 
button, then click and drag to specify an area of the page to zoom, use the drop-
down list in the toolbar to use pre-set zoom levels, or choose the View menu Zoom 
command to change the zoom level. You can view a page at 50%, 100%, 200%, 
400%, full screen, or fit the page in the current window.
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Symbols

. 149

.ASC files
opening 47�48

.CVS files
opening 47�48

.DBF files
opening 47�48

.DIF files
opening 47�48

.EPS files
creating 332

.HPGL files
creating 332
importing 333

.INI file
editing 341�348

.JNB files
exporting as non-notebook files 51
saving 50

.JNT files
creating 409
defined 2
saving 409

.MOC files
opening 47�48

.PRN files
opening 47�48

.SMB files
importing 60

.SP5 files
opening 47�48

.SPG files
opening 47�48

.SPW files
opening 47�48

.TXT files
opening 47�48

.WK* files

opening 47�48
Numerics
10th/90th percentiles

box plots 263
2D graphs

adding plots 172
arranging data 235, 237
bar charts 234
box plots 234, 264
creating 238, 240
creating multiple axes for single plot 275
creating plots with error bars 244
error bars 262
examples 9�14
grouped bar charts 247, 250
grouped bar charts with error bars 247
line/scatter 407
linear regression lines 264�268
modifying plots 234�273
multiple axes 275
multiple plots 172
plotting data 234, 235, 237
plotting multiple curves 236
plotting mutiple curves, same X or Y 236
plotting X or Y using row numbers 237
polar axes 367
reference lines 273
same X or Y for multiple curves 235
single curve plots 235

3D bar charts
data format 154
fills 191

3D function
generating mesh data 301

3D graphs
adding plots 172
axes placement during rotation 296
bar chart data format 154
bar charts 278
changing view 292

Index



Chapter 

414

creating 283, 284
creating mesh 287
data format 154
examples 15�17
frame lines 298
generating mesh data 3, 291
interpolating data 291
interpolating mesh data 3
light source 295
lighting 296
line data format 154
mesh 278
mesh data format 154
mesh grids 3
mesh lines/fills 292
mesh plots 287
modifying 277�298
multiple plots 172
origin axes 293
perspective 296
plotting data 277, 279, 282
positioning axes 296
rotation 296
scatter 407
scatter data format 154

3D grid points 3
3D mesh plots

data format 154
3D plots

see 3D graphs
3D scatter plots

adding drop lines 196�198
data format 154
lines 187
symbols 176�184

A
Accessing

SigmaPlot user information 21
Adding

axes 275
axis breaks 230
contour labels 307�309
exploding slices to pie charts 354�355
frame lines 296
labels to page 134�136

multiple axes for single plot 275
new plots 172
prefix/suffix to tick labels 221
reference lines 273
sections to notebook files 43
suffixes/prefixes 307
text to page 134�136
worksheets to notebook files 43

Algorithm
inverse distance interpolation 289

Aligning
axis titles 201
graphs 34
legends 143
objects/graphs/labels 3, 130�131
snap-to grids 132
text 133
using crosshairs 132
using snap-to 132
with grids 131
with rulers 131

Alphanumeric symbols 180
Angular axes

about 361
arc 362�363
defined 395
modifying 367
range 362�363
rotation 362�363
scale 362�363
units for polar plots 162

Angular values 357
Apex

dragging to modify ternary axis ranges 376
Applying

data transforms 3
Arc, axis

angular 362�363
Arithmetic mean

see mean
Arranging

data for 2D graphs 235, 237
data for 3D graphs 282
data for a single curve 235
data for bubble plots 246
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data for contour plots 282
data for polar plots 357
data for ternary graphs 371
radial and angular values for polar plots 357
XY data for polar plots 357

Arrhenius scale 208
Arrows

drawing 121
modifying arrow heads 124

ASCII files
defined 395
see text files

Aspect ratio
defined 395
Options 94

Attributes
changing line 227�228
defining axis breaks 229
text formatting 137

Author information
Options 18

AUTOEXEC.BAT
defined 395

Automatic legends 2
displaying 139
editing 141
Options 17
see also legends

Available statistics 64
Averaging

see  mean
Axis

3D placement during rotation 296
about 273
adding 275
additional for multiple plots 273
angular 162, 367
breaks 2, 230
category scale 205
changing range 202
changing scale 36, 206
contour range values 306
creating multiple for single plot 275
defined 9, 395
dragging to modify ternary ranges 376

Extreme Value Distribution axis scale 208
labels 201
labels, defined 396
line attributes 227�228
linear scale 204, 403
logarithmic scale 204, 403
logit scale 204, 403
modifying 296
modifying range by dragging 376
moving 2D 227
multiple 2
multiple pairs 275
natural log scale 204, 403
origin axes 293, 404
pair, defined 396
placement, defined 396
polar 367
positioning 3D 296
positioning using Graph Properties dialog 226
probability scale 204, 406
probit scale 204, 406
radial 367
radial tick labels 367
range values 202
range, defined 396
scale types 206
scale values 221
scale, category 206
tick labels 221
tick marks 216, 384
titles 201, 396
turning on/off 225
using drawing tools, using formatting commands 

3
using Object Properties dialog 228
X and Y 2

Axis breaks
appearance 229
creating 230
defined 395

Axis scale
Arrhenius 208
Extreme Value Distribution 208
types 204�205

Axis titles
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hiding 201
viewing 201

Axis, range
contour plots 306

Axis, scale
switching to category 206

B
Back planes

color 231
defined 396
grid lines 232

Background colors
modifying 191

Backup files
Options 18

Bad points 176
defined 396

Bar charts
automatic reference lines 271
bar widths 195
creating 238, 240
defined 396
edges 123�124
error bars 262
examples 234
fills 123�124, 191
grouped bars with error bars 250, 252
histograms 253�256
horizontal data format 154
needle 253
needle plot 195
selecting data 161
spacing bars 194�196, 250
stacked 408
step 253
vertical data format 154

Bar charts, 3D
creating 283, 284
examples 278

Bar widths
changing 28
variable 196

Bars
edges 123�124
fills 123�124, 191

spacing 194�196, 250
stacked 408
widths 195

Base
using as tick labels 219, 309

Base and exponent
defined 396

Bidirectional error bars
data format 156

Blocks
defined 397

Blocks, data
inserting and deleting 79�81
sorting 77�78

Box plots
10th/90th percentiles 263
box fills/color 263
box widths 263
creating 238, 240
data format 154
defined 397
edges 123�124
examples 234
fills 123�124, 191
mean lines 263
modifying 264
outliers 263
symbols 176�184, 263
whisker cap widths 263

Boxes
drawing 121
edges 123�124
fills 123�124, 191

Breaking
links 118

Breaks
see axis breaks

Bubble plots 176
2D 247
applications 244
arranging data 246
arranging data for size 245
converting area data to diameters 245
plotting data 246
transforms dialog 245
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X, Y values 244
Bucket values

histograms 254
C
Calculating

confidence intervals 268�270
error bar mean 261
error bars 262
linear regressions 268�270
prediction intervals 268�270

Cap width
see  Error bars

Cartesian
defined 397

Category scale 205
creating 206
defined 397

Cells
defined 397
moving to 58
using as column titles 83

Centering
axis titles 201

Changing
3D graph view 292
axis range 202
axis scale 36, 206
bar/box fills 123�124
colors 188
column width 68�69
contour labels 307�309
contour plots 304�309
contour range values 306
edge color 189
fill pattern 189
fills 188
foreground color 189
graph titles 28
grids 230
inserted object icons 116
line end attributes 124
line types 124, 185
multiple selected objects 125
objects fills 123�124
page color 145�146

pasted object icons 115
pattern density of plot fills 189
patterns 188
pie charts 355
polar plots 360�361
radial axes 364�367
radial axes tick labels 367
range direction 379
scale direction 379
slice fills 123�124
source files for links 118
symbol fills 123�124
ternary axis direction 379
ternary graphs 374
ternary range 379
ternary scale type 378�379
text formatting 137
tick label text 218
tick values 221
units of measurement 145
see also Modifying

Chapters
outline 21

Characters
non-keyboard 135
using as symbols 180

Chart fills
color incrementing 189

Charts
creating pie charts 353

Cholesky decomposition 269
Clearing

graph titles 121
graphs/objects 121
legends 121
see also deleting

Clipboard 78
cutting and copying data 75, 78, 108
defined 397
placing contents 398
using 108

Codes
assigning to worksheet 335�340
defined 397
fill pattern codes 340
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line type codes 340
symbol codes 338�339

Coefficients
defined 397
regression 407

Color 191
assigning to worksheet 191
axis lines 227�228
bars 191
box plots 191, 263
changing 188
contour lines 306
custom incrementing schemes 191�193
custom, using 146�149
error bars 258
frame lines 296
graph back planes 231
grids 231
incrementing chart fills 189
line 124
lines 186
mesh lines/fills 292
page 145�146
radial axes 366
reference lines 272
tick marks 215, 384

Color incrementing
customizing 191�196
symbols 178

Column averaging
defined 397
grouped bar chart 250, 252

Column picker dialog
Graph Wizard 168�169
interpolate mesh 287
normalizing ternary data 370

Column statistics
defined 398
exporting 67
maximum value 66
minimum positive value 66
minimum value 66
missing values 66
other values 66
printing 67

setting Options 17�19
size of sample 65
standard deviation 65
standard error 65
sum of sample 65
viewing 3, 64�67

Column width
changing 68�69

Columns
averaging 65
column title dialog 82
defined 397
deleting 79�81
editing titles 83
inserting empty 79�81
inserting graphic cells 191
inserting symbol size values 182
key 77
multiple Z 279
picking different data for current plot 169
plotting multiple curves, same X or Y 236
plotting X or Y using row numbers 237
plotting XYZ 282
same X or Y for multiple curves 235
selecting 77
Sizing 68
sizing 76
sorting data 77�78
statistics 64�67
switching from rows to columns 81
tick labels 223, 309
titles 82�83
type labels 223

Common logarithmic axis scale 204
defined 398

Computing
see calculating

Confidence intervals
adding to 2D graphs 267�268
calculating 268�270
linear regressions 267�268

Confidence lines
95% and 99% confidence interval 65
defined 269�270, 398

CONFIG.SYS file
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defined 398
Contour labels

changing frequency 307
numeric 308�309
rotating 307
skipping 223
suffixes/prefixes 307
text attributes 308
turning on/off 307

Contour lines
color 306
line types 305
modifying 305�306
showing/hiding 305
thickness 305

Contour plots
adding labels 307�309
data format 154
defined 398
editing contour labels 308
example 14
frequency of contour labels 307
line types 305
modifying 304�309
modifying contour lines 305�306
modifying labels 307�309
modifying Z data range/scale 306
plotting data 280�282, 304
sample graph 14
X,Y,Z values 280

Conventions
manual 21

Converting
area data to diameters for bubble plots 245
data to mesh format 291

Coordinate system
defined 398

Copy and Paste 62, 63
Copy shortcut 58
Copying

data 79
defined 398
graphs 100
notebook items between notebooks 49
objects/graphs 108

Correlation coefficient (R)
defined 398

Creating
additional axes for multiple plots 273
axis breaks 230
category scale 206
contour plots 304
EPS files 332
Excel worksheets 43
graphs 151�167, 171�198
graphs using Excel worksheets 87
graphs with Graph Wizard 160
histograms 253�256
JNT files 409
labels 133�136
legends 133�136
multiple axes for single plot 275
multiple curves 236
new graph for current page 100
new object to insert 116
page templates 106�119
pie charts 353
polar plots 360
sections 43
single curve plots 235
ternary graphs 372�373
text labels, legends 133
worksheets 43

Crosshairs 132
Cubic spline interpolation

defined 398
Curve fitting

generating data 92
using the Regression Wizard 92
see also regressions and the Programming Guide

Curves
break in 176
defined 399
multiple for polar plots 357
multiple in graph 257
multiple, same X or Y 236
plotting multiple 236, 257
plotting X or Y using row numbers 237
same X or Y for multiple curves 235
single 235
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spline curve 408
Custom color 146�149

right-clicking 149
Customer Service 19�20
Customizing

color increments 191�196
error bar directions 260
fill increments 191�196
fill sequences in worksheet 335�340
line increments 191�196
line sequences in worksheet 335�340
symbol increments 191�196
symbol sequences in worksheet 335�340
tick labels 223, 309
tick mark intervals 216

Cut shortcut 58
Cutting

data 79
defined 399
notebook items between notebooks 49
objects/graphs 108

D
Data

2D graphs 234, 235
3D graphs 277, 279
applying transforms 3
arranging for 2D graphs 235, 237
arranging for 3D graphs 282
arranging for bubble plots 246
arranging for contour plots 282
arranging for polar plots 357
arranging for ternary graphs 371
column statistics 64�67
contour plots 282, 304
converting bubble plot area 245
converting data to diameters for bubble plots 245
converting to mesh 291
converting to mesh format 3
copying 79
curve fitting 92
cutting 79
deleting 79
effects of weight values 288
entering 55�88, 92
entering 2D 23

exporting 400
fitting equations to 92
generating 92
generating mesh 301
Graph Properties dialog 175
importing 30, 60�63, 81, 402
inserting 60
interpolating 3, 289
interpolating mesh 287
long form mesh format 280
mesh, converting to 3
missing 176
modifying 29
moving 79
multiple-curve plots (ternary triplets) 370
normalizing for ternary graphs 370�371
one column for multiple curves in polar plot 357
out-of-axis range 176
pasting 79
picking 162
pie charts 352�354
plotting 24
plotting additional 172
plotting different data for current plot 169
plotting portion of 175
plotting X or Y using row numbers 237
polar plots 357, 360
printing 52�53
radial and angular values 357
rearranging 81
regression 3
sampling 175
saving 50
selecting 24, 77
selecting for bar charts 161
selecting for ternary graphs 372
single-curve plot (ternary triplets) 369
sorting 77�78
ternary graphs 371, 372
transforms 92
transposing 81
using transform language 91
weighting mesh 288
X,Y, many Z for contour and mesh plots 281
XY pairs 235
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XY values for polar plots 357
Data columns

labeling 31
Data format

3D graphs 154
box plots 154
contour plot 154
graph styles 155�160
graph types 153
horizontal bar chart 154
line and scatter plot 154
line plot 154
long form mesh 280
multiple horizontal step plot 157
multiple regressions 155
multiple scatter plot 155
multiple spline curves 156
multiple vertical step plot 156, 157
pie chart 154
polar plot 154
scatter plot 154
simple regression 155
simple scatter plot 155
simple vertical plot 156
specifying 162
ternary graphs 154
vertical bar chart 154
vertical dot plot 156

Data set
defined 399

Date and Time
Options 17
tick intervals 213

Date and Time axis scale
tick labels 223
tick labels for contour plots 309
tick marks 213
using 209

Date and Time format
date delimiters 74
entering 59
regional settings 74
time delimiters 60
using with Excel 75
worksheet display 71�75

Date delimiters
Date and Time formats 74

Defaults
setting graph 153

Degrees of freedom 90
Delete Cells... command

shortcut 58
Delete shortcut 58
Deleting

columns and rows 79�81
data 79
graph titles 121
legends 121
objects 121
plots 174
undoing delete 174
see also clearing

Delimiter
defined 399

Density
changing pattern of plot fills 189

Design
graphing references 22
principles of graphing 22
suggested reading 22

Dialogs
Options 18

Direction
customized error bars 260
error bars 259
reference lines 272

Display formats
Date and Time format 71�75
numbers 70�71

Displaying
automatic legends 139
axes 225
contour labels 307�309
contour lines 305
frame lines 298
grid lines 232
page margins 143
plots 174
reference lines 271
toolbars 6�8
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DOS
shell, defined 399

Dot plot
vertical data format 156

Double-clicking
opening Graph Properties dialog 165

Dragging
2D axes 226
defined 399
radial axes 364
ternary axes 376

Drawing
arrows 121
ellipses 121
lines 121
objects 3, 121
toolbar 122

Drop lines
adding to plots 196�198
attributes 197
defined 399
for single point 198
modifying 197

E
E Notation Always

display 70
E Notation When Needed

display 70
Edge color

changing 189
Edges

bar/box 123�124
defined 399
plot line thickness 189
slice 123�124

Edit box
worksheet 59

Edit menu commands
Copy 79
Cut 79
Delete Cells... 79
Insert New Object 116
Paste 79
Transpose Paste 81

Edit text

defined 399
Editing

automatic legends 141
axis tick labels 217
axis titles 201
column titles 83
contour labels 307, 308
graph titles 166�167
notebook items 46
notebook sections 46
object links 118
page format 143
pasted graphs in other applications using OLE2 

109�118
plot name 166
radial axes tick labels 366
SPW32.INI file 341�348
text 137
tick labels 218

editing 46
Ellipses

drawing 121
Embedding

defined 399
objects 111�118
Reports 111

Encapsulated PostScript
see EPS files

Engineering notation 219
Entering

column titles 82�83
data 23, 55�88, 92
data from keyboard 59
Greek symbols 135
labels 134�136
symbols in legends 136
text 133�136

EPS files
creating 332
defined 400
importing 333

Equations
confidence intervals 269�270
linear regression 268�269
prediction intervals 270
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Error bar source 161
Error bar values 161
Error bars

absolute direction 259
bidirectional data format 156
calculating 262
cap width 258
color 258
creating 2D plots with 244
creating grouped bar charts with 247
custom directions 260
defined 400
direction 259, 400
generating 262
grouped bar charts 250, 252
horizontal data format 155
line thickness 258
mean computation method 261
methods for generating 262
modifying 262
modifying appearance 258
multiple and regressions data format 155
multiple data format 155
plot types 240
relative direction 259
simple and regression data format 155
simple data format 155

European address and phone number 20
Examples

2D graphs 9�14
3D graphs 15�17
contour plot 14
mesh plot 16
pie chart 12
polar plot 13

Excel worksheets
creating graphs 87
limitations 86
new 43
opening data files 85
opening other file formats 47
regression 87
statistics 86
system requirements 4
toolbars 87

transforms 87
using 84�85
using Date and Time format 75
using Excel Export commands 86
using Excel print commands 86
workbooks 3

Exit command 20
Exiting

SigmaPlot 20
Exploding pie chart slices 354�355

defined 400
Exponents

defined 400
numeric tick labels 219, 309

Exporting
column statistics 67
data 400
defined 400
Excel worksheets 86
worksheet data 52�53, 400

Extreme Value Distribution scale 208
F
Factor

axis tick labels 220
File formats

.HPGL 332
import Comma Delimited (.CSV) 61
import dBase (.DBF) 61
import DIF 61
import DOS files 60
import Lotus 1-2-3 (WK*) 61
import Microsoft Excel (.XLS) 61
import Mocha Worksheets 61
import Plain Text (.TXT, .PRN,.DAT,.ASC) 61
import Quattro/DOS (.WK*) 61
import SigmaPlot 1.0 and 2.0 (.SPW) 60
import SigmaPlot Macintosh 4 and 5 Worksheet 

60
import SigmaScan (.SPW) 61
import SigmaStat 1.0 (.SMB) 60

File menu commands
Page Setup 143
SigmaLink 48

File types 85
Files
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as objects to insert 116
breaking links between source and object 118
changing source for linked objects 118
embedding objects 111�118
EPS files 332
exporting as non-notebook files 51
HPGL 333
HPGL files 332
importing data from 60�63, 81
JNT files 409
linking objects 111�118
notebook 39
notebook templates 106�119
opening non-notebook 47�48
PostScript 332
printing to 332�333
saving 50
saving notebook 50
SPW32.INI 341�348
text 63
updating links 117

Fill pattern
changing 189

Fills
bar chart 123�124
box plot 123�124
box plots 263
changing 188
custom incrementing schemes 191�193
defined 400
increment customizing 191�196
mesh plots 292
modifying 191
object 123�124
pattern codes 340
pie chart 123�124
symbol 123�124

Film recorder
defined 400

Fitting
equations to data 92

Fixed Decimal
display 70

Fonts
defined 400

Greek 135
PostScript 133, 333
printing tips 329�333
screen and printer 329
symbols 135
TrueType 133, 329�330

Foreground color
changing 189

Format menu commands
Align 130�131
line 124

Formatting
Date and Time tick labels 223
labels 3
text 137

Frame lines
adding to 3D graphs 298
color 296
defined 400
line type 296
modifying 296
relative to origin 298
relative to viewer 298
turning on/off 298

Frequency
contour labels 307

Functions
MESH 300

G
Gaussian transform

defined 400
Generating

curve fit data 92
data for 3D functions 92
error bars 262
linear regression lines 264�268
mesh data 3

Geometric mean
defined 401

Global
changing multiple page objects 125

Global text changes 137
Glossary 395�411
Go to...

worksheet cell 58
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Graph
defined 401

Graph defaults 2, 19
Options 153
setting 153

Graph dialogs
Graph Properties 95
Graph Wizard 95

Graph page
see page

Graph page command
creating files 332�333
printing to file 332�333

Graph Properties dialog 98
3D view tab 292, 296
bar widths 195
changing ternary axis range 378
customizing tick labels 223
data sampling 175
modifying graphs 163�164
modifying grids and planes 164
modifying tick appearance 209, 214
modifying titles and legends 164
moving axes 226
naming plots 167
pie charts 354
positioning 2D axes 226
radial axes 364
viewing/hiding axis 225

Graph Properties dialog box
modifying graphs 26

Graph style
multiple straight lines 156
simple straight line 156

Graph style data format
bidirectional error bars 156
horizontal point plot 156
hortizontal error bars 155
multiple error bars 155
multiple error bars and regressions 155
multiple horizontal step plot 157
multiple regressions 155
multiple scatter plot 155
multiple spline curves 156
multiple vertical step plot 156

simple error bars 155
simple error bars and regression 155
simple horizontal step plot 157
simple regression 155
simple scatter plot 155
simple spline curve 156
simple vertical step plot

format 156
vertical dot plot 156
vertical point plot 156

Graph styles
3D graph display 2
cubic spline interpolation 2
error bars 2
regression 2
selecting with Graph Wizard 2

Graph titles
changing 28
deleting 121

Graph toolbars
2D, 3D 100

Graph type data format
3D bar chart 154
3D line plot 154
3D mesh plot 154
3D scatter plot 154
box plots 154
contour plot 154
horizontal bar chart 154
line and scatter plot 154
pie chart 154
polar plot 154
ternary 154
vertical bar chart 154

Graph types
defined 401

Graph Wizard 160
additional axes 273
bubble plots 246
changing graph type/style 169�170
creating 3D graphs 283
creating mesh plots 285
multiple plots 273
picking data 168
pie charts 353, 358, 372
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selecting graph styles 2, 25
selecting graph types 25
ternary graphs 371
using 97

Graphic file formats
see file formats

Graphs
2D example 9�14
3D example 15�17
adding drop lines 196�198
adding plots 172
adding to page 100�101
aligning 34, 130�131
anatomy of 9�15
automatic legends 138�143
axes 296
box plots 264
centering 130�131
contour plots 14, 351�374
copying 108
creating 151�167, 171�198
cutting 108
data format for graph styles 155�160
data format for graph types 153
defaults, setting 153
defined 9
displaying automatic legends 139
editing in other applications using OLE2 

109�118
grid lines 232
grouped bar charts 247, 250
grouping/ungrouping objects/text 129
hiding 119
hiding automatic legend 139
hiding graph titles 120
hiding on page 119�121
hiding using shortcut menu 119
hiding/displaying plots 174
legends 133
line/scatter 403, 407
modifying 151�167, 171�198
modifying 2D plots 234�273
modifying 3D plots 277�298
modifying type/style 169�170
modifying using Graph Properties dialog 

163�164
moving 126�128
multiple curves, same X or Y 236
multiple plots 172
naming plots 166
pasting without data 112
picking different data for current plot 168�169
pie charts 12, 351�374, 400
plotting data 235, 237
plotting multiple curves 236
plotting X or Y using row numbers 237
polar plots 13, 351�374
references for design 22
resizing labels/legends automatically 95
same X or Y for multiple curves 235
saving 50
scaling 126�128
scatter, 3D 407
selecting 165
selecting style 155�160
selecting type 153
shortcuts to modify 165
single curve plots 235
sizing 34, 126�128
stacked bar charts 408
styles 155�160, 401
symbols 176�184
ternary 351�374
titles 166�167
types 2, 153
using Paste Special 109�112
viewing on page 119�121
working on pages 118�119, 123�125, 146�149
zooming in/out 101�102

Graphs, 2D
 see 2D graphs

Graphs, 3D
see 3D graphs

Greek symbols 135
entering 135

Grids 232
aligning graphs and objects 131
color 231
defined 401
displaying in front/behind 232
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graph back planes 232
hiding 232
line types 232
mesh graphs 3
modifying 296
snap-to 132
turning on/off 232

Grouped bar charts
column averages 250, 252
creating 247, 250
creating with error bars 247
error bars 250, 252
examples 247
spacing bars 194�196

Grouping
objects/text 129

H
Halftones

printing 331
Hardware

system requirements 4
Help system

defined 401
using 19

Hiding
automatic legends 139
axes 225
axis titles 201
contour lines 305
frame lines 298
graph titles 120
graphs on page 119�121
graphs using shortcut menu 119
grid lines 232
legends 120
plots 174
plots using shortcut menu 173
radial axis labels 366
statistics 66
tick labels 217
tick marks 201
toolbars 6�8

Histogram Wizard
using 253�255

Histograms

bucket values 254
creating 253�256
defined 401
histogram transform function 253
Histogram Wizard 253�256
HISTOGRM.XFM transform 255�256

Horizontal bar chart
data format 154

Horizontal error bars
data format 155

Horizontal point plot
data format 156

Hot key
defined 402

I
Icons

changing display for inserted objects 116
changing display for pasted objects 115
displaying inserted objects as 116
displaying pasted objects as 115

Important note
flag used in manual 21

Importing
data 30, 402
data files 60�63, 81
defined 402
EPS files 333
files 61
HPGL files 333
text files 63

In 20
Inches

page units 145
Incrementing

lines 186
symbol color 178

Incrementing colors
chart fills 189

Incrementing schemes
customized 191�193
defined 407
symbols 179

Independent graph pages 49
Independent t-test 91

performing 90



Chapter 

428

Information
using this manual 21

Insert Cells shortcut 58
Insert Date and Time command

for reports 319
Insert Graphic Cells command 191
Insert New Object command 116
Inserting

columns and rows 79�81
data 60
defined 402
displaying inserted objects as icons 116
linked objects 117
modifying inserted object icons 116
new object 116
objects from file 116

Insertion mode
turning on/off 60

Interpolating data
inverse distance method 289
mesh plots 3, 291
setting mesh range values 288

Intervals
confidence/prediction 65, 267�268
tick mark values assigned to a worksheet 216
tick marks 210

Inverse distance interpolation 287
algorithm 289
defined 402

J
Jandel

European office 20
K
Key column 77
Keyboard

entering data with 59
moving around worksheet 57�58

Keystrokes
functions 57

L
Labeling

data columns 31
Labels

adding to page 134�136

aligning 3, 130�131
automatic scaling with graphs 95
axis titles 201, 396
axis values 221
column titles 82�83
column type 223
contour 307�309
creating 133�136
defined 402
editing tick 218
entering non-keyboard characters 135
formatting 3
frequency of contour 307
graph titles 166�167
grouping/ungrouping 129
numeric tick 219, 308
radial axes 367
reference lines 272
rotating 135
rotating contour 307
size, defined 402
sizing 402
suffixes/prefixes 307
tick mark 221, 409
using column title dialog 82
using for column titles 82

Landscape
defined 402
page orientation 144

Layering in front/behind
grid lines 232
reference lines 272

Layout
graph design references 22

Legends
adding symbols 136
adding to page 134�136
aligning 143
automatic 2, 17, 138�143
automatic scaling with graphs 95
creating 133, 133�136
defined 402
deleting 121
editing 141
ungrouping 143
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see also Automatic legends
Light source

3D graphs 296
Line and scatter plots

adding drop lines 196�198
creating 238, 240
data format 154
examples 234

Line plot data formats
multiple horizontal step plot 157
multiple spline curves 156
multiple vertical step plot 156
simple horizontal step plot 157
simple spline curve 156
vertical step plot 156

Line plots
3D data format 154
adding drop lines 196�198
adding drop lines to 196�198
color 186
creating 238, 240
data format 154
examples 234
lines 187
midpoint step 186
multiple straight lines 156
step 186
straight 186
symbols 176�184

Line type
frame lines 296
modifying 124
reference lines 272

Line/scatter graphs
defined 403, 407
error bars 262
lines 187
symbols 176�184

Linear axis scale 204, 219
defined 403

Linear Regression dialog
defined 403

Linear regressions
calculating 268�270
confidence/prediction intervals 267�268

defined 268�269, 403
extending to axes 266
forcing through origin 266
generating 264�268
multiple curves 266
polynomial order 266
results 267

Lines
adding arrow heads 124
assigning to worksheet 191
attributes 227�228
axis 227�228
changing end attributes 124
changing thickness 186
changing type 185
codes for custom sequences 340
color 186
contour 305�306
custom incrementing schemes 191�193
drawing 121
drop 196�198
error bars 258
frame 296
grid 232
grid line types 232
increment customizing 191�196
incrementing 186
layering in front/behind symbols 186
line/scatter plots 187
linear regression 264�268
mesh plots 292
midpoint step plots 186
modifying 187
modifying properties 124
plot 187
radial axes 364�367
reference 273, 406
smoothed 186
spline curves 186
step plots 186
type 185, 340

Linking
defined 403
objects 111�118
Reports 111
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worksheets 48
Links

breaking 118
changing source files 118
editing 118
manual/automatic updating 117
viewing object links 117�118

Logarithmic axis scale 204, 219
defined 403

Logit axis scale 204
defined 403

M
Magnifying

page view 101
Major ticks

Date and Time axis scale 213
modifying 210

Manual
conventions 21
organization of 21

Maximum value (max)
column statistics 66

Mean
column statistics 65
error bar computation method 261

Mean lines 263
box plots 263

Median lines 263
Menu bar

defined 403
Mesh data

converting 3
effects of weight values 288
generating 3, 301
interpolating 3, 291
weighting 288

Mesh plots
3D data format 154
creating 287
defined 403
effects of weight values 288
example 16
examples 278
fills/color 292
interpolating data 3

light source 295
mesh data 3
mesh lines 292
modifying lines/fills 292
plotting data 280�282
transparent 285
weighting data 288
X,Y,Z values 280

MESH.XFM file
generating mesh data 301

Millimeters
page units 145

Minimum positive value (min pos)
column statistics 66

Minimum value (min)
column statistics 66

Minor ticks
Date and Time axes 213
modifying 213

Missing values
column statistics 66
plotting 176

Modifying
2D plots 234�273
3D graph view 292
3D plots 277�298
angular axes 367
automatic legends 138�143
axes 296
axis break appearance 229
axis range 202
axis range by dragging 376
axis scale 206
box fills/color 263
box plots 264
box widths 263
contour labels 307�309
contour lines 305�306
contour plots 304�309
data 29
drawn objects 123�125
drop lines 196�198
edges 189
error bar 262
error bar appearance 258
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error bar computation method 261
error bar direction 259
fills 191
frame lines 296
graph lighting 296
graph perspective 296
graph rotation 296
graph styles 169�170
graph titles 166�167
graph types 169�170
graphs 26, 151�167, 171�198
graphs using Graph Properties dialog 163�164
grid lines 296
grids 230
grids and planes 164
inserted object icons 116
line color 124
line end attributes 124
line thickness 124
line type 124
lines 187
mesh plots 292
multiple selected objects 125
multiple text labels 137
notebook items 40
object fills 123�124
object links 117�118
page color 145�146
page view 101�102
pasted object icon 115
patterns 191
pie charts 355
plot name 166
plot pattern line thickness 189
polar axes 367
polar plots 360�361
radial axes 367
radial axes arc 364�367
radial axes tick labels 367
source files for links 118
symbol attributes 177
symbols 176�184
ternary axis direction 379
ternary plots 374
ternary tick labels 384

ternary tick marks 383
text formatting 137
tick labels 221
tick marks 296
titles and legends 164
whisker cap widths 263
see also Changing

Mouse
moving objects 126
sizing objects 126

Moving
2D axes 227
2D axes manually 226
2D Axes with mouse 226
around the worksheet 57�58
axes to precise location 226
axes with Graph Properties dialog 226
axis titles 201
data 79
graphs 126�128
notebook items between notebooks 49
objects 126�128
objects to back/front 128
radial axis 364�367
to worksheet cell 58
toolbars 8

Multiple axes
creating 275

Multiple curves
creating 257
plotting data 257
regression options 266
same X or Y for 235

Multiple error bars
data format 155

Multiple error bars and regressions
data format 155

Multiple plots 172
additional axes 273

Multiple regressions
data format 155

Multiple scatter plot
data format 155

Multiple spline curve
format 156
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Multiple straight line plot 156
Multiple Z columns 279
N
Naming

graph pages 46
graphs 166�167
notebook files 46
notebook items 46
plots 166
sections 46
worksheets 46

Natural log scale 204
defined 403

Needle plot
creating 195

New
Excel worksheet 43
graphs with templates 103
pages with templates 103
sections 43
worksheets 43

New Features
bubble plots 2
Date and Time 2
Excel 2
export graph objects 2
graph defaults 2
Histogram Wizard 2
modifying ticks 2
Report Editor 2
SigmaPlot 2
ternary graphs 2
transparent mesh 2

Non-keyboard characters
see text

Non-notebook files
exporting to original file format 51
opening 47�48

Notebook files 39
adding new sections 43
adding new worksheets 43
defined 404
naming 46
opening 47
saving 29, 38, 50

template notebook files 106�119
viewing 47

Notebook items 46
cutting/copying between notebooks 49
exporting as non-notebook files 51
naming 46
opening 47
printing selected notebook items 54
saving 50
viewing 47

Novice prompting
defined 404
Options 17

Numbers
display formats 70�71
Options 17

Numeric axis values
factoring out 220

Numeric values
changing contour labels 308�309
tick labels 219, 308

O
Object Properties dialog 94

axis attributes 228
modifying line 124
specifying location 127
specifying size 127

Objects
aligning 3, 130�131
breaking links 118
changing source files for links 118
copying 108
cutting 108
displaying as icons 115, 116
drawing 3, 121
editing linked 111�118
editing links 118
embedding 111�118
fills 123�124
grouping/ungrouping 129
inserting from file 116
inserting linked objects 117
inserting new 116
linking 111�118
modifying 123�125
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modifying object links 117�118
mouse, using to size 126
moving 126�128
moving front/back 128
multiple selection 125
pasting as linked/embedded 115
pasting as specified file type 115
pasting to a page 109�119
positioning on a page 406
scaling 126�128
sizing 126�128
updating links 117
using the Paste Special command 109�112
viewing object links 117�118
working on pages 118�119, 123�125, 146�149

OLE2 4
defined 404
embedding 109�118
linking 109�118
pasting graphs 109�118

Opening
data files into Excel worksheets 85
defined 404
new graph page 43�45
non-notebook files 47�48
notebook files 47
notebook items 47
worksheets 47, 48
worksheets from other SPSS applications 48

Options
author information 18
automatic 95
automatic legends 17
backup files 18
column statistics 17�19
Date and Time 17
defined 404
dialogs 18
graph defaults 153
grid colors 95
grid density 95
grids 95
novice prompting 17
numbers 17
page 17�19

page undo 94
page units 94
setting program 94�95
show rulers 95
Snap-to 95
statistics 17
stretch maintains aspect ratio 94
templates 18
worksheet 17�19

Orientation
defined 404

Origin
axes, defined 404
of tick marks 410

Origin axes 293
Other values

column statistics 66
Outliers

box plots 263
Out-of-range values

plotting 176
Output

creating files 332�333
EPS files 333
HPGL files 333
PostScript files 332

Overwrite mode 60
defined 404

P
Page

adding graphs 100�101
aligning objects/graphs 130�131
associating with worksheet 99
automatic legends 138�143
changing format 143
clearing graphs/objects 121
color 145�146
copying graphs 100
copying objects/graphs 108
creating graphs for current 100
creating new objects to insert 116
cutting objects/graphs 108
defined 404
deleting objects 121
editing format 143
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embedding objects 111�118
exporting as non-notebook file 51�52
hiding graph titles 120
hiding graphs 119�121
hiding legends 120
inserting objects from files 116
legends 134�136
linking objects 111�118
magnifying 101
moving between notebooks 49
moving objects/graphs 126�128
naming 46
notebook files 39
opening new 43�45
orientation 402
paper size 144
pasting graphs 100
pasting graphs/objects 109�112
positioning graphs/objects on 406
selecting graphs 95
selecting objects 95
selecting text 95
setting grid color 95
setting grid density 95
setting Options 17�19
setting snap-to grids 95
setting units of measurement 94
setup 143
showing grids 95
showing rulers 95
sizing graphs and objects 126�128
specifying graph and object location 127
specifying graph and object size 127
starting new 43�45
templates 106�119
text and labels 134�136
units of measurement 145
viewing full 101
viewing graphs 119�121
working with graphs 118�119, 123�125, 

146�149
working with objects 118�119, 123�125, 

146�149
zooming in/out 101�102

Page undo

Options 94
Paired t-test 90

defined 409
performing 90

Paper size 144
Paste shortcut 58
Paste Special

command 109�112
defined 405
displaying pasted objects as icons 115
embedding objects 111�118
linking objects 111�118
modifying pasted object icons 115
pasting graphs without data 112

Pasting
data 79
defined 405
graphs as metafiles 110
graphs to page 100
graphs/objects with the Paste Special command 

109�112
objects 109�112
transpose 81
see also Inserting

Patterns
assigning to worksheet 191
changing 188
changing density of plot fills 189
modifying 191
plot line thickness 189

Perspective
3D graphs 296
defined 405

Picking data 162
different columns to plot 169
different data for current plot 169
Graph Wizard 168

Pie charts 191
adding exploding slices 354�355
data format 154
defined 405
example 12
examples 352
fills 123�124, 191
modifying 355
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plotting data 352�354
rotating 354�355
sample graph 12
slice edges 123�124
slices 400

Planes
defined 396

Plot fills
pattern density 189

Plot styles
multiple curves 257

Plot types
error bars 240

Plots
about 273
adding new 172
contour 351�374
custom incrementing schemes 191�193
defined 9, 405
deleting 174
displaying 174
dummy 275
fill patterns and colors 188
hiding using shortcut menu 173
hiding/showing 174
layering lines in front/behind symbols 186
lines 187
multiple 172
multiple axes for single 275
naming 166
needle plot 195
offsetting radial axes 365
pattern line thickness 189
picking different data 169
pie charts 351�374
plotting portion of data 175
polar 351�374
polar axes 367
same X or Y for multiple curves 235
scatter defined 407
selecting 165
single curve 235
symbols 176�184
ternary 351�374
types 2

undo delete 174
Plots, 2D

box plots 264
creating with error bars 244
grouped bar charts 247, 250
line 234
line and scatter 234
linear regression lines 264�268
modifying 2D 234�273
multiple curves 257
reference lines 273
scatter 234
types available 234, 235

Plots, 3D
bar charts 278
mesh 278
modifying 277�298
types available 277, 279

Plotting
data 24

Plotting data
2D graphs 235, 237
3D graphs 282
additional data 172
bubble plots 246
contour plots 282
missing and out-of-range values 176
multiple curves 236, 257
multiple curves, same X or Y 236
polar plots 357
portion of 175
ternary graphs 371
using row numbers for X or Y values 237

Point
defined 405

Point plot
horizontal data format 156
vertical data format 156

Pointer
defined 405

Points
page units 145

Polar axes
modifying 367
radial tick labels 367
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Polar plots
angular axes 362�363
angular axis units 162
arranging data 357
creating 360
data for multiple curves 357
data format 154
defined 405
example 13, 356
lines 187
modifying 360�361
offsetting radial axes 365
plotting data 357, 360
radial and angular values 357
radial axes 364�367
sample graph 13
symbols 176�184
using XY values 357

Polar plots, multiple curves
data from one column 357

Polynomial order
regression lines 266

Portrait
page orientation 144

Portrait orientation
defined 405

Positioning
2D axes 227
2D axes using Graph Properties dialog 226
3D axes 296
defined 406
graphs on page 406
objects/labels on page 406
toolbars 8

PostScript
EPS files 332, 333
fonts 333
printing files 332
printing fonts 330

Precise location
moving axes to 226

Precision options 220
Prediction intervals

adding to 2D graphs 267�268
calculating 268�270

defined 270
linear regressions 267�268

Prefixes
contour labels 307
tick labels 221

Printer drivers
printing tips 329�333

Printers
fonts 329

Printing
column statistics 67
Excel worksheets 86
halftones 331
page 37
PostScript files 332
PostScript fonts 330
selected notebook items 54
tips 329�333
to graphic file formats 332�333
TrueType fonts 329�330
worksheet data 52�53

Probability axis scale 204
defined 406

Probit axis scale 204
defined 406

Properties
modifying text 137

Q
Quality control lines

see reference lines
QuickStart 23
Quitting

SigmaPlot 20
R
R value

defined 406
Radial axes

attributes 366
defined 406
lines 364�367
modifying 364�367
moving 364�367
offset from graph center 365
tick labels 367
turning on/off 364�367
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Radial labels
turning on/off 366

Radial values 357
Random data

generating 91
Range

Z data for contour plots 306
Range, axis

angular axis 362�363
axis values 202, 306
changing 202
defined 396
modifying by dragging 376
ternary axes 378

Rearranging data 81
Reference lines

adding to 2D graphs 273
defined 406
direction 272
displaying 271
displaying in front/behind 272
labels 272
line attributes 272
line thickness 272
line type 272
lower specification 272
statistics 272
turning on/off 271

References
graph design 22

Regional settings
Date and Time format 74

Regression Wizard 3, 92, 265
see Programming Guide

Regressions
coefficients 407
defined 403, 406
fitting data 3
linear, defined 403
order 407
using data in Excel worksheets 87
using the Regression Wizard 92

Report Editor 3
creating reports 312
description 311

formatting toolbar 318
ruler 315

Report Options command 312
Report page

defined 407
Reports

embedding objects 111
inserting date and time 318
linking objects 111
Report Editor 3

Results
linear regressions 267
t -test 90

Right-clicking
custom color 149
hiding graphs 119
hiding plots 173
selected graphs 165
selected graphs and objects 95
to create new sections 43
to create new worksheets 43

Rotating
3D graphs 296, 407
3D graphs axes placement 296
angular axis 362�363
contour labels 307
labels 135
pie charts 354�355
text 135

Rows
deleting 79�81
inserting empty 79�81
selecting 77
sizing 68, 76
transposing 81
using as column titles 82, 83

Rulers
aligning graphs and objects 131

S
Sampling

data 175
Saving

data 50
graphs 50
JNT files 409
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linear regression results 267
notebook files 29, 38, 50, 50
pages 50
t-test results 90
worksheets 50

Scale
angular 362�363
axis 2
base/exponent labels 219
category 205, 206
changing 206
common log 204
Extreme Value Distribution 208
linear 204
logit 204
natural logarithmic 204
probability 204
probit 204
tick labels 221
tick marks 216, 384
types 2, 206

Scale, axis
base/exponent labels 309
category 397
contour plots 306
defined 396
linear 403
logit 403
natural log 403
natural logarithmic 403
probability 406
probit 406

Scales
Arrhenius 208

Scaling
aspect ratio 395
graphs 126�128
objects 126�128
resizing labels/legends automatically with graphs 

95
setting aspect ratio option 94
using mouse 126
using Object Properties 127

Scatter plots
3D data format 154

creating 238, 240
data format 154
drop lines 198
error bars 262
examples 234
lines 187
symbols 176�184

Scatter plots, 3D
changing to mesh plot 291
creating 283, 284
defined 407

Scientific notation 219
defined 407
using as axis values 219, 309

Scroll box
defined 407

Section
creating 43
defined 407
editing 46
naming 37, 46
new 43
notebook files 39

Selecting
all data in worksheet 77
columns 77
data 24, 77
data for bar charts 161
defined 408
entire worksheet 77
graph style 155�160
graph type 153
graphs 165
graphs on page 95
objects on page 95
plots 165
right-clicking graphs 95, 165
rows 77
text on page 95

Selection mode 95
Setting

axis breaks 230
program options 341�348

Setting up
graph page format 143
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Settings
3D graph view 292
angular axis 362�363
aspect ratio 94
axis breaks 229
column statistics 17�19
error bars 258
frame lines 296
graph defaults 153
object location on page 127
program options 94�95
radial axes 364�367
reference lines 272
statistics 66
worksheet 17�19

Shading
3D graphs 296

Shapes
lines 186

Shortcut menu
hide 119, 173

Shortcuts
worksheet 58

Showing
see Viewing

SigmaLink
defined 408
worksheet 48

SigmaPlot
exiting 20
new features 2
notebook files 39
system requirements 4
using OLE2 to edit graphs pasted to other 

applications 109�118
using this manual 21

Simple error bars
data format 155

Simple error bars and regression
data format 155

Simple regression
data format 155

Simple scatter plot
data format 155

Simple spline curve

data format 156
Simple straight line plot

data format 156
Single curves

creating 235
Size

column statistics 65
values from column for symbols 182

Sizing
aspect ratio 395
Columns and Rows 68
columns and rows 76
graphs 34, 126�128
labels 402
objects 126�128
resizing labels/legends automatically with graphs 

95
setting aspect ratio preference 94
using mouse 126
using Object Properties dialog 127

Slices, pie chart
defined 400
edges 123�124
exploding 354�355
rotating 354�355

Snap-to 132
Sorting

data 77�78
defined 408

Spacing
bars 194�196
bars from different plots 194�196, 250
box plots 263

Speed
increasing drawing speed 174

Spline curve
defined 408

SPSS
identification number 4
serial number 4

SPW32.INI file
editing 341�348

Stacked bar charts
automatic reference lines 271
defined 408
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Standard deviation
column statistics 65
defined 408

Standard error
column statistics 65
defined 409

Statistics
calculation of t 90
Options 17
reference lines 272
setting Options 66
showing/hiding 66
using Excel worksheets 86
worksheet 3

Student�s t statistic
see t -test

Styles
defined 401
graph 155�160, 401

Subscript 133
Suffixes/prefixes

contour labels 307
tick labels 221

Sum
column statistics 65

Summary Information
author 18

Superscript 133
Symbols

alphanumeric 180
assigning to worksheet 191
box plots 263
changing edge color 178
changing edge thickness 178
changing fills 178
changing size 177
changing type 177
characters used as 180
color incrementing 178
custom codes 338�339
custom incrementing schemes 191�193
defined 409
dot/crosshair color 178
fills 123�124
Greek 135

increment customizing 191�196
incrementing schemes 179
inserting in legends 136
layering lines in front/behind 186
modifying attributes 177
modifying in plots 176�184
size values from a worksheet column 182
using characters as 180

System requirements 4
Excel workbooks 4
hardware 4

T
t -test

calculation of t 90
unpaired test 91

TEMPLATE.JNT 107, 409
Templates

creating 106�119
defined 409
JNT files 107, 409
notebook files 106�119
Options 18
page 106�119
SigmaPlot samples 328

Terminology 9
Ternary axes

about 374
changing range 378
dragging 376

Ternary axis direction
modifying 379

Ternary graphs 374
arranging data 371
changing axis direction 379
changing range direction 379
changing scale direction 379
changing scale type 378
creating 372�373
data for multiple -curve plot 370
data for single plot curve 369
data format 154
data source 371
defined 369
Graph Wizard 371
line plots 369
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line/scatter plots 369
modifying plots 374
modifying tick labels 384
modifying tick marks 383
normalizing data for 370�371
percentage scale (0-100) 371
plot data set 372
plotting data 371
scatter plots 369
selecting data 372, 373
selecting worksheet data 371
third-column data 370
transforms menu 370
unitary scale 371

Ternary triplets
data for 369
multiple-curve plots 370

Text
adding to page 134�136
alignment 133
editing contour labels 308
editing tick labels 218
entering 133�136
formatting 137
grouping/ungrouping 129
properties dialog 137
rotating 135
subscript 133
superscript 133
using as plot symbols 180

Text box
defined 409

Text files
defined 409
importing 63

Text labels
creating 133

Text mode
entering non-keyboard characters 135

Text Properties dialog
changing text lables 217

Thickness
axis lines 227�228
contour lines 305
grid lines 232

line 124, 186
radial axes 366
reference lines 272
tick marks 215, 384

Thickness plot pattern lines 189
Three dimensional

see 3D (at beginning of index)
Tick 213
Tick direction 214
Tick intervals

Date and Time 213
Tick labels

custom 223, 309
date and time 309
Date and Time axes 223
defined 409
editing text 218
factors 220
modifying 221
modifying ternary 384
numeric notation 219, 308
prefix/suffix 221
radial axes 367
text attributes 217
time and date 220
turning on/off 217
using from a worksheet column 223, 309

Tick Line options 215
Tick marks

customizing intervals 216
Date and Time axes 213
defined 409
hiding 201
intervals 210
intervals assigned to a worksheet 216
labels 221, 409
length 215, 384
modifying 216, 384
modifying ternary 383
origin 410
turning on/off 215
viewing 201

Time and date
see also Date and Time

Time delimiters
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Date and Time format 60
Titles

axis 201
column 82�83
column title dialog 82
editing 83
graph 166�167
hiding graph 120
using cells as column titles 83
using worksheet rows as column titles 82

Toolbars
2D graph 31
defined 410
displaying 6�8
drawing 122
Excel 87
hiding 6�8
positioning 8
Report Editor 7
using 6, 31

Tools menu
draw arrow 121
draw box 121
draw ellipse 121
draw line 121

Tools menu commands
Text 133�136

ToolTips 7
Trajectory plots

creating 283, 284
lines 187
symbols 176�184

Transforms
applying to data 3
defined 3, 410
generating data 92
generating mesh data 301
HISTOGRM.XFM 255�256
using data in Excel worksheets 87
using transform language 91

Transforms menu
interpolate 3D mesh 291
Regression Wizard 92
ternary data 370

Transparent mesh

creating plots 285
selecting shading 285
video card requirements 410

Transpose Paste shortcut 58
Transposing

defined 410
rows and columns 81

Triplet data
interpolating 291

TrueType fonts
printing 329�330

t-test
defined 409
paired test 90
performing 90

Tukey plot
see box plot

Turning on/off
axes 225
contour labels 307
contour lines 305
frame lines 298
grids 232
insertion mode 60
plots 174
radial axes 364�367
radial labels 366
reference lines 271
tick labels 217
tick marks 215
toolbars 6�8

Two dimensional
see 2D (at beginning of index)

Types
graph 153
lines 185

U
Ungrouping

legends 143
objects/text 129

Units of measurement
page 145

Unpaired t -test 91
Updating

object links 117
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User-defined
command with bubble plots 245

V
Values

angular 357
axis range 306
axis scale 202, 306
bucket 254
minimum 66
minimum and maximum 66
minimum positive 66
missing 66
plotting missing and out-of-range 176
radial 357
tick intervals 210
Z data for contour plots 306

Values, axis
factors 220
labels 221
numeric labels 219, 308
range 202, 306
time and date 220, 309

Variable bar widths 196
Vertical bar chart

data format 154
Vertical dot plot

data format 156
Vertical point plot data format 156
Video card requirements

transparent mesh 410
View

3D graphs 292
View menu commands 101

drawing toolbar 122
full screen 101
zoom 101

Viewing
axis titles 201
column statistics 3, 64�67
column statistics in Excel worksheets 86
contour lines 305
full page 101
graphs 101�102, 119
graphs on page 119�121
inserted objects as icons 116

linear regression results 267
notebook files 47
notebook items 47
object links 117�118
pasted objects as icons 115
tick marks 201
toolbars 6�8, 87

W
Weighting

effects on data 288
mesh plot data 288
option value 288

Whiskers
box plots 263
defined 411

Widths
bar/box widths 195
box widths 263
whisker caps 263

Window menu commands 100
Wizards

Graph 160
Histogram 253�256
Regression 3

Worksheet
assigning codes 335�340
associating additional pages 99
column statistics 64�67, 86
column titles 82�83
column type labels 223
creating 43
defined 410
edit box 59
entering data 55�88, 92
Excel 84�85
exporting as non-notebook file 51
exporting data 52�53, 400
going to a cell 58
importing data 60�63, 81
inserting columns and rows 79�81
inserting graphic cells 191
inserting symbol size values 182
insertion mode 60
linking 48
moving around 57�58
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moving between notebooks 49
moving data 79
naming 46
new 43
notebook files 39
opening 47, 48
opening from other SPSS applications 48
overwrite mode 60
printing 52�53
right-click pop-up menu shortcuts 58
selecting all data 77
selecting data 77
selecting entire 77
setting Options 17�19
SigmaLink 48
SigmaPlot 3
sorting data 77�78

statistics 3
Statistics, showing/hiding 66
transposing rows and columns 81

X
X,Y values

bubble plots 244
X,Y, many Z

Contour plots 281
Mesh plots 281

X,Y,Z values
Contour plots 280
Mesh plots 280

Z
Zooming in/out

defined 411
on graphs 34, 101�102


